PAC CONTROL
USER’S GUIDE
# Table of Contents

## Chapter 1: Welcome to PAC Control
- Introduction ......................................................... 1
- For Developers: SNAP PAC REST API .......................... 1
- About this Guide ................................................... 1
  - Choosing Documentation ........................................ 2
  - Document Conventions ......................................... 3
  - Help, Documents, and Opto22.com Resources ............... 3
  - Product Support .................................................. 4
  - System Requirements ............................................. 5
  - Important Note on Disk Drives ................................. 5
  - Compatible Controllers and I/O Units ....................... 5

## Chapter 2: PAC Control Tutorial
- Introduction ......................................................... 7
- Opening the Strategy ............................................. 7
- Saving the Strategy ............................................... 9
- Examining the Strategy ........................................... 10
  - The Strategy Tree Window .................................... 11
  - Docking the Strategy Tree ................................... 12
  - Using Quick Find ............................................... 13
- Opening a Chart .................................................. 13
  - PAC Control Blocks and Connections ....................... 15
- Opening a Block ................................................... 16
  - Add a New Block and a New Connection .................... 16
  - Rename a Block ................................................ 17
  - Select a Continue Block’s Destination ..................... 18
- Adding a Command ................................................ 18
- Configuring a Control Engine .................................. 23
- Compiling the Strategy ......................................... 25
- Running the Strategy ............................................ 27
  - Inspecting Messages ......................................... 29
  - Stepping Through the Chart .................................. 29
  - Auto Stepping .................................................. 31
- Compiling and Downloading the Change ..................... 34
- Using a Watch Window .......................................... 37
Chapter 5: Working with Control Engines ................................................. 95
Introduction .................................................................................. 95
Configuring Control Engines ......................................................... 95
    Defining a Control Engine on Your PC ................................... 95
    Associating the Control Engine with Your Strategy ............... 98
Segmenting Networks In PAC Control .......................................... 99
Creating Redundant Ethernet Links in PAC Control ..................... 100
    System Architecture for Ethernet Link Redundancy .......... 101
    Configuring Ethernet Link Redundancy ........................... 104
    Using Strategies with Link Redundancy .......................... 104
Using Redundant Controllers ....................................................... 104
Changing or Deleting a Control Engine ........................................ 104
    Changing a Control Engine’s Definition .......................... 104
    Changing the Control Engine that Receives the Downloaded Strategy .................................................. 105
Removing a Control Engine’s Association with a Strategy .......... 105
Deleting a Control Engine from Your PC ................................... 105
Inspecting Control Engines and the Message Queue ................... 106
    Inspecting Control Engines in Debug Mode ................. 106
    Viewing the Message Queue ....................................... 108
    Inspecting Control Engines from PAC Terminal ........... 110
Archiving Strategies on the Control Engine .............................. 110
Restoring Archived Strategies from the Control Engine .......... 112
Moving Control Engines from One PC to Another ...................... 113
Downloading Files Using PAC Terminal ..................................... 114

Chapter 6: Working with I/O ............................................................... 117
Introduction .................................................................................. 117
Choosing a Configuration Tool ...................................................... 117
    Configuring groov I/O with PAC Control .................. 117
    Choosing a Configuration Tool for SNAP I/O ............. 117
Importing PAC Manager I/O Configuration into PAC Control .... 118
Copying SNAP I/O Configurations .............................................. 118
Adding an I/O Unit ...................................................................... 119
    Changing the Baud Rate for SNAP Serial I/O Units .... 122
    Changing the Baud Rate and Mode for SNAP Serial I/O Units .................................................. 122
    Tuning the I/O Unit Timeout Value for SNAP Ethernet I/O Units ............................................... 123
    Changing Configured I/O Units .................................. 124
    Deleting Configured I/O Units .................................... 124
Adding I/O Points .......................................................................... 124
    Making I/O Values Publicly Accessible ...................... 124
    Automatically Adding groov I/O Modules and Channels .................................................. 124
    Manually Adding groov I/O Modules & Channels or SNAP I/O Modules & Points ......... 126
<table>
<thead>
<tr>
<th>Chapter 7: Working with Strategies</th>
<th>175</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>175</td>
</tr>
<tr>
<td>Creating a New Strategy</td>
<td>175</td>
</tr>
<tr>
<td>Opening a Strategy</td>
<td>176</td>
</tr>
<tr>
<td>Opening an Existing Strategy</td>
<td>176</td>
</tr>
<tr>
<td>Opening an ioControl Strategy</td>
<td>176</td>
</tr>
<tr>
<td>Opening a Recently Used Strategy</td>
<td>176</td>
</tr>
<tr>
<td>Loading a Strategy or Mode at Startup</td>
<td>176</td>
</tr>
<tr>
<td>Opening Strategies in PAC Control</td>
<td>176</td>
</tr>
<tr>
<td>Opening an OptoControl Strategy</td>
<td>177</td>
</tr>
<tr>
<td>Saving and Closing</td>
<td>177</td>
</tr>
<tr>
<td>Saving the Strategy and All Charts</td>
<td>177</td>
</tr>
<tr>
<td>Saving the Strategy and Some Charts</td>
<td>177</td>
</tr>
<tr>
<td>Saving the Strategy to a New Name</td>
<td>177</td>
</tr>
<tr>
<td>Saving Before Debugging</td>
<td>178</td>
</tr>
<tr>
<td>Closing a Strategy</td>
<td>178</td>
</tr>
<tr>
<td>Saving a Strategy to Flash</td>
<td>178</td>
</tr>
<tr>
<td>Saving to Flash Once</td>
<td>178</td>
</tr>
</tbody>
</table>
Chapter 8: Working with Flowcharts

Introduction .................................................. 213
Creating a New Chart ........................................ 213
Working with Chart Elements ............................... 214
  Chart Components .......................................... 214
  Changing the Appearance of Elements in a Chart Window ........ 215
  Drawing Blocks ............................................. 217

Archiving Strategies on the Computer ..................... 179

Compiling and Downloading ................................ 180
  Compiling and Downloading in One Step ................. 180
  Switching the Strategy .................................... 182
  Compiling without Downloading .......................... 183
  Downloading Only ......................................... 183
  Background Downloading .................................. 183
  Downloading Without Using PAC Control ................ 185
  Changing Download Compression .......................... 187

Running a Strategy Manually .............................. 188
Running a Strategy Automatically (Autorun) ............... 188
  Protecting a Running Strategy ............................. 189

Debugging .................................................. 189
  Choosing Debug Level ..................................... 189
  Changing Debugger Speed .................................. 189
  Pausing a Chart or Subroutine ......................... 190
  Stepping Through a Chart or Subroutine ............... 191
  Setting and Removing Breakpoints ...................... 193
  Managing Multiple Breakpoints .......................... 195
  Interpreting Elapsed Times .............................. 196

Viewing and Printing ........................................ 196
  Viewing Strategy Filename and Path ..................... 197
  Viewing an Individual Chart or Subroutine ............ 197
  Viewing All Charts in a Strategy ....................... 197
  Printing Chart or Subroutine Graphics .................. 198
  Viewing and Printing Strategy or Subroutine Commands .... 200
  Viewing and Printing Strategy or Subroutine Elements .... 201
  Viewing and Printing a Cross Reference ............... 202
  Viewing and Printing a Bill of Materials ............... 202
  Viewing and Printing I/O Point Mappings ............... 203

Searching and Replacing ................................... 204
  Searching .................................................. 204
  Replacing .................................................. 206

Legacy Options ............................................. 208
  Existing Strategies ....................................... 208
  New Strategies ............................................ 208
  Enabling Legacy Options .................................. 209

Advanced Options .......................................... 210

Searching and Replacing ................................... 204
  Searching .................................................. 204
  Replacing .................................................. 206

Chapter 8: Working with Flowcharts .......................... 213

Interpreting Elapsed Times ................................ 196
Managing Multiple Breakpoints ............................ 195
Setting and Removing Breakpoints ....................... 193
Pausing a Chart or Subroutine ............................ 190
Stepping Through a Chart or Subroutine ................ 191
Changing Debugger Speed .................................. 189
Choosing Debug Level ..................................... 189
Compiling and Downloading ............................... 180
Compiling and Downloading in One Step ................. 180
Switching the Strategy ..................................... 182
Compiling without Downloading .......................... 183
Download Only ............................................. 183
Download Without Using PAC Control .................... 185
Changing Download Compression .......................... 187
Running a Strategy Manually .............................. 188
Running a Strategy Automatically (Autorun) ............... 188
  Protecting a Running Strategy ............................. 189
Debugging .................................................. 189
  Choosing Debug Level ..................................... 189
  Changing Debugger Speed .................................. 189
  Pausing a Chart or Subroutine ......................... 190
  Stepping Through a Chart or Subroutine ............... 191
  Setting and Removing Breakpoints ...................... 193
  Managing Multiple Breakpoints .......................... 195
  Interpreting Elapsed Times .............................. 196
Viewing and Printing ........................................ 196
  Viewing Strategy Filename and Path ..................... 197
  Viewing an Individual Chart or Subroutine ............ 197
  Viewing All Charts in a Strategy ....................... 197
  Printing Chart or Subroutine Graphics .................. 198
  Viewing and Printing Strategy or Subroutine Commands .... 200
  Viewing and Printing Strategy or Subroutine Elements .... 201
  Viewing and Printing a Cross Reference ............... 202
  Viewing and Printing a Bill of Materials ............... 202
  Viewing and Printing I/O Point Mappings ............... 203

Searching and Replacing ................................... 204
  Searching .................................................. 204
  Replacing .................................................. 206

Legacy Options ............................................. 208
  Existing Strategies ....................................... 208
  New Strategies ............................................ 208
  Enabling Legacy Options .................................. 209

Advanced Options .......................................... 210
Chapter 10: Programming with Commands ............................................ 255

Introduction .......................................................................................... 255
Analog Point Commands ........................................................................ 256
  Offset and Gain Commands ................................................................. 256
  Analog Totalizers ............................................................................... 256
  Minimum/Maximum Values ................................................................. 256
  Analog Points and OptoScript Code ...................................................... 256
  Reading or Writing Analog Points ......................................................... 257
Chart Commands ..................................................................................... 257
  About the Task Queue ........................................................................ 257
Communication Commands .................................................................... 257
  Communication Handles ..................................................................... 258
  TCP Communication Handles .............................................................. 260
  UDP Communication Handles ............................................................ 267
  Managing and Accessing Files in the Control Engine’s File System .... 275
  Moving Files via FTP .......................................................................... 282
  Communicating with Serial Devices .................................................... 286
  Sending an Email ................................................................................ 290
  Retrieving a Webpage ........................................................................ 299
Control Engine Commands ..................................................................... 302
  Commands Relating to Permanent Storage ......................................... 303
Digital Point Commands ....................................................................... 303
  States, Latches, and Counters .............................................................. 304
  Totalizers ........................................................................................... 305
  Pulses ................................................................................................. 305
  IVAL and XVAL ................................................................................ 306
  Additional Commands to Use with Standard Digital Points ............... 306
  Standard Digital Points and OptoScript Code ...................................... 306
  Reading or Writing Digital Points ......................................................... 307
Error Handling Commands ..................................................................... 307
  IO Enabler Sample Strategies ............................................................ 307
I/O Quality Commands ........................................................................... 307
  Quality Indicator Codes ..................................................................... 308
I/O Unit Commands ............................................................................... 309
  Commands for Ethernet Link Redundancy .......................................... 309
  Table Commands ............................................................................... 310
I/O Unit—Event Message Commands .................................................... 310
I/O Unit—Memory Map Commands ....................................................... 311
I/O Unit—Scratch Pad Commands ......................................................... 311
Logical Commands ............................................................................... 313
  Understanding Logical Commands ..................................................... 314
Mathematical Commands ..................................................................... 314
  Using Integers ................................................................................... 315
  Using Floats ....................................................................................... 315
  Mixing and Converting Integers and Floats ......................................... 317
Miscellaneous Commands ..................................................................... 317
  Comment Commands ......................................................................... 317
PID—Ethernet Commands ..................................................................... 318
Chapter 11: Using OptoScript ............................ 333

Introduction ........................................... 333

About OptoScript .................................... 333

When to Use OptoScript ............................ 334

For Math Expressions ............................... 334

For String Handling ................................. 335

For Complex Loops .................................. 337

For Case Statements ............................... 339

For Conditions ...................................... 340

For Combining Expressions, Operators, and Conditions ............ 341

OptoScript Functions and Commands ............... 342

Standard and OptoScript Commands ............... 342

Using I/O in OptoScript ......................... 342

OptoScript Syntax .................................. 343

More About Syntax with Commands ............... 344

OptoScript Data Types and Variables ............. 344

Variable Name Conventions ....................... 344

Using Numeric Literals ............................ 345

Making Assignments to Numeric Variables ......... 345

Using Strings ....................................... 345

Working with Pointers ............................ 346

Working with Tables ............................... 348
# Appendix B: Errors and Messages

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>838</td>
</tr>
<tr>
<td>Types of Errors</td>
<td>838</td>
</tr>
<tr>
<td>PAC Control Errors</td>
<td>838</td>
</tr>
<tr>
<td>Queue Messages</td>
<td>834</td>
</tr>
<tr>
<td>Status Codes</td>
<td>835</td>
</tr>
<tr>
<td>Naming Conflicts</td>
<td>835</td>
</tr>
<tr>
<td>List of Common Messages</td>
<td>835</td>
</tr>
</tbody>
</table>

# Appendix C: PAC Control Files

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>393</td>
</tr>
<tr>
<td>Files Related to a Strategy</td>
<td>393</td>
</tr>
<tr>
<td>Files Associated with a Subroutine</td>
<td>394</td>
</tr>
<tr>
<td>Files in the PAC Control Directory</td>
<td>394</td>
</tr>
</tbody>
</table>

# Appendix D: Sample Strategy

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>395</td>
</tr>
<tr>
<td>Factory Schematic</td>
<td>395</td>
</tr>
<tr>
<td>Description of the Process</td>
<td>395</td>
</tr>
<tr>
<td>Dough Vessel</td>
<td>395</td>
</tr>
<tr>
<td>Chip Hopper</td>
<td>396</td>
</tr>
<tr>
<td>Oven</td>
<td>396</td>
</tr>
<tr>
<td>Inspection Station</td>
<td>396</td>
</tr>
<tr>
<td>Conveyor</td>
<td>396</td>
</tr>
<tr>
<td>Emergency Stops</td>
<td>396</td>
</tr>
<tr>
<td>Required I/O</td>
<td>397</td>
</tr>
<tr>
<td>Analog I/O</td>
<td>397</td>
</tr>
<tr>
<td>Digital I/O</td>
<td>397</td>
</tr>
</tbody>
</table>

# Appendix E: OptoScript Language Reference

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>399</td>
</tr>
<tr>
<td>OptoScript Compared to Standard Programming Languages</td>
<td>399</td>
</tr>
<tr>
<td>Function Comparison</td>
<td>400</td>
</tr>
<tr>
<td>Variable Comparison</td>
<td>402</td>
</tr>
<tr>
<td>Notes to Experienced Programmers</td>
<td>403</td>
</tr>
<tr>
<td>Variable Database and Other Surprises</td>
<td>403</td>
</tr>
<tr>
<td>PAC Control's Target Audience</td>
<td>403</td>
</tr>
<tr>
<td>Language Syntax</td>
<td>403</td>
</tr>
<tr>
<td>OptoScript Lexical Reference</td>
<td>404</td>
</tr>
<tr>
<td>Keywords (Reserved Words)</td>
<td>404</td>
</tr>
<tr>
<td>Operators</td>
<td>404</td>
</tr>
<tr>
<td>Comments</td>
<td>405</td>
</tr>
<tr>
<td>OptoScript Grammar Syntax Reference</td>
<td>405</td>
</tr>
</tbody>
</table>

# Appendix F: Software Licensing Information

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opto 22 License Agreement for Embedded Software</td>
<td>409</td>
</tr>
</tbody>
</table>

# Index

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>411</td>
</tr>
</tbody>
</table>
1: Welcome to PAC Control

INTRODUCTION

Welcome to PAC Control™, Opto 22’s visual control language for Opto 22 SNAP PAC control systems and the input/output (I/O) units that work with them.

PAC Control makes it easy to write control applications with little or no programming experience. If you know how to design a control application and can draw some flowcharts to describe it, you already know the basics of PAC Control. At the same time, PAC Control provides a complete and powerful set of commands, as well as the OptoScript™ programming language, to meet your most demanding industrial control needs.

PAC Control comes in two forms: PAC Control Basic™ and PAC Control Professional™.

- **PAC Control Basic** is included in the purchase of an Opto 22 SNAP PAC controller and is also available as a free download from our website, www.opto22.com. PAC Control Basic includes both flowchart and OptoScript programming, subroutines, a graphical debugger, and about 400 commands.

- **PAC Control Professional** is available for purchase either separately or as part of the complete PAC Project™ Professional software suite. The Professional version of PAC Control adds:
  - Support for controller redundancy and Ethernet link redundancy to controllers and I/O units
  - Support for Legacy hardware, including serial mistic™ I/O units with a SNAP PAC S-series controller
  - A conversion utility to help you move older OptoControl™ strategies to PAC Control
  - Additional "Pro version only" PAC Control commands

For information on features supported by a specific controller, see the controller documentation.

FOR DEVELOPERS: SNAP PAC REST API

If you’re a developer who’d like to use PAC Control strategy tags in communications with other devices, the Opto 22 SNAP PAC REST API is a secure and powerful way to do just that. The API is available in SNAP PAC R-series and S-series controllers with PAC firmware R9.5a and higher. To configure https access to your PAC’s RESTful server and learn how to call the API, visit developer.opto22.com.

ABOUT THIS GUIDE

This user’s guide not only teaches you how to use PAC Control, but also provides programming instruction and tips. The separate **PAC Control Command Reference, Legacy Edition** (form 1711) describes in detail all PAC Control programming commands and instructions.

This guide assumes that you are already familiar with Microsoft® Windows® on your personal computer, including how to use a mouse, standard commands, and menu items to open, save, and close files. If you are
ABOUT THIS GUIDE

not familiar with Windows or your PC, refer to the documentation from Microsoft and your computer manufacturer.

This guide covers both PAC Control Basic and PAC Control Professional.
The Basic icon indicates features or functions that apply only to PAC Control Basic.
The Pro icon indicates features or functions that apply only to PAC Control Professional.

Here’s what is in this user’s guide:

1: Welcome to PAC Control—information about the guide and how to reach Opto 22 Product Support.
2: PAC Control Tutorial—a tutorial designed to help you use PAC Control as quickly as possible. The chapter leads you through a sample strategy that you can manipulate, download, and run in Debug mode.
3: What Is PAC Control?—an introduction to PAC Control, key terminology, and the main windows and toolbars.
4: Designing Your Strategy—programming in PAC Control: how to get from your real-world control problem to a working strategy.
5: Working with Control Engines—how to configure and communicate with control engines.
6: Working with I/O—how to configure and communicate with input/output (I/O) units, I/O points, and PID loops.
7: Working with Strategies—detailed steps for creating, compiling, and running strategies.
8: Working with Flowcharts—detailed steps for creating and working with the flowcharts that make up your strategy.
9: Using Variables and Commands—steps for configuring the seven types of variables you can use in programming: communication handle, numeric, string, pointer, numeric table, string table, and pointer table variables. Also shows how to use the commands that control the I/O and variables you’ve configured.
10: Programming with Commands—important tips on using PAC Control commands to accomplish what you want in your strategy.
11: Using OptoScript—details on the optional scripting language available in PAC Control for complex loops, string handling, and mathematical expressions.
12: Using Subroutines—how to use subroutines to streamline your strategy development.
A: Troubleshooting—tips for resolving communication problems and other difficulties you may encounter.
B: Errors and Messages—types of errors, where you’ll see them, and the causes of common errors.
C: PAC Control Files—a list of all PAC Control files located in the PAC Control directory and in any strategy directory.
D: Sample Strategy—an illustration and description of the sample “Cookies” strategy used in Chapter 1.
E: OptoScript Language Reference—details about OptoScript code, including comparisons to other languages, lexical reference, and notes to experienced programmers.
Index—alphabetical list of key words and the pages where they are located.

Choosing Documentation

This user’s guide contains the latest information you need to use PAC Control with your SNAP PAC system. However, if you are using Opto 22 “legacy” products designed to work with pre-SNAP PAC systems, see the PAC Control User’s Guide, Legacy Edition (form 1710). The legacy version includes references to pre-SNAP PAC devices and commands, which are not included in this guide.
For information on what we mean by “legacy” and how to migrate from an older system to a SNAP PAC system, see the *SNAP PAC System Migration Technical Note* (form 1688).

To enable legacy I/O units and commands in PAC Control, see “Legacy Options” on page 208.

**Document Conventions**

The following conventions are used in this document:

- Italic typeface indicates emphasis and is used for book titles. (Example: “See the *PAC Display User’s Guide* for details.”)
- Names of menus, commands, dialog boxes, fields, and buttons are capitalized as they appear in the product. (Example: “From the File menu, select Print.”)
- File names appear either in all capital letters or in mixed case, depending on the file name itself. (Example: “Open the file TEST1.txt.”)
- Key press combinations are indicated by plus signs between two or more key names. For example, Shift+F1 is the result of holding down the Shift key, then pressing and releasing the F1 key. Similarly, Ctrl+Alt+Delete is the result of pressing and holding the Ctrl and Alt keys, then pressing and releasing the Delete key.
- “Click” means press and release the left mouse button on the referenced item. “Right-click” means press and release the right mouse button on the item.
- Menu commands are referred to with the Menu > Command convention. For example, “File > Open Project” means to select the Open Project command from the File menu.
- Numbered lists indicate procedures to be followed sequentially. Bulleted lists (such as this one) provide general information.

To simplify the text and make it quicker to read, this document consolidates all the variants of a part name to one part name. For example, there are three variants of the SNAP-PAC-S1:

- SNAP-PAC-S1
- SNAP-PAC-S1-FM
- SNAP-PAC-S1-W

When you see “SNAP-PAC-S1” in the text, the information also applies to SNAP-PAC-S1-FM and SNAP-PAC-S1-W. If there is a situation where the information does not apply to one of the variants, it is specifically called out in the text.

**Help, Documents, and Opto22.com Resources**

To help you learn, understand, and use PAC Control systems, we offer a wide variety of options:

- Help is available in PAC Control and in all of the applications in the PAC Project™ Software Suite from Opto 22.
  - To see screen and field-level help, click the Help button on any PAC Control screen. While entering commands (instructions), click the Command Help button to see details about the command.
  - In the PAC Control menu bar, click Help to view the list of help topics.
  - Click Help > Manuals to open the PDF versions of the documents that are installed when you install PAC Control, including:
    - The *PAC Control User’s Guide* (form 1700)—Shows how to install and use PAC Control.
    - The *PAC Control Command Reference* (form 1701)—Contains detailed information about each command available in PAC Control.
    - The *PAC Control Commands Quick Reference* (form 1703)—Lists all PAC Control commands plus their OptoScript code equivalents and arguments.
About This Guide

- Our website at www.opto22.com offers a broad range of resources—from helpful videos to online blogs, forums, and news to free online self-training. We even offer free hands-on training at our headquarters in Temecula, California.

Product Support

If you have any questions about PAC Control, you can call, fax, or email Opto 22 Product Support.

**Phone:**
800-TEK-OPTO (800-835-6786 toll-free in the U.S. and Canada)
951-695-3080
Monday through Friday,
7 a.m. to 5 p.m. Pacific Time

**Fax:**
951-695-3017

**Email:**
support@opto22.com

**Opto 22 website:**
www.opto22.com

When calling for technical support, you can help us help you faster if you provide the following information to the Product Support engineer:

- A screen capture of the Help > About dialog box showing software product and version (available by clicking Help > About in the application’s menu bar).
- Opto 22 hardware part numbers or models that you’re working with.
- Firmware version (Available in PAC Manager by clicking Tools > Inspect. Available in groov Manage by clicking Info and Help > About.)
- Specific error messages you saw.
- Version of your computer’s operating system.

Installing PAC Control

PAC Control is a component of the PAC Project Software Suite, a comprehensive set of software tools for industrial automation, remote monitoring, and data acquisition projects in any line of business.

Installation is easy and quick, and you can download PAC Project directly from the Opto 22 Support > Downloads webpage.

The PAC Project installer includes both the Basic (free) version of the software suite, and the software for PAC Project Professional. Click here for a comparison of PAC Project Basic and PAC Project Professional features.

To install PAC Control:

1. Download PAC Project from the Opto 22 Support > Downloads webpage.
2. Navigate to the folder where you downloaded PAC Project, and then double-click the installation file (PAC_Project_<release number>.exe) to begin installation.

**NOTE:** Email messages and phone calls to Opto 22 Product Support are grouped together and answered in the order received.

NOTE: You must have an OptoPassword to install the Professional version of PAC Control. For details, see the Opto 22 website, www.opto22.com, Support > Downloads tab, and click the link for OptoPassword (located in the text above the Search field).

If you have trouble installing PAC Control, contact Opto 22 Product Support at 800-835-6786 (toll-free in the U.S. and Canada) or 951-695-3080.
System Requirements

Installation Requirements

Here’s what you need to install and run PAC Control. If you are using PAC Display, please see its requirements in the PAC Display User’s Guide (form 1702).

• A computer with a standard or mainstream processor and (at least) the minimum memory required for your version of Microsoft Windows. (Low-end CPUs are not recommended.) Additional memory may be required for some configurations.

• One of the following operating systems:
  – Microsoft® Windows® 10 Professional (32-bit or 64-bit)
  – Windows 7 Professional (32-bit or 64-bit)

*NOTE: PAC Project cannot be installed on Windows XP or older Windows operating systems. Embedded operating systems are not tested or supported.

• Ethernet capability

• VGA or higher resolution monitor. Minimum size: 800x600 with small fonts

• Mouse or other pointing device

• (Optional) Installed Windows printer

• For available hard disk requirements, please see the PAC Project Release Notes.

• Compatible control engine and I/O unit(s), as shown on page 5.

Important Note on Disk Drives

Opto 22 applications, including PAC Control, perform best when using files from a local hard disk. Network drives may be used, but performance may suffer and depends upon the speed and reliability of the network. While it may be possible to use other drive types, such as key chain USB drives and memory cards, their use is not recommended. They are better suited for transferring files rather than directly accessing them.

Compatible Controllers and I/O Units

Both PAC Control Basic and PAC Control Professional are compatible with the processors, controllers, and I/O units listed in the table below. For legacy brains and I/O units, see the PAC Control User’s Guide, Legacy Edition (form 1710).

<table>
<thead>
<tr>
<th>Using this Control Engine...</th>
<th>groov EPIC PR1</th>
<th>SNAP PAC S-series</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNAP-PAC-R1</td>
<td>SNAP-PAC-R1</td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td>SNAP-PAC-R1-W</td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td>SNAP-PAC-R2-W</td>
<td>SNAP-PAC-EB1</td>
</tr>
<tr>
<td>SNAP-PAC-R2-W</td>
<td>SNAP-PAC-EB1-W</td>
<td>SNAP-PAC-EB2</td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td>SNAP-PAC-EB2-W</td>
<td>SNAP-PAC-EB2-W</td>
</tr>
<tr>
<td>SNAP-PAC-EB1-W</td>
<td>Generic OptoMMP device</td>
<td>G4EB2</td>
</tr>
<tr>
<td></td>
<td>E1</td>
<td>E13</td>
</tr>
<tr>
<td></td>
<td>E2</td>
<td>E2</td>
</tr>
</tbody>
</table>

1 Before you can use a SNAP-R1 or SNAP-R2 unit, you must first load SNAP-PR1 or SNAP-PR2 firmware (the current release).

2 The OptoMMP devices are available in 1 to 48 channel versions.

3 G4EB2 devices are supported through native PAC Control applications.

4 E13 devices are supported through native PAC Control applications.
SNAP PAC R-series\(^4\) and SoftPAC\(^4\)

<table>
<thead>
<tr>
<th>Using this Control Engine...</th>
<th>SNAP-PAC-R1</th>
<th>SNAP-PAC-R1-B</th>
<th>SNAP-PAC-R1-W(^1)</th>
<th>SNAP-PAC-R2</th>
<th>SNAP-PAC-R2-W(^1)</th>
<th>SNAP-PAC-EB1</th>
<th>SNAP-PAC-EB1-W(^1)</th>
<th>SNAP-PAC-EB2</th>
<th>SNAP-PAC-EB2-W(^1)</th>
<th>Generic OptoMMP device(^2)</th>
<th>G4EB2</th>
<th>E1(^3)</th>
<th>E2(^3)</th>
</tr>
</thead>
</table>

\(^1\) Wired+Wireless PACs and I/O can be used on a wired Ethernet network or on a wireless LAN.

\(^2\) An Ethernet device with an OptoMMP memory map.

\(^3\) Note that R-series controllers and SoftPAC do not support SB-series I/O units.
INTRODUCTION

In this chapter, we’ll start with a sample strategy: a control application for a simple cookie factory. You’ll learn how to work with strategies, open and manipulate flowcharts, work with variables and I/O points, configure a control engine, compile and download a strategy, run it in Debug mode, make an online change, and more. The tutorial can be used with either PAC Control Basic or PAC Control Professional. (The images in the tutorial show PAC Control Basic.)

The best way to use the tutorial is to sit down at your computer and follow it through. To start, all you need is PAC Control, which allows you to do everything up to the point of downloading your strategy. To do the complete tutorial you will need the controller and I/O included in a SNAP PAC Learning Center. For more information, go to www.opto22.com, and search for the part number SNAP-PACLCL.

In This Chapter

- Opening the Strategy ............................................................... page 7
- Saving the Strategy ................................................................. page 9
- Examining the Strategy ............................................................. page 10
- Opening a Chart ..................................................................... page 13
- Opening a Block ...................................................................... page 16
- Adding a Command ................................................................. page 18
- Configuring a Control Engine .................................................. page 23
- Compiling the Strategy ............................................................. page 25
- Running the Strategy ............................................................... page 27
- Compiling and Downloading the Change ................................ page 34
- Using a Watch Window ............................................................ page 37
- Closing the Strategy and Exiting .............................................. page 42
- What’s Next? ............................................................................ page 43

OPENING THE STRATEGY

A strategy is a complete control program developed in PAC Control. Our sample strategy controls a cookie factory. The sample strategy is described in detail on page 395, but for now, let’s just open and explore it. In this tutorial, we’ll use PAC Control Basic.
1. Start PAC Control.¹
   The PAC Control main window opens.

2. On the PAC Control toolbar, click the Open Strategy button.

3. In the Open Strategy dialog box, browse to
   C:\Users\Public\Public Documents\Opto 22\PAC Project 10.3\Control Basic Examples\ioCookies.
   (If you’re using PAC Control Pro, substitute “Control Pro Examples” for “Control Basic Examples” in the
   folder location.)

4. Click Cookies.idb to select it, and then click Open to open the strategy in PAC Control.
   If a File Format Change warning message is displayed, click Yes to continue.

¹ In Windows 10, click the Windows Start button, and then click Opto 22 > PAC Control Basic 10.3 (or
   PAC Control Pro 10.3).
In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 10.3 >
   PAC Control Basic 10.3 (or PAC Control Pro 10.3).
The Cookies strategy opens and the PAC Control window now shows the Cookies strategy in the Strategy Tree window. (Yours may look somewhat different.)

SAVING THE STRATEGY

Now let’s save the strategy to a new name, so we can change it while leaving the original intact.

1. In the PAC Control menu bar, click File > Save Strategy As.

2. Since each PAC Control strategy must be located in its own directory, you can’t save the strategy in its current location: you need to create a new folder for the new strategy.
   a. In the Save Strategy As dialog box, click the Up One Level button to move up to the Control Basic Examples directory.
b. Right-click the mouse anywhere in the subfolders pane. In the pop-up menu, click New > Folder. The new folder appears in the list.

c. Type My Cookies to replace rename the folder.
d. Double-click the folder to open it.
e. In the File name field, type Cookies. The dialog box now looks like this:

f. Click Save. Your new strategy is saved in the My Cookies directory.

EXAMINING THE STRATEGY

Briefly, our cookie factory consists of:
- A tank of pre-mixed cookie dough
- A tank of chocolate chips
- An oven
- A visual inspection station
- A conveyor belt
- Compressed air to blow rejected cookies off the belt

The process starts when a ball of dough drops from the dough tank onto the belt. The conveyor belt moves the dough ball under the chip tank to receive some chips, and then it moves the dough into the oven to bake. The next stop is an inspection, where rejected cookies are blown off the belt and good cookies move along to shipping. Should anything go wrong, we also have some built-in alarms to stop the process.

The best way to see all the components of the strategy is to look at the Strategy Tree.

**The Strategy Tree Window**

To configure and run a strategy, you must leave the Strategy Tree window open—if you close the Strategy Tree window, the strategy closes, too.

To expand a folder in the Strategy Tree, click the plus sign; click the minus sign to collapse the folder.

To move the Strategy Tree window, click and drag title bar. To minimize, maximize, or dock it, click the buttons in title bar. To resize the window, drag any edge.
Expanding the folders in the Strategy Tree reveals that the strategy includes five flowcharts (in the Charts folder), eight Numeric Variables, and one Mixed I/O Unit (with both analog and digital points). The Strategy Tree not only shows you all components of the strategy but it also provides shortcuts to many common PAC Control activities, such as opening flowcharts, adding new variables, and configuring points.

Docking the Strategy Tree

Since the Strategy Tree is so useful, you’ll probably want to keep it visible while you create and debug your strategy. To keep the Strategy Tree window visible, you can dock it in a separate frame.

1. Click the docking button \( \text{dock button} \) in the upper-right corner of the Strategy Tree window.
   The Strategy Tree moves into its own frame at the left side of the main window.

2. To change the width of the Strategy Tree’s frame, move your mouse over the right side of the frame. When the pointer changes to the Windows Splitter icon \( \text{Windows Splitter icon} \), click and then drag the side to make the frame wider or narrower.
CHAPTER 2: PAC CONTROL TUTORIAL

Using Quick Find

The quick find tool at the bottom of the Strategy Tree helps you to find items quickly in the tree. Use the Next and Prev buttons (or F3 and Shift+F3) to find multiple matches. Any partial match will work.

For example, if you enter the word, “setpoint,” when you click Next, the first match is found.

When you click Next again, the next match is found.

OPENING A CHART

Every control process can be planned and mapped out using one or several PAC Control flowcharts, or charts. Because flowcharts are easy to follow, PAC Control strategies are easy to understand. For an example, let’s take a look at the Dough_Chip_Control chart.

1. With the Charts folder expanded, double-click the Dough_Chip_Control chart name on the Strategy Tree. (You can also open a chart by clicking Chart > Open in the PAC Control menu bar, and then double-clicking the chart name.)
The chart appears somewhere in the large frame of the main window.

2. Click and drag the title bar of the chart window if necessary to see the Maximize button at the upper right. Click the Maximize button to make the chart fully fit the frame. Note the tabs at the bottom of the main window; the white tab tells you you’re viewing a chart, and the gray tab shows the chart’s name.
PAC Control Blocks and Connections

Let’s take a closer look at what this chart does. Even without its descriptive comments, it’s easy to see that this program segment begins by starting a conveyor belt. If the belt isn’t running at the correct speed, the process goes into a loop until the speed is correct. When it is correct, dough is dropped on the belt, and then chips are dropped on the dough. The process then loops back to re-evaluate the conveyor speed, waiting if it’s incorrect, and dropping more dough and chips if it’s correct.

The rectangular-shaped blocks are called **action blocks**. They do things.

The diamond-shaped blocks are **condition blocks**. They decide things.

Charts may also contain other blocks, including oval-shaped **continue blocks**, which route the program logic back to another block in the same chart, and hexagon-shaped **script blocks**, which contain instructions and logic written in PAC Control’s built-in OptoScript programming language.

**Connections** link the blocks together and show how the program logic flows. Action blocks exit through just one connection, since they always go in one direction. Condition blocks exit through two connections, one for a true evaluation and the other for a false evaluation.
Let's see what's in a block.

1. Double-click the Drop Dough block.
   The Instructions dialog box appears.

This block contains four instructions: Move, Turn On, Delay (Sec), and Turn Off. Each one has a description above it.

2. Double-click the Turn On instruction to see more about it. (You could also click it once and click Modify).
   The Edit Instruction dialog box for the Turn On command appears.

Here we see the details of the command: it turns on doDoughDispenseValve (the digital output point for the dough dispensing valve). In other words, it opens the valve.

3. Close the Edit Instruction dialog box by clicking OK or Cancel.
4. Close the Instructions dialog box by clicking Close or by pressing Esc (the Escape key).

**Add a New Block and a New Connection**

Before we leave the Dough_Chip_Control chart, let's make a cosmetic change. We noted earlier that we didn't have any continue blocks in this chart. Let's add one to replace the long connection that loops from the Drop Chips block up to the Speed OK? block.

1. Delete the existing long connection line by clicking it to select it, and then pressing the Delete key.
2. Now click the Continue Block tool in the toolbar. When you bring the mouse back into the chart area, an oval outline appears, representing the new continue block.

3. Position the oval below the Drop Chips block, and then click the mouse. A continue block appears with the default name Block (and the block number).

4. If you move the mouse pointer again, a new oval outline follows. Deactivate the Continue Block tool by right-clicking the mouse, or by pressing Esc. Your screen should now look something like this:

5. Connect the Drop Chips block to the continue block:
   a. Click the Connect tool.
   b. Click once in the Drop Chips block.

   NOTE: When using connections, always click first in the block that the connection is coming from.

6. If you move your pointer around the screen, you see a connection following the pointer. Click the top of the continue block to complete the connection. Deactivate the Connect tool by right-clicking the mouse button or by pressing Esc.

**Rename a Block**

Let's rename the continue block.

1. Click the continue block to select it.
2. Right-click the continue block and select Name from its pop-up menu. The Name Block dialog box appears.
3. Type `Back to ‘Speed OK?’` over the selected text, and then click OK. The chart now looks something like this:

![Dough_Chip_Control chart](image)

**Select a Continue Block’s Destination**

Now let’s give the continue block its instructions.

1. Double-click the continue block to see a list of all the blocks in the chart.

![Select Continue Block Destination](image)

2. Click the Speed OK? block to select it, and then click OK.

When the program reaches the continue block, it returns to the Speed OK? block. We haven’t changed the way the program works; we’ve just done the same thing in a different way.

Continue blocks are useful in a complex chart to avoid crossing connection lines.

**ADDING A COMMAND**

Now we’re going to add a command (also called an “instruction”) to a block in the Dough_Chip_Control chart. This command will keep track of the number of cookies we produce.

*NOTE: To enable legacy commands in PAC Control for a specific strategy, see “Legacy Options” on page 208.*
1. Double-click the Drop Dough block.

![Image of Instructions dialog box]

2. We’ll add the new instruction (command) between the Turn On and Delay (Sec) commands.
   a. Click anywhere on Delay (Sec) to highlight this command.
   
   **TIP:** The highlighted area indicates the position where the next command is added.
   
   b. Click Add to open the Add Instruction dialog box.

---

**Finding Commands in the Instructions Dialog Box.** There are several ways to find commands.

- If you know the exact name of the command you want, you can start typing it as soon as you open the Instructions dialog box. (Don’t worry about typing over the Absolute Value command—it appears in the Instruction field only because it’s the first command in the alphabetical list of commands). As you type, the first command matching the letters you have typed is filled in automatically. As you continue typing, PAC Control displays the next matching command. When you see the command you want, press Enter or click the Add button to add it to the block.

For example, if you want to create a Move command:

<table>
<thead>
<tr>
<th>As you type:</th>
<th>This command appears:</th>
</tr>
</thead>
<tbody>
<tr>
<td>m</td>
<td>Make Integer 64</td>
</tr>
<tr>
<td>mo</td>
<td>Modulo</td>
</tr>
<tr>
<td>mov</td>
<td>Move</td>
</tr>
</tbody>
</table>
One way to add a command is to click the Instruction drop-down list, and then scroll through the list of commands to find the one you want.

A third way to add a command is the one we’ll use now.  

3. In the Add Instruction dialog box, click Select.

![Select Instruction dialog box]

Command groups are listed on the left, and commands in the highlighted group are listed on the right.  

4. The command we want will increase a counter. Counting sounds like math, so let’s try the Mathematical group.  

Click Mathematical on the left to highlight it, then scroll through the list on the right until you find the Increment Variable command. Click it once.

![Select Instruction dialog box with Increment Variable highlighted]

NOTE: If you need information about a command, click the Command Help button.

5. Click OK, and this command is displayed in Instruction filed of the Add Instruction dialog box.  

The cursor is automatically moved to the next field, which is Comment. Comments are optional but very useful; they can help someone else understand the purpose of the instruction.  

6. In the Comment field, type Increment a counter of cookies produced.

7. Next, click the Type drop-down list (the field that currently reads “All Valid Types”). This list shows what those valid types are: a float variable, an integer 32 variable, and an integer 64 variable.
Counters are integers, so select Integer 32 Variable.

8. Now we’re going to create the integer 32 variable to increment, which will be called nCookie.Counter.
   a. Click the Name down-down list (the field that currently reads “bStartFlag”).
      The drop-down list shows all variables currently configured as integer 32 variables:

      ![Image of Add Instruction dialog box]

      nCookie.Counter is not in the list, because we haven’t created it. We’ll create it now using what we call "on-the-fly configuration."

   b. Click bStartFlag to select it, and then type the new variable name right over it: nCookie.Counter
   c. Click OK to close the dialog box, and the following message appears.

      ![Image of PAC Control Basic dialog box]

      d. Click Yes to create the new nCookie.Counter variable.
         Notice that the name and type have already been filled in.

      ![Image of Add Variable dialog box]
ADDING A COMMAND

**e.** Add a description, if you wish. Leave the initial value at zero, which is the default, and don’t make any changes in the Public Access pane. (If you’re curious, Public Access makes your tags accessible to other programs, such as Inductive Automation’s® Ignition® SCADA software.)

**f.** Click OK to save your changes and close the dialog box.

9. In the Add Instruction dialog box, click OK to close it.

The new instruction appears in the Drop Dough Instructions dialog box.

![Drop Dough Instructions dialog box](image)

But maybe it makes more sense to start the counter at the *beginning* of the process, rather than in the middle, after some dough has already been dropped. Let’s change it.

10. With the Increment Variable command highlighted, right-click to display the pop-up menu, and then click Cut. (You can also use Ctrl+X to cut.) Cutting puts the instruction in the Windows Clipboard.

11. Now click Turn On to highlight it. Right-click to display the pop-up menu, and then click Paste. You can also use Ctrl+V to paste. The Increment Variable command is pasted above the highlighted instruction, like this:

![Increment Variable command pasted](image)

12. Click Close to return to the chart.

13. To save the changes you’ve made, click the Save Strategy button on the toolbar, and then click OK.
14. Take a look at your new variable in the Strategy Tree:
   – If the Variables folder is collapsed, click plus sign to expand it.
   – If the Numeric Variables folder is collapsed, click the minus sign to expand it.
   Your new nCookie_Counter variable should be in the list in alphabetical order.

Congratulations! You’ve just added a cookie counter variable. Now we’re ready to download the strategy to a control engine. But first we have to tell PAC Control that about our control engine.

CONFIGURING A CONTROL ENGINE

Up to this point, we’ve been able to play around in PAC Control without hardware. Now it’s time to configure a control engine (a controller).

1. If you have a PAC Control-compatible controller and I/O unit that you can use for this tutorial, make sure they are on the same network as your PC, and make sure you have loaded the most recent firmware.
   For a list of compatible controllers and I/O units, see page 5. For instructions to load firmware, see the PAC Manager User’s Guide (form 1704).

2. Double-click the Control Engines folder on the Strategy Tree, or select Configure > Control Engines.
   The Configure Control Engines dialog box appears.

Since we haven’t configured a control engine yet, there are no control engines in the list.

3. Click Add.
   If PAC Control is on a network that has configured controllers, you’ll see them in the list. Otherwise, the list will be empty.

4. Click Add again to add a control engine.
The Control Engine Configuration dialog box appears.

5. Enter Cookie Controller as the control engine name. The name can contain letters, numbers, spaces, and most other characters except colons and square brackets. Spaces cannot be used as first or last characters.

6. Under System Type, make sure Standard is selected.

7. Enter the control engine’s IP address. On hardware such as a SNAP PAC R-series controller, the IP address is usually written on a sticker on the side of the unit. If an IP address has not been assigned to the control engine, see the PAC Manager User’s Guide (form 1704), for configuration instructions.

   If you’re using a SoftPAC™ computer-based controller:
   a. Use the loopback IP address—127.0.0.1—if PAC Control and SoftPAC are on the same PC.
   b. If SoftPAC is not on the same computer as PAC Control, use the IP address of the NIC card on the PC running SoftPAC. NOTE: The SoftPAC PC’s NIC must be configured with a static IP address.

   NOTE: In PAC Control Professional, a second IP address field is available, so you can designate a secondary communication path to the control engine should the primary one fail. For more information, see “Creating Redundant Ethernet Links in PAC Control” on page 100.

8. Make sure that you have not changed the values in the Port, Retries, and Timeout fields, and then click OK.
The newly configured control engine appears in the Select Control Engine dialog box.

9. Make sure the new Cookie Controller control engine is selected (highlighted), and then click OK. The new control engine appears in the Configure Control Engines dialog box.

If you have only one configured control engine at this point, it is automatically set as the active control engine (that is, the control engine that will run the strategy). If there were more than one control engine associated with your strategy, you would select the control engine you want, and then click Set Active to load it into the Active Engine field.

10. Click OK to close the Configure Control Engines dialog box.
In the Strategy Tree, the new control engine appears as the first entry in the Control Engines folder.

COMPILING THE STRATEGY

The simplest way to compile a strategy is to enter Debug mode. The strategy is saved and compiled before changing modes.

NOTE: The remainder of the tutorial is designed to work with the controller and I/O on a SNAP PAC Learning Center. For more information, go to www.opto22.com and search for the part number, SNAP-PACLC.

1. Click the Debug mode button on the toolbar (or in the menu bar, click Mode > Debug).
In the Save Strategy dialog box, click Yes to save the strategy.

2. Yes or OK for any other message you may see, for example:
Two additional dialog boxes appear. The first dialog displays the progress as the strategy is compiled. The second dialog shows progress as the strategy is downloaded to the control engine.

Assuming the strategy was compiled and downloaded successfully, you are now in Debug mode. (Note that the strategy isn’t running quite yet.) In the PAC Control window, you’ll notice that the Debug toolbar is now available. The mode is shown at the bottom of the main window. The open chart window shows that the strategy is stopped, as shown in the following figure:

**RUNNING THE STRATEGY**

In Debug mode, we’re going to run our strategy and examine it to see how running a strategy affects variables, command blocks, and so on. The first chart to run in any strategy is the Powerup chart, so we’ll look at it first.

1. In the Strategy Tree, expand the Charts folder and then double-click Powerup. When the Powerup chart opens, notice that the PAC Control window shows its status as Stopped.
2. Click the Run Strategy button.  

You may briefly see a progress window. In the strategy Status area (at the bottom of the chart window), the word Stopped changes to Running. Let’s try pausing the program to see where we are.

3. Click the Pause Chart button. (If the Pause Chart button is grayed out, click anywhere in the Powerup chart to activate the Debug toolbar, and then click the button.)

The hatch marks on the Start? block indicate that this command block was about to be executed when we clicked Pause. Apparently the program isn’t getting past this block. Notice that the False exit routes right back to the top of the Start? block, while the True exit moves on to Start Charts. We can see that if the start flag had been true (non-zero), the program would have gone right into the Start Charts block. Since we didn’t get that far, the start flag must be zero.

And in fact it is. We planned it that way because we wanted someone (for example, a factory operator) to start the process intentionally. We can simulate this ourselves in PAC Control by manually setting the flag to a non-zero value.

4. In the Strategy Tree, expand the Numeric Variables folder, and then double-click the bStartFlag variable. The View Variable dialog box appears.

In this box, you can view the variable’s value, but you can’t change it until you maximize the dialog box.

---

2 If “Error” is displayed in the status bar (and the bottom of the PAC Control window), click it to open the PAC Message Viewer. Then, use the messages to figure out and resolve the problem. Remember: This part of the tutorial assumes you have a SNAP PAC Learning Center (or that you’ve configured a controller and I/O unit that can run the example strategy).
5. Click the Maximize button. This dialog box displays current information about bStartFlag. You can see that the variable has a value of 0 (zero), and you would be correct to think its value is initialized to 0 on strategy download.

![Variable bStartFlag](image)

6. Highlight 0 in the dialog box, and then type 1 to replace it. The field turns purple, indicating a change has been made but not implemented.

![Variable bStartFlag with value 1](image)

7. Click Apply to implement the change. Then, minimize the View Variable dialog box and move it out of the way.

Inspecting Messages

The status bar in the main PAC Control window tells you when an information, warning, or error message has been placed in the message queue. Messages can help in troubleshooting your strategy.

1. Click the light-blue box in the status bar at the bottom of the window. If you don’t see the box, click Control Engine > Messages to view the View Message Queue dialog box.

![View Message Queue dialog box](image)

In this example, the message tells you that the I/O unit has powered up.

2. Close the dialog box to return to the Powerup chart.

Stepping Through the Chart

Now let’s step through the chart to control when instructions are executed and see what happens.

1. Click inside the Powerup chart to activate the Debug toolbar, and then click the Step Over button .
   The hatch marks move from Start? to Start Charts. We’ve just moved (stepped) to the next block.

2. PAC Control executes the Start Charts block and steps to the next command block. Since there are no more blocks in this chart, we are actually exiting this chart and moving on to new instructions in another chart. The Powerup chart has stopped, and you can see the word Stopped at the bottom left of the chart.
In the View Variable dialog box, the bStartFlag value reverts to zero, because the Start Charts block set the flag back to zero.

3. Close the bStartFlag View Variable dialog box. Click the Powerup chart window to activate the Debug toolbar, and then click the Pause Chart button to turn stepping off. (Note that the Strategy Status indicators show “Step Off.”)

4. Now, close the Powerup chart (Chart > Close), and then double-click the Charts folder on the Strategy Tree. The View Chart Status dialog box appears. This dialog box shows us all the charts in our strategy. As you can see, four of the charts are running, and one (Powerup) is stopped.

Powerup is stopped because it has already done its job. Let’s check the running charts.

5. Close the View Chart Status dialog box and click inside the Dough_Chip_Control chart again.

6. If your mouse has a wheel, hold down the Ctrl key and move the mouse wheel up or down to change the zoom.
   If your mouse doesn’t have a wheel, there are several other ways to zoom out, too. You can right-click the chart and select Zoom from the pop-up menu. You can select Zoom Out from the View menu. You can press the + or - keys on the keyboard. After zooming out, the chart looks something like this:

   You can zoom back in if you wish by holding down the Ctrl key and moving the mouse wheel down or one of the other methods.
   The chart’s status bar indicates that it is running, but we can’t see much happening.
7. Click the Pause Chart button \[ \square \].
   One of the command blocks appears with hatch marks.

8. Now click the Step Over button \[ \square \].
   The next command block is hatched.

9. Continue clicking and watch how the program proceeds from Speed OK? to Drop Dough to Drop Chips to Back to ‘Speed OK?’ and back up to Speed OK?
   A pulsating green border appears around a block when the commands inside the block are being executed. While you are stepping through, and anytime the Pause Chart button is clicked, the chart status indicates Step On.

10. Click the Pause Chart button again to run the strategy at full speed.
    Step Off now appears in the chart status bar.

**Auto Stepping**

The final stepping option is auto stepping. You can select this option whether or not the chart is currently paused.

1. Click the Auto Step Chart button \[ \square \] and watch the program move from block to block.
   At one time or another, your chart looks like this:

   ![Flowchart Diagram]

   Notice that in the PAC Control toolbar, the Run and Auto Step Chart buttons are depressed. The chart status bar shows us the chart is running and in Step Auto mode. The time indicator to the right of Break Off shows the time it took for the most recent block to execute.

2. Click the Auto Step Chart button again to end auto stepping.
   Step Off appears, indicating the program is again running without interruption.
   Now let’s see how many cookies we’ve produced to this point.
3. On the Strategy Tree, double-click the numeric variable nCookie_Counter.

The Value field should increase every time a cookie is produced, adding to the total number of cookies produced since the strategy run began. The nCookie_Counter above shows this figure as 42. (Yours may be different.) But nCookie_Counter tells us the total number of cookies put on the conveyor belt, without considering that some of them may be rejected by the inspection station. We need to subtract the number of bad cookies so that nCookie_Counter keeps track of the number of cookies sent out the door, not just sent to the oven.

4. Close the nCookie_Counter View Variable window and click the Configure mode button on the toolbar.

5. Double-click the Oven_Inspection_Control chart on the Strategy Tree to open it.

The chart window looks something like this:

Near the bottom of the chart, the Reject Cookie? block determines whether a bad cookie has been found. If one has, the strategy moves to the next block, Blow Off, which is where the bad cookie gets blown off the conveyor. When that happens, we want to decrement the nCookie_Counter variable.
6. Double-click the Blow Off block to open its instructions window:

![Instructions - Oven_Inspection_Control - Blow Off - Block 15 window]

This command block is executed only when a bad cookie has been found. This block first resets the on-latch triggered by the bad cookie, so that the next cookie won’t be marked bad, too. The block then turns on the reject valve. The valve stays on for two seconds before being shut off. Let’s decrement the counter after the cookie is gone and the valve is shut.

7. Scroll down and click the open spot below the other instructions.
   The highlighted line marks the position of the next command to be added.

8. Click Add.

![Add Instruction window]

You can use PAC Control without a mouse, and to demonstrate how, we’ll use only the keyboard to enter data in this dialog box.

9. Type `dec` in the Instruction field.
   The Decrement Variable command appears, since it’s the first command that starts with that text pattern.
   This is the command we want to use.

10. Press Tab twice to move to the Comment field, and (if you want to) type a comment.

11. Press Tab again to move to the Type field. Press the down arrow on your keyboard twice to select Integer 32 Variable.

12. Press Tab again to advance to the Name field, and then press the down arrow until you see `nCookie_Counter`. 
13. Press Tab again and notice that an outline appears on the OK button. An outlined button means that pressing the space bar or Enter is equivalent to clicking the button. Now the dialog box looks like this:

![Add Instruction dialog box](image)

14. Press OK. The dialog box closes and the new command appears in the Instructions window.

![Instructions window](image)

15. Click Close to return to the Oven_Inspection_Control chart.

### Compiling and Downloading the Change

Now we’ll compile and download the modified strategy.

1. Click the Debug mode button ![Debug](image) on the toolbar. At each warning message, click Yes or OK to continue.
2. On the toolbar, click the Run Strategy button ![Run](image).
3. In the Strategy Tree, double-click the bStartFlag variable. Maximize the dialog box, change the value to 1, and then click Apply. Close the dialog box.
4. Click inside the Oven_Inspection_Control chart to make it the active chart, and then click the Auto Step Chart button.
You see three blocks being processed: Speed OK?, Oven On, and Reject Cookie? The strategy doesn’t move into the Blow Off block. That’s because an inspector has to flag bad cookies, but we don’t have an inspector right now. So we’ll simulate what would happen by tripping the digital input that flags a bad cookie.

5. In the Oven_Inspection_Control chart, click the Auto Step Chart button again to stop auto stepping. Step Auto changes to Step Off in the status bar.

6. Click the Pause Chart button.
   Step Off changes to Step On.

7. Click the Breakpoint tool and click once on the Blow Off block.
   A red box appears around the Blow Off block, and Break On now appears in the chart status bar.

8. Click the right mouse button or press Esc to release the tool. Notice that Break On now appears in the chart status bar.

9. Click the Dough_Chip_Control tab at the bottom of the PAC Control main window.
   The chart appears.
10. Click the Pause Chart button to pause the chart.
USING A WATCH WINDOW

To see clearly what we're doing, we'll create a watch window to monitor cookie production.

1. In the Strategy Tree, double-click nCookie_Counter.

   ![Image](image1)

   The value is frozen at some number, such as the 74 shown above. Since the counter is no longer increasing, we can see that cookie production has temporarily stopped.

2. Click the Maximize icon (in the lower right corner) to display the scanning options.

   ![Image](image2)

3. Click Watch.

   The Add Watch dialog box opens.

   ![Image](image3)

4. Since there is no watch window available to select, we'll create one.

   Click New.

   ![Image](image4)
5. Make sure the My Cookies directory appears in the Look in field. Type a name for the watch window in the File name field. Then click Open. The watch window name appears in the Add Watch dialog box, and the new watch window appears behind it.

6. In the Add Watch Entry dialog box, click OK. Close the nCookie.Counter view variable dialog box. The new watch window looks something like this:

![Watch window](image)

Since we want to be able to see chart windows as well as the watch window, let’s dock the watch window at the bottom.

7. In the watch window, click the docking button in the upper-right corner.
The watch window moves to the bottom of the main window.

Now we’ll trip the latch that signals a bad cookie.

8. On the Strategy Tree, under the I/O Units folder at the bottom of the window, expand Mixed_IO_Unit by clicking the plus sign at the left of the name.
   You see a folder named Points.
9. Expand the Points folder to display the digital I/O points configured for this I/O unit.

11. In the minimized dialog box, click the Maximize button.

NOTE: Don’t worry if the red error message “I/O unit not configured” or XVAL values appear in this dialog box. This occurs because the strategy is configured for sample hardware that probably doesn’t correspond to your actual I/O units and modules. PAC Control can’t locate this hardware. That’s okay for this example.

When an inspection finds a bad cookie, the on-latch attached to the I/O point diInspectionPassFailSwitch is supposed to go on. We’re going to trip it manually.

12. Click one of the arrows in the On-Latch IVAL field to change it to On. Also make sure that the Enable comm field says No.

The dialog box should look like this:

13. Click Apply.

The On-Latch IVAL field turns green after a second or two, indicating the latch is on.

14. Click Watch.

We’ll add the variable to our watch window, so we can see what happens.

15. In the Add Watch dialog box, leave all portions checked. Click OK to add the variable to the Cookie Watch window. Close the view point dialog box.

16. In the Cookie Watch window, click the plus sign next to (02) diInspectionPassFailSwitch. (Your screen may show only part of the words.)
17. Move your cursor over the right side of the Name column until the cursor changes shape. Then click and drag the column to make it wider, until you can see all the words.

![Watch Window](image1.png)

18. Click in the Oven_Inspection_Control chart to make it active, and move the scroll bars until you can see the Blow Off block at the bottom. Your window now looks something like this:

![Oven_Inspection_Control](image2.png)

19. Click the Step Over button as many times as it takes to get the hatch marks to the Blow Off block. Now watch the nCookie.Counter IVAL value in the watch window as you click the button again.
A bad cookie was found, so the counter was decreased by one. At the same time, the on-latch was reset to Off, as you can also see in the watch window.

20. Click the Auto Step Chart button to go back to auto stepping.
   The counter does not decrease again, because the on-latch is no longer set. But the counter won’t increase until we start the Dough_Chip_Control chart again.

21. Click the Dough_Chip_Control chart tab. Click the Pause Chart button to unpause the chart. Verify that Step On changes to Step Off in the chart status bar.
   The watch window shows the nCookie_Counter value going up again.

CLOSING THE STRATEGY AND EXITING

Before we finish this tutorial, you may want to explore the sample strategy on your own. You can double-click items in the Strategy Tree or open up other charts to see what they do. You can also double-click command blocks to see what they contain.

1. When you’re ready to stop, click the Stop Strategy button in the toolbar.
   This action prevents the strategy from running continuously unattended on the control engine.
   A dialog box asks if you are sure you want to stop the strategy.

2. Click Stop Strategy.

3. To close the strategy, select File > Close Strategy; or select File > Exit to quit PAC Control. If dialog boxes ask whether you want to remove breakpoints and take charts out of stepping mode, click Yes.
WHAT'S NEXT?

Your introduction to PAC Control is now complete. Using the sample Cookies strategy, you learned how to:

- Open, save, and close a strategy
- Work with the Strategy Tree
- Work with charts and add commands in blocks
- Configure a control engine
- Compile, run, step through, and add breakpoints to a strategy
- Make an online change
- Use a watch window to monitor variables and I/O points.

The rest of this book expands on the knowledge you’ve just acquired. Now may be a good time to look at the table of contents or thumb through the book and familiarize yourself with its contents. Some sections you may want to read; others you’ll probably just refer to as needed.
WHAT'S NEXT?
3: What Is PAC Control?

INTRODUCTION

The tutorial in Chapter 2 introduced you to PAC Control without explaining much about it. In this chapter we’ll learn more about PAC Control and see its main windows and toolbars.

In This Chapter
About PAC Control ...............................................................page 45
General Control Concepts .................................................page 47
PAC Control Terminology ....................................................page 49
PAC Control Main Window ...................................................page 53
Windows and Dialog Boxes in PAC Control ....................page 57
Customization Features .......................................................page 63
Online Help ............................................................................page 74

ABOUT PAC CONTROL

PAC Control is a programming language based on flowcharts. Whether you have PAC Control Basic or PAC Control Professional, you use PAC Control to develop software that monitors and controls all kinds of equipment and sensors, from a simple heating system to a complex factory. The software you develop controls the Opto 22 hardware that runs your heating system or factory.

The diagram below shows how PAC Control on your PC can work with the hardware in your control system. This example shows a small system; yours may be even smaller or considerably larger and more complex. The diagram uses a SNAP-PAC-S1 as the control engine. Input/output (I/O) points on the subordinate SNAP PAC I/O units monitor and control the analog, digital, and serial devices connected to them. All these terms are defined in the following pages.
Control System Example

**PAC Display**
Viewing, Trending, Alarming

**PAC Control**
Programming, Debugging

**SNAP PAC S-series controller**
Runs strategy; controls all I/O

**SNAP PAC I/O unit**

- **Fuel Pump** (Analog output)
- **Furnace Temperature** (Thermocouple) (Analog input)
- **Tank Level** (Analog input)
- **Photo Sensor** (Digital input)
- **Barcode Reader** (Serial device)
- **Conveyor**
- **Pump (On or Off)** (Digital output)

**SNAP PAC I/O unit**
GENERAL CONTROL CONCEPTS

Automation

Automation is a way of adding intelligence to an industrial process. When you automate a process, you are less dependent on human action to carry out the process. The process generally becomes faster, more accurate, and more reliable. For example, take a look at the tank level and pump combination in the diagram on the previous page. Instead of having a person watch the level in the tank and turn the pump on or off when the level gets too low or too high, you can automate the process by installing a processor and I/O. The processor and I/O respond in milliseconds and are on the job 24 hours a day.

Control Engines

In an Opto 22 PAC Control system, the control engine is the programmable component in Opto 22 controllers that provides the intelligence required for automation.

Using PAC Control, you create a software program (a strategy) that tells the control engine how every aspect of a process should work. You download the strategy to an Opto 22 control engine which runs it as a stand-alone application. On a SNAP PAC controller, the strategy is stored in the controller’s electronic memory; the development PC can be turned off or used for other operations while the control engine runs the program. Whenever necessary you can modify the strategy and download it again to the control engine.

In the diagram on the previous page, one SNAP PAC S-series controller runs the program that controls the three areas of automation.

Digital and Analog Inputs and Outputs

An industrial process can include many different hardware components: switches, pumps, tanks, valves, furnaces, conveyors, photo sensors, thermocouples, and so on. All the components communicate with the control engine in the controller by way of input/output (I/O) points.

Input points are wired to hardware that brings information into the control engine from the process. Examples of devices that can be wired to input points are thermocouples, switches, and sensors. The control engine takes the information from the input points—such as whether a switch is on or what temperature is registered on a sensor—processes it using the software instruction set, and returns information to the process through output points.

Output points are wired to hardware that receives information from the control engine and uses this information to control components of the process. For example, lights, motors, and valves are all devices that can be wired to output points. Using an output point, the control engine might turn on a light or open a valve.

There are two types of I/O points, digital and analog:

- **Digital points** can be either on or off (True or False). Push buttons and LEDs are examples of digital devices. An LED is either on or off; it has no other possible state.
  
  In the Control System Example on page 46, the photo sensor is an example of a digital input device. The photo sensor is either on or off. When it turns off as the sheet passes through its beam, the digital I/O module tells the control engine it is off, and the control engine responds as programmed to stamp the sheet.
  
  The pump is an example of a digital output device. Based on information from the tank level input, the control engine turns the pump on or off as programmed.

- **Analog points** have a range of possible values. Temperature and pressure are examples of analog information. Temperature might be any number in a range, -2 or 31.65 or 70.1 or many other possible numbers.
In the Control System Example on page 46, the tank level sensor is an analog input device. It registers the changing level of water in the tank and reports the level to the control engine, which responds by turning the pump on or off.

The fuel pump is an example of an analog output device. Based on information about the temperature in the furnace, the control engine adjusts the pressure of fuel through the pump as programmed.

**SNAP Serial Communication Modules**

In the PAC Control system, some I/O modules do not contain standard analog or digital input/output points, but are used for communication over a serial network.

SNAP serial communication modules provide one or two channels for sending data to or receiving data from a serial device (RS-232 or RS-485/422) or a protocol like PROFIBUS or Controller Area Network (CAN) that can communicate over a serial network. In the Control System Example on page 46, the barcode reader is an example of a serial device.

**KEY FEATURES**

- “Copying SNAP I/O Configurations” on page 118
  Using a configuration file, you can copy an I/O configuration from one strategy to another. Or, using PAC Manager, you can send the configuration to multiple I/O units at the same time.

- “Segmenting Networks in PAC Control” on page 99
  You can leverage the two independent Ethernet network interfaces on a SNAP PAC controller to segment the control network from the company network.

- “Creating Redundant Ethernet Links in PAC Control” on page 100
  (Pro only) If you are using SNAP PAC controllers and PAC Control Professional, you can use Ethernet link redundancy to set up alternate network links.

- “Persistent Data” on page 232
  You can configure the data in most variables to be persistent. The variable’s value is saved in the controller’s memory; the value is retained and not reinitialized when the strategy is run, stopped, or started—or even if the strategy is modified and re-downloaded.

- “Pointer Commands” on page 321
  For advanced programming, you can create pointers that store the memory address of a variable or some other PAC Control item, such as a chart, an I/O point, or a PID loop. You can perform any operation on the pointer that you could perform on the object the pointer points to.

- “Setting Initial Values in Variables and Tables During Strategy Download” on page 240
  When you are adding table variables in PAC Control, you can set all table elements to one initial value. Or you can set each individual table element to its own value by creating an initialization file to download with your PAC Control strategy.

- “Using Subroutines” on page 368
  You can use subroutines that are independent from strategies, but that can be called from any chart or other subroutine in your strategy. Subroutines offer two ways to work with variables and other logical elements: they can be passed in or they can be local to the subroutine.

- “Configuring PID Loops” on page 148
  A proportional integral derivative (PID) control loop (often referred to as a PID loop) monitors a process variable, compares the variable’s current value to a desired value (a setpoint), and calculates an output to correct error between the setpoint and the variable. Because the calculation is complex, it is done by a mathematical formula, or algorithm, that you can then adjust (tune) for each PID loop.
CHAPTER 3: WHAT IS PAC CONTROL?

PAC CONTROL TERMINOLOGY

**action block**  Action blocks are rectangular blocks in a flowchart that contain one or more instructions (actions) that do the work of the strategy, such as turning things on or off, setting variables, and so on. Several instructions can be placed in one action block. Action blocks can have many entrances, but only one exit.

**analog point**  Analog points have a range of possible values. Temperature and pressure are examples of analog information. Temperature might be any number in a range, -2 or 31.65 or 70.1 or many other possible numbers. Analog points can be either inputs (such as a tank level sensor) or outputs (such as a fuel pump).

**blocks**  A chart is made up of action blocks, condition blocks, continue blocks, and OptoScript blocks connected by arrows, which show how the process flows. A chart used with redundant controllers also has sync blocks.

**sync block**  The sync block tool is visible only when controller redundancy support is enabled. A sync block is used to synchronize redundant controllers at strategic locations in a transactional chart (a chart that contains sync blocks). For more information, see the SNAP PAC Redundancy Option User’s Guide (form 1831).

**condition block**  Condition blocks are diamond-shaped blocks in a flowchart that contain questions (conditions) that control the logical flow of a strategy. Condition blocks can have many entrances, but only two exits: True and False. The block can contain more than one condition, and you can use AND or OR to indicate whether all conditions must be true to exit True, or whether any one condition must be true to exit True.

**continue block**  Continue blocks are oval-shaped blocks in a flowchart that route the flow of execution to an action, condition, or OptoScript block. They do not contain any instructions, but store only the name of the next block to execute. Continue blocks can have many entrances, but no exits, since the exit is defined within the block. Continue blocks avoid awkward connections between two blocks that are far apart.

**digital point**  Digital points can be either on or off (true or false). Push buttons and LEDs are examples of digital devices: an LED is either on or off; it has no other possible state. Digital points can be either inputs (such as a photo sensor) or outputs (such as a pump).

**external value**  The external value (XVAL) is the real-world value measured or set by an I/O point. The PAC Control strategy reads and writes only to internal values, and transfers internal values to external values if communication to the associated I/O unit is enabled.

**flowcharts**  Since most control applications are complex, the strategy typically consists of a series of process flowcharts, or charts, that all work together. Each chart controls one aspect of the strategy—one piece of the automated process. Together, all the charts constitute the strategy. The total number of charts in a strategy is limited only by the amount of memory available in the control engine.
A chart can be running, suspended, or stopped. A running chart is actively performing its assigned task. A suspended chart is temporarily paused. A stopped chart is inactive. Every chart in a PAC Control strategy can change the status of any other chart in the strategy, yet every chart is independent of every other chart. Any combination of charts can be running simultaneously, up to the maximum limit allowed on the control engine. (See also, multitasking.)

Every strategy automatically contains a Powerup chart. The Powerup chart is automatically started when the strategy begins running, so it starts other charts. All other charts you create, based on the needs of your process.

input point  Input points are wired to hardware that brings information into the brain from the process. Examples of devices that can be wired to input points are thermocouples, switches, and sensors. The control engine in the brain takes the information from the input points—such as whether a switch is on or what temperature is registered—processes it using commands in the strategy, and returns information to the process through output points.

instructions (commands)  PAC Control commands, or instructions, tell the control engine what to do at each step in the flowchart to control the process. Each block in a chart contains one or more instructions, such as Convert Number to String or Start Counter or Chart Running?

Commands are in two forms: Actions and Conditions.

- **Action commands** do something in the process; for example, Convert Number to String and Start Counter are both action commands. On the flowchart they appear as instructions in action blocks, which are rectangular in shape. They may also appear in hexagonal OptoScript blocks.

- **Condition commands** check a condition and are in the form of a question. Chart Running? and Variable False? are examples of condition commands. They appear as instructions in condition blocks, which are diamond-shaped, or in hexagonal OptoScript blocks. Condition commands are questions that always have two possible answers, either yes or no (true or false). The answer determines the flow of logic and what happens next in the chart.
The instruction shown below is for the condition block, *Button D3 On?* This block contains only one instruction. As you look at the chart, you can see that the answer to the question in the instruction determines whether the process flows to *Turn LED D7 On* or to *Turn LED D7 Off*.

---

**internal value**  The internal value (IVAL) is the value read or written by the PAC Control strategy. Internal values are transferred to external values only when communication to the I/O unit is enabled.

**multitasking**  The control engine can run several charts seemingly at once, each performing a different task through a time-slicing technique called multitasking (also called multicharting). Opto 22 SNAP PAC R-series controllers can run up to 16 charts plus one host task simultaneously; SNAP-PAC S-series controllers can run up to 32 charts plus one host task simultaneously; a SoftPAC controller can run up to 64 charts plus one host task simultaneously. The host task is an invisible chart used to communicate to a PC, which may be running PAC Control in Debug mode or PAC Display.

Each chart in a running or suspended state counts toward the total that can run simultaneously. Charts that are stopped do not. When the Powerup chart is running, it also counts.

The actual order and timing for running tasks is not deterministic—that is, it is not always the same, but depends on priorities at any given time. For example, communication may sometimes take a higher priority than a running chart.

**OptoScript block**  OptoScript blocks are hexagonal blocks in a flowchart that contain OptoScript code. OptoScript is a procedural language that can simplify tasks such as math computations, string handling, and complex loops and conditions. OptoScript blocks can have more than one entrance but only one exit.

**output point**  Output points are wired to hardware that receives information from the brain and uses this information to control components of the process. For example, lights, motors, and valves are all devices that can be wired to output points. Using an output point, the control engine in the brain might turn on a light or open a valve.

**pointer**  A pointer does not store the value of a variable; instead, it stores the memory address of a variable or some other PAC Control item, such as a chart, an I/O point, or a PID loop. You can perform any operation on
the pointer that you could perform on the object the pointer points to. Pointers are an advanced programming feature and are very powerful, but they also complicate programming and debugging.

Because pointers can point to any data type, pointer tables can store an assortment of data types in a single table.

Pointers allow one level of indirection within PAC Control; a pointer cannot point to another pointer. After you add a pointer through the "Add Variable Dialog Box" on page 234, you can use it wherever the object itself would be used.

strategy  The software program you create using PAC Control Basic or PAC Control Professional. The strategy includes all the definitions and instructions (commands) necessary to control the process that one Opto 22 controller handles. Since most control processes are complex, the strategy typically consists of a series of process flowcharts that all work together, with each chart controlling one piece of the automated process. You may have several PAC Control systems, each controlling a different process and therefore running different strategies. Or you may have two or more PAC Control systems controlling identical processes in different areas and running the same strategy.

variables  A variable is a holding place that represents a piece of information in a strategy, such as the parameters for communication, temperature reported by a thermocouple, the name of a chart, or a group of words and numbers to be sent to a display. The information a variable represents is called the value of the variable. As a strategy runs, the variable’s name remains the same, but its value may change. For example, the value of a variable named Oven_Temperature may change several times while its strategy is running, but its name remains Oven_Temperature.

A variable stores one of six types of data: floating point, integer, timer, string, point, or communication handle. When you create the variable, you designate the type of data it contains.

- A floating point (or float) is a numeric value that contains a decimal point, such as 3.14159, 1.0, or 1234.2. A good example of a float variable is one that stores readings from an analog input, such as a thermocouple.

- An integer is a whole number with no fractional part. Examples of integer values are -1, 0, 1, 999, or -456. The state of a switch, for example, could be stored in an integer variable as 1 (on) or 0 (off).

- A timer stores elapsed time in units of seconds with resolution in milliseconds. Up timers count up from zero, and down timers start from a value you set and count down to zero. For example, you could set a down timer to make sure a value is updated at precise intervals.

- A string stores text and any combination of ASCII characters, including control codes and extended characters. For instance, a string variable might be used to send information to a display for an operator to see. A string variable can contain numeric characters, but they no longer act as numbers. To use them in calculations, you must convert them into floating point or integer numbers. And a numeric value to be displayed on a screen must be converted into a string first.

- A pointer does not store the value of a variable; instead, it stores the memory address of a variable or some other PAC Control item, such as a chart or an I/O point.

- Communication handles store parameters needed for communication with other devices.

You can use variables that are individual pieces of information, and you can also use table variables, which are groups of related information in the form of a table.
PAC CONTROL MAIN WINDOW

With a strategy open, the main window in PAC Control Basic and PAC Control Pro look similar to this:

Since PAC Control uses standard Microsoft Windows conventions, you’ll recognize the title bar and menu bar and already be familiar with some of the menus, such as File, Edit, View, Window, and Help. This section discusses some things that may not be familiar.

**Status Bar**

The status bar at the bottom of the window shows you information about PAC Control. When you move your mouse over the toolbar, a description of the button you’re pointing to appears in the status bar. The status bar indicates the mode PAC Control is in and indicates messages or errors helpful in debugging.

To hide or show the status bar, choose View > Status Bar. A check mark next to the menu item means the status bar will show; no check mark means it is hidden.
Mode

You can run PAC Control in three modes: Configure, Debug, or Online. The current mode is shown in the status bar, on the right. Toolbars and menus change depending on the mode.

- **Configure mode** is used to create, modify, save, and compile strategies, flowcharts, and subroutines; and to configure control engines, I/O, and variables.
- **Debug mode** is used to download, run, and debug strategies and to view control engine and communication status and errors while the strategy is running.
- **Online mode** is a scaled-down version of Configure mode, used to change a strategy while it is running. You cannot add variables and I/O in Online mode, but you can change ones that already exist.

  **NOTE:** When you change a chart in Online mode, a new copy of that chart is downloaded to the control engine, but the old one is not deleted. After you have made a few online changes, the additional chart copies begin to take up memory. To avoid memory problems, be sure you stop the strategy after making several online changes and completely compile and download it to clear out old chart copies.

To change modes, choose the mode you want from the Mode menu, or click its button in the toolbar.

Toolbars

Toolbars give you shortcuts for doing many things that also appear on menus. Toolbars in PAC Control include standard Windows buttons like New and Save as well as special buttons for PAC Control functions. The tools that you can use depend on which mode you’re in. Tools not currently available are grayed out.

The following toolbars are standard in PAC Control.

- **Mode Selection Toolbar**
- **Configure Mode and Online Mode Toolbar**
- **Debug Mode Toolbar**

**Mode Selection Toolbar**

The mode selection tools are always available.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Config]</td>
<td>Configuration Mode</td>
</tr>
<tr>
<td>![Debug]</td>
<td>Debug Mode</td>
</tr>
<tr>
<td>![Online]</td>
<td>Online Mode</td>
</tr>
</tbody>
</table>

**Configure Mode and Online Mode Toolbar**

The following toolbars appear in configure mode and online mode.

In a smaller window, the toolbar looks like this.
## Debug Mode Toolbar

The following toolbar appears in debug mode.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Run Strategy]</td>
<td>Run Strategy</td>
</tr>
<tr>
<td>![Stop Strategy]</td>
<td>Stop Strategy</td>
</tr>
<tr>
<td>![Pause Chart]</td>
<td>Pause Chart</td>
</tr>
<tr>
<td>![Inte]</td>
<td>Introduce</td>
</tr>
<tr>
<td>![Over]</td>
<td>Over</td>
</tr>
<tr>
<td>![Out]</td>
<td>Out</td>
</tr>
<tr>
<td>![Auto Step]</td>
<td>Auto Step</td>
</tr>
<tr>
<td>![Breakpoint]</td>
<td>Breakpoint</td>
</tr>
</tbody>
</table>

In a smaller window, the debug toolbar looks like this.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Run Strategy]</td>
<td>Run Strategy</td>
</tr>
<tr>
<td>![Stop]</td>
<td>Stop</td>
</tr>
<tr>
<td>![Pause]</td>
<td>Pause Chart</td>
</tr>
<tr>
<td>![Inte]</td>
<td>Introduce</td>
</tr>
<tr>
<td>![Auto Step]</td>
<td>Auto Step</td>
</tr>
<tr>
<td>![Breakpoint]</td>
<td>Breakpoint</td>
</tr>
</tbody>
</table>
Strategy Tree

The Strategy Tree opens when you open a strategy, and closing it is equivalent to closing the strategy. The Strategy Tree shows you all the elements of your strategy: control engines, flowcharts, subroutines, variables, I/O units and points, and PIDs.

The Strategy Tree works just like Windows Explorer: you can expand or collapse folders to view or hide what is in them. You can easily see what is in your strategy, open elements to change them by double-clicking them, or open a pop-up menu by right-clicking on an element.

Each element in the strategy is represented by a button, shown just to the left of its name. The table below shows the buttons and what they represent.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Control Engine" /></td>
<td>Control Engine</td>
<td><img src="image" alt="Integer 32 Table" /></td>
<td>Integer 32 Table</td>
</tr>
<tr>
<td><img src="image" alt="Chart" /></td>
<td>Chart</td>
<td><img src="image" alt="Integer 64 Table" /></td>
<td>Integer 64 Table</td>
</tr>
<tr>
<td><img src="image" alt="Subroutine" /></td>
<td>Subroutine</td>
<td><img src="image" alt="String Table" /></td>
<td>String Table</td>
</tr>
<tr>
<td><img src="image" alt="Integer 32 Variable" /></td>
<td>Integer 32 Variable</td>
<td><img src="image" alt="Pointer Table" /></td>
<td>Pointer Table</td>
</tr>
<tr>
<td><img src="image" alt="Integer 64 Variable" /></td>
<td>Integer 64 Variable</td>
<td><img src="image" alt="Digital I/O Unit" /></td>
<td>Digital I/O Unit</td>
</tr>
<tr>
<td><img src="image" alt="Float Variable" /></td>
<td>Float Variable</td>
<td><img src="image" alt="Mixed I/O Unit" /></td>
<td>Mixed I/O Unit</td>
</tr>
<tr>
<td><img src="image" alt="Down Timer Variable" /></td>
<td>Down Timer Variable</td>
<td><img src="image" alt="Analog Input Point" /></td>
<td>Analog Input Point</td>
</tr>
<tr>
<td><img src="image" alt="Up Timer Variable" /></td>
<td>Up Timer Variable</td>
<td><img src="image" alt="Digital Input Point" /></td>
<td>Digital Input Point</td>
</tr>
</tbody>
</table>
CHAPTER 3: WHAT IS PAC CONTROL?

WINDOWS AND DIALOG BOXES IN PAC CONTROL

Windows and dialog boxes in PAC Control follow Microsoft Windows standards. You can minimize, maximize, move, resize, and tile them as needed. See your Microsoft Windows documentation for information on how to perform these functions.

Using Tabs to View Open Windows

When multiple windows are open—especially if they are maximized—it can be difficult to know where you are, and windows can become lost behind each other. However, you can click the tabs at the bottom of the main PAC Control window to move among chart windows, subroutine windows, watch windows, and blocks you may be stepping through for debugging.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STR</td>
<td>String Variable</td>
</tr>
<tr>
<td>CH</td>
<td>Communication Handle</td>
</tr>
<tr>
<td>FLT</td>
<td>Float Table</td>
</tr>
<tr>
<td>PTR</td>
<td>Pointer Variable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Analog Output Point</td>
</tr>
<tr>
<td></td>
<td>Digital Output Point</td>
</tr>
<tr>
<td></td>
<td>PID Loop</td>
</tr>
</tbody>
</table>

Gray tabs show open windows. Click a tab to bring its window into view.

White tabs show where you are when stepping through a chart or subroutine.
The upper layer of tabs appears when you are stepping through your strategy in Debug mode. It acts as a kind of call stack to let you see how you got to the current block or command.

Docking Windows

You can place the strategy Tree and watch windows where you want them (dock them) in the PAC Control main window. Docked windows do not have tabs but are contained in their own frames. PAC Control remembers their position the next time you open that strategy.

- To dock a window, click the docking button in the window’s title bar.
The window moves to its own frame. (Compare the following figure with the one on page 53 to see the difference in the Strategy Tree window.)

- To change the docked position, click and drag the window’s title bar to any edge of the main window.
- To change the docked window’s width or height, click and drag the edge of its frame in the direction you want.
- To free the window from its docked position, click the docking button in its title bar.

**Zooming in a Chart or Subroutine Window**

You can change the scale of any chart or subroutine window by using the zoom feature. There are several ways to zoom:

- Hold down the Ctrl key and move the mouse wheel up and down.
- Press the + or - keys on the keyboard.
- Right-click anywhere on a chart or subroutine window to display a pop-up menu. Select Zoom and choose In, Out, or Reset (to return the zoom to 100 percent).
- From the View menu, choose Zoom In, Zoom Out, or Zoom Reset.
- To pick the zoom percentage you want, click the zoom field at the bottom right of the window and choose one of the preset zoom levels. The “Zoom to fit” option resizes the chart to fit in the window.

*NOTE: Zooming always takes place with reference to the center point of the window.*
Here is a window at 50 percent zoom:

![Window at 50 percent zoom](image1)

The same window at 200 percent zoom looks like this:

![Window at 200 percent zoom](image2)

**Panning a Chart**

The pan tool allows you to easily pan around a flowchart.

1. Using the pan tool, click and hold to grab a portion of a chart.
You can access the pan tool either from the toolbar or by holding down the space bar and clicking the left mouse button.

2. Move the pan tool to a new position and release. The chart moves to a new position.

Redrawing a Chart or Subroutine Window

If you want to move quickly to a particular block, you can redraw a chart or subroutine window with any block at its center.

1. With a chart or subroutine open in the active window, select View > Center On Block, or right-click in the chart or subroutine window and choose Center On Block from the pop-up menu.
The Center On Block dialog box appears, listing all blocks in the chart.

![Center On Block dialog box](image)

2. Double-click the block you want, or click it once and click OK.

The chart or subroutine is redrawn with the selected block in the center of the window.

### Changing Column Width in a Dialog Box

Many dialog boxes include several columns of information. To see all the data in some columns, you may need to make columns wider.

- To widen or narrow a column, click the right edge of the column label and drag it horizontally.

![Configure I/O Units dialog box](image)

- To resize a column to the exact width of its longest entry, double-click the line that separates the column from the one on its right.
Sorting Data in a Dialog Box

In some dialog boxes with columns of data, you can sort the information in the way you want to see it. The Center On Block dialog box provides an example.

The blocks in this dialog box normally appear in alphabetical order by the block name.

- To sort by block number instead, click the Block Id column label.

- To sort in the opposite order (descending numbers instead of ascending numbers), click the Block Id column label again.

Some dialog boxes don’t allow custom sorting. If you click a column label in these dialog boxes, nothing happens.

CUSTOMIZATION FEATURES

This section describes PAC Control special features for displaying numeric data, launching other applications from PAC Control, and modifying strategies using PAC Control’s Command-Line Interface tool.

Setting Decimal, Binary, or Hex Display Mode

You can set up PAC Control to show the values of all integers and integer tables in decimal (the default), binary, or hexadecimal (hex) format. Binary and hex formats help you use masks. Hex view is available in all modes: Configure, Debug, and Online.
The default view is in decimal notation, as shown in the following figure.

To view integers and integer tables in binary view, choose View > Binary Integer Display, or click the DEC button and choose Binary. The integers appear as shown below.

To view integers and integer tables in hex view, click BIN in the dialog box, and then select Hexadecimal. Here’s how the integers appear in hex:

To return to decimal view, click HEX and then select Decimal.

**Setting Hex String View**

You can also set strings to appear in hex notation. Here is the View Variable window showing a string in regular notation:

To change to hex notation, click the ASCII button on the dialog box.
Setting Up Applications to Launch from PAC Control

You may find it useful to launch other software applications directly from PAC Control. For example, you may want to launch PAC Display, Notepad, or the Calculator from PAC Control. You can set up PAC Control so that these applications appear in the Tools menu.

**NOTE:** If you launch an application from within PAC Control when that application is already running, a second instance of the application may open. It depends on the application; some check to see whether the application is already running, and some do not.

1. With PAC Control open, choose Tools > Customize. The Customize dialog box appears.

2. Click Add. In the Menu Text field, type the name of the application as you want it to appear in the Tools menu.

3. In the Command field, type the path for the application’s executable file, or click the Browse button and then navigate to the file.

4. (Optional) In the Arguments field, type any necessary command line parameters.

5. (Optional) In the Initial Directory field, type the directory the application should default to when it runs. For example, this is the directory the application would show when you open or save files.

6. Repeat the steps to add other applications. To change an application’s position in the menu list, highlight it and click the Move Up or Move Down keys.

7. When you have finished adding applications, click OK. The PAC Control main window is displayed, and the applications you’ve added now appear in the Tools menu.
Using PAC Control’s Command-Line Interface Tool

PAC Control’s Command-Line Interface (CLI) tool was built for customers who want a fast and easy way to modify existing strategies without using the PAC Control graphical user interface.

CLI is a command-line program that runs in Microsoft’s Command Prompt window. It can:
- Move a configured I/O module or I/O point to an empty position on the same or different I/O unit
- Add new variables
- Create a control engine download (.cdf) file

You can perform operations one at a time, or you can run multiple commands in a batch.

Responses to commands (and error codes) are logged to a file. For details, see “Checking CLI Command Output.”

CLI Commands and Syntax

CLI commands are not case-sensitive. You can run them from either a normal or an Admin (“elevated privilege”) Command Prompt window.

The syntax for a CLI command is:

```
<CLI executable program> <strategy filename> /<operation> <arguments>
```

where:
- `<CLI executable program>` is your PAC Control filename and extension:
  - For PAC Control Basic, the program is `control.basic.exe`
  - For PAC Control Professional, it is `control.pro.exe`
- `<strategy filename>` is the strategy to modify; for example: `cookies.idb`
  Note that you can perform operations on only one strategy at a time.
- `/<operation> <arguments>` is the operation to perform and its required arguments (see “CLI Operations and Arguments” on page 67). Multiple arguments are separated by semicolons.

**IMPORTANT:** Paths, filenames, and arguments that contain a space must be enclosed in straight quotes (" ").

Depending on the folder you run CLI from, you may need to enter the path and filename for the CLI executable program, the strategy, or both.

For example, if PAC Control Basic is installed on your C:\ drive, the path and filename for the CLI executable program is:

"C:\Program Files (x86)\Opto22\PAC Project 10.3\control.basic.exe"

Because the path contains spaces, the path and filename have been enclosed in straight quotes.

Example of a CLI command and response.
Paths, filenames, and arguments that include spaces must be enclosed in straight quotes.
Note that the response is a new prompt.

When typing CLI commands:
- Type a space **after:**
- The CLI executable program name.
- The strategy filename.
- The operator.

- Type a semicolon (;) between arguments. Don’t put spaces before or after the semicolons.
- If your path, filename, or arguments include spaces, you must enclose them with straight quotes (" ").

Saving the Strategy

After performing a command, the CLI saves the strategy used in the command.

When you use the /cdf option with a strategy from a previous version of PAC Control, the strategy will be updated to the current version of PAC Control. When this happens, there is no warning message (like the one displayed when you open an older strategy in PAC Control).

CLI Operations and Arguments

The following table describes the CLI operations and arguments. Required characters are shown in **bold, red** color to make them easier to see.

<table>
<thead>
<tr>
<th>To do this:</th>
<th>...use this operation:</th>
<th>...with these arguments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a configured I/O module to an empty position</td>
<td>/mm</td>
<td>&lt;source I/O unit&gt;;&lt;source module position&gt;;&lt;target I/O unit&gt;;&lt;target module position&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>where:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &lt;source I/O unit&gt; is the name of the I/O unit that contains the module you want to move.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &lt;source module position&gt; is the current position number of the module to move.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &lt;target I/O unit&gt; is the name of the I/O unit you want to move the module to.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &lt;target module position&gt; is the position number where you want to move the module. Note that the position must be empty (that is, not configured with another module).</td>
</tr>
</tbody>
</table>

Example:

C:\>control.pro.exe cookies.idb /mm Mixed_IO_Unit;8;Sprinkler_Control;4

Move a configured I/O point to an empty position

| /mp                                           | <source I/O unit>;<source point name>;<target I/O unit>;<target module position>;<target point position> |
|                                               | where:                  |
|                                               | • <source I/O unit> is the name of the I/O unit that contains the point you want to move. |
|                                               | • <source point name> is the name of the point to move. |
|                                               | • <target I/O unit> is the name of the I/O unit you want to move the point to. |
|                                               | • <target module position> is the position number of the module where you want to move the point. |
|                                               | • <target point position> is the point number on the module where you want to move the point. Note that the position must be empty (that is, not configured with another point). |

Example:

C:\>control.pro.exe cookies.idb /mp Mixed_IO_Unit;doRejectValve;Valve_Unit;2;0
### Add a variable

NOTE: This operation does not support pointer variables or pointer table variables.

`/av

<variable type><variable name><description><initialization type><initial value>[<string width>][<table length>]

where:
- `<variable type>` indicates the type of variable.
  Enter one of the following values.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT32_VAR</td>
<td>32-bit integer variable</td>
</tr>
<tr>
<td>INT64_VAR</td>
<td>64-bit integer variable</td>
</tr>
<tr>
<td>FLOAT_VAR</td>
<td>Float variable</td>
</tr>
<tr>
<td>STR_VAR</td>
<td>String variable</td>
</tr>
<tr>
<td>DNTMR_VAR</td>
<td>Downtimer variable</td>
</tr>
<tr>
<td>UPTMR_VAR</td>
<td>Uptimer variable</td>
</tr>
<tr>
<td>CMHDL_VAR</td>
<td>Communication handle variable</td>
</tr>
<tr>
<td>INT32_TBL</td>
<td>32-bit table variable</td>
</tr>
<tr>
<td>INT64_TBL</td>
<td>64-bit table variable</td>
</tr>
<tr>
<td>FLOAT_TBL</td>
<td>Float table variable</td>
</tr>
<tr>
<td>STR_TBL</td>
<td>String table variable</td>
</tr>
</tbody>
</table>

- `<variable name>` is the name of the variable. The name must follow PAC Control conventions (for example, it cannot start with or contain spaces, it cannot start with a number, and so forth). Maximum length is 50 characters.

- `<description>` is a brief description of the variable (in straight quotes, if it contains spaces). To leave the description field blank, enter a space in straight quotes (like this: "   "). Maximum length for the description is 127 characters.

- `<initialization type>` indicates how to initialize the variable. Enter one of the following values.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON_DOWN-LOAD</td>
<td>Initialize the variable on strategy download.</td>
</tr>
<tr>
<td>ON_RUN</td>
<td>Initialize the variable when the strategy runs.</td>
</tr>
<tr>
<td>PERSISTENT</td>
<td>(Not applicable to timer variables.) This argument makes</td>
</tr>
<tr>
<td></td>
<td>the variable persistent. For more information about</td>
</tr>
<tr>
<td></td>
<td>persistent variables, see “Persistent Data” on page 232.</td>
</tr>
</tbody>
</table>

- `<initial value>` is the variable’s initial value.

NOTE: Not applicable to timer variables. For timers, enter a space for this argument.
### To do this: **...use this operation:**

<table>
<thead>
<tr>
<th><strong>...with these arguments:</strong></th>
<th>(Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>{} [{&lt;string width&gt;};{&lt;table length&gt;}] Applicable only to strings and table variables.</td>
<td></td>
</tr>
<tr>
<td>Strings: The string width. Example: 15</td>
<td>The maximum width you can give a string is 1024 characters.</td>
</tr>
<tr>
<td>String tables: The string width and table length. Example: 15; 99</td>
<td>Note the semicolon between the numbers. The maximum width you can give a string is 1024 characters. The maximum table length is 1,000,000 elements.</td>
</tr>
<tr>
<td>Integer and float tables: The table length. Example: 99</td>
<td></td>
</tr>
</tbody>
</table>

#### Example:

```
C:\>control.pro.exe cookies.idb /av INT32_VAR;nFlavor;"Cookie_Flav-
vor";ON_RUN;0
```

<table>
<thead>
<tr>
<th><strong>Perform a series of commands</strong></th>
<th><strong>/f</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• &lt;filename of a text file that contains CLI commands&gt;</td>
<td></td>
</tr>
<tr>
<td>– This feature lets you issue one command to perform all the commands in a text file.</td>
<td></td>
</tr>
<tr>
<td>– Each command must follow CLI command syntax:</td>
<td></td>
</tr>
<tr>
<td>$&lt;CLI executable program&gt; &lt;strategy filename&gt; /&lt;operation&gt; &lt;arguments&gt;$</td>
<td></td>
</tr>
<tr>
<td>– Each command must be on a separate line. (Don’t use word wrapping in the file.)</td>
<td></td>
</tr>
<tr>
<td>– Each command is processed in order.</td>
<td></td>
</tr>
<tr>
<td>– Responses (and, if applicable, errors) are logged to a file. For details, see “Checking CLI Command Output.”</td>
<td></td>
</tr>
</tbody>
</table>

#### Example:

```
C:\>control.pro.exe cookies.idb /f "C:\Documents\my_batch_commands.txt"
```

<table>
<thead>
<tr>
<th><strong>Compile a strategy into a .cdf file</strong></th>
<th><strong>/cdf</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>This operation has no arguments. The output is saved in the folder where PAC Control is installed.</td>
<td></td>
</tr>
</tbody>
</table>

#### Example:

```
C:\>control.pro.exe cookies.idb /cdf
```

*a* Remember that module numbers and point numbers are zero-based; the first position is number 0 (not 1).

*b* See “Saving the Strategy” on page 67.

The syntax to load a strategy in PAC Control’s graphical user interface is:

```
<CLI executable program> <strategy filename>
```

#### Example: C:\>control.pro.exe cookies.idb

**Checking CLI Command Output**

For each CLI command you enter, the system logs a record in a Control.Output.csv file. (If the file already exists, new messages are appended to the file.) You can view the Control.Output.csv file to see whether or not a CLI command was successful. The file’s .csv format lets you open the file in text editors (like Notepad), as well as in spreadsheet programs (like Excel).

- When a command is successful, CLI logs “Succeeded,” and the name of the operation you performed.
- When a command fails, the message shows “Failed,” followed by an error code (described on page 70), the name of the operation, and the arguments entered with the operation.
ControlOutput.csv files are located in the same folder as the strategy used in the CLI command. For example, if the strategy in your command is located in the C:\MyStrategies folder, the ControlOutput.csv is saved in C:\MyStrategies.

Example of a ControlOutput.csv file opened in Microsoft Excel®. In this example, Excel has parsed the data into columns.

Error Codes

This table explains the error codes you might see in the Control.Output.csv log file.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Error code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>all</td>
<td>1</td>
<td>No operation was entered. Please enter an operation.</td>
</tr>
<tr>
<td>/f (Command file)</td>
<td>2</td>
<td>The text file containing CLI commands could not be opened.</td>
</tr>
<tr>
<td>all</td>
<td>3</td>
<td>CLI could not open the strategy.</td>
</tr>
<tr>
<td>all</td>
<td>4</td>
<td>The strategy does not have a configured controller</td>
</tr>
<tr>
<td>/cdf (Compile to .CDF file)</td>
<td>5</td>
<td>CLI could not create the .cdf file.</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>CLI could not re-open the .cdf file.</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>CLI could not create the .crn file.</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>CLI could not open the intermediate file.</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>CLI could not append to the .crn file.</td>
</tr>
<tr>
<td></td>
<td>70</td>
<td>CLI could not open the strategy because it was previously saved in PAC Control Basic.</td>
</tr>
<tr>
<td></td>
<td>71</td>
<td>CLI could not find the path to a file you want to download after the strategy.</td>
</tr>
<tr>
<td></td>
<td>72</td>
<td>CLI could not save the strategy because it is currently open in PAC Control Basic or Professional.</td>
</tr>
<tr>
<td></td>
<td>73</td>
<td>CLI could not save the strategy because the CLI does not have permission to access the specified folder.</td>
</tr>
<tr>
<td>Operation</td>
<td>Error code</td>
<td>Meaning (Continued)</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/av (Add Variable)</td>
<td>10</td>
<td>The variable type argument is missing.</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>The variable name argument is missing, or too long (maximum length is 50 characters), or is formatted incorrectly, or already in use, or is a programming “reserved word.” (Reserved words cannot be used as variable names.)</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>The description argument is missing or too long. The maximum size for a description is 127 characters.</td>
</tr>
<tr>
<td></td>
<td>13</td>
<td>The initialization kind argument is missing.</td>
</tr>
<tr>
<td></td>
<td>14</td>
<td>The initial value argument is missing.</td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>(Applicable only to string and string table variables.) The string width argument is missing or too long. The maximum size you can give a string is 1024 characters.</td>
</tr>
<tr>
<td></td>
<td>16</td>
<td>(Applicable only to table variables.) The table length argument is missing or too long. (Maximum table length is 1,000,000 elements.)</td>
</tr>
<tr>
<td></td>
<td>17</td>
<td>Cannot create the variable.</td>
</tr>
<tr>
<td></td>
<td>18</td>
<td>Cannot get an ID for the new variable.</td>
</tr>
<tr>
<td></td>
<td>19</td>
<td>Cannot add the variable to the strategy.</td>
</tr>
<tr>
<td>Operation</td>
<td>Error code</td>
<td>Meaning</td>
</tr>
<tr>
<td>-----------</td>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td>The source I/O unit is missing. Please enter the name of the source I/O unit.</td>
</tr>
<tr>
<td></td>
<td>21</td>
<td>The source module position is missing. Please enter a source module position number. Remember that module positions are zero-based (count up from 0 instead of from 1).</td>
</tr>
<tr>
<td></td>
<td>22</td>
<td>The target I/O unit is missing. Please enter the name of the target I/O unit.</td>
</tr>
<tr>
<td></td>
<td>23</td>
<td>The target module position is missing. Please enter a target module position number. Remember that module positions are zero-based (count up from 0 instead of from 1).</td>
</tr>
<tr>
<td></td>
<td>24</td>
<td>The source I/O unit is not in the strategy. Check the name and re-enter.</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>The source module position is out-of-range. Check the number and re-enter. Remember that module positions are zero-based (count up from 0 instead of from 1).</td>
</tr>
<tr>
<td></td>
<td>26</td>
<td>The target I/O unit is not in the strategy. Check the name and re-enter.</td>
</tr>
<tr>
<td></td>
<td>27</td>
<td>The target module position is out-of-range. Check the number and re-enter. Remember that module positions are zero-based (count up from 0 instead of from 1).</td>
</tr>
<tr>
<td></td>
<td>28</td>
<td>A module already exists at the target module position. Enter an empty module position.</td>
</tr>
<tr>
<td></td>
<td>29</td>
<td>No module is defined at the source module position. Check the number and re-enter.</td>
</tr>
<tr>
<td></td>
<td>30</td>
<td>One or more points on the source module are referenced by a PID loop, and the target I/O unit is not the source I/O unit. To move the module, remove the PID loops, or make sure the source module and the target module are the same.</td>
</tr>
<tr>
<td></td>
<td>31</td>
<td>The target module cannot be used because it’s not compatible with the source module.</td>
</tr>
<tr>
<td></td>
<td>32</td>
<td>The source I/O unit cannot be verified.</td>
</tr>
<tr>
<td></td>
<td>33</td>
<td>The target I/O unit cannot be verified.</td>
</tr>
<tr>
<td></td>
<td>34</td>
<td>The source module position is out-of-range. Check the number and re-enter. Remember that module positions are zero-based (count up from 0 instead of from 1)</td>
</tr>
<tr>
<td></td>
<td>35</td>
<td>The target module position is out-of-range. Check the number and re-enter. Remember that module positions are zero-based (count up from 0 instead of from 1).</td>
</tr>
<tr>
<td></td>
<td>36</td>
<td>The points on the source module are not allowed on the target I/O unit.</td>
</tr>
</tbody>
</table>
## KEYBOARD AND MOUSE SHORTCUTS

Use the following keyboard and mouse shortcuts to view and navigate a chart.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Error code</th>
<th>Meaning (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td></td>
<td>The source I/O unit is missing. Please enter the name of the source I/O unit.</td>
</tr>
<tr>
<td>41</td>
<td></td>
<td>The source point name is missing. Please enter the name of the source point.</td>
</tr>
<tr>
<td>42</td>
<td></td>
<td>The target I/O unit is missing. Please enter the name of the target I/O unit.</td>
</tr>
<tr>
<td>43</td>
<td></td>
<td>The target module position is missing. Please enter a target module position number. Remember that module positions are zero-based (count up from 0 instead of from 1).</td>
</tr>
<tr>
<td>44</td>
<td></td>
<td>The target point position is missing. Please enter a target position number. Remember that point positions are zero-based (count up from 0 instead of from 1) and are the position on the module (not the absolute point position).</td>
</tr>
<tr>
<td>45</td>
<td></td>
<td>The source I/O unit is not in the strategy. Check the name and re-enter.</td>
</tr>
<tr>
<td>46</td>
<td></td>
<td>The source point name is not in the strategy. Check the name and re-enter.</td>
</tr>
<tr>
<td>47</td>
<td></td>
<td>The target I/O unit is not in the strategy. Check the name and re-enter.</td>
</tr>
<tr>
<td>48</td>
<td></td>
<td>The target module position is out-of-range. Check the number and re-enter. Remember that module positions are zero-based (count up from 0 instead of from 1).</td>
</tr>
<tr>
<td>49</td>
<td></td>
<td>The target point position is out-of-range. Check the number and re-enter. Remember that point positions are zero-based (count up from 0 instead of from 1) and are the position on the module (not the absolute point position).</td>
</tr>
<tr>
<td>/mp (Move Point)</td>
<td>50</td>
<td>A point already exists at the target point position. Enter an empty point position.</td>
</tr>
<tr>
<td>51</td>
<td></td>
<td>The point on the source module is referenced by a PID loop, and the target I/O unit is not the source I/O unit. To move the point, remove the PID loop, or make sure the source module and the target module are the same.</td>
</tr>
<tr>
<td>52</td>
<td></td>
<td>The target point cannot be used because it's not compatible with the source point.</td>
</tr>
<tr>
<td>53</td>
<td></td>
<td>The source I/O unit cannot be verified.</td>
</tr>
<tr>
<td>54</td>
<td></td>
<td>The target I/O unit cannot be verified.</td>
</tr>
<tr>
<td>55</td>
<td></td>
<td>The source point name cannot be verified.</td>
</tr>
<tr>
<td>56</td>
<td></td>
<td>The target module position is out-of-range. Check the number and re-enter. Remember that module positions are zero-based (count up from 0 instead of from 1).</td>
</tr>
<tr>
<td>57</td>
<td></td>
<td>The target point position is out-of-range. Check the number and re-enter. Remember that point positions are zero-based (count up from 0 instead of from 1) and are the position on the module (not the absolute point position).</td>
</tr>
<tr>
<td>58</td>
<td></td>
<td>The point on the source module is not allowed on the target I/O unit.</td>
</tr>
<tr>
<td>59</td>
<td></td>
<td>Quadrature modules must be moved to an even numbered channel.</td>
</tr>
<tr>
<td>60</td>
<td></td>
<td>Quadrature modules require two adjacent channels. The second channel is occupied by another point.</td>
</tr>
</tbody>
</table>
To open Help within PAC Control, click Help > Help Topics in the PAC Control menu bar, or click the Help button in any dialog box. Help buttons in dialog boxes are context-sensitive and provide help specifically on that dialog box. Buttons labeled “Command Help” give specific information on the command (instruction) you are currently using. (The command must be highlighted to open Command Help.)

For brief explanations of buttons, move your mouse over the button and look in the status bar.

In Action and Condition Instructions dialog boxes, let your mouse rest for a second on a command, and you’ll see a list of the variable types used in that command. (To show or hide the variable types list, in Configure mode, click PAC Control Options > Show/Hide Instruction Type Information.)

To open copies of PAC Control manuals and quick reference cards, click Help > Manuals. You will need Adobe Acrobat Reader to open these files. You can also find information, documents, and support on the Opto 22 website.
INTRODUCTION

This chapter introduces you to PAC Control programming—how to design a PAC Control strategy to control your automated process. For additional important information on using PAC Control commands (instructions) to program your strategy effectively, see page 255 and the individual command information in the PAC Control Command Reference.

NOTE: Because our focus in PAC Project is on the SNAP PAC System, PAC Control initially shows only SNAP PAC I/O units and the commands used with them. When you’re using the SNAP PAC system only, hiding legacy I/O units and commands makes it simpler and less confusing to build your strategy. However, the legacy capabilities are still there and can be made visible in a specific strategy as needed. For information, see “Legacy Options” on page 208.

In This Chapter
Steps to Design ..............................................................page 75
Basic Rules .................................................................page 82
Instruction Examples ....................................................page 84
Optimizing Throughput .................................................page 93

STEPS TO DESIGN

How do you get from your real-world control problem to a working PAC Control strategy that solves it? Here’s an outline of the basic approach; we’ll fill in the details on the following pages.

First, solve the problem.

- Define the problem.
  - What am I trying to do?
  - What inputs and data do I have to work with?
  - What do the outputs have to be?
  - How many times does the process have to be repeated?

- Design a logical sequence of steps to solve the problem.
  - Break down the larger process task into sub-process tasks.
  - Break down the sub-process tasks into detailed steps.

- Test the steps.

Next, build the strategy.

- Configure hardware.
  - Control Engines
  - I/O units
  - I/O points
• Determine necessary variables and configure them.
• Create charts, one for each sub-process, and add instructions.
• Compile and debug each chart.
• Compile and debug the whole strategy.

Finally, use and improve the strategy.

Now let’s take a look at each of these steps in order.

Solving the Problem

You can avoid a lot of extra time and rework if you define and solve your problem before you ever start building a flowchart in PAC Control.

Defining the Problem

Suppose, for example, you want to automate a simple lawn sprinkler system. Start by asking yourself (or others) questions about the control process you’re trying to do.

What are you trying to do? Start with the big picture and work down to the smaller details.

• Big picture: I’m trying to control this sprinkler system.
• Smaller details:
  – The sprinklers should turn on every Sunday and every Wednesday.
  – They should not turn on if it’s raining.
  – They should start at six o’clock in the morning.
  – They need to run for 15 minutes.

What inputs and data do you have to work with? List all the inputs. Describe the data they provide. Check for any inputs or data you need but don’t have.

<table>
<thead>
<tr>
<th>Input</th>
<th>Data the input provides</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hygrometer</td>
<td>Humidity (percentage from 0–100%)</td>
</tr>
<tr>
<td>Day</td>
<td>Day of the week (Sunday through Saturday)</td>
</tr>
<tr>
<td>Time</td>
<td>Hour of the day (24-hour clock)</td>
</tr>
<tr>
<td>Sprinkler status</td>
<td>Whether sprinklers are currently running (on or off)</td>
</tr>
<tr>
<td>Input from timer</td>
<td>Length of time sprinklers have been on (in minutes)</td>
</tr>
</tbody>
</table>

What do the outputs need to be? List all the outputs. Describe the results that are needed. Check for any outputs you need but don’t have.

<table>
<thead>
<tr>
<th>Output</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sprinkler switch</td>
<td>Turns sprinklers on or off</td>
</tr>
<tr>
<td>Timer control</td>
<td>Sets timer</td>
</tr>
</tbody>
</table>

How many times does the process have to be repeated? Our example is a simple sprinkler system in which the process happens twice a week on certain days. In a more complex system, however, you might have one section of the sprinklers turn on, followed by other sections, repeating the process several times in different areas and then repeating the whole pattern on certain days.
Designing a Logical Sequence of Steps to Solve the Problem

Now that you’ve determined what you’re trying to do and what your inputs, data, and outputs look like, you’re ready to outline the steps needed to solve the control problem. Think about how you would do the job if you were doing it by hand. Again, work from the top down, starting with big steps and then breaking those big steps into smaller steps.

Sprinkler Control System

Every day at 6:00 a.m.:
1. Check the day and the weather.
2. If it’s raining, leave the sprinklers off.
3. If it’s the right day and it’s dry, turn them on.

1. Check the day and the weather.
   Read the day of the week.
   If it’s Sunday or Wednesday, read the hygrometer.

2. If it’s raining, leave them off.
   If the hygrometer says 100%,
   check to make sure sprinklers are off.
   If they’re on, turn them off.

3. If it’s the right day and it’s dry,
   turn them on.
   If it’s Sunday or Wednesday and if the hygrometer says 99% or below,
   turn sprinklers on.
   Start the timer.
   When they’ve been on for 15 minutes, turn them off.

If a human being were doing this job, this level of instruction would probably be just fine. With a computer, however, the instructions need more detail. For example, the first instruction, “Every day at 6:00 a.m.,” would have to be expanded more like this:

   a. Read the hour.
   b. If the hour equals six, go on to the next step.
   c. If the hour does not equal six, go back to step a.

Testing the Steps

Now that you have your steps in place, run through each sub-process in your mind to see if anything is missing. Is there an answer for every “if”? Are all the possibilities taken into account?

It may help you to draw out your control process as a flowchart. Often it is easier to see decision points and responses to decisions in a flowchart. You’re still working at the human level at this point; just be aware that the computer may require more details.
Here’s a possible flowchart for the simple sprinkler control problem.

**Simple Sprinkler System Process Flowchart**

At 6:00 a.m., read the day of the week

- Is it Sunday or Wednesday?
  - Yes: Read the hygrometer
    - Is humidity less than 100%?
      - Yes: Turn sprinklers on and set timer for 15 minutes
      - No: Sprinklers off?
        - Yes: Turn sprinklers on and set timer for 15 minutes
        - No: Wait 24 hours
  - No: Wait 24 hours

- timer expired?
  - Yes: Turn sprinklers off
  - No: Sprinklers off

Building the Strategy

Once you have the control problem solved in detail, you can begin building the strategy in PAC Control. Now you’ll add all the logical details the computer needs.

Configuring Hardware

The first step in building your strategy is to configure your control engine, I/O units, and I/O points. (For details and step-by-step procedures, see Chapter 5: Working with Control Engines and Chapter 6: Working with I/O.) You can add more I/O units and points later if needed, but it saves time to configure them now.

When you solved this control problem, some of the inputs and outputs you defined were physical I/O, such as the hygrometer and the switch to turn on the sprinklers. You configure these physical inputs and outputs as the I/O points.

Here are the I/O points you might configure for the simple sprinkler system:

<table>
<thead>
<tr>
<th>Physical I/O</th>
<th>Type</th>
<th>I/O Point Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hygrometer</td>
<td>Analog Input</td>
<td>Hygrometer</td>
</tr>
<tr>
<td>Sprinkler status</td>
<td>Digital Input</td>
<td>Sprinkler_Status</td>
</tr>
<tr>
<td>Sprinkler switch</td>
<td>Digital Output</td>
<td>Sprinkler_Switch</td>
</tr>
</tbody>
</table>
Determining and Configuring Variables

Some of the inputs and outputs you defined when you solved the problem were not physical I/O, but information. For example, the day of the week is not a physical input; it’s a piece of information you can get using a command in PAC Control. These inputs and outputs become variables.

You also need variables to store the information that input points give you. And you may need variables for manipulating information.

To determine the variables you need, think about the pieces of information your process requires. Then look at the PAC Control commands in the PAC Control Command Reference. Find the commands you need and check them to see what types of variables each command requires.

For example, you need to know what day of the week it is. Will the control engine give you this information as a string (for example, “Wednesday”) or in some other format? When you check the command Get Day of Week, you discover that the day is returned as a number (Wednesday = 3), so you set up this variable as a numeric integer.

Here are some variables you may need. (See Chapter 9: Using Variables and Commands for more information and step-by-step procedures to add variables.) You can change them or add other variables later if necessary.

<table>
<thead>
<tr>
<th>Variable Needed</th>
<th>Type</th>
<th>Name in PAC Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hour of the day</td>
<td>Numeric (32-bit integer)</td>
<td>Time_of_Day</td>
</tr>
<tr>
<td>Day of the week</td>
<td>Numeric (32-bit integer)</td>
<td>Day_of_the_Week</td>
</tr>
<tr>
<td>Humidity</td>
<td>Numeric (float)</td>
<td>Humidity</td>
</tr>
<tr>
<td>Down timer</td>
<td>Timer</td>
<td>Timer</td>
</tr>
</tbody>
</table>

Creating PAC Control Charts and Adding Instructions

If you have already drawn the process in a flowchart, this step will go faster. PAC Control is based on flowcharts because they are a natural way to show a control process. And the block names and instructions you add to charts—just like the names of variables—are in normal, everyday language. (For details and step-by-step procedures, see Chapter 8: Working with Flowcharts and Chapter 9: Using Variables and Commands.)

The difference between the flowchart you drew before and the chart you create in PAC Control is that the flowchart was designed for human beings, but the PAC Control chart must be more detailed so the computer can follow it.

Because the chart is more detailed—and because most control processes are far more complex than our sprinkler system—you will usually create multiple charts for a PAC Control strategy. Break the process down into logical chunks, or modules, and then create a chart for each module. A modular design makes it easier to test and to update your strategy.

Even for a simple process like our sprinkler control, there is no single “correct” way to solve the control problem and build the strategy. Instead, there are many possible ways.
The following chart shows one example:

One difference between this chart and the human-level chart on page 78 is that several delays have been added to the chart. There is one before rechecking the hour of the day, one before rechecking the day of the week, one before rechecking whether the timer has expired, and finally one before starting the flowchart over again.

This sprinkler system is not time-critical. If the sprinklers turn on at a little past 6:00 a.m. or the grass is watered an extra few seconds, it doesn’t matter. Delays give the control engine time to do other things. (For more information on delays and using control engine time effectively, see page 93.)

Each block in the chart contains the PAC Control commands (instructions) that do the work in the system. For example, here are the instructions for the block “Turn on sprinklers, set timer”:
As you create charts and enter instructions, keep referring to the PAC Control Command Reference. The Command Reference describes the “arguments” for each command, which are pieces of information you must enter in the instruction. You can also press F1 to open online help for commands, which gives you the same information as in the printed Command Reference.

For example, one of the commands shown above, Set Down Timer Preset Value, has two arguments. The Command Reference and online help tell you that the first argument—the target value, or the value from which the timer counts down—can be a float variable or a float literal (entered in either decimal or hexadecimal form), and that the second argument is the name of the down timer variable. You need this information when you enter the instruction in the Add Instruction dialog box.

The sample flowchart we've shown uses standard PAC Control commands only. If you have a programming background, you may wish to incorporate OptoScript blocks in your flowchart. OptoScript is a procedural language that can simplify some programming tasks, including string handling, math calculations, and complex loops and conditions. See Chapter 11: Using OptoScript for more information.

**Compiling and Debugging the Strategy**

When all charts are completed and their instructions added, the next step is to compile and debug the strategy. But first, check your hardware. Check cabling and connections, and make sure the actual I/O matches the configured I/O in the strategy.

Now compile and debug the strategy. (For details and step-by-step procedures, see Chapter 7: Working with Strategies. If you have problems, see Appendix A: Troubleshooting.)

If you have multiple charts, debug each one separately and then debug the strategy as a whole. It is easier to find errors in one flowchart than in a group of interrelated ones.

Make sure the connections between charts are accurate. For example, is a chart started at the correct block in another chart?

Use the debugging tools discussed in Chapter 6 to find errors by stepping through a chart and setting breakpoints to discover which block or line contains the problem. And if you’ve tried everything and it still doesn’t work, contact Opto 22 Product Support at 800-835-6786 (toll-free in the U.S. and Canada) or email support@opto22.com.

**Using and Improving the Strategy**

Any strategy is one of several possible ways to solve a control problem. One way may be more efficient under some circumstances; another way may be better for others. As you use the strategy over time, as control needs change, and as you become more knowledgeable about PAC Control, you’ll find ways to make the strategy better.
BASIC RULES

The sprinkler strategy we just created is a simple example. This section gives basic rules to keep in mind when you're solving more complex control problems.

When you create a new PAC Control strategy, a Powerup chart is automatically included. You add all the other charts you need, and the total number of charts in the strategy is limited only by the control engine’s memory. Be aware, however, that the maximum number of charts that can be running at any one time is based on the control engine you are using:

- 16 charts on a SNAP PAC R-series controller
- 32 charts on a SNAP PAC S-series controller
- 64 charts on a SoftPAC controller

Program logic moves through a flowchart in one of two ways: flow-through or loop.

- A chart with flow-through logic performs a set of specific commands and then stops. It has a beginning and an end, and at the end is a condition or action block that has no exit. Subroutines, the Powerup chart, and any other chart that does not need to run continuously should always have flow-through logic. In complex strategies, be careful when using delays and condition looping (waiting for something to occur) in charts with flow-through logic.

- A chart with loop logic has no end. It loops through a set of actions and conditions continuously. A loop-logic chart can have several paths through which the direction of the logic may flow, depending on certain criteria. Use loop logic for a chart that needs to run continuously. (The simple sprinkler chart has loop logic; it runs continuously.)

Chart Guidelines

As you design your strategy, put each sub-process of your overall control problem into a separate chart within the strategy. On a SNAP PAC R-series controller, a maximum of 16 charts (plus one host task) can run at once. On a SNAP PAC S-series controller, 32 charts (plus one host task) can run at once. On a SoftPAC controller, 64 charts (plus one host task) can run at once. (For more information, see “Optimizing Throughput” on page 93.)

In general, follow these chart guidelines:

- Use the Powerup chart just to set initial values for variables, perform setup commands, and start the main charts. Use flow-through logic so the Powerup chart will stop as soon as the other charts begin.

- Create a few charts to monitor essential or time-critical pieces of your process, such as emergency stops on dangerous equipment or I/O that must be monitored continuously. These charts should use loop logic so they are constantly running.

- If a set of operations is used multiple times in your strategy or is used in more than one strategy, you can put that logic in a subroutine and call the subroutine when needed. Calling a subroutine doesn’t require as much time as calling a chart or starting a new chart. In addition, a subroutine starts as soon as it is called in the context of the chart that is calling the subroutine. A Start Chart command is simply placed in the task queue and started in turn. See Chapter 12: Using Subroutines for more information.

- Use the text tool to type a descriptive title in each chart and add any necessary explanations. Keep blocks far enough apart to easily see the flow, and if possible, design the chart so its entire flow can be seen within one window. If a chart becomes too complex, split it into smaller charts.

- Within a chart, leave Block 0 empty. This makes it easy to insert logic at the beginning of the chart by adding a block between Block 0 and the next block. If a block contains more instructions than can be
easily traced and debugged, break it down into two or more sequential blocks. Never place another block in the flowchart before Block 0. Charts always start with Block 0, which cannot be deleted.

**Naming Conventions**

To save trouble in the long run, it’s wise to establish naming conventions for charts, blocks, variables, I/O units and points, control engines, subroutines, and so on. If you name these elements in a consistent way from the beginning, it is easier to find them in lists, to see related elements, and to know their functions without opening them.

Since PAC Control automatically alphabetizes these names, you can plan naming schemes to place similar items together in the way you expect to use them.

Names have a maximum length of 50 characters. They can be all upper-case characters, or they can be mixed case.

**In chart names**, for example, you might include a few letters indicating whether the chart monitors critical tasks, is a master chart calling others, or is periodically called:

- Mntr_Tank_Leak (constantly running chart that monitors a critical situation)
- Mstr_Conveyor_Process (master chart that calls others for a sub-process)
- Call_Message_Display (chart called by a master chart for a specific purpose)

**Block names** should tell what the block does, so you can understand a chart without needing additional explanations. Block names should describe the purpose of the instructions within them. Use a question for the name of a condition block, with a true exit reflecting the answer yes.

- Read Thermometer (action block)
- Temperature Too High? (condition block)
- Turn On Pump 1 or Pump 1 On (action block)
- Pump On? (condition block)

**Variable names** can include Hungarian notation to indicate the type of variable, since the variable type is not always apparent in its name. For example a variable named *Month* might be either a string or an integer. However, using Hungarian notation, *sMonth* indicates a string, and *nMonth* indicates an integer.

Another good practice is to identify variables used in a single chart differently than variables used by more than one chart or process, especially if you have a large chart and want to separate these types of variables. For variables used only in a table, you can include the table name in the variable name. For example, you might use the name *Fail_Count_in_Config_Values* for a variable to be used in a table named Config_Values.

The following table shows suggested notation for use in PAC Control:

<table>
<thead>
<tr>
<th>Variable type</th>
<th>Letter</th>
</tr>
</thead>
<tbody>
<tr>
<td>integer 32 variable</td>
<td>n</td>
</tr>
<tr>
<td>integer 32 variable used as Boolean</td>
<td>b</td>
</tr>
<tr>
<td>integer 32 table</td>
<td>nt</td>
</tr>
<tr>
<td>integer 64 variable</td>
<td>nn</td>
</tr>
<tr>
<td>integer 64 table</td>
<td>nnt</td>
</tr>
<tr>
<td>float variable</td>
<td>f</td>
</tr>
<tr>
<td>float table</td>
<td>ft</td>
</tr>
<tr>
<td>down timer</td>
<td>dt</td>
</tr>
<tr>
<td>up timer</td>
<td>ut</td>
</tr>
<tr>
<td>string variable</td>
<td>s</td>
</tr>
<tr>
<td>string table</td>
<td>st</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable type</th>
<th>Letter</th>
</tr>
</thead>
<tbody>
<tr>
<td>pointer variable</td>
<td>p</td>
</tr>
<tr>
<td>pointer table</td>
<td>pt</td>
</tr>
<tr>
<td>digital I/O unit</td>
<td>dio</td>
</tr>
<tr>
<td>mixed I/O unit</td>
<td>mio</td>
</tr>
<tr>
<td>analog input point</td>
<td>ai</td>
</tr>
<tr>
<td>analog output point</td>
<td>ao</td>
</tr>
<tr>
<td>digital input point</td>
<td>di</td>
</tr>
<tr>
<td>digital output point</td>
<td>do</td>
</tr>
<tr>
<td>chart</td>
<td>cht</td>
</tr>
<tr>
<td>communication handle</td>
<td>cmh</td>
</tr>
</tbody>
</table>
In I/O point names, you may want to indicate the point's function, the state of the device when the point is active, its location, or a schematic reference. You can abbreviate names of familiar devices and write out less familiar names. Include the information you need in the order in which it will be most useful to you:

- Heater_Switch (You have only one heater.)
- Htr6_Switch_SW23B (You have many heaters, and the schematic reference is needed.)
- Cnvyr_Speed_Encoder_BldgA (You want all conveyors to appear together.)
- BldgA_Cnvyr_Speed_Encoder (You want all points in Building A to appear together.)

**INSTRUCTION EXAMPLES**

This section includes examples of common instructions you may want to use. See Chapter 10: Programming with Commands for more information on programming with PAC Control. If you need to use math calculations, strings, or complex loops and conditions in your strategy, also see Chapter 11: Using OptoScript for examples of OptoScript. OptoScript is a procedural language within PAC Control that can make programming easier, especially if you are an experienced programmer.

**Creating Messages to Display On Screen**

You may need to create messages to display on screen, for example to give data to operators. Typically these messages consist of some specific, literal words and symbols followed by a variable value and maybe some additional literal words or symbols.

You can create the message in a single block in your PAC Control chart, like this:

1. To enter the literal text, use the command Move String. Remember to include spaces where you want them to appear, such as after the equal sign.

2. Add the variable value by converting it to a string and appending it to the string you just created.

3. If needed, append another literal string.
Alternatively, you can create the message by placing the following OptoScript code within a single OptoScript block:

```optoscript
FloatToString(Current_Temp, 5, 1, Current_Temp_String);
Current_Temp_Message = "Current temperature = " + Current_Temp_String + "F.";
```

OptoScript can be more efficient for string handling than standard PAC Control commands. See Chapter 11: Using OptoScript for more information.

**Error Handling**

Every strategy should have a way to handle errors. It's important to check values and errors that are returned from the commands in your strategy. Communication to an I/O unit, for example, will be automatically disabled if a command sends it variable values that are clearly wrong, such as a memory map address in an incorrect format.

**Counting**

Most standard digital inputs can be used as counters to count the number of times the input changes from off to on. The availability of counters depends on the brain's capabilities, and the speed of counters depends on the module.

For information on brain capabilities, see the SNAP PAC Brains Data Sheet (form 1689).
For more information on module counting speed, see the module’s specifications on the Opto 22 website, www.opto22.com. On the website, select Products > SNAP PAC System > Brains and I/O > Digital I/O.

NOTE: You can use counters on high-density modules with SNAP-PAC-R1 and SNAP-PAC-R1-B controllers, and SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware R8.1 or higher.

Before using a counter, you must configure the point as a counter. (See “Adding I/O Points” on page 124, or use PAC Manager.) Counters on Ethernet and SNAP PAC I/O units do not need to be started, and they cannot be stopped. Therefore, do not use the Start Counter and Stop Counter commands with SNAP PAC I/O units. However, you can use Get Counter and Get & Clear Counter.

Counters on mistic I/O units must first be started using the Start Counter command. In addition to Start Counter, you can use the following commands on mistic I/O units: Stop Counter, Get Counter, Get & Clear Counter, and Clear Counter.

Using a Count Variable for Repetitive Actions

A numeric variable for counting is useful when the same action needs to be repeated a specific number of times. For example, suppose your process includes filling a packing box with a dozen bags of cookies. You can use a count variable to track how many bags are dropped into the box.

Here’s part of a chart showing how you would use a count variable in this way:

If you are an experienced programmer, you’ll notice that this example is a for loop. You can use the following OptoScript code within a single OptoScript block to accomplish the same result:

```optoscript
for Bag_Count = 1 to 12 step 1 //Count 12 items dropped into box
  Bag_Dropper = 1; //Turn on bag dropper
next
```

See Chapter 11: Using OptoScript for more information on using code to streamline control structures in your strategy.
Programming Case Statements

A frequent need in programming is to create case statements, also called “switch” statements, “if/then/else” statements, or “nested if” statements. These statements create multiple decision points: if the condition is A, then X will happen; if the condition is B, then Y will happen, and so on. (This example uses regular PAC Control commands; see Chapter 11: Using OptoScript for another option that takes up less space in your flowchart.)

For example, suppose you have a conveyor with three speeds: high (3), low (2), and stopped (1). Sometimes it runs at high speed, sometimes at low speed; but before a box can be put on the conveyor, the conveyor must be stopped. And it can be stopped only from low speed, not from high speed. Here’s a portion of a chart showing the case statements that control this process:

The example above shows three cases, because there are three possible speeds and each speed demands a different action.

If you had only two possibilities (for example, if the box could also be put on the conveyor at low speed), you could handle both possibilities within one condition block. For example, you could put two Equal? commands in the same condition block, and check the Or operator, as shown at right.

Using a Timer

A timer stores elapsed time in units of seconds (with a resolution in milliseconds). Timers can range from 0.001 to 4.611686 \times 10^{15} seconds.
Timers come in two forms:
- Up timers count up from zero. They’re typically used to measure how long something takes.
- Down timers start from a value you set, and then count down to zero. They’re used to determine when an event should begin.

Here’s an example of a down timer. In this example, the process starts every 1.5 seconds.

For more information, see “Using Timers” on page 331.

Using a Flag Lock

The Flag Lock and Flag Unlock commands allow you to give a task exclusive access to one or more objects—such as tables, integers, or I/O units—until the task is complete. For example, if you want two different charts to change the values in the same table, it is important for one chart to complete its task before allowing the second chart to access the table.

To demonstrate, the following charts show how to construct two charts in a strategy so that each chart can access the same table without interference from the other chart.

Chart 1 and Chart 2 are very similar. The main difference is that one block (D) in Chart 1 adds 2 to each table element, while in Chart 2 it adds 3.
Here’s what each block accomplishes:

A—Get Table Lock. Uses the following instructions to wait until Chart 2 unlocks the flag before it locks the flag on the table. It also tracks the number of times Chart modifies the table, and it gets the length of the table. The Timeout value of -1 makes the chart wait the other chart has successfully unlocked the flag on the table. See also, “Flag Lock Timeout Values” on page 90.

Flag lock will wait until Chart 2 unlocks the flag on the table. See also, “Flag Lock Timeout Values” on page 90.

Tracks the number of times the table has been modified by Chart1

Gets the length of the table and puts it in Int_Table_Index
Using the numeric variables Modified_by_Chart1 and Modified_by_Chart2 (from Chart 2), a watch window can track the number of times the table has been modified by each chart. For details, see "Using Watch Windows for Monitoring" on page 170.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modified_by_Chart1</td>
<td>Integer</td>
<td>91</td>
</tr>
<tr>
<td>Modified_by_Chart2</td>
<td>Integer</td>
<td>49</td>
</tr>
<tr>
<td>Int_Table_Index</td>
<td>Integer</td>
<td>17</td>
</tr>
</tbody>
</table>

**B—Decrement Table Index.** The table has 100 elements, numbered from 0 to 99. This instruction block starts at element 99 and on each loop decrements by 1 to go to the next element. This continues until it reaches index 0.

**C—Index >=0.** If the index is greater or equal to zero, the chart proceeds to **D**. If the index equals -1, the chart goes to **E**.

**D—Add 2 (or 3) to Table Element.** Adds two (or three) to the value of the current table index.

**E—Release Table Lock.** This block uses a Force unlock of zero, which means it will unlock only for the chart that locked the flag. In this case, if Chart 1 locked the flag, only Chart 1 can unlock the flag.

**Flag Lock Timeout Values**

The following chart shows the effect of different Timeout values used with the Flag Lock command:

<table>
<thead>
<tr>
<th>Timeout</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>Wait until success. The application will wait (block) as long as it takes to lock the flag. Since it never gives up, the only value that can be returned is 0.</td>
</tr>
<tr>
<td>0</td>
<td>Don’t wait at all. Succeeds only if the flag is available to be locked immediately. Makes this a non-blocking call. If the flag is not already locked, a return of 0 (Success) is returned. If the flag is locked, a -17 (Already Locked) error is returned.</td>
</tr>
<tr>
<td>Value greater than 0</td>
<td>Wait maximum of value milliseconds to lock the flag. If it succeeds within the specified time, 0 is returned; otherwise, a -37 (Timeout on Lock) error is returned.</td>
</tr>
<tr>
<td>Value less than 0</td>
<td>Produces a-8 (Invalid Data) error</td>
</tr>
</tbody>
</table>

**Pointers and Indexing**

The following examples show three possible ways to control 16 fans based on setpoints.

**Without Pointers**

The first way, shown below, uses individual fan outputs and setpoint variables to determine whether to turn off or on the appropriate fan. It’s a simple way to solve the problem but takes a long time to program and
produces a large, repetitive section in the flowchart. It also consumes more control engine memory, due to
the large number of conditional and action blocks.

Each fan output (Motor01–Motor16) uses a separate temperature input (Temp01–Temp16) and a separate setpoint variable
(SP01–SP16). The flowchart cycles through them all to control the fans.
With Pointers and Indexing

The second way uses pointers and indexing to accomplish the same result in a smaller space, using less control engine memory and fewer programming steps. The fan outputs and the temperature inputs are referred to by pointers. The setpoints, instead of requiring individual variables, are simply numbers in a table.

The flowchart sets initial values for the pointers, and then cycles through the pointer tables to control the fans. (Tables have already been initialized in the Powerup chart.)
Using OptoScript

The third way also uses pointers and indexing, but places all the action in an OptoScript block. See Chapter 11: Using OptoScript for more information on using OptoScript.

OPTIMIZING THROUGHPUT

For tips on how to design your PAC Project system and program your PAC Control strategy to ensure optimum system performance see Optimizing PAC Project System Performance technical note (form 1776). For additional information, see the PAC Display User’s Guide (form 1702).
5: Working with Control Engines

INTRODUCTION

This chapter shows you how to configure and work with control engines. For the list of compatible hardware and software, see page 5.

In This Chapter

Configuring Control Engines ............................................................. page 95
Segmenting Networks In PAC Control ............................................. page 99
Creating Redundant Ethernet Links in PAC Control .................... page 100
Using Redundant Controllers .......................................................... page 104
Changing or Deleting a Control Engine ........................................ page 104
Inspecting Control Engines and the Message Queue ............... page 106
Archiving Strategies on the Control Engine ............................... page 110
Restoring Archived Strategies from the Control Engine ............ page 112
Downloading Files Using PAC Terminal ............................... page 114

CONFIGURING CONTROL ENGINES

Before you can use a control engine to run a strategy, you must first define the control engine on your PC and then associate the control engine with your PAC Control strategy.

- See “Defining a Control Engine on Your PC” below to identify the connection through which the PC and the control engine communicate. Because this process writes to the Windows Registry on your PC, you must define control engines for each computer that uses your strategy. (If your computer can boot to two operating systems, you must configure control engines for each operating system.) You can define control engines in PAC Control or in the software utility, PAC Terminal.

- See “Associating the Control Engine with Your Strategy” on page 98 to identify which defined control engine is the active control engine. Although you can associate several control engines with the same strategy if necessary, the strategy can be downloaded to only one at a time. The control engine set to receive the download is called the active engine. You must use PAC Control for associating the control engine with your strategy.

Defining a Control Engine on Your PC

You can use either PAC Terminal or PAC Control to define a control engine on your PC. Follow these steps to define a control engine using the PAC tool of your choice.

1. Start either PAC Terminal or PAC Control, and then open the Select Control Engine dialog box:
Using PAC Terminal:
- In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 10.3 > Tools > PAC Terminal 10.3.
- In Windows 10, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.3.
From PAC Terminal’s menu bar, click Configure > Control Engines. When the Select Control Engine dialog box opens, go to step 2.

Using PAC Control:

a. Start PAC Control. (For instructions, see the footnote for “Start PAC Control.” on page 8.)
b. Open a strategy in either Configure mode or Online mode.
c. From PAC Control’s menu bar, click Configure > Control Engines. The Configure Control Engines dialog box appears.

d. Click Add.
The Select Control Engine dialog box appears.

2. The Select Control Engine dialog box lists all the control engines configured on your system, whether or not they are associated with your strategy.
   - If the control engine you want appears in the list, it has already been defined on this PC, click to highlight the control engine’s name and then click OK. Then skip to “Associating the Control Engine with Your Strategy” on page 98.
   - If the control engine you want is not in the list, click Add.
The Control Engine Configuration dialog box appears.

3. Complete the fields as described in “Control Engine Configuration Dialog Box” below.
4. Click OK.

The Select Control Engines dialog box appears, displaying your new control engine in the list.

5. In the Select Control Engine dialog box, highlight the control engine you want to associate with the strategy, and then click OK. Continue with “Associating the Control Engine with Your Strategy” on page 98.

Control Engine Configuration Dialog Box

A—Control Engine Name. Enter a descriptive name for the control engine. Valid characters are letters, numbers, spaces, and most other characters except colons and square brackets. Spaces cannot be used as first or last characters.

B—System Type. Select the system type:
- Standard: A normal system not using redundant networks or redundant controllers.
• Redundant Networks (Pro only): A system that has redundant networks (also known as link redundancy). When selected, two IP address boxes are available under Settings for the primary and secondary networks. See “Creating Redundant Ethernet Links in PAC Control” on page 100 for more information.

• Redundant Controllers (Pro only): Use with a system configured with the SNAP PAC Redundancy Option. When selected, three IP address boxes are available under Settings for Controller 1, Controller 2, and Arbiter. For more information on setting up the Redundancy Option, see the SNAP PAC Redundancy Option User’s Guide (form 1831).

C—IP Address/Hostname. The IP Address/Hostname text boxes available depend on your System Type. Each IP address is entered in decimal notation (for example, 192.9.200.24).

Hostnames are supported only in standard configurations, not redundant ones. In order to use a hostname, your network must have a domain name server (DNS) and the hostname must already have been entered in your DNS either by you or someone in your IT department.

• For Standard: Enter the IP address or hostname of the control engine.

• For Redundant Networks (Pro only): Enter the Primary and Secondary IP addresses on a SNAP PAC controller: the Primary IP address is ETHERNET 1, the Secondary IP address is ETHERNET 2. Both IP addresses use the same port number. See “Creating Redundant Ethernet Links in PAC Control” on page 100 for more information.

• For Redundant Controllers (Pro only): For the SNAP PAC Redundancy Option. Enter addresses for Controller 1, Controller 2, and Arbiter. For more information on setting up the Redundancy Option, see the SNAP PAC Redundancy Option User’s Guide (form 1831).

D—Port. Enter the control engine’s IP port number. The default of 22001 is the port of the host task on the control engine; this default normally should not be changed.

E—Retries. Retries indicate the number of times PAC Control will reattempt communications with the control engine. Since retries are automatically handled by the protocol (TCP/IP), enter zero here.

F—Timeout. Enter the timeout value in milliseconds. Timeout value is the length of time PAC Control tries to establish communication through the port. If it fails, it tries again as many times as specified in D. Any positive integer is valid. For Ethernet, 3–5 seconds (3000–5000 milliseconds) is a good starting point.

Associating the Control Engine with Your Strategy

After you have defined the control engine on your PC (see page 95), it can be associated with your strategy.

1. If you are in PAC Terminal, close PAC Terminal. Open the strategy in PAC Control (Configure mode or Online mode) and from the menu bar, click Configure > Control Engines.
In the Configure Control Engines dialog box, the engine’s name appears in the list.

2. Check to make sure the correct control engine appears in the Active Engine field. If not, highlight the one you want and click Set Active.

Only one control engine can be active. If only one control engine is listed, it automatically becomes the Active Engine.

Your control engine configuration is complete. To configure I/O units and points, see Chapter 6: Working with I/O.

SEGMENTING NETWORKS IN PAC CONTROL

You can take advantage of the two independent Ethernet network interfaces on a groov EPIC processor or a SNAP PAC controller to segment the control network from the company network. Because the two network interfaces are completely independent and have separate IP addresses, they can be set up on two separate networks. Host traffic can communicate on one, while the controller communicates with the I/O units on the other. (If you need help understanding how the two Ethernet network interfaces on a SNAP PAC controller differ from the two Ethernet network interfaces on a SNAP PAC brain, see OptoNews Tip: Two Ethernet interfaces - different on PACs & brains on our website, www.opto22.com. There is a similar explanation in the groov EPIC and groov RIO user guides for their respective products.)

To segment networks, start by assigning a secondary IP address:
- to the Ethernet 2 interface on a SNAP PAC controller with PAC Manager, following instructions in the PAC Manager User’s Guide (form 1704).
- to the ETH1 interface on a groov EPIC processor with groov Manage, following instructions in the groov EPIC User’s Guide (form 2267).

Remember that this network interface must be on a completely separate network segment.

You don’t need to do anything special in PAC Control. Configure only one control engine, using the IP address of the Ethernet interface to be used for host communication. The control engine will direct communication to I/O units through the other interface, based upon the I/O unit’s IP address. The IP addresses of the I/O units must be compatible with the secondary IP address of the controller.

NOTE: PAC Display Basic and other hosts on the company network cannot communicate with I/O units when they are on a separate network. To solve this problem, you can purchase PAC Project Professional, or PAC Display Basic.
Creating Redundant Ethernet Links in PAC Control

Professional and OptoOPCServer (version R7.0 and higher) separately; these applications support network segmenting by communicating with I/O units through the controller. Also, you can add a second network interface card (NIC) and assign it an IP address compatible with the I/O unit network.

Creating Redundant Ethernet Links in PAC Control

(Pro only) Create redundant Ethernet links to provide a backup network connection in case the primary connection route becomes unavailable. If that happens, the controller switches to the secondary communication route.

There are a few ways to create redundant links in PAC Project, which you can combine:

- **Controller to I/O**: When you create a redundant link from the controller to I/O, if communication to the primary I/O unit IP address fails, communication switches automatically to the secondary I/O unit IP address, which usually is the second Ethernet network interface on a SNAP PAC R-series controller. See “Commands for Ethernet Link Redundancy” on page 309 for more information on primary and secondary I/O units.

  NOTE: If your system has redundant controllers, in order to use link redundancy from the controller to the I/O, you must connect ETHERNET 2 on the controllers and on the I/O units to the same switch. No other devices can be connected to that switch.

- **PAC Display Pro to controller**: When a PAC Display Professional project is installed on a PC with two network interface cards (NICs), the project can be configured to use the primary and secondary IP addresses to access data from the PAC Control strategy running on the control engine. One address is always active. If the primary address is unavailable, then the secondary address becomes the active address, and the PAC Display scanner automatically shifts to the secondary address. If the secondary address fails, then the primary address becomes the active address and automatically tries the primary address again. For details, see the PAC Display User’s Guide (form 1702).

  NOTE: If your system has redundant controllers, you cannot use link redundancy between PAC Display Pro and the controller. For more information on using redundant controllers, see the SNAP PAC Redundancy Option User’s Guide (form 1831).
System Architecture for Ethernet Link Redundancy

As shown in the examples below, you can set up your system in several ways to take advantage of the link redundancy capability in PAC Control. For additional information, see the SNAP PAC controllers’ user’s guides. For details on how PAC Display works with link redundancy, see the PAC Display User’s Guide (form 1702).

Using a SoftPAC Controller. In examples 1 and 2 below, the PAC S-series controller can be replaced by a SoftPAC controller. The PC running SoftPAC must have two network interface cards (NICs) configured with static primary and secondary IP addresses on different subnets.

Example 1: Ethernet Link Redundancy

In this example, the primary concern is that the Ethernet network may need maintenance or may fail, leaving the computer running PAC Display Professional, the computer running the OptoOPCServer (as the PAC Display scanner), the controller, and the I/O units unable to communicate.

The solution is to connect all these devices on two networks; if one network goes down, devices can communicate on the other. Note that each computer has two network interface cards (NICs). I/O units are controlled by the controller. Each I/O unit is connected to its own group of sensors and actuators, but all are connected to the same two networks.

If one network needs maintenance, for example to replace a switch, you can safely shut it down using the Set Target Address commands in PAC Control and options in PAC Display Professional.
Example 2: Ethernet Link, Computer, and Software Redundancy

The second example of link redundancy illustrates concern not only about the stability of the Ethernet network, but also about the computers and the software that run on them. Any of these things—the network, a computer, or the OptoOPCServer or PAC Display Professional software running on the computer—may need maintenance or may fail.

The solution here is to provide duplicate computers and software, and connect all devices on two networks. Each computer has two NICs. I/O units are all controlled by the controller. Each I/O unit is connected to its own group of sensors and actuators, but both are connected to the same two networks.

For more information on using Ethernet link redundancy with PAC Display, see the *PAC Display User’s Guide* (form 1702).
Example 3: Ethernet Link Redundancy with Serial I/O Units

This third example of link redundancy shows a SNAP PAC S-series controller with serial I/O units. The redundancy is in the Ethernet networks between the controller and computers running PAC Display Professional and OptoOPCServer. This example provides link redundancy for the Ethernet network. Again, note that the computers all have two NICs.

![Opto 22 Redundant Network Diagram]

SNAP PAC S-series controller controls all I/O units

Ethernet switch, network #1

PCs, with two NICs running OptoOPCServer (as PAC Display scanner)

Ethernet switch, network #2

PC with two NICs running PAC Display Pro

PC with two NICs running PAC Display Pro

Sensors and actuators, location #1

Sensors and actuators, location #2

Sensors and actuators, location #3
Configuring Ethernet Link Redundancy

(Pro only) Ethernet link redundancy from PAC Display Pro to a control engine is easy to configure. First, make sure the secondary IP address has been assigned to the controller in PAC Manager. Then in PAC Control, just enter both the primary and secondary IP addresses when you configure the control engine (see page 95). Once you have set up link redundancy for the control engine you are using in your PAC Control strategy, it works automatically in PAC Display.

To configure link redundancy from the control engine to I/O units, enter both the primary and secondary IP addresses when you configure the I/O unit (see “Adding an I/O Unit” on page 119).

Using Strategies with Link Redundancy

(Pro only) Although PAC Display and OptoOPCServer (as the PAC Display Pro scanner) automatically shift to the secondary address when the primary address is not available, the PAC Control debugger does not. In PAC Control, you control which address receives communication, so you know exactly how communication is occurring during debugging. To change between primary and secondary control engine addresses, follow the steps in “Changing the Control Engine that Receives the Downloaded Strategy” on page 105.

Once you have changed the address, when you enter Debug mode, you are communicating through the address you chose. Downloading the strategy to a SNAP PAC controller through one of its Ethernet interfaces replaces any strategy that was downloaded earlier through its other interface.

USING REDUNDANT CONTROLLERS

The SNAP PAC Redundancy Option allows you to configure two redundant SNAP-PAC-S controllers that use the same PAC Control strategy. By utilizing sync blocks in the strategy and persistent/redundant variables, critical data is synchronized in both controllers so that the inactive controller can take over at any time and become the active controller. To learn more about the SNAP PAC Redundancy Option and how to set up a strategy using sync blocks and persistent/redundant variables, see the SNAP PAC Redundancy Option User’s Guide (form 1831).

NOTE: If your system has redundant controllers, you cannot use link redundancy between PAC Display Pro and the controller.

CHANGING OR DELETING A CONTROL ENGINE

See the following topics to change or delete a control engine:

- “Changing a Control Engine’s Definition” (below)
- “Changing the Control Engine that Receives the Downloaded Strategy” on page 105
- “Removing a Control Engine’s Association with a Strategy” on page 105
- “Deleting a Control Engine from Your PC” on page 105

Changing a Control Engine’s Definition

Whenever necessary, you can change a control engine’s definition on your PC—its name, the port the PC uses to communicate with it, or the PC port setup (such as timeouts and retries). These changes can be made either in PAC Control or in PAC Terminal.

1. Choose one of the following:
   - In PAC Control: With the strategy open in Configure mode or Online mode, right-click the control engine name on the Strategy Tree and choose Modify from the pop-up menu.
   - In PAC Terminal: From the PAC Terminal menu bar, click Configure > Control Engine.
The Select Control Engine dialog box appears.

2. In the Select Control Engine dialog box, click the control engine you want to change and click Modify.

3. Make the necessary changes, following the same steps you would for configuring the control engine initially. (For help, see “Defining a Control Engine on Your PC” on page 95.)

Changing the Control Engine that Receives the Downloaded Strategy

You can configure several control engines for a strategy, but only one at a time can receive the downloaded strategy. The control engine that receives the strategy is called the active engine.

NOTE: In PAC Control Professional, you can also configure a control engine for Ethernet link redundancy (see “Creating Redundant Ethernet Links in PAC Control” on page 100 for more information). In this case, you can also choose whether the primary or secondary IP address will receive the strategy.

To change the control engine that receives the downloaded strategy, follow these steps:

1. Make sure the strategy is open and in Configure or Online mode.

2. On the Strategy Tree, right-click the name of the control engine you want to set as the active engine. If its name does not appear in the Strategy Tree, follow the steps in “Configuring Control Engines” on page 95.

3. From the pop-up menu, choose Set Active.

   The active engine moves to the top of the list in the Strategy Tree.

4. (Pro only) If the control engine is configured for Ethernet link redundancy, right-click the name of the control engine on the Strategy Tree again. From the pop-up menu, choose Use Primary IP Address or Use Secondary IP Address.

Removing a Control Engine’s Association with a Strategy

If you no longer want to use a control engine with a strategy, you can remove its association with the strategy. This action does not delete the control engine’s definition on your PC.

CAUTION: Do not delete the control engine from within the Select Control Engine dialog box. Doing so will delete it from the PC as well as the strategy.

1. Make sure the strategy is open in Configure mode or Online mode.

2. On the Strategy Tree, right-click the name of the control engine you want to remove. From the pop-up menu, choose Delete.

   The control engine is no longer associated with your strategy.

Deleting a Control Engine from Your PC

If you are sure that a control engine will no longer be used with your PC, you can delete it using PAC Terminal. Deleting the control engine removes its definition only on the PC you are using.

1. Start PAC Terminal:
   – In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 10.3 > Tools > PAC Terminal 10.3.
   – In Windows 10, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.3.

2. Right-click the name of the control engine in the list.

   CAUTION: Make sure you are highlighting the right one. You cannot undo a deletion.

3. From the pop-up menu, choose Delete.

   The control engine is no longer defined on the PC.
INSPECTING CONTROL ENGINES AND THE MESSAGE QUEUE

You may want to inspect or change control engines while you are running the strategy in Debug mode. See the following topics to view control engine information and the engine’s message queue, either from PAC Control in Debug mode or from PAC Terminal:

“Inspecting Control Engines in Debug Mode” (below)
“Viewing the Message Queue” on page 108
“Inspecting Control Engines from PAC Terminal” on page 110

Inspecting Control Engines in Debug Mode

With the strategy running in Debug mode, choose Control Engine > Inspect.

You can also double-click the active engine (the first one under the Control Engines folder) on the Strategy Tree, or right-click the control engine and choose Inspect from the pop-up menu.

The Inspecting dialog box opens.

Here you see data relating to the control engine. If you are using Ethernet link redundancy in PAC Control Professional, remember that the information shown is for the IP address you chose before entering Debug mode. (See “Using Strategies with Link Redundancy” on page 104 for more information.)

**A—Control Engine.** Type of device the control engine is running on and the device’s IP address.
B—Firmware Version. Version number of the firmware (kernel) loaded on the device, and the date the firmware was released.

C—Memory Available. Amount of memory (RAM) available on the control engine. For example, a SNAP R-series controller has a total of 16 MB of RAM on the control side, 2 MB of which is battery-backed. Volatile RAM shows the amount of total RAM available for use. Battery-backed RAM shows the amount available in battery-backed RAM, where persistent variables, variables initialized on download, the autorun flag, and the strategy archive are stored. File Storage RAM shows the space available in the control engine’s file system. See the PAC Manager User’s Guide (form 1704) for more information about the file system. See also the SNAP PAC Memory Usage Technical Note (form 1646).

D—Up Time. Total time that the control engine has been running since powerup.

E—Device Time. Current date and time recorded on the control engine.

F—Sync time to PC. Click to synchronize the control engine’s time and date to that of the PC running PAC Control.

G—Message Queue. Number of messages (information, warning, and error messages) encountered when attempting to run the strategy on the control engine (up to a maximum of 1000 messages). (See “Viewing the Message Queue” below.) Click to open the View Messages dialog box, listing the details of any information, warning, or error messages.

H—Active. Name of the strategy currently running on the control engine, the date and time it was downloaded, and the number of charts currently running.

I—Archive. Information about the strategy currently archived on the control engine.

J—Run/Stop. Start or stop the active strategy.

K—Store to Flash. Click to store either the active or alternate strategy to flash memory. Only one strategy at a time can be stored in flash memory. This button is enabled if there is a strategy stored in RAM, even if the strategy is currently stored in flash. See Burned in flash (N) on this dialog box.

L—Alternate. Name of the alternate strategy, and the date and time it was downloaded.

M—Switch and Run/Switch. Click Switch and Run to make the alternate strategy the active strategy and run it in the control engine. Click Switch to make the alternate strategy the active strategy without running it.

N—Stored in flash. Shows whether a strategy is currently stored in flash memory.

O—Autorun. Click to indicate whether the strategy should automatically run when the control engine is restarted. The strategy must be stored to flash to autorun. See Store to Flash (above) and “Saving a Strategy to Flash” on page 178.

P—Loop Time. Time required to gather the inspection data from the control engine (the average time taken for a single transaction).

Q—Comm Errors. Any communication errors.
Viewing the Message Queue

The message queue holds error, information, and warning messages. All may be helpful in troubleshooting. When a message is placed in the queue, a blue INFO, yellow WARNING, or red ERROR box appears in the PAC Control status bar, as shown in the following diagram.

1. Click the INFO, WARNING, or ERROR box.

2. To see all the information in the column, drag the edge of a column heading.
3. To see all of the information for one message, double-click the message.

4. To refresh the display with the latest messages, click Refresh.

5. To copy all messages in the View Messages dialog box for transfer to another program, such as Excel, click Copy All.

6. To delete the top (oldest) message on the list, click Pop Top Message.

7. To delete all messages, click Clear Messages.

8. Close the dialog box to return to the Inspect Control Engine dialog box. Any changes you have made to the queue are reflected there.

**Message Queue Information**

Each message in the View Messages dialog box includes the following information:

- **Code.** The message or error code number. For details, see “List of Common Messages” on page 385 (or see User, if the message was placed in the queue using the command Add Message to Queue).

- **Severity.** Information, Warning, or Error.

- **Chart and Block.** The chart and block being executed when the error occurred. If the error occurred outside the strategy, for example when trying to connect to an I/O unit, Chart shows <system>. If the error occurred in a subroutine, Chart shows the chart that called the subroutine, and Block indicates the name of the subroutine plus the block number in the format <sub name>.<block number>. For example, error #4 above (“Cannot divide by zero”) occurred in block 1 of the subroutine Variable_Increase_Notification, which was called by the Temperature_Control chart.

- **Line.** If you are in Full Debug mode, the line being executed when the error occurred.

- **Object.** The table, I/O unit, or other object affected by the message. In errors #1 and #2 above, the control engine was unable to communicate with I/O unit EIO_C. The unit’s IP address is shown for easy reference.

- **Time and Date.** When the error occurred.
Inspecting Control Engines from PAC Terminal

You can also inspect control engines from PAC Terminal.

1. Start PAC Terminal:
   - In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 10.3 > Tools > PAC Terminal 10.3.
   - In Windows 10, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.3.
   The PAC Terminal window appears.

2. Double-click the control engine you want to see (or right-click it and choose Status from the pop-up menu).
   The Inspect Control Engine dialog box appears. The dialog box is explained on page 106.

ARCHIVING STRATEGIES ON THE CONTROL ENGINE

Archiving strategies on the control engine provides a backup in case original strategy files on the computer are lost. When you archive a strategy to the control engine on an Opto 22 controller, a zipped file is saved in battery-backed RAM. On a SoftPAC controller, a zipped file is saved on the PC's hard drive. In either case, if power to the control engine is lost, the archive is still there.

We recommend you archive to the computer (during strategy development); you can also archive to the control engine (when the strategy is completed). Archiving to the control engine as well as the computer makes sure that an older strategy can always be found and updated, even after personnel changes occur and years pass. See also, “Archiving Strategies on the Computer” on page 179.

Archive files are date and time stamped, and zipped for compact storage. The archive file name on the control engine is in one of the following formats:

- Path\Filename.Download.D02282000.T114351.zip
- Path\Filename.Online.D02282000.T114351.zip

The date stamp (D) is in the format mm/dd/yyyy. In the examples above, the date is February 28, 2000. The time stamp (T) is in the format hh/mm/ss. In the examples above, the time is 51 seconds past 11:43 A.M.
Make sure the control engine has sufficient memory available to store the archive file. Since only one strategy at a time can be on the control engine, only the latest archive for that strategy is on the control engine. Other archives are erased during strategy download.

To archive a strategy to the control engine:

1. In PAC Control, choose File > Strategy Options.

   ![Strategy Options dialog box](image)

   2. In the Strategy Options dialog box > Archive tab, select “Archive strategy to disk when strategy is downloaded” and select “During download, save archive to the control engine and save strategy to flash memory.”

   ![Strategy Options dialog box](image)

   3. Click OK.

   The strategy will be archived to the computer and to the control engine when it is downloaded. Any archive already on the control engine will be replaced by the new archive. In addition, the strategy will be saved to flash memory, so it will still be available if power to the controller is turned off.
If original strategy files are lost or damaged, you can use PAC Terminal to restore the strategy archive from the control engine to a computer.

1. Start PAC Terminal:
   - In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 10.3 > Tools > PAC Terminal 10.3.
   - In Windows 10, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.3.
   The PAC Terminal window appears.

2. Right-click the control engine and choose Upload > Strategy Archive from the pop-up menu.

3. In the Save PAC Control Strategy Archive As dialog box, navigate to the folder where you want to save the archive file. Keep the file name as it is, so you can see the date and time it was originally downloaded to the control engine. Click Save.
   A dialog box shows progress as the archive file is uploaded to the computer.

4. Navigate to the zipped archive file. Assuming you are using WinZip, double-click the file name. Highlight all files and click Extract. Extract them to the location you want.

5. When all files are extracted, double-click the .idb file to open the strategy. If necessary, re-link subroutines and files run before or after a strategy.
   Re-linking may be necessary because the directory structure in the zip file may not match what was originally on the computer. The zip file structure is as follows:
   Root (Jdb, chart files, .inf)
   Subroutines
   Control engine files
     Control_Engine_Name_1
     Before run file
     After run file
     Control_Engine_Name_2
     …
MOVING CONTROL ENGINES FROM ONE PC TO ANOTHER

Sometimes it’s necessary to transfer a strategy to another computer, such as when the computer has to be replaced, or when another PC will be used to run the control application. Instead of typing in each control engine on the new computer, you can open the ControllerNames.ini text file and merge the control engine names from a source PC with those on a target PC.

NOTE 1: Use this procedure only if you have PAC Control version R9.4a or higher. For versions prior to R9.4a, see the OptoKnowledgeBase article KB80603 on the Opto 22 website, http://opto22.com. However, the best method is to install the newest software and use the method described here.

NOTE 2: When PAC Control version R9.4a or higher is first used, it automatically migrates the control engine definitions from older versions. If you then use an older version of PAC Control to add another control engine, the new control engine will not automatically be available in the R9.4a or higher version, because it checks the older versions of control engine definitions only the first time it is run.

To move all the control engines from a source PC to a target PC:

1. On the source PC, locate the Controller.ini file. This file can be found in the following location:
   C:\ProgramData\Opto 22\PAC Project\ControllerNames.ini

2. Send the file by email or other means so that it can be opened on the target PC.

3. On the target PC, open the ControllerNames.ini files for the source and target PCs with a text editor such as Notepad.

Source

![ControllerNames.ini - Notepad](image1)

Target

![ControllerNames.ini - Notepad](image2)
4. Copy the list of control engines from the source PC file and paste them to the end of the list of control engines in the target PC file.

Target and Source merged on target PC

5. Save the target ControllerNames.ini file on the target PC before closing it.
All of the control engines in the merged file will now be available in PAC Control.

DOWNLOADING FILES USING PAC TERMINAL

Using PAC Terminal, you can download PAC Control strategies or Forth files related to the strategy, such as library or initialization files, directly to a control engine, without having to open each program.

For information on using the brain’s file system to store data and manipulate it within your strategy, see “Managing and Accessing Files in the Control Engine’s File System” on page 275.

NOTE: If you are downloading a PAC Control strategy that requires other files, be sure to download the files in the correct order (for example, library file, then strategy file, then initialization file). If you need to set initial values for individual table elements on strategy download only, see “Setting Initial Values in Variables and Tables During Strategy Download” on page 240.

1. Start PAC Terminal:
   – In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 10.3 > Tools > PAC Terminal 10.3.
   – In Windows 10, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.3.

The PAC Terminal window appears.
2. Right-click the control engine and choose Download > Forth File from the pop-up menu.
3. In the Download File dialog box, click Browse.
4. In the Open dialog box, locate the file you want to download. When the full path appears, click OK.
   If necessary to find the file, choose All Files from the Files of Type drop-down menu.
   The download begins, and a dialog box shows its progress.
DOWNLOADING FILES USING PAC TERMINAL
6: Working with I/O

INTRODUCTION

In addition to configuring a control engine to run your strategy, you also need to configure input/output hardware to do the work: turning things on, setting temperatures, monitoring controls, and so on. This chapter shows you how to configure and work with I/O units, I/O points, and PID loops.

In This Chapter
Choosing a Configuration Tool.............................................................. page 117
Adding an I/O Unit ..................................................................................... page 119
Adding I/O Points........................................................................................ page 124
The Configure I/O Modules and Points Dialog Box ...................... page 144
Configuring PID Loops.............................................................................. page 148
Inspecting, Monitoring, and Changing I/O in Debug Mode ... page 153
Inspecting and Tuning PID Loops........................................................ page 160
Using Watch Windows for Monitoring .............................................. page 170

CHOOSING A CONFIGURATION TOOL

Configuring I/O is one of your major planning steps in developing a PAC Control strategy. Generally it’s best to configure all I/O units, channels/points, and PID loops at once, before you start building flowcharts.

- For groov I/O modules and groov RIOs, there are several tools to configure I/O; however, for PAC Control strategies, use only PAC Control.
- For SNAP PAC Controllers and I/O, you can use either PAC Control or PAC Manager.

Configuring groov I/O with PAC Control

You can configure groov I/O with PAC Control, but not with PAC Manager.

NOTE: You may have read that you can configure groov I/O with groov Manage. However, any configuration you do in groov Manage cannot be exported to PAC Control. (groov Manage doesn’t export its I/O configuration. You can use PAC Control to scan for groov I/O modules; however, it doesn’t bring in existing channel names, channel types, offset/gain configuration, and so forth.)

For more information about groov Manage, see the groov EPIC User’s Guide, form 2267.
Choosing a Configuration Tool for SNAP I/O

About E1 and E2 brain boards: You can configure E1s and E2s like any other I/O unit if you have E1/E2 firmware R1.2a (and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E2s), see I/O Configuration for E1 an E2 Brain Boards (form 1576).

For most I/O units, if you are already in PAC Control, configuration is easier there and you can use the loopback IP address for SNAP PAC R-series I/O units controlling themselves. However, some functions for I/O units cannot be configured in PAC Control.

If you use PAC Manager, you can save your configuration to a file, load it to multiple I/O units at once, and use it for referencing points in OPC. However, you cannot use the loopback address in PAC Manager.

Choose your configuration tool based on what you need to do:

<table>
<thead>
<tr>
<th>Use PAC Control for I/O configuration if</th>
<th>Use PAC Manager for SNAP I/O configuration if</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You have only one I/O unit or I/O unit configurations are different.</td>
<td>• You have multiple I/O units whose configurations are exactly the same or similar.</td>
</tr>
<tr>
<td>• The strategy will run on SNAP PAC R-series I/O units that are controlling themselves using the loopback IP address, 127.0.0.1.</td>
<td>• You are using a modem connection (PPP) or SNMP.</td>
</tr>
<tr>
<td>• You are using an Ethernet network for communications (or using a SNAP PAC controller with an SB brain).</td>
<td>• You are using event messages or email.</td>
</tr>
<tr>
<td>• The strategy handles all logic; you are not also configuring events and reactions on I/O units.</td>
<td>• You are configuring events and reactions on the I/O unit in addition to strategy logic.</td>
</tr>
<tr>
<td>• You are not using PAC Control.</td>
<td>• You are not using PAC Control.</td>
</tr>
</tbody>
</table>

Whichever tool you use for configuring I/O, be aware of the impact if you later change configuration. For example, if you configure I/O in PAC Manager, download the configuration file to I/O units, and then later add a point in PAC Control, remember that your configuration file doesn’t contain that point.

If you use PAC Manager, follow instructions in the PAC Manager User’s Guide (form 1704). When you have finished configuration and saved the configuration file, you can import it into PAC Control following the steps in “Importing PAC Manager I/O Configuration into PAC Control” below.

If you use PAC Control, follow the steps beginning with *Adding an I/O Unit* on page 119.

Importing PAC Manager I/O Configuration into PAC Control

If you have configured all I/O units, points, and PID loops in PAC Manager, follow these steps to import the configuration file into a PAC Control strategy.

1. Open the strategy in PAC Control. In the Strategy Tree, right-click the folder named “I/O Units,” and from the pop-up menu, choose Import.
2. Navigate to the configuration file you created and saved in PAC Manager. Double-click it to open it.
   The configuration information is imported. You can expand the I/O Units folder to see the imported units and their points.

   If you need to configure additional I/O units from within PAC Control, see *Adding an I/O Unit* on page 119. To tune PID loops, see "Inspecting and Tuning PID Loops" on page 160.

Copying SNAP I/O Configurations

*Note: These instructions apply only Ethernet-based I/O units. Remember, you cannot use PAC Manager for groov RIO, groov EPIC, or serial-based I/O units.*
If you have two strategies that use similar I/O units and points, you can export an I/O configuration from one strategy into a file, and then import it into the other strategy.

If you need similar configurations for several I/O units, you can use PAC Manager to send it to multiple I/O units at once. For more information about PAC Manager, see the PAC Manager User’s Guide (form 1704).

Creating the Configuration Export File

1. Open the strategy you are copying from in PAC Control. In the Strategy Tree, right-click the folder named “I/O Units” (not the icon representing a specific I/O unit), and then choose Export from the pop-up menu. The Export I/O Units to an Opto Tag Database dialog box appears.
2. Navigate to the location where you want to place the export file. Type the file name, and click Save. The export file is created. It is a comma-delimited ASCII file and its file extension is .otg. Because it is an ASCII file, you can open it in applications like Notepad and Excel.

Importing the Configuration File

When you import the I/O configuration file, it does not delete any I/O units or points that are already there. If the import file contains I/O units with the same names as those already in the strategy, you can choose whether to update them. Updating changes points that have the same name and adds new points, but does not delete points.

1. Open the strategy into which you want to import the I/O configuration.
2. In the Strategy Tree, right-click I/O Units and then choose Import from the pop-up menu.
3. Navigate to the location of the export file you created. Highlight its name and click Open. The I/O units and points are updated from the configuration file. To see them, click the plus sign next to the I/O Units folder on the Strategy Tree.

ADDING AN I/O UNIT

In PAC Control, the term I/O unit usually refers to:
- a chassis or rack with an I/O processor (a processor, controller, brain, or brain board mounted on the chassis or rack) and up to 16 I/O modules attached.
- a groov RIO device

Some important things to consider before you start:
- If you already configured groov I/O modules or groov RIOs in groov Manage, those configurations will be overwritten by any configurations you set in PAC Control. For an explanation, see “Configuring groov I/O with PAC Control” on page 117.
- If you already configured SNAP I/O in PAC Manager, you can still add I/O units and points from within PAC Control.
- If you need to enable legacy I/O units in PAC Control for a specific strategy, review the information in “Legacy Options” on page 208 before continuing.

To add an I/O unit:
1. Make sure the strategy is open and in Configure mode. On the Strategy Tree, double-click the I/O Units folder. (You can also select Configure > I/O from the menu bar.)
PAC Control displays the Configure I/O Units dialog box, showing all configured I/O units.

You configure most of the data in these columns when you add or modify an I/O unit.

The Ref Count (Reference Count) is a field that you don’t configure. It represents the number of I/O points configured on the I/O unit plus the number of times the I/O unit is referenced in the strategy.

2. To configure a new I/O unit, click Add or double-click anywhere in the box below any listed units. PAC Control displays the Add I/O Unit dialog box.

3. Complete the fields as described in “Add I/O Unit Dialog Box”.

4. Click OK. PAC Control creates a folder under the I/O Units folder in the Strategy Tree.
   
   **groov I/O unit only**—When you click OK, PAC Control prompts you to automatically add groov I/O modules and channels. For an explanation on how this works and what you need to do, see “Automatically Adding groov I/O Modules and Channels” on page 124.

Add I/O Unit Dialog Box

Use this dialog box to add a new I/O unit to the strategy or edit an existing unit.

For details on saving the I/O Unit Configuration, see “Inspecting I/O Units” on page 154.
A—Name. Enter a name for the I/O unit. The name must start with a letter and may contain letters, numbers, and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the unit.

C—Type. When adding an I/O unit, select the type of I/O unit from the drop-down list. When upgrading an older I/O unit to a SNAP PAC device, applicable upgrades are shown in the drop-down list. (You cannot upgrade older I/O units to a groov I/O unit or groov RIO unit.)

D—Primary Address. For Ethernet I/O units, type the IP address or hostname of the groov RIO unit, processor, controller, or brain attached to the I/O unit. If the unit is local (for example, the same SNAP PAC brain on which the strategy will run), select Local (loopback). This sets the address to a loopback address, 127.0.0.1. This tells the unit to talk to itself, so if you change the unit’s IP address or hostname, you don’t have to change the address for the I/O unit.

For serial units, type the unit’s address (valid range is 0–255).

E—Secondary Address. (Optional; Pro only; Ethernet-based I/O units only, except groov RIO units) To designate a secondary I/O unit for communication if this I/O unit is unavailable, enter the secondary unit’s IP address or hostname. Note that both I/O units use the same port number.

F—Port. For Ethernet-based I/O units, communication with the control engine is Ethernet, and the default port number is 2001. If you have changed this port for security purposes, also change it here. (See the controller’s user guide for details.)

For serial-based I/O units, the communication port and parameters are shown for you. binary/CRC settings on your hardware are required. For more information, see “Changing the Baud Rate for SNAP Serial I/O Units”.

G—Enable Communications. Select whether you want communication to the I/O unit enabled or disabled on startup. Enabled is the default. Disabling communication to an I/O unit is the same as disabling communication to all points on the unit.

H—Timeout. Enter the number of times the control engine should try to communicate with the I/O unit, and enter the length of time the control engine should wait for a response when communicating with this I/O unit. If after the first communication attempt there is no response within the timeout period, the control engine retransmits. If there is no response within the timeout period, it transmits again. This repeats according to the number of tries specified. If no response is received within the final timeout period, communication to the I/O unit is disabled. The default number of tries is 3. The default timeout period is 1 second.

In most cases, it is a good idea to start with the default values and only make changes if your system has problems using the defaults.

CAUTION: If the timeout is long and the I/O unit is turned off or unreachable, the control engine could take quite a while to execute a command that talks to I/O. See also, “Tuning the I/O Unit Timeout Value for SNAP Ethernet I/O Units” on page 123.

I—Fahrenheit/Celsius. (Analog and Mixed units only) Choose whether temperatures will be handled in Fahrenheit or Celsius.

J—Watchdog. Select whether you want a Watchdog on the unit (not available on remote simple I/O units). The default is No (disabled). If you select Yes, a new field appears; enter the Watchdog timeout value (in seconds). The default timeout is 0.5 seconds.

With a Watchdog, the I/O unit monitors activity on the port. If no communication is received for the specified interval, the unit assumes a Watchdog state. All selected outputs will then immediately go to a specified value, as configured in the Watchdog field of the Add Analog Point or Add Digital Point dialog boxes. (See “Manually Adding groov I/O Modules & Channels or SNAP I/O Modules & Points” on page 126.)
Adding an I/O Unit

Changing the Baud Rate for SNAP Serial I/O Units

NOTE: This section is for PAC Control Basic users. If you have the Pro version, see “Changing the Baud Rate and Mode for SNAP Serial I/O Units” on page 122.

If the default baud rate shown in the Add I/O Unit dialog box is not correct, you can change it. This baud rate is for communication through the RS-485 port to serial I/O units. It does not affect other serial ports on the controller or communication handles using these ports.

NOTE: Once you have configured a serial port for use with an I/O unit, do not configure a communication handle on the same port.

1. Make sure the strategy is open and in Configure mode.
2. Choose File > Strategy Options, then click the Serial I/O Ports tab.

![Strategy Options]

3. Select the correct port for the controller. Choose the correct baud rate from the drop-down list, and then click OK.

NOTE: If you are configuring a SNAP-PAC-S1 controller you must use port 2. If you are using a SNAP-PAC-S2, see the PAC Manager User’s Guide (form 1704), for the default serial port assignments or to change a serial port assignment.

Changing the Baud Rate and Mode for SNAP Serial I/O Units

This section is for PAC Control Professional users. If you have the Basic version, see “Changing the Baud Rate for SNAP Serial I/O Units” on page 122.

NOTE: Once you have configured a serial port for use with an I/O unit, do not configure a communication handle on the same port.

If the default baud rate shown in the Add I/O Unit dialog box is not correct, you can change it. This baud rate is for communication through the RS-485 port to serial I/O units. It does not affect other serial ports on the controller or communication handles using these ports.

In addition you can also choose Binary or ASCII mode. The controller will talk to all I/O units on that port in the same mode.

NOTE: There is no ASCII version of OptoMMP protocol (which is used on SNAP PAC SB brains), so if a port is set to ASCII, you won’t be able to mix mistic and SNAP PAC SB brains as you can in Binary mode.
1. Make sure the strategy is open and in Configure mode.
2. Choose File > Strategy Options, then click the Serial I/O Ports tab.

![Strategy Options dialog box]

3. Select the correct ports for the controller, and then choose the correct baud rate and mode from the drop-down lists and click OK.

   If you are configuring a SNAP-PAC-S1 controller, you must use port 2 for serial I/O units. If you are using a SNAP-PAC-S2, see the PAC Manager User's Guide (form 1704), for the default serial port assignments or to change a serial port assignment.

   In addition, make sure to jumper the non-SNAP PAC brain for the correct setting, either Binary CRC (cyclic redundancy check) or ASCII CRC. Although at the brain level you can choose Binary/ASCII and CRC/Checksum independently, the Opto 22 drivers support only binary CRC or ASCII CRC.

   ASCII CRC is only for mistic brains. If a port is set for ASCII but has a SNAP-PAC-SB1/2 on it, the compiler will generate a warning.

**Tuning the I/O Unit Timeout Value for SNAP Ethernet I/O Units**

*NOTE: This section applies to SNAP Ethernet I/O only. groov I/O modules constantly monitor quality. For details, see the groov EPIC User's Guide, form 2267.*

The default I/O Unit timeout value is 1 second. However, for best overall performance you can tune the value for your system.

A SNAP PAC controller automatically retries 2 times before disabling communication to an I/O unit that is unresponsive, and it uses the same timeout value for the first attempt and the 2 retries. So, with a 1 second timeout value and 2 retries, it takes 3 seconds before an unresponsive unit is taken offline. This means the chart or command that is trying to read or write to that I/O unit will be delayed by 3 seconds.

When using SNAP PAC Ethernet brains (SNAP-PAC-R1, SNAP-PAC-R1-B, SNAP-PAC-R2, SNAP-PAC-EB1, or SNAP-PAC-EB2) on a wired LAN (local area network), a timeout value of 0.1 seconds may be fine. When using a WAN (wide area network), a wireless network, the Internet, or you are not sure what the networking technology is, it may be best to use the default value of 1 second. However, if the controller’s message queue shows loss of communication with Ethernet I/O units, it may be necessary to increase the timeout value.

**For Advanced Users:**

If you are an advanced user with a lot of Ethernet experience, you may want to determine normal response times from a brain using an Ethernet capture utility such as Wireshark® ([www.wireshark.org](http://www.wireshark.org)). Look for the fastest response time, the *normal* or typical response time, and the longest response time.
Adjust the timeout value to be larger than the maximum observed response time. It is best not to use a timeout value that is too short because this will cause unnecessary communication retries and timeouts. We recommend making the timeout be at least 50% to 100% longer than the maximum observed response time. In addition, we recommend not using a timeout value that is less than 0.1 seconds. For example, if the value is 0.1 seconds, then communication to an unresponsive I/O unit will be disabled within 0.3 seconds. If the network connectivity is very slow, you may need to use a significantly longer timeout value such as 3 to 5 seconds or longer.

**Changing Configured I/O Units**

1. To change a configured I/O unit, make sure the strategy is open and in Configure mode.
2. Find the I/O unit’s name on the Strategy Tree. Double-click it to open the Edit I/O Unit dialog box. See “Add I/O Unit Dialog Box” on page 120.
3. Make the necessary changes and click OK.

You can also change an I/O unit from the Configure I/O Units dialog box by double-clicking the unit’s name or highlighting it and clicking Modify.

**Deleting Configured I/O Units**

*CAUTION: Be careful when deleting I/O units. You cannot undo a deletion.*

You cannot delete an I/O unit that has I/O points configured, or if it is referenced in a PAC Control command.

1. To delete a configured I/O unit, make sure the strategy is open and in Configure mode.
2. Find the I/O unit’s name on the Strategy Tree. Right-click it and choose Delete from the pop-up menu.

The I/O unit is deleted from the strategy.

You can also delete an I/O unit from the Configure I/O Units dialog box by highlighting the unit’s name and clicking Delete.

**ADDING I/O POINTS**

After you add an I/O unit, you can then add its I/O modules and points (or channels, as they are called in groov I/O modules and groov RIO units). There are two ways to do this in PAC Control: manually or (for groov I/O modules only) automatically.

**Making I/O Values Publicly Accessible**

You can make the value of an I/O point or channel publicly accessible to third-party applications like Inductive Automation’s® Ignition® SCADA software. The default setting is not to allow public access.

- When you add an I/O point or channel manually, enable the Make Public (Readable) checkbox.
- If you instruct PAC Control to automatically add groov I/O channels to your strategy, you will need to manually edit the channels to grant public access.

For instructions on manually editing the points or channels, see “Add/Edit Digital Point Dialog Box” on page 129 and “Add/Edit Analog Point Dialog Box” on page 133.

**Automatically Adding groov I/O Modules and Channels**

To manually add groov I/O modules and channels or to edit the channels after automatically adding them, see “Manually Adding groov I/O Modules & Channels or SNAP I/O Modules & Points” on page 126.
When a groov I/O unit and the computer running PAC Control are on the same network (and their IP addresses and subnet masks are compatible), PAC Control can automatically detect and add groov I/O modules and channels to a strategy. If you use the Add I/O Unit dialog box to add a groov I/O unit, when you click OK, PAC Control prompts you:

A—**Automatically detect and add modules.** Click the checkbox to instruct PAC Control to automatically add the I/O modules.

B—**Automatically create channels.** Click the checkbox to instruct PAC Control to also create the channels.

C—**Name Format.** Use the "Name format" text field to create a format for the point names. Enter any combination of text and the following format codes:

- %1—Point type (for example, ai or do).
- %2—I/O unit name.
- %3—Module position.
- %4—Channel position.
- %5—A unique identifier that is generated automatically

*Example:* %1_%2_%3%4 would expand to something like di_MyIoUnit_0801.
*Example:* %1ABC_%5 would expand to something like aoABC_473

Click Format information (D) to view the syntax help.

PAC Control remembers the options you select and displays them the next time you configure another groov I/O unit.

When you finish making changes, click one of the buttons:

**Yes.** PAC Control displays a confirmation message when it finishes scanning the chassis, identifying the modules, and adding them and their channels to the I/O unit.

In this example, PAC Control identified 7 modules, with a combined total of 100 channels.
No. The I/O unit is added to the strategy but modules and channels aren’t automatically created. You can manually configure them by following the steps in “Manually Adding groov I/O Modules & Channels or SNAP I/O Modules & Points” on page 126.

Cancel. The dialog box closes, but the Add I/O Unit dialog box remains open for you to make changes.

NOTE: To make automatically-created channels publicly accessible to third-party systems, you must manually edit their Public Access setting. For details, see the Public Access setting in “Add/Edit Digital Point Dialog Box” on page 129 and “Add/Edit Analog Point Dialog Box” on page 133.

Manually Adding groov I/O Modules & Channels or SNAP I/O Modules & Points

Before you add an individual I/O point or channel, such as a sensor or a switch, you must add the I/O unit the point is on. See “Adding an I/O Unit” on page 119.

- If you are working with groov I/O modules, you can automatically add channels at the same time you are adding the module by following the directions in “Automatically Adding groov I/O Modules and Channels” on page 124.
- To add a “placeholder” for a SNAP serial communication module, see “Configuring a SNAP Serial Module” on page 140.

Adding a Digital I/O Point

NOTE: If you need to add several similar points, you can save some time by following the directions in “Copying a Configured I/O Point” on page 146 after you have added the first point.

1. With the strategy open and in Configure mode, double-click the I/O Units folder (not the individual unit’s icon) on the Strategy Tree.
   The Configure I/O Units dialog box appears.

   ![Configure I/O Units](image)

2. Highlight the I/O unit the points are on, and click I/O Modules and Points.
   The Configure I/O Modules and Points dialog box appears. (See also “The Configure I/O Modules and Points Dialog Box” on page 144.)
   - If you are using G1 or G4 single-point modules (for example with a G4EB2 or E1 brain), double-click the point you want to use. Skip to step 9.

   ![Configure I/O Modules and Points](image)
If you are using groov I/O or SNAP I/O modules, notice the module icons in the dialog box. (The following example shows a SNAP PAC I/O unit, so both digital and analog modules can be configured on the same rack.)

3. Highlight the number that represents the module’s position on the rack, then click Add. A list of available modules appears.

4. Choose the module type and then the exact module from the lists.

5. To add points automatically, select “Automatically create points within the new module.”
Use the “Name format” text field to create a format for the point names. Enter any combination of text and the following format codes:

- %1—Point type (for example, ai or do).
- %2—I/O unit name.
- %3—Module position.
- %4—Channel position.
- %5—A unique identifier that is generated automatically

*Example:* %1_%2_%3%4 would expand to something like di_MyIoUnit_0801.
*Example:* %1ABC_%5 would expand to something like aoABC_473

6. Click OK.

7. In the Configure I/O Modules and Points dialog box, click the plus sign next to the new module to expand it.

   Notice that the module icon is color-coded to reflect the type of module being configured: white for digital DC input, red for digital DC output, yellow for digital AC input, and black for digital AC output.

8. Highlight the point you want to configure and click Add.

9. Complete the fields as described in “Add/Edit Digital Point Dialog Box” below.

10. When you have completed the fields, click OK. The new point appears in the list.
Here is an example of how it might look on a SNAP I/O unit:

![Configuring I/O Points]

**Add/Edit Digital Point Dialog Box**

*NOTE: The fields are the same in the Add Digital Point and Edit Digital Point dialog boxes.*

**A—Name.** Enter a name for the point. The name must start with a letter and may contain letters, numbers, and underscores. (Spaces are converted to underscores.)

**B—Description.** (Optional) Enter a description of the point.

**C—Type/Module.** For non-SNAP I/O units, choose the module type and the exact module from the drop-down lists. For a G4EB2, all 32 digital points are addressed as a single I/O unit; if you are using the G4EB2 with Quad Pak modules, make sure you configure each group of four points as either all inputs or all outputs. For SNAP I/O units, Type and module are already filled in for you, as shown in the example above.
**D—Features.** To use a feature of the module, choose it from the drop-down list. You can configure some input modules with a counter, totalizer, or other feature. (Inputs automatically have both on-latches and off-latches.)

**E—Default.** To set a default state for the point when the strategy is run, click Yes and choose the state (Off or On). To leave the point in the state it was before, click No.

**F—Watchdog.** (Output modules only) To set a Watchdog, click Yes and choose On or Off from the drop-down list.

**G—Enable Communication.** Select whether you want communication to this I/O point enabled or disabled on startup. Enabled is the default.

**H—Enable Quality Indicator.** (Available on some groov I/O channels only) Select this option to display the channel’s data quality in applicable PAC Control dialog boxes. By default, this option is enabled. groov I/O modules that report quality continuously poll their channels for current data values and identify deviations between reported and expected values. For more information and a list of applicable groov I/O modules, see “I/O Quality Commands” on page 307.

**I—Public Access (Optional).** Select Make Public (Readable) to allow the point to be read by certain third-party applications. To allow these applications to write to the point, select Allow Write Capability. By default, public access is disabled. For details, see “Public Access” on page 239.

Adding an Analog I/O Point

1. Make sure the strategy is open and in Configure mode. In the Strategy Tree, double-click the folder named “I/O Units” (not the icon representing a specific I/O unit).

2. In the Configure I/O Units dialog box, highlight the I/O unit the points are on, and click I/O Points. The Configure I/O Modules and Points dialog box appears.

   – *(Pro only)* If you are using a non-SNAP I/O unit *(not including the B3000 or B3000-B)*, double-click the channel you want to use. Skip to step 6.

   – If you are using a SNAP I/O unit *(including the B3000 or B3000-B)*, notice the module icons in the Configure I/O Modules and Points dialog box.

3. Highlight the number of the analog module’s position on the rack, then click Add.

*NOTE: In this example, a digital module has already been added in position zero. This example shows a SNAP PAC I/O unit, so both digital and analog modules can be configured on the same rack.*
4. Choose the module type (Analog Input or Analog Output).

5. To add points automatically, select “Automatically create points within the new module.”

Use the “Name format” text field to create a format for the point names. Enter any combination of text and the following format codes:

- %1—Point type (for example, ai or do).
- %2—I/O unit name.
- %3—Module position.
- %4—Channel position.
- %5—A unique identifier that is generated automatically

Example: %1_%2_%3%4 would expand to something like di_MyIoUnit_0801.
Example: %1ABC_%5 would expand to something like aoABC_473
6. In the Configure I/O Modules and Points dialog box, click the plus sign next to the new module to expand it. Notice that the module icon is color-coded to reflect the type of module being configured: blue for analog input, green for analog output.

7. Highlight the point you want to configure and click Add.
8. Complete the fields as described in “Add/Edit Analog Point Dialog Box” below.
9. When you have completed the fields, click OK.
   The new point is added.

   NOTE: If you need to add several similar points, see “Copying a Configured I/O Point” on page 146.
Add/Edit Analog Point Dialog Box

NOTE: The fields are the same in the Add Analog Point and Edit Analog Point dialog boxes.

A—Name. Enter a name for the point. The name must start with a letter and may contain letters, numbers, and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the point.

C—Type/Module. For non-SNAP I/O units, choose the module type and the exact module from the drop-down lists.

For SNAP I/O units: Type and module are already filled in for you. You may be able to choose a different range from the drop-down list.

D—Full Range. Full range and units for this module.
E—**Clamping.** (Outputs only—optional) To limit output to the device attached to the point, enter and upper and lower clamp value. (If these fields are left blank, no clamp is applied.) To delete clamp values, click Clear.

F—**Scaling.** (You won’t see Scaling if you selected a groov module with thermistor range). Assign custom units and values to the module. For example, you could scale the readings of a -10 to +10 VDC input point to measure its input as zero liters per second when the real-world reading is zero VDC, and 1000 liters per second when the real-world reading is 5 VDC.

This example would look like this:

![Add Analog Point](image)

In this example, units are changed to liters/second and lower and upper values are changed. Although the module has an output of -10 to +10 volts, the device attached to the point outputs only 0–5 volts. Scaling reflects the device’s range.

In this case Clamping protects the device by ensuring that out-of-range voltage will never be sent to it.

Custom scaled values are floating point values.

- **Analog input points:** Analog inputs typically have under-range and over-range capability, which means you want to take the under-range and over-range values into account when you specify the scaling values. For example, for a GRV-IMAI-8 module, if you select 4 to 20 mA as the input range, the specification table indicates that it has an under-range limit of 1.8 mA and an over-range limit of 22 mA. That means that the module could read a value as low as 1.8 mA; anything below that would be flagged as under-range. Check the specification table for your selected module to determine if there are under-range and over-range capabilities.

  Also note that with firmware R8.0a and higher, you can use regular or inverted scaling. Inverted scaling means the lower value is greater than the upper value; inverted scaling can accommodate a sensor, for example, that is wired to the SNAP module in a way that produces a negative current or voltage.

- **Analog output points:** Analog outputs do not have under-range or over-range capability. Also, you cannot use inverted scaling. The upper value must be greater than the lower value.

Thermocouple values are not linear and cannot be scaled.

To return the units and upper/lower values to the defaults for the module, click Default.

F—**Steinhart-Hart Coefficients.** (You will see this only if you selected a groov module with thermistor range). If you selected one of the thermistor ranges with specific curve values, the fields display the value for each coefficient and you can’t edit those values. If you selected the thermistor range with a custom curve, enter each of the coefficient values.

G—**Send Value (Filter Weight).** (Inputs only—optional) To set the average filter weight for an analog input point, check this box and enter the value. A filter weight smooths analog input signals that are erratic or
change suddenly. The formula used for filtering is \( Y = \frac{X - Y}{W} + Y \), where \( Y \) is the filtered value, \( X \) is the new unfiltered value, and \( W \) is the filter weight. The larger the filter weight you enter, the smoother the analog signal. Filtering is applied to values in engineering units, including minimum and maximum values. It does not apply to values in counts.

H—Send Values (Offset and Gain). (Inputs only—optional) To set offset and gain for the analog input point, check this box and enter values. If you don’t know what values to enter, you can use PAC Manager to calibrate offset and gain for the point. For details, see the PAC Manager User’s Guide (form 1704).

I—Default. To set the initial state of the controller’s interval value (IVAL) for this I/O point when the strategy is run, click Yes and define the value. To leave the IVL at its last state, click No.

If communication to the point is disabled, only the internal values (IVALs) are accessed or updated by the control engine. The real-world external values (XVALs) for inputs don’t change because they are controlled by external devices. The IVLs for inputs are set and will be overwritten by the XVALs unless communication to the I/O unit or point is disabled.

The default (value) is available for both inputs and outputs. It sets the IVL for the point in the strategy in the controller when the strategy is run. This can be useful when the I/O unit is not accessible or communication to the I/O unit is intentionally disabled when the strategy first starts. When communication to an I/O unit is disabled, any I/O-related commands in the strategy will act only on the I/O point IVLs because the controller is not able to access the XVALs at the I/O unit when communication to that I/O unit is disabled.

Once communication to the I/O unit is enabled and the I/O unit is accessible, then the first command to access that point will update the IVL. For example, if you use the Move command to write a different value to an output, both the IVL and XVAL are updated with the new value. If you use a Move command to read an input, the XVAL is moved to the IVL as part of reading the input point.

J—Watchdog. (Outputs only) To set a Watchdog on this point, click Yes, and define the value to be assigned to the output if the Watchdog is triggered. A Watchdog is triggered if no communication activity is detected on the bus for the amount of time specified in the Watchdog field of this point’s I/O unit. For no Watchdog, click No.

K—Enable. Select whether you want communication to this I/O point enabled or disabled on startup. Enabled is the default.

L—Enable Quality Indicator. (Available on some groov I/O channels only) This option allows the channel’s data quality to be displayed in applicable PAC Control dialog boxes. By default, this option is enabled. groov I/O modules that report quality continuously poll their channels for current data values and identify deviations between reported and expected values. For more information and a list of applicable groov I/O modules, see “I/O Quality Commands” on page 307.

M—Public Access (Optional). Select Make Public (Readable) to allow the point to be read by certain third-party applications. To allow these applications to write to the point, select Allow Write Capability. By default, public access is disabled. For details, see “Public Access” on page 239.

Manually Adding groov RIO Channels

Before you add an individual groov RIO channel, you must add the groov RIO unit as an I/O unit. See “Adding an I/O Unit” on page 119.
Adding a Digital or Analog I/O Channel

1. With the strategy open and in Configure mode, double-click the I/O Units folder (not the individual unit’s icon) on the Strategy Tree. PAC Control displays the Configure I/O Units dialog box.

   ![Configure I/O Units dialog box](image1)

2. Highlight the groov RIO unit the channels are on, and click I/O Modules and Points. PAC Control displays the Configure RIO Channels dialog box.

   ![Configure RIO Channels dialog box](image2)

3. To add a digital or analog channel, click Unconfigured next to the channel number. PAC Control displays a drop-down list with all the available functions and signal types. The following example shows the functions and signal types available for channel 0 on GRV-R7-MM1001-10.

   ![Configure RIO Channels dialog box with functions list](image3)
The first two characters indicate the function (DI indicates digital input, DO indicates digital output, AI indicates analog input, AO indicates analog output). The text after the colon describes the signal type.

4. Select the function and signal type. PAC Control fills in the Ref Count and Details column with default values.

5. Click Details to review and change default values for the signal type. For example:
   - If you selected AI: ± 150 mV, you may want to change the default scaling.
   - If you selected a signal type that supports quality indication, you may want to disable Enable Quality Indicator.
   - If you want to make the channel public, you can enable Make Public (Readable).

6. Repeat steps 3 through 5 for each additional I/O channel you want to add. If you are done, Click OK.

Configure RIO Channels Dialog Box

Because channels on a groov RIO can be configured as an input or an output, as well as different signal types, the dialog box looks and behaves different from the other point/channel configuration dialog boxes.

A—Channel Number. Refers to the channel number assigned to the RIO unit. You cannot change this number.

B—Channel Type. A drop-down list that shows you which function and signal type you can assign to this channel. Each groov RIO offers a different set of signal types, so what's available on this list depends on the model you selected. After you select a function and signal type, PAC Control fills in the Ref Count and Details column with more information about the signal type.

C—Name. Enter a name for the channel. The name must start with a letter and may contain letters, numbers, and underscores. (Spaces are converted to underscores.)

D—Ref Count. The Ref Count (Reference Count) represents the number of I/O channels configured on the I/O unit plus the number of times the I/O unit is referenced in the strategy. You can’t change this number.

E—Details. Shows more information about the signal type you selected. When you first select a signal type, PAC Control fills this field with default values for any features available for the signal type. You can change these values by clicking on the box, which opens the corresponding editing dialog box:
   - “Add/Edit Digital Point Dialog Box” on page 129
   - “Add/Edit Analog Point Dialog Box” on page 133
Manually Adding a groov Serial Communications Channel

A groov communications channel is an I/O channel that connects to a groov serial module, like GRV-CSERI-4.

1. With the strategy open and in Configure mode, double-click the I/O Units folder (not the individual unit’s icon) on the Strategy Tree. PAC Control displays the Configure I/O Units dialog box.

2. Highlight the I/O unit that contains the serial communications module, and click I/O Points. PAC Control displays the Configure I/O Modules and Points dialog box. (For a description of the Configure I/O Modules and Points dialog box, see “The Configure I/O Modules and Points Dialog Box” on page 144.)

   NOTE: groov serial modules can be added only to the first four slots (00, 01, 02, or 03).
3. Highlight the number that represents the module's position on the rack, then click Add. PAC Control displays the Add Module dialog box.

4. For Type, click Communication. The GRV-CSERI-4 serial module is already highlighted.

5. Click OK.

6. In the Configure I/O Modules and Points dialog box, click the plus sign next to the new module to expand it.
7. Highlight the channel you want to configure and click Add. PAC Control displays the Add Serial Channel dialog box. Complete the fields as described below.

A-Name. Enter a name for the channel. The name must start with a letter and may contain letters, numbers, and underscores (Spaces are converted to underscores.)

B-Description. (Optional) Enter a description of the point.

C-Type. Select the configuration you want.

8. Click OK. The new channel appears in the list.
Here is an example of how it might look on a groov I/O unit:

Configuring a SNAP Serial Module

Use PAC Manager to configure SNAP serial communication modules (part numbers starting with “SNAP-SCM”), including the SNAP-SCM-PROFIBUS-DP and SNAP-SCM-CAN2B modules. For more information, see the PAC Manager User’s Guide (form 1704).

However, you can configure “placeholders” for SNAP serial modules in an I/O unit so that you can more easily identify their location in a rack.
To configure a placeholder for a SNAP serial module:

1. With the strategy open and in Configure mode, double-click the I/O Units folder (not the individual unit’s icon) on the Strategy Tree. PAC Control displays the Configure I/O Units dialog box.

2. Highlight the I/O unit that contains the serial communications module, and click I/O Points. PAC Control displays the Configure I/O Modules and Points dialog box. Notice the module icons in the dialog box.

3. Highlight the number that represents the module’s position on the rack, then click Add. A list of available modules appears.
4. For Type, click Communication. The SNAP-SCM-232 serial module is already highlighted.

![Add Module Dialog]

5. Select the module to configure, and then click OK. The Configure I/O Modules and Points dialog box is displayed.

![Configure I/O Modules and Points Dialog]

6. Click Close to save the configuration and close the dialog box. The new module appears in the list.

**Changing SNAP I/O Unit and Point Configuration**

If you want to upgrade your current SNAP PAC brain or controller to a different model, you can change configured I/O units and points as follows:

- If you replace a SNAP brain or rack-mounted controller, you can often change the entire I/O unit at once. This feature does not apply to serial B3000 or B3000-B brains. See the list of allowed replacements in “Replace a SNAP Brain or Rack-mounted Controller” on page 143.
- You can move a SNAP I/O point or an entire SNAP I/O module to a different position on the same or a different SNAP I/O unit. See “Moving a Configured I/O Module or Point” on page 145.
- You can fill in empty points on a SNAP I/O module or a SNAP I/O unit, or copy a point to another position. See “Copying a Configured I/O Point” on page 146.
- You can also change a SNAP point you’ve configured (page 148) or delete it (page 148).
Replace a SNAP Brain or Rack-mounted Controller

In most cases you can change the entire I/O unit type when you replace any of the following brains or rack-mounted controllers as shown in the table below, and you won’t need to reconfigure existing I/O points.

However, if you’re replacing an R1 or EB1 with an R2 or EB2, and any points on the I/O unit have the digital features Counter, On Pulse, Off Pulse, Frequency, or Period, you’ll need to change those I/O points. You’ll see a warning about this when you try to change the I/O unit type.

<table>
<thead>
<tr>
<th>Old I/O unit type</th>
<th>New I/O unit type</th>
<th>Old I/O unit type</th>
<th>New I/O unit type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNAP-PAC-R1</td>
<td>SNAP-PAC-R2</td>
<td>SNAP-UP1-D64</td>
<td>SNAP-PAC-R1*</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-EB1</td>
<td>SNAP-PAC-R2*</td>
<td>SNAP-PAC-R2*</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-EB2</td>
<td>SNAP-PAC-EB1*</td>
<td>SNAP-PAC-EB2*</td>
</tr>
<tr>
<td>SNAP-PAC-R1-B</td>
<td>SNAP-PAC-R1*</td>
<td>SNAP-B3000-ENET</td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>SNAP-PAC-R2</td>
<td>SNAP-PAC-R1</td>
<td>SNAP-PAC-R1*</td>
<td>SNAP-PAC-EB1*</td>
</tr>
<tr>
<td>SNAP-PAC-EB1</td>
<td>SNAP-PAC-R1</td>
<td>SNAP-ENET-RTC</td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>SNAP-PAC-EB2</td>
<td>SNAP-PAC-R1</td>
<td>SNAP-ENET-S64</td>
<td>SNAP-PAC-R1-B</td>
</tr>
<tr>
<td>SNAP-PAC-SB1</td>
<td>SNAP-PAC-R1</td>
<td>SNAP-UP1-ADS</td>
<td>SNAP-PAC-R1-*</td>
</tr>
<tr>
<td>SNAP-PAC-SB2</td>
<td>SNAP-PAC-R1</td>
<td>SNAP-UP1-M64</td>
<td>SNAP-PAC-R1*</td>
</tr>
<tr>
<td>SNAP-ENET-D64</td>
<td>SNAP-PAC-R1*</td>
<td>GENERIC OPTOMMP</td>
<td>SNAP-PAC-R1</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-R2*</td>
<td>DEVICE</td>
<td>SNAP-PAC-R2</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-EB1*</td>
<td></td>
<td>SNAP-PAC-EB1*</td>
</tr>
<tr>
<td></td>
<td>SNAP-PAC-EB2*</td>
<td></td>
<td>SNAP-PAC-EB2*</td>
</tr>
</tbody>
</table>

* This change requires a mounting rack change.

To change a SNAP I/O unit type:

1. With the strategy open in Configure mode, double-click the I/O Units folder in the Strategy Tree.
2. Select the I/O unit you want to change and click Modify.
3. Click the Type dropdown list to see the possible types you can change it to.

![Edit I/O Unit dialog box](image)

Other I/O unit types you can change this one to

4. Choose the new type, make any other necessary changes, and click OK.

**THE CONFIGURE I/O MODULES AND POINTS DIALOG BOX**

The Configure I/O Modules and Points dialog box allows you to make a variety of changes to I/O modules and points.

To open the dialog box:

1. Make sure the strategy is open and in Configure mode. In the Strategy Tree, double-click the folder named “I/O Units” (not the icon representing a specific I/O unit).
2. In the Configure I/O Unit dialog box, highlight the unit and then click I/O Points. The Configure I/O Modules and Points dialog box opens.

For a SNAP I/O unit, it looks something like this:

![Configure I/O Points](image)
For a groov I/O unit, the dialog box also has a Scan for New Modules button:

### Scanning for New Modules (groov I/O only)

Click the Scan for New Modules button to open the Automatically Add Modules and Channels dialog box. This dialog box lets PAC Control detect and automatically add I/O modules and channels in groov I/O units. For details, see “Automatically Adding groov I/O Modules and Channels” on page 124.

### Moving a Configured I/O Module or Point

You can move a configured I/O module or I/O point to an empty position on the same I/O unit or a different I/O unit.

- To move a module, select it and click Move To.
THE CONFIGURE I/O MODULES AND POINTS DIALOG BOX

- To move a point, expand an individual module by clicking its plus sign (+), or expand all modules by clicking Expand All. Select the point you want to move and click Move To.

1. In the left column, select the I/O unit you want to move the module or point to. (The I/O unit it’s on now is selected by default.) In the right column, select the position you are moving the module or point to. Then click OK. You return to the Configure I/O Modules and Points dialog box, and the point has been moved.

Copying a Configured I/O Point

If you have several points on an I/O module that are the same, you can copy a configured point:
- To fill empty points on the same module.
- To fill all empty points on the I/O unit.
- To another point on the same or a different I/O unit.

1. With the strategy open in Configure mode, double-click the I/O Units folder on the Strategy Tree to open the Configure I/O Units dialog box.

2. Select the I/O unit whose points you want to copy, and then click the I/O Points button. The Configure I/O Modules and Points dialog box is displayed. Click Expand All so you can see the points.

3. Highlight the point you want to copy and click the Copy To button. From the pop-up menu, choose one of the following:
To copy the point to fill empty points on the module, choose Fill In Module. The point is copied to the other empty points on the same module.

To copy the point to fill all empty points on the I/O unit, choose Fill In I/O Unit. The point is copied to all empty points on similar modules (for example, to all empty points on digital input modules, whether they are the same or a different part number), and the module and point are copied to all compatible slots without configured modules.

To copy the point to one other point (either on the same or a different I/O unit), choose To Specific. The Copy To dialog box opens.
In the left column, choose the same or another I/O unit. In the right column, choose the location of the point to copy to. Available points are shown in black. Already configured points, points on a different type of module (digital output instead of digital input, for example), and point numbers not on the rack (such as point 40 on an 8-module rack) are grayed out. If the point is copied to an empty module slot, the module part number from the copied point is added, too.

4. After you copy a point, change the new point as needed by double-clicking its point name. In the Edit Digital Point dialog box, type the new name and make any other changes. For details, see “Add/Edit Digital Point Dialog Box” on page 129.

changing a configured I/O point

1. With the strategy open in Configure mode, expand the I/O Units folder on the Strategy Tree until you can see the I/O point you want to change. Double-click the I/O point name.

2. In the Edit Analog Point or Edit Digital Point dialog box, make the necessary changes. (For more information, see “Add/Edit Digital Point Dialog Box” on page 129 and “Add/Edit Analog Point Dialog Box” on page 133.)

3. Click OK to save the settings and close the dialog box.

Deleting a Configured I/O Point

You cannot delete an I/O point that is referred to in the strategy.

CAUTION: Be careful when deleting I/O points. You cannot undo a deletion.

1. With the strategy open in Configure mode, expand the I/O Units folder on the Strategy Tree until you can see the I/O point you want to delete.

2. Right-click the I/O point’s name and choose Delete from the pop-up menu.

You can also delete an I/O point from the Configure I/O Modules and Points dialog box by highlighting its name and clicking Delete.

Configuring PID Loops

PID loops (or simply PIDs) are used to drive an input (a process variable) toward a particular value (the setpoint) and keep the input very close to that value by controlling an output. For example, consider temperature control, where the input is a measurement of ambient temperature, the setpoint is the desired temperature, and the output is a heater. The PID for this system will use a mathematical formula that controls the output to maintain a desired temperature, efficiently adjust to changes in setpoint, and compensate for changes in load, such as the influx of cold air. In this example, a temperature sensor (analog input), a thermostat (analog input), and a heater control (analog output) are components of one system, controlled by a PID loop.

This guide assumes that you are already familiar with using PIDs. PID calculations are complex and the physical qualities of systems suitable for PID control differ greatly. This guide includes only basic information for configuring PIDs.

- groov and SNAP PAC I/O units support 96 PID loops.
- groov RIO units support 4 PID loops.

PIDs can control isolated systems or be part of cascaded systems where one loop controls the setpoints or input variables of others. For maximum flexibility, any PID input, setpoint, or output can be determined by PAC Control commands.
**PIIDs and Strategies**

The PID operates at the I/O unit, independently of the controller. However, the controller supports logic commands to read and write various PID parameters and modes. Once configured and initialized, a PID operates until the I/O Unit loses power.

When you change PID configuration in PAC Control, remember that changes are not written to the I/O unit until the strategy is downloaded and run. For a groov, SNAP PAC, I/O unit, be sure to save PID configuration to flash memory following instructions for the I/O unit.

If you subsequently download a different strategy to the control engine, you’ll receive an error message (-700) reminding you that a PID loop is still running and that it may conflict with the new strategy. To turn off a PID loop, start PAC Manager and use Inspect mode to change the PID’s algorithm to None.

Each PID loop must be individually configured and tuned.

Configuration steps start in “Adding a PID Loop” on page 149, and tuning steps are described in “Inspecting and Tuning PID Loops” on page 160. For additional information, see “PID—Ethernet Commands” on page 318; the OptoTutorial: SNAP PAC PID (form 1641); and the Tuning a PID Control Loop technical note (form 2171).

**Adding a PID Loop**

1. With the strategy open and in Configure mode, double-click the I/O Units folder (not the individual unit’s icon) on the Strategy Tree. The Configure I/O Units dialog box opens.

![Configure I/O Units](image)

2. Select the I/O unit the PID will be on, and click PID Loops.

![Configure PID Loops](image)

3. Double-click the lowest unused number.
The Add PID Loop Dialog appears.

4. Complete the fields as described in “Add PID Loop Dialog Box” below, and then click OK. The new PID appears in the Configure PID Loops dialog box.

5. When you have finished configuring PIDs, click Close. PIDs appear in the Strategy Tree under the I/O unit.
CHAPTER 6: WORKING WITH I/O

A—Name. Type a unique, descriptive name for the PID. The name must start with a letter and may contain letters, numbers, and underscores (spaces are converted to underscores).

B—Description. (Optional) Enter a description of the PID.

C—Input. Select the type of input: I/O Point, Host, or PID Output.
- If the PID’s process variable comes from an I/O point on the same unit, select I/O Point. Choose the point from the drop-down list or type a point name to configure a new point.
- If the PID’s process variable comes from the PAC Control strategy, select Host. Enter an initial value for the input.
- If the PID’s process variable is the output of another PID on this brain (a cascading control loop), select PID Output. Choose the PID from the drop-down list.

D—Square Root. (Optional) If you chose I/O Point or PID for step C, check this box if the error should be calculated based on the square root of the process variable (applies to flow control systems where volumetric flow is proportional to the square root of a signal from a flow transducer).

E—Low/High Range. Set the valid range of the process variable by entering the low range and the high range. (See Output Options for optional responses to out-of-range input.)

F—Setpoint. Choose the source for the setpoint: I/O Point, Host, or PID Output.
- To control the setpoint using a device (on the same brain) such as a potentiometer, select I/O Point; choose an I/O point from the drop-down list or type a new point name.
- To control setpoint using PAC Control or PAC Display, select Host. For Initial Value, enter the most common operating value.
- If another PID loop will control the setpoint, select PID Output and choose the PID from the drop-down list.

G—Output. Choose the destination for the PID output: I/O Point or Host. (To use the output for controlling the setpoint or input of another PID, choose Host.)

H—Lower Clamp/Upper Clamp. Enter upper and lower clamp values to prevent the output from exceeding a desirable range. These values should equal the range of the output point, if used. Or choose values to make sure that the output device doesn’t shut off (for example, keeping a circulation pump running regardless of the PID output) or that the output never reaches a destructively high setting (for example, keeping a motor below maximum).

I—Min Change/Max Change. (Optional) Enter minimum and maximum change values. The output won’t respond until the minimum change is reached (for example, you may not want a heater to turn on to correct a 1 degree error). Maximum change prevents too drastic a change in output (for example, you could limit the increase in a pump’s output to prevent pipe breakage). The default for both minimum and maximum is zero, which disables the feature.

J—Output Options. Choose how the PID should respond if the input goes out of range. To have PAC Control logic or an operator respond, check Switch to manual mode. To force the output to a specific value, check that option and type the output values.

NOTE: If both boxes are checked (forced output and manual mode), the output will be forced and the PID put into manual mode; but if the PID is already in manual mode, the output will not be forced. (You can use the command Get PID Status Flags to determine current settings.)

If neither box is checked and the PID input goes out of range (as defined by E–Low/High Range) then the output will freeze, but only while the input is out of range.
**K—Algorithm.** Choose algorithm: Velocity, ISA, Parallel, or Interacting. For details on algorithms, see “Algorithm Choices” on page 319.

**L—Mode.** Choose the Mode you want the PID to be initialized to. The main difference between Automatic and Manual mode is that in Manual mode the PID loop stops its mathematical calculation. In both modes the PID’s output value is still copied to the analog output.
- Auto mode: The PID makes calculations based on the difference between the input and the setpoint resulting in changes to the output, which causes the input to move toward the setpoint.
- Manual mode: The PID stops making changes to the output, but continues to write the PID output to the analog point (or configured destination for the PID output). Manual mode allows PAC Control logic or an operator to control the PID output, which in turn is written by the PID loop to the analog point (or configured destination of the PID output).

*NOTE: If the value of the analog point or configured destination is changed, it will be overwritten by the PID output.*

**M—Scan Rate.** Enter a scan rate to determine how often the input is scanned and the controller output is calculated. Minimum value is 0.001 (1 ms). Scan time should be greater than system lag (the time it takes for the controller output to have a measurable effect on the system). Also consider other PIDs and tasks on the brain competing for processing power.

**N—Gain.** Type a positive or negative value for Gain. Heating systems usually require a negative value and cooling systems a positive value. NOTE: Gain is usually refined during the tuning process.

**O—Fd Fwd Initial/Fd Fwd Gain.** (Optional) Enter Feed forward Initial and Feed forward gain values if you need to offset the controller output in your application. These values are constants that are multiplied and added to the controller output; often they are not used in PIDs.

**P—Tune I/Tune D.** (Optional) Type Integral and Derivative settings if you know the desirable settings. However, Integral and Derivative are not essential to basic configuration and are better determined in the tuning process.

### Changing a PID Loop

You can change the PID loop’s configuration and its position in the I/O unit.

1. Make sure the strategy is open and in Configure mode. On the Strategy Tree, expand the I/O Units folder until you see the PIDs folder for the I/O unit you want. Double-click the PIDs folder.
   The Configure PID Loops dialog box opens, listing all configured PID loops. Remember that the number of PID loops available depends on the I/O unit.
PID loops are scanned by the I/O unit in the order that they appear in this list.

2. To move the PID loop to a different position on the I/O unit, use the up- and down-arrows in the dialog box.

3. To change the PID loop’s configuration, double-click its name to open the Edit PID Loop dialog box. Change the fields as necessary. For help in completing the fields, see “Adding a PID Loop” on page 149.

Deleting a PID Loop

Only PID loops that have a reference count of zero can be deleted. Be careful when deleting PID loops; you cannot undo a deletion.

1. Make sure the strategy is open and in Configure mode. On the Strategy Tree, expand the I/O unit’s folder and then expand the PID subfolder to find the PID loop you want to delete.

2. Right-click the name of the PID loop and choose Delete from the pop-up menu.

The PID loop is deleted.

You can also delete a PID loop in the Configure PID Loops dialog box by highlighting it and clicking Delete.

INSPECTING, MONITORING, AND CHANGING I/O IN DEBUG MODE

You may want to monitor or change I/O while you are running your strategy in Debug mode to test and debug your strategy. PAC Control offers two ways to display and interact with I/O in Debug mode:

• Inspection windows—Monitor the value of I/O points or channels, either individually or along with all the other points or channels on an I/O unit. If you are monitoring a single point or channel, the window can be minimized (to show only the IVAL and XVAL) or maximized to show more information (like the value of any configured features). If you are monitoring an I/O unit, PAC Control organizes the points or channels by I/O module. If you are monitoring a RIO unit, the inspection window shows all the configured channels on the unit. You can force the values of I/O points or channels. The rest of this section describes how to work with inspection windows.

• Watch windows—Monitor the value of I/O points or channels that you select and organize in whichever order you want. You can also add other strategy elements like PID loops and variables. You can save a watch window with the strategy. You can create multiple watch windows, which can help you group strategy elements in a way that makes sense to you. You can change the value of any of these strategy elements by double-clicking on it to open the corresponding inspection dialog. For instructions, see “Using Watch Windows for Monitoring” on page 170.
Inspecting I/O Units

With the strategy running in Debug mode, double-click an I/O unit in the Strategy Tree. PAC Control displays the Inspect I/O Unit dialog box, showing information about the unit and its points. The title bar shows the name of the I/O unit and whether scanning is occurring.

Here is an example of an Inspect I/O Unit dialog box for a groov EPIC I/O unit:

![Groov EPIC I/O Unit Dialog Box](image1)

The dialog box would look similar if you were inspecting a SNAP I/O unit, with SNAP I/O module part numbers on the left. Here is an example of an Inspect I/O Unit dialog box for a groov RIO I/O unit:

![Groov RIO I/O Unit Dialog Box](image2)

**NOTE:** Scanning stops whenever you click a changeable field. It resumes as soon as you click Apply, another button, or an unchangeable field. To apply changes, click Apply before clicking another button or field; otherwise, the pending changes will be lost.

**To change the I/O unit’s current status,** click the up or down arrow in the Enable Comm field. Then click Apply.

- If you change it, the background turns magenta until you click Apply.
- Yes on a green background means enabled; No on a red background means disabled.
To view an individual I/O point or channel, highlight its name in the list.

- To add an I/O element to a watch window, click Add Watch. See page 170.
- To open an inspection window to change an I/O point or channel, click View. Then see “Inspecting and Changing Discrete I/O Points or Channels” or “Inspecting and Changing Analog I/O Points or Channels” for the I/O point or channel you are changing (discrete or analog).

To close the dialog box when you’ve finished inspecting the I/O unit, click Close.

**Saving I/O Unit Configuration to Flash**

To protect the I/O unit configuration information from being lost when the power is turned off, set the Stored Configuration option, which saves the following parameters:

<table>
<thead>
<tr>
<th>Analog</th>
<th>Digital</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O module configuration</td>
<td>I/O module configuration</td>
</tr>
<tr>
<td>Initial output settings</td>
<td>Comm link watchdog time</td>
</tr>
<tr>
<td>Comm link watchdog time</td>
<td>Temperature conversion type</td>
</tr>
<tr>
<td>Temperature conversion type</td>
<td>Input offset and gain settings</td>
</tr>
</tbody>
</table>

1. Click the Information tab.
2. Click the Store button under Stored Configuration (Flash).

Saving to flash memory this way is the same as saving to flash by other methods, such as saving a SNAP I/O unit’s configuration by using PAC Manager, and is preferable to using the command Write I/O Unit Configuration to EEPROM.

To reset saved parameters to their powerup default values, click the Clear button.

**Inspecting and Changing Discrete I/O Points or Channels**

You can inspect a discrete point’s data, change its status, or force its internal values (IVALs) or external values (XVALs) in Debug mode. To monitor the point or channel in a watch window, see page 170.

To inspect a discrete point or channel: With the strategy running in Debug mode, double-click the I/O point or channel on the Strategy Tree. Or double-click an I/O unit in the Strategy Tree, click the Points (Compact) tab or Channels (Compact) tab of the Inspect I/O Unit Dialog box, and then double-click the I/O point or channel.

PAC Control displays a small dialog box that shows the IVAL and XVAL.

- The XVAL, or external value, is the “real” or hardware value as seen by the I/O unit. This value is external to the control engine.
- The IVAL, or internal value, is a logical or software copy of the XVAL that is in the control engine. The IVAL may or may not be current, since it is updated to match the XVAL only when a strategy in the control engine reads or writes to an I/O point or channel.

If the discrete point or channel is configured with a counter, the counter value appears instead of the status.
To change the value of a discrete point or channel: Click the Maximize button to view more information.

The title bar shows the name of the discrete point or channel and whether scanning is occurring.

NOTE: Scanning stops whenever you click a changeable field. It resumes once you click Apply, another button, or an unchangeable field. If scanning resumes before you click Apply, any changes you made are lost. Use the Clear button to immediately clear the field.

A—Quality. (Read-only. Available only on some groov I/O modules and groov RIO units.) Indicates the channel’s data quality. “Good” indicates the channel isn’t currently reporting any data quality issues. groov I/O modules and groov RIO units that report quality continuously poll their channels for current data values and identify deviations between reported and expected values. When an issue is detected, a description is displayed in this field.

When the issue is resolved, “Good” is once again displayed in this field. For more information and a list of applicable groov I/O modules and groov RIO units, see “I/O Quality Commands” on page 307.

B—IVAL. The point or channel’s current internal value. Switch between On and Off; then click Apply.

C—XVAL. The point or channel’s current external value. Switch between On and Off; then click Apply.

D—On-Latch, Off-Latch. The state of the point or channel’s on and off latches.

E—<Feature name>. Internal and external values of any feature that might have been configured, such as a counter or frequency.

F—Communication. Control whether communication from the control engine is enabled for the I/O unit or point/channel.

  - Yes on a green background means enabled
  - No on a red background means disabled.

To change the communication on a point/channel, click either the up or down arrow on the Point field; then click Apply. To change the communication on an I/O unit:
1. Click Open Parent. PAC Control displays the Inspect I/O Unit dialog box.
2. Click either the up or down arrow on the Enable comm. field.
3. Click Apply, then click Close to return to the I/O point/channel window.

Asterisks in a field indicate an out-of-range value. Dashes in an XVAL field indicate a communication error.

To add the point or channel to a watch window, click Watch and see page 170.

To view configuration information for a point or channel, click More Info.

To inspect an I/O unit’s configuration, click Open Parent.

To close the dialog box when you’ve finished inspecting the I/O point or channel, click the “X” on the upper right corner.

(Pro only) To add a plot control, click Plot.

---

Inspecting and Changing Analog I/O Points or Channels

You can review an analog point’s data, modify its status, or force its internal values or external values in Debug mode. To monitor the point in a watch window, see page 170.

To inspect an analog point or channel: With the strategy running in Debug mode, double-click the I/O point or channel on the Strategy Tree. Or double-click an I/O unit in the Strategy Tree, click the Points (Compact) tab or Channels (Compact) tab of the Inspect I/O Unit dialog box, and then double-click the I/O point or channel.

The small dialog box that appears shows the IVAL and XVAL.
- The XVAL, or external value, is the “real” or hardware value as seen by the I/O unit. This value is external to the control engine.

---

A—Click Data to save, copy, or print the current plot.
B—Click Time Axis to adjust the resolution.
C—Click Include IVAL to see a concurrent plot of the IVAL.
The IVAL, or internal value, is a logical or software copy of the XVAL that is in the control engine. The IVAL may or may not be current, since it is updated to match the XVAL only when a strategy logic in the control engine reads or writes an I/O point or channel.

To change the value of an analog point or channel: Click the Maximize button to view more information.

The title bar shows the name of the analog point or channel and whether scanning is occurring.

Asterisks in a field indicate an out-of-range value. Dashes in an XVAL field indicate a communication error.

Change the fields as necessary:

A — Quality. (Read-only. Available only on some groov I/O modules and groov RIO units.) Indicates the channel's data quality. "Good" indicates the channel is not currently reporting any data quality issues. groov I/O modules and groov RIO units that report quality continuously poll their channels for current data values and identify deviations between reported and expected values. When an issue is detected, a description is displayed in this field.

When the issue is resolved, "Good" is once again displayed in this field. For more information and a list of applicable groov I/O modules and groov RIO units, see "I/O Quality Commands" on page 307.

B — IVAL. The point or channel's current internal value. You can force it to any value within the valid range of the analog point. For an input, the valid range may exceed the apparent range; that is, you may be able to enter a value lower than the zero-scale value or higher than the full-scale value. For an output however, you cannot enter a value outside of the range defined by the zero-scale and full-scale values. After you change it, click Apply.

C — XVAL. The point or channel's current external value. You can force the XVAL outputs to any value within the valid range of the analog point; then click Apply.

D — Communication. Current point or channel status: Yes on a green background means enabled, No on a red background means disabled. To change the status, click one of the arrows; then click Apply.

To add the point or channel to a watch window, click Watch and see page 170.
To view configuration information for a variable, click More Info.

To inspect the I/O unit’s configuration, click Open Parent.

To close the dialog box when you’ve finished inspecting the I/O point or channel, click the “X” on the upper right corner.

*(Pro only)* To add a plot control, click Plot.

A—Click Data to save, copy, or print the current plot.

B—Click Time Axis and Value Axis to adjust the resolution.

C—Click Show IVAL to see a concurrent plot of the IVAL.
In Debug mode, you can view PID loops and tune them. This section gives you basic steps for inspecting PIDs, determining system lag, and tuning PIDs. For additional information, see the Tuning a PID Control Loop technical note (form 2171) and the OptoTutorial: SNAP PAC PID (form 1641). Both forms are available for download from our website at www.opto22.com.

Inspecting a PID

1. With the strategy running in Debug mode, double-click the PID on the Strategy Tree.

2. View or change PID parameters as necessary. Click the other tabs to see additional data. To tune the PID, see page 165.

3. To add the PID to a watch window, click Add Watch and see page 170.

4. To save, copy, or print the current plot, click the Data button and choose from the pop-up menu.

5. To save changes to any of the PID configuration parameters, click Save Tuning.

Determining System Lag

You can directly control the PID output to determine system lag, which is essential to setting the PID scan rate. Considerations in setting scan rate are:

- Slower scan intervals may be easier to tune. The PID controller has time to see the effect of the previous output before calculating a new output.
Faster scan rates may be necessary to achieve the desired response. When scan intervals are shorter than the system lag, tuning must compensate for any over-correction from the controller output. Also see the Tuning a PID Control Loop technical note (form 2171), available for download from our website at www.opto22.com.

1. **Determine two significantly different output settings that are within the capabilities of your system.**
2. **With the strategy running in Debug mode, double-click the PID on the Strategy Tree.**

3. **Set the Mode to Manual (if not set already) and click Apply.**
4. **In the Output field, type one of your two output settings and click Apply.**
   Use an output value typical of your system but low enough to allow you to change output by 20%.
5. **Reset your time axis, if necessary, by clicking the Time Axis and choosing from the pop-up menu. Then choose Reset Scale Tracking from the same menu.**
   The span setting varies according to your system; a 3-minute span is often suitable. Until you are familiar with the PID plot, it is recommended that you avoid using the shortest settings (10-seconds or 1-second). After you’ve observed a change in the input, you can zoom in on the graph, which is described later.
6. **Wait for your system to stabilize.**
The system is stable when the Input value does not vary significantly (some drift can be expected). Stabilization may take several minutes, depending on the system.

7. Increase the resolution of the Input Axis by clicking the Input Axis menu and choosing a span setting of 1 or 5 percent.

8. Center the Input Axis, if necessary, by clicking the red line at its left end and dragging it up or down until the plot is visible.

9. Under the Time Axis menu, choose Reset Scale Tracking. This is a precautionary step, as changing settings on the plot can fix the plot at a certain point in time. Resetting the time axis ensures that you are viewing the real-time values.

10. In the Output field, type the other of your two output settings and click Apply. A 20% percent increase is a moderate, detectable change for most systems. Your system may require a larger or a smaller change to stay within safety constraints.
11. Wait for a discernible change in the Input axis.

The Input axis (indicated by the upper white arrow added to this picture) begins to respond to the change in output (lower white arrow).

12. Increase the resolution of the Time Axis by clicking the Time Axis button and choosing a lower percentage, such as View 1 Minute Span.

13. Scroll the Time Axis to locate the point at which you changed the Output. Both the time and input axes should display the point at which the Output changed, the lag, and the point the input changed. If not, adjust the Input axis and Time axis, until this information is displayed.

14. From the Data menu, select Cursor. The data cursor, a line with a value bar attached to it, appears on the plot.
15. Right-click the data cursor and choose Delta X from the Style submenu.

16. To measure the system lag (the time between the change in output and the change in input), click and drag the first vertical red bar to just after the output change. Drag the second bar to just before the change in input.

If you are unable to get the precision you want, you can view the plot at a lower time span, such as 10 seconds. You will need to reposition your plot and the measurement bars of the Delta X cursor.

The example above shows a system lag of 1.88 seconds. Generally, a suitable scan rate can be anywhere from one-third the system lag to two times the system lag.
Tuning a PID Loop

Tuning a PID involves manipulating the P, I, and D constants in real time. The following steps should be viewed as general suggestions to show you features that are available for tuning. We highly recommend the OptoTutorial: SNAP PAC PID (form 1641) and the Tuning a PID Control Loop technical note (form 2171) for more detailed information. These forms are available for download from our website at www.opto22.com.

**CAUTION:** Before following these procedures, make sure you know the limits of the equipment being controlled and monitored by your PID loop. Also, make sure that these points are configured properly. Any values suggested in these steps are for example only and must be modified according to the capabilities and constraints of your system.

1. Make sure the following PID features have already been configured:
   - Scan Rate
   - Input
   - Input low range and high range
   - Output
   - Output lower and upper clamp.
   - Algorithm
   - Setpoint. If your setpoint changes during normal operation, tune your PID with the setpoint configured to host, so you can simulate setpoints from an input point or from another PID.
   - Gain. A final gain constant will be determined by tuning, but before you can tune your PID, your gain constant must be either a positive or negative number according to the type of system you have. For example, a heating system reports a negative error when heat needs to be applied; a negative gain constant turns this error into a positive output for the heater. Alternatively, a cooling system reports a positive error when the input exceeds the setpoint; a positive gain constant maintains the positive output to the chiller.
   - Optional, depending on your system: Minimum and maximum changes to Output and Output forcing when the Input is out of range.

2. Download and run your strategy.
   The current PID configuration is written to the I/O unit. You can stop your strategy at this point if you wish, as the PID will continue operating.
3. In Debug mode, double-click the PID on the Strategy Tree.

4. Set the PID Mode to Auto (if not set already) and click Apply.

5. Change the Setpoint, if desired, by typing a new setpoint and clicking Apply. (Setpoint must be configured as Host.) Depending on the type of system, your PID may maintain a setpoint or respond to changes in setpoint. Experiment with setpoint changes again after tuning the P, I, and D constants.

6. Adjust the span of the input, output, and time axes according to how much change you expect from your system. To set a span, click the axis button and choose from the pop-up menu.

7. If desired, type a new Scan Rate and click Apply.

   For most systems, you should use an appropriate scan rate based on the system lag (see “Determining System Lag” on page 160). However, you can experiment with Scan Rates before tuning the P, I, and D constants or adjust scan rate after tuning.
CHAPTER 6: WORKING WITH I/O

Here is an example for Scan Rate:

The lag for this system was determined to be about 2 seconds. The left half of the plot reflects a 0.5-second scan rate, while the right half shows a 3-second scan rate. Notice both scan rates have the same effect on the input, however, the 3-second scan rate is using less of the processor’s resources.

8. Experiment with gain settings by typing a new value in the Gain field and clicking Apply.
   The easiest way to tune most PIDs is to experiment with the gain constant first. Try various gains to see how well the system stays at setpoint and responds to setpoint changes.
In the example below, the white arrows (added for the example) show where gain constants of -2, -5, -10, and -20 were applied:

With only a gain constant applied, the input often stabilizes at an incorrect value. In this heating example, a gain setting of -30 drove the input close to the setpoint, but subsequent increases failed to eliminate the offset. It is time to try integral constants to eliminate the offset error.
9. Experiment with the integral constant: in the Tune I field, type a number between 0 and 1 and click Apply. (Your PID may require larger numbers.) In this example, an integral constant of 0.1 corrected the offset error.

The far left side of the plot shows the offset before an integral constant of 0.1 was applied. This setting eliminated the offset. In many applications, a minor fluctuation around the setpoint is acceptable, and these applications use gain and integral only. In some applications, however, the fluctuations at the setpoint indicate that the gain is too high (too much gain makes a system unstable) or that a derivative constant is required.

10. If derivative correction is needed, experiment with the derivative constant: in the Tune D field, type 1 and click Apply. (Your PID loop may require a larger number.) In this example, a derivative of 10 makes a noticeable difference in keeping the input near the setpoint.

Many PID systems are effectively controlled with gain and integral constants only and no derivative constant. In this example, the gain and integral settings are maintaining the temperature at 0.06 from setpoint. To demonstrate the effect of the derivative constant, the resolution of the input axis was increased to show a 1 percent span. At this resolution, the plot reveals changes of 0.01 degrees F.

The left side of the plot shows the effect of gain at -30, integral at 0.1, and no derivative constant. The arrow shows when a derivative constant of 10 was applied. The right side of the plot shows how the derivative constant is keeping the input closer to setpoint.
11. Click Save Tuning to save your tuning parameters to the strategy database. Changes are lost unless you save them. You may wish to save your tuning parameters when you see any improvement in performance, even if they are not final.

![PAC Control Professional dialog box](image)

12. Click Yes. Values are saved to the PAC Control strategy. Remember to save PID parameters to the I/O unit’s flash memory, too (see “Inspecting I/O Units” on page 154).

**USING WATCH WINDOWS FOR MONITORING**

While the strategy is running, you can monitor several strategy elements at once in a watch window: I/O units, digital and analog points, PID loops, variables, even charts. You cannot monitor subroutine parameters or variables that are local to a subroutine in a watch window.

Unlike inspection windows, watch windows can be created the way you want, docked in a position most convenient for you, and are saved with your strategy. You cannot change strategy elements in a watch window, but you can open the inspect dialog box from the watch window and change the element there.

**Creating a Watch Window**

1. With the strategy open and in Debug mode, choose Watch > New.
2. In the Create New Watch Window dialog box, navigate to the location where you want the watch window file to be kept (usually in the same folder as the strategy). Enter the watch window file name and click Open. The empty watch window appears.

3. Add elements you want to watch in this window by clicking them on the Strategy Tree and dragging them into place in the watch window, or by right-clicking them and choosing Watch from the pop-up menu.

You can add I/O units, digital and analog points, PID loops, variables, and charts. You cannot add subroutine parameters or variables that are local to a subroutine.

Depending on which element you add and how you add it, it may appear immediately in the window, as shown here.
For some elements, the Add Watch Entry dialog box appears, so you can specify what to watch.

4. If an Add Watch Entry dialog box appears, click to place or remove the check mark next to any item. When all the items you want to watch are checked, click OK. The element is added to the watch window. The watch window is automatically saved.

**Opening an Existing Watch Window**

If a watch window was open when you exited Debug mode, it will automatically open again when you re-enter Debug mode. To open other watch windows, follow these steps.

1. Make sure the strategy is open and in Debug mode.
2. Choose Watch > Open.
3. Navigate to the watch window you want to open and double-click its name. The window opens in the position you left it.

**Working in Watch Windows**

Watch windows are flexible. You can dock the window where you want it in the PAC Control main window. You can also move, delete, and inspect elements in the window.

- **To dock the watch window**, click the docking button in its title bar.
The window moves to its own frame.

See "Docking Windows" on page 58 for more information.

- **To expand or collapse watch window** you have added to an I/O unit, PID loop, chart, or table, click its plus or minus sign.

- **To rearrange elements** in the watch window list, click the item you want to move and drag it to a new location, or right-click it and choose Move Up or Move Down from the pop-up menu.
  
  You can also sort elements in the window by clicking on the column label. For example, to sort by Type, click the label Type in the column heading. Click again to change the order from ascending (A–Z) to descending (Z–A).

- **To move an element** from one watch window to another, open both windows and drag the element where you want it. To copy an element to another watch window (so it will appear in both windows), hold down the Ctrl key while you drag it.
- **To delete an element**, right-click it and choose Delete from the pop-up menu.
- **To inspect an element**, double-click it.

  The inspect dialog box opens. For information on using it, see “Inspecting Control Engines and the Message Queue” on page 106.
7: Working with Strategies

INTRODUCTION

A strategy is the software program you create in PAC Control. A strategy is similar to a file in any Microsoft Windows program. You use standard Windows menu items to create a new strategy, to open an existing strategy, or to save a strategy. The strategy includes all the definitions and instructions necessary to control your process. This chapter is a step-by-step reference for working with strategies in all three strategy modes: Configure, Debug, and Online.

In This Chapter
Creating a New Strategy ............................................................... page 175
Opening a Strategy ........................................................................ page 176
Saving and Closing ....................................................................... page 177
Saving a Strategy to Flash .............................................................. page 178
Archiving Strategies on the Computer ........................................ page 179
Compiling and Downloading ........................................................ page 180
Running a Strategy Manually ....................................................... page 188
Running a Strategy Automatically (Autorun) ............................... page 188
Stopping a Strategy ....................................................................... page 189
Debugging .................................................................................... page 189
Viewing and Printing .................................................................. page 196
Searching and Replacing ............................................................. page 204
Legacy Options ............................................................................. page 208
Advanced Options ........................................................................ page 210

CREATING A NEW STRATEGY

Each PAC Control strategy must be located in its own directory. When you create a new strategy, you must create a new directory or use an empty one. Each strategy in its own directory keeps all its files in one place and makes it easy to copy a strategy to another location for modification or backup.

1. To create a new strategy, select File > New Strategy, or press Ctrl+N, or click the New Strategy icon on the toolbar.
2. In the New Strategy dialog box, navigate to the directory where you want the strategy to be placed. Create a new folder if necessary.
3. Type the strategy name.
   As you can see in the Files of type field, PAC Control files have an extension of .idb.
4. Click Open.
   The new strategy is created. Its Strategy Tree and Powerup charts appear in the PAC Control main window.
OPENING A STRATEGY

For information on the main window, see “PAC Control Main Window” on page 53.
For programming information, see page 75.
For steps to create charts, see “Creating a New Chart” on page 213.

OPENING A STRATEGY

Only one strategy at a time can be open in PAC Control. If you currently have a strategy open, it must be closed before another is opened. You are prompted to save changes before it closes.

Opening an Existing Strategy

NOTE: PAC Control does not support strategy (.idb) files that have been downloaded from Dropbox® cloud storage service. If you try to run an .idb file that was stored on Dropbox, PAC Control may display an “Invalid storage format” error message and fail to open the strategy. Instead of using Dropbox, save your .idb files to a portable storage media or try using a different cloud storage service.

1. To open an existing strategy, select File > Open Strategy, or press Ctrl+O, or click the Open Strategy icon on the toolbar.
2. In the Open Strategy dialog box, navigate to the strategy you want to open and click Open.
   The strategy opens in Configure mode, with the windows in the same position they were when the strategy was closed.

Opening an ioControl Strategy

If you have been using ioControl Basic or Professional with a SNAP PAC controller, migration to PAC Project Basic or Professional is simple. Because the individual programs within the suite are essentially the same (although they have new features and hardware support), you can simply open a strategy in PAC Control and then save it. For safety, we recommend you back up all ioProject files before opening them in PAC Project. See also, “Opening Strategies in PAC Control” below. For more information on migrating your system to SNAP PAC, see the SNAP PAC System Migration Technical Note (form 1680).

Opening a Recently Used Strategy

To open a strategy you have recently used, choose its name from the list at the bottom of the File menu. The ten most recently opened strategies are listed.

Loading a Strategy or Mode at Startup

To have PAC Control automatically start up with the strategy that was open when you exited, choose Configure > Options and click to put a check mark next to Load Last Strategy at Startup.

To have PAC Control open strategies in the same mode as when you exited PAC Control, choose Configure > Options and click to put a check mark next to Load Last Mode at Startup.

Opening Strategies in PAC Control

CAUTION: Once a strategy is opened in PAC Control Professional, it can no longer be opened in PAC Control Basic.

A strategy saved in ioControl version 6.1 or less can be opened in either PAC Control Basic or Professional. A PAC Control Basic strategy can also be opened in PAC Control Professional. However, PAC Control Professional strategies cannot be opened in Basic or in any earlier version of PAC Control.
Opening an OptoControl Strategy

(Pro only) If you are moving a strategy from OptoControl to PAC Control Professional, PAC Control will open it and help you convert it. Although many things will convert without difficulty, planning ahead is essential to make the job easier. Before opening an OptoControl strategy in PAC Control, read the FactoryFloor to PAC Project Migration Technical Note (form 1692).

SAVING AND CLOSING

CAUTION: Once a strategy is opened in PAC Control Professional, it can no longer be opened in PAC Control Basic.

Saving the Strategy and All Charts

To save all your work quickly, choose File > Save All. The strategy and all modified charts and subroutines are saved.

Saving the Strategy and Some Charts

NOTE: You cannot save changes to a subroutine this way. To save a subroutine, use File > Save All, or use Subroutine > Save or Subroutine > Save All.

1. To change changes to some charts but not others, click the Save Strategy icon on the toolbar (or choose File > Save Strategy, or press Ctrl+S).
   The Save Strategy dialog box appears, highlighting all charts modified since the last save.

2. To save some charts and not others, press Ctrl and then click any charts you don’t want to save. You can also click Select All to select all of the charts, or click Clear All to select none of them.
3. When only the charts you want to save are highlighted, click OK. The strategy and the highlighted charts are saved.

Saving the Strategy to a New Name

1. To save the strategy and all its charts under a new name, choose File > Save Strategy As.
2. In the Save Strategy As dialog box, navigate to where you want the new strategy to be. Create a new folder if necessary. Remember that each strategy must be in its own directory.
3. In the Strategy Name field, enter the new strategy name. Click Save. The strategy and all its charts are saved under the new name in the new directory.

Saving Before Debugging

When you change to Debug mode, you are prompted to save a strategy you have modified. If you don’t want to be prompted to save before entering Debug mode, choose Configure > Options and click to remove the check box for Prompt To Save Strategy Before Running Debugger.

Closing a Strategy

To close a strategy, click the close box in the Strategy Tree or choose File > Close Strategy.

NOTE: Since only one strategy at a time can be open in PAC Control, creating a new strategy or opening an existing strategy automatically closes any current strategy first. If you’ve made changes to the current strategy, you are prompted to save them.

SAVING A STRATEGY TO FLASH

When you finish working on your strategy and have downloaded it, you should save it to the control engine’s flash memory. By default, a strategy is downloaded to the control engine’s RAM. Saving it to flash protects the strategy in case of a power loss. You can save it to flash just once, when needed, or save every time the strategy is downloaded.

Saving to Flash Once

You can save the strategy to flash at any time when you are in Debug mode. To do so, choose Control Engine > Save Strategy to Flash.

Saving to Flash on Every Download

CAUTION: It is possible to wear out flash memory if you save to it many, many times. Use the following steps only when your strategy is finished.

1. When you have finished the strategy and are in Configure mode, choose File > Strategy Options.
2. In the Strategy Options dialog box, click the Download tab. Check Save strategy to flash memory after download.

If a control engine loses power and then restarts, the autorun flag tells the control engine to automatically start running the strategy that is in flash memory. If the autorun flag is not set, the strategy must be started manually after power is restored to the control engine.

3. To have the strategy run automatically after a control engine restarts, check Set autorun flag after download.

4. Click OK.

ARCHIVING STRATEGIES ON THE COMPUTER

Archiving strategies to the computer helps you track changes during development and provides a backup in case of a failure on the control engine.

Archive files are “zip files” (files compressed into one package with a file extension of .zip) and are date and time stamped. Archives are found in the same folder as your strategy. Since a new archive file is created each time you archive a strategy, you are free to manually delete any old archive files you don’t want to keep.

We recommend you archive both to the computer (during strategy development) and to the control engine (when the strategy is completed). Archiving to the control engine as well as the computer makes sure that an older strategy can always be found and updated, even after years pass and personnel changes occur. See also, “Archiving Strategies on the Control Engine” on page 110.

PAC Control offers three ways to archive strategies to the computer:

- To make an archive at any time, choose File > Archive Strategy. A dialog box shows you the name and location of the archive file.
- To have an archive automatically created whenever the strategy is closed, choose File > Strategy Options. In the Strategy Options dialog box, select “Archive strategy to disk when strategy is closed.”
- To have an archive automatically created whenever the strategy is downloaded, choose File > Strategy Options. In the Strategy Options dialog box, select “Archive strategy to disk when strategy is downloaded.”
The archive file name will be in one of the following formats:

<table>
<thead>
<tr>
<th>Archive method</th>
<th>File name format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual archive or archive when strategy is closed</td>
<td>Path\Filename-archive.D02282007.T114351.zip</td>
</tr>
<tr>
<td>Archive on download</td>
<td>Path\Filename-download.D02282007.T114351.zip</td>
</tr>
<tr>
<td>Archive when downloading from online mode</td>
<td>Path\Filename-online.D02282007.T114351.zip</td>
</tr>
</tbody>
</table>

The date stamp (D) is in the format mm/dd/yyyy. In the examples above, the date is February 28, 2007. The time stamp (T) is in the format hh/mm/ss. In the examples above, the time is 51 seconds past 11:43 A.M.

To restore an archived strategy:
1. Locate the archive (zip file) you want to restore. (You can find it in the same folder as the strategy .idb file.)
2. Create a new folder, and then unzip (extract) the archived files to the new folder.
3. From the new folder, double-click the strategy’s .idb file to open the strategy as normal.

**TIP**: To configure a strategy to start running at completion of the strategy download, select the “Start strategy after download completes” check box on the File > Strategy Options > Download tab.

Before your strategy can be tested or run, it must be compiled and then downloaded to a control engine. When a strategy is compiled, all the commands, OptoScript code, charts, and variable and I/O definitions it contains are verified and converted into a format that the control engine can understand. Then the strategy can be sent (downloaded) to a control engine. Only compiled strategies can be downloaded.

**NOTE**: Before you can download your strategy, make sure you have downloaded the latest firmware to your control engine. For instructions, see the controller’s user’s guide.

### Compiling and Downloading in One Step

**NOTE**: If you are using Ethernet link redundancy in PAC Control Professional, make sure you are downloading through the IP address you want to use, either the primary or secondary address. See “Creating Redundant Ethernet Links in PAC Control” on page 100 for more information.

1. With the strategy open in PAC Control, click the Debug mode icon on the toolbar, or choose Mode > Debug.
   Changing to Debug mode automatically saves and compiles the strategy, including all code in OptoScript blocks.
2. If you see a Powerup Clear Expected message, click OK.
A download warning message may appear.

This message tells you that the strategy to be downloaded doesn’t match the strategy already loaded on the control engine, either because it is a different strategy or because it has been changed since the last download.

3. To continue the download, click Yes.

As the strategy is compiled, the Compile Progress dialog box appears. This dialog may appear only briefly. However, if there are errors or warnings, the dialog box will stay open. You can copy the errors and warnings by clicking the right mouse button and selecting Copy All as Text.

If there are errors, the strategy will not compile. Click Close to continue in Configure mode. If there are only warnings, click Close to continue in Debug mode.
If no errors or warnings occur, the Strategy Download dialog box appears.

![Strategy Download](image)

The Strategy Download dialog box will vary somewhat depending on your settings.

**NOTE:** If you are using background downloading (see “Background Downloading” on page 183), while the strategy is downloaded, there may be a very slight degradation in performance. This is due to the overhead on the controller to process the strategy download.

4. (Optional) If there is already an active strategy which is set up to have an alternate strategy, and you want to switch strategies, click Switch & Run to stop the active strategy and run the strategy you just downloaded. Or, you can click Switch to stop the active strategy and make the new strategy the active one (but not yet running).

   Cancel aborts the new download. The controller is left as it was before the download occurs.

When the download is complete, you are in Debug mode. (If you receive errors, see “Types of Errors” on page 383 and “Strategy Problems” on page 376.

After switching strategies, you can switch back to the original strategy by clicking Control Engine > Inspect in Debug mode and use the Switch and Run or Switch button in the Inspect Control Engine dialog box, or you can use PAC Terminal. When the strategy is switched back, the persistent variables are created and compared.

### Switching the Strategy

If there is already an active strategy which is set up to have an alternate strategy (as described in “Background Downloading” on page 183), and you want to switch strategies, do the following:

1. In Debug mode, choose Control Engine > Inspect to open the Inspect Control Engine dialog box.

2. Choose either the Switch and Run or the Switch button.

   The Switch & Run button stops the active strategy and runs the strategy you just downloaded. The Switch button stops the active strategy and makes the new strategy the active one (but not yet running).

When the strategy is switched (as described in the previous steps), the following operations occur:

- Persistent variables are compared. If the type and size of the persistent variable are consistent, the contents are copied. If the type and size do not match, a new persistent variable is created. New persistent variables are initialized to zero and new persistent strings are initialized to NULL (empty) strings.
- I/O unit configurations are compared. If the I/O unit configurations match, I/O will not be initialized.
- The Powerup chart is called.

See also, “Background Downloading” on page 183.
Compiling without Downloading

Sometimes you may want to compile without downloading, just to see if a chart, subroutine, or strategy compiles correctly. You can compile the active chart or subroutine only, just the changes you have made to the strategy, or the entire strategy.

Compiling the Active Chart or Subroutine

Whenever a chart or subroutine window is open and active, you can compile just that chart or subroutine. To do so, in Configure mode, click the Compile Active View icon on the toolbar, or choose Compile > Compile the Active Chart. The menu option shows the name of the chart or subroutine you are compiling.

As soon as you choose the menu option, the chart or subroutine is saved and compiled. You are alerted only if errors are found.

Compiling Changes Only

To compile just the changes since the strategy was last compiled, choose Compile > Compile Changes. The menu option shows the name of the strategy you are compiling.

As soon as you choose the menu option, the strategy and all modified charts and subroutines are saved and compiled. You are alerted only if errors are found.

Compiling the Entire Strategy

To compile the entire strategy including all charts and subroutines, in Configure mode, click the Compile All icon on the toolbar, or choose Compile > Compile All. The menu option shows the name of the strategy you are compiling.

As soon as you choose the menu option, the entire strategy is saved and compiled. The Compile Progress dialog box appears. You are alerted if errors are found.

Downloading Only

If your strategy has been compiled, you can download it again quickly. Downloading again is useful if you want to run your strategy from a clean slate by reinitializing any variables that are set only on a strategy download.

To download a strategy that has already been compiled, you must be in Debug mode. Choose Control Engine > Download Strategy.

The Download to dialog box appears and your strategy is downloaded.

**TIP:** To configure a strategy to start running at completion of the strategy download, select the "Start strategy after download completes" check box on the File > Strategy Options > Download tab.

Background Downloading

The Background Downloading feature allows you to download an updated or alternate strategy to a controller (or processor) while the active strategy currently on the controller continues to run. With two different strategies downloaded to the controller you can switch rapidly from one strategy to the other.

This allows you to:

- Download a new or updated strategy to the controller and then optionally run it. The existing strategy continues to run during the download process until you select the option to switch to the newly downloaded strategy. This minimizes downtime. For larger strategies, downtime is dramatically reduced.
• Download and test a new or updated strategy but still keep the original strategy available. You can switch back the original very quickly by manually switching from one strategy to the other, or—if the original is still stored to flash—by cycling power.

You can use background downloading as an alternative to Online mode, which also allows you to make changes while a strategy is running. The following table describes the differences between Online Mode and Background Downloading:

<table>
<thead>
<tr>
<th></th>
<th>Online Mode</th>
<th>Background Downloading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can you add variables, I/O, and charts?</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Can you add and change blocks, change instructions, and edit existing charts?</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>What is downloaded in Debug mode?</td>
<td>Only the edited charts are downloaded. All other charts keep running.</td>
<td>The entire alternate strategy is downloaded while the entire active strategy continues to run.</td>
</tr>
<tr>
<td>Where does the strategy restart after download?</td>
<td>The affected charts restart at block 0.</td>
<td>If you switch to the alternate strategy after download, the strategy starts with the Powerup chart.</td>
</tr>
<tr>
<td>How is the controller memory affected?</td>
<td>When a chart is downloaded, the old one is not deleted, so this consumes additional memory. To free up memory used by old charts, the strategy should be stopped and then compiled and downloaded.</td>
<td>Controller memory is cut in half when background download is set it in PAC Manager. Also, the number of charts that can run simultaneously is reduced by one.</td>
</tr>
</tbody>
</table>

To enable Background Downloading:

**NOTE:** Controller or processor memory is cut in half when background downloading is enabled. Also, the number of charts that can run simultaneously is reduced by one.

1. Enable the feature in the controller or processor:
   a. For SNAP PAC controllers, start PAC Manager and follow these steps:
      a. Click the Inspect icon to open the Inspect window.
      b. In the Inspect Window’s IP Address field, type the IP address for the SNAP PAC controller.
      c. Click Status Write, then scroll down to Strategy Download Method.
      d. Click the Value field for Strategy Download Method, select Background from the drop-down menu, and then click Apply.
      e. Under Operation Commands, highlight “Store configuration to flash,” and click Send Command.
   b. The configuration is stored to flash memory and a Success message appears. For more information, see the [PAC Manager User’s Guide](#) (form 1704).
   a. For groov EPIC processors, follow these steps:
      a. Log into the groov EPIC processor with an administrator account.
      b. From the groov Manage Home page, click Controller > PAC Controller > Configuration.
      c. Click Background Downloading.
      d. Click Save.
   b. For more information, see the [groov EPIC User’s Guide](#) (form 2267).

2. Restart the control engine:
   a. For SNAP PAC controllers, start PAC Manager and follows these steps:
      a. Click the Inspect icon to open the Inspect window.
      b. In the Inspect Window’s IP Address field, type the IP address for the SNAP PAC controller.
c. Click Status Write.
d. In the Operation section, highlight “Restart Device from powerup” (in the OptoMMP Device sub-section) and click Send Command. The SNAP PAC is restarted.

   – For groov EPIC processors, follow these steps:
   a. Log into the groov EPIC processor with an administrator account.
   b. From the groov Manage Home page, click Controller > PAC Controller.
   c. Click Disable. Click OK on the confirmation prompt.
   d. After the Status is switched to Disabled, click Enable. Click OK on the confirmation prompt.

   – For either a controller or a processor, cycle power.
4. In the Download tab under Background Downloading, select “Use background downloading and fast strategy updating.”
5. (Optional) Under Flash Memory, select “Save strategy to flash memory after download.”
6. (Optional) To have the strategy run automatically after a control engine restarts, select “Set autorun flag after download.”

7. Click OK.

PAC Control is now set to download the strategy in the background when you click the Debug mode icon. Next, see “Compiling and Downloading” on page 180. See also, “Switching the Strategy” on page 182.

**Downloading Without Using PAC Control**

If you are creating strategies for users who do not have PAC Control on their systems (for example, if you are an integrator or OEM), you can make a control engine download file that can be downloaded to a SNAP PAC controller by using either the graphical interface in PAC Terminal or the command line interface with a batch file. This one download file is built for a specific control engine but can also be downloaded to other similar control engines. It contains everything PAC Control would download, including .per, .inc, and .crn files, control engine-specific files, and initialization information.

In most cases you will want the downloaded strategy to be saved to flash memory and to start automatically (autorun) when power is cycled to the control engine. Before you create the download file, follow the steps in
“Saving to Flash on Every Download” on page 178. Check the boxes to have the strategy saved to flash memory after download and to set the autorun flag after download. This information will become part of the download file.

Creating the Control Engine Download (.cdf) File

With the strategy open in PAC Control in Configure mode, right-click the name of the control engine in the Strategy Tree and choose Compile Control Engine Download File from the pop-up menu. (You can also choose Compile > Compile Control Engine Download File.)

The file is created in the same folder as the strategy, with a .cdf extension and a file name consisting of the strategy’s name and the control engine’s name (for example, MyStrategy.MyEngine.cdf).

Once the control engine download file is created, it can be downloaded using either the graphical interface in PAC Terminal or the command line interface with a batch file you create.

Downloading the .cdf File using PAC Terminal

1. Start PAC Terminal:
   - In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 10.3 > Tools > PAC Terminal 10.3.
   - In Windows 10, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.3.
   The PAC Terminal window appears.

2. Right-click the name of the control engine you want to download the file to.
3. In the pop-up menu, choose Download > Control Engine Download File.

4. Enter the path and file name of the .cdf file, or click the Browse button and navigate to it. When the file name appears in the File to Download field, click OK. The file is downloaded to the control engine.

Using Command Lines or a DOS Batch File to Perform PAC Terminal Tasks

If you do not want your end user to have to use PAC Terminal, you can use DOS-level commands or create a DOS batch file to download a .cdf file. In addition to downloading a .cdf file, the DOS commands can also run or stop a strategy, or define the control engine on the PC that will download the file. PAC Terminal must be installed on the PC where the batch file is used.

The following table lists actions you may want to take within PAC Terminal:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Use this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show help information for termcl</td>
<td>-h control_engine_name</td>
</tr>
<tr>
<td>Download the specified file to the specified controller. Compression can be between 0 (none) and 10 (max).</td>
<td>-d control_engine_name filename [-z compression]</td>
</tr>
<tr>
<td>Run the strategy in the specified control engine</td>
<td>-r control_engine_name</td>
</tr>
<tr>
<td>Stop the strategy in the specified control engine</td>
<td>-s control_engine_name</td>
</tr>
<tr>
<td>Send a Forth command to the control engine</td>
<td>-c control_engine_name Forth_command</td>
</tr>
<tr>
<td>Add a control engine definition to the system. Does not modify an existing definition. Example: -a MyCE tcp 10.20.30.40 22001 0 2000</td>
<td>-a control_engine_name tcp ip-addr port retries timeout_ms</td>
</tr>
<tr>
<td>Download the encrypted SSD file to the controller</td>
<td>-dp control_engine_name ssd_filename</td>
</tr>
<tr>
<td>Prevent response messages from printing to the DOS screen</td>
<td>Append the DOS switch -q</td>
</tr>
</tbody>
</table>

This example shows lines included in a batch file that will define the control engine, download the .cdf file to it, and then run the strategy:

```
termcl -a MyCE tcp 10.20.30.40 22001 0 2000
termcl -d MyCE "c:\My_Project\MyStrategy.MyCE.CDF"
termcl -r MyCE
```

Changing Download Compression

If you have a very large strategy, short timeouts, and slow connections on your network, you may need to decrease the compression level to download the strategy successfully. When you decrease compression, the
strategy takes longer to download because it is sent in smaller chunks. If you are having difficulty downloading your strategy, follow these steps to decrease compression:

1. With the strategy open in Configure mode, choose File > Strategy Options.
2. In the Strategy Options dialog box, click the Download tab.

3. Move the slider to the left to reduce compression, and then click OK. You may need to experiment with the setting until the strategy downloads successfully.

RUNNING A STRATEGY MANUALLY

1. With the strategy open, choose Mode > Debug.
2. Click the Run Strategy icon  (or press F5, or select Debug > Run).
   You can also run a strategy from the Inspecting dialog box. See “Inspecting Control Engines in Debug Mode” on page 106.

RUNNING A STRATEGY AUTOMATICALLY (AUTORUN)

You can set the strategy to run automatically (autorun) if the control engine loses power and then restarts. In traditional Opto 22 controllers, the OptoControl autorun function was controlled by a jumper. For PAC Control, it’s controlled by the autorun flag. If the autorun flag is not set, the strategy must be started manually after power is restored to the control engine. The strategy must be saved in flash memory for autorun to work.

You can set the autorun flag in two ways:

- In Configure mode, save the strategy to flash memory and set the autorun flag every time the strategy is downloaded. (Be careful you do not save to flash too often, as flash memory eventually wears out.) See “Saving to Flash on Every Download” on page 178.
- In Debug mode, save the strategy to flash memory by choosing Control Engine > Save Strategy to Flash. Then right-click the control engine in the Strategy Tree and choose Inspect from the pop-up menu. In the
Inspect dialog box, enable Autorun. (See “Inspecting Control Engines and the Message Queue” on page 106 for more on the Inspect dialog box.)

Protecting a Running Strategy

If you want a strategy to run automatically without interruption, you can protect the strategy by disabling all host communications to the control engine.

To protect the strategy, first make sure the strategy is saved to flash and that the autorun flag is set. To disable host communication, start PAC Manager and set the Control Engine port to 0, and then save that change to flash. For more information on setting this port, see the PAC Manager User’s Guide (form 1704).

NOTE: This action also disables communication between PAC Display and the control engine.

STOPPING A STRATEGY

To stop the strategy, click the Stop Strategy icon (or press F3, or select Debug > Stop). You can also stop a strategy from the Inspecting dialog box; see “Inspecting Control Engines in Debug Mode” on page 106.

DEBUGGING

Once the strategy is running, if it doesn’t appear to be working correctly, you can use several tools in Debug mode to figure out what the problem is. You can pause a chart or subroutine; step into, over, or out of each block; watch it slowly step through the blocks; or add a breakpoint to a block to stop the strategy just before it executes that block.

The chart’s or subroutine’s status is shown in the lower left-hand corner of its window. This corner shows whether the chart or subroutine is running, stopped, or suspended, and whether the debugging tools, such as stepping and breakpoints, are in effect. The chart or subroutine must be running in order to use these tools.

Choosing Debug Level

You can choose one of two levels of debugging:

- **Minimal Debug** lets you step from block to block, but does not allow you to step into blocks. Less information is downloaded to the control engine for minimal debugging, so downloading the strategy takes less time and less control engine memory. The strategy also runs slightly faster.

- **Full Debug** lets you step into blocks, so you can step through each instruction in an Action or condition block and through each line of OptoScript code in an OptoScript block. If you are using OptoScript, you will probably want to spend the additional time to download your strategy at the full debug level.

To change debug level, make sure you are in Configure mode. From the Configure menu, choose Minimal Debug or Full Debug. The next time you enter Debug mode, the strategy will be compiled and downloaded with the new level.

Changing Debugger Speed

Before you enter Debug mode, you may want to consider changing debugger speed. Depending on the number of charts and windows open in PAC Control, and depending on other processing your computer is doing at the same time, you may find that running the debugger affects the computer’s or the control engine’s performance of other tasks. If necessary, you can slow down the debugger by increasing the time delay between debugging calls to the control engine, therefore leaving more processing time for other tasks.
In addition, a slower setting may be useful when checking communication using PAC Message Viewer (see page 380).

To change debugger speed, follow these steps:

1. With the strategy in Configure mode, choose Configure > Options. Alternatively, in Debug mode, choose Debug > Options.
2. In the PAC Control Options dialog box, click the Debugger tab.

3. Click and drag the slider to the speed you want.

   The default speed is shown in the figure above. Since performance varies depending on your hardware and software, you may need to experiment to find the most efficient speed.

   If you don’t want the debugger to follow auto stepping, deselect “When stepping, make sure the active block is visible.”

**Pausing a Chart or Subroutine**

You can temporarily stop any running chart or subroutine by pausing it. When you pause a chart or subroutine, it finishes the instruction it was executing, then stops at the next block (in Minimal Debug) or the next line (in Full Debug).

To pause the chart or subroutine in the active window, click the Pause Chart or Pause Subroutine icon, or press F7, or select Debug > Pause Chart or Debug > Pause Subroutine.
Here’s an example of a paused chart:

Hatch marks and a red outline appear on the Start block, indicating that this block is to be executed next. The status bar shows Step On, which means you can step through the chart or subroutine if you wish.

**Stepping Through a Chart or Subroutine**

When you step through a chart or subroutine, you control the timing and execution of its commands in a running strategy. You can see what commands are being executed when, and you can monitor the status of variables and I/O that are affected by the commands.

There are two types of stepping: single-stepping and automatic stepping. Use single stepping to go through flowchart blocks at your own pace. Use auto stepping to watch the flowchart step automatically.

**CAUTION:** Since stepping through a running chart or subroutine—even auto stepping—slows down execution, be cautious if your strategy is running on real equipment. For example, stepping through a strategy might leave a valve open much longer than it should be.

**Single Stepping**

When you are debugging a strategy, start by using the Step Over icon to go through a chart one block at a time. The Step Over icon may be all you need to find any problems. If necessary, go back to Configure mode and change to full debug (see “Choosing Debug Level” on page 189) so you can step into blocks and execute one line at a time.

1. Pause the chart or subroutine to be stepped through by pressing the Pause Chart or Pause Subroutine icon.[1](#)
2. To step to the next command block, click the Step Over icon[2](#) (or press F10, or select Debug > Step Over).

   The commands in the highlighted block are executed, the hatch marks move to the next command block, and the chart pauses again. Compare the chart below to the one on page 190.
The hatch mark has moved to the next block.

3. If you need to step inside flowchart blocks and move through them one command at a time (or in OptoScript blocks, one line of code at a time), make sure you have downloaded your strategy at the full debug level. See "Choosing Debug Level" on page 189 for help.

4. If the chart or subroutine is not already paused, press the Pause Chart or Pause Subroutine icon 🔄.

5. To step inside the block you are on (the one with the hatch marks), click the Step Into icon ⏯ (or press F11, or select Debug > Step Into).

The Step Into button takes you inside the current block, so you can step one command at a time.

6. To move from line to line, click either the Step Into or the Step Over icon.
If a command within the block calls a subroutine, Step Into takes you into the subroutine. Step Over skips over the subroutine.

7. To step from a command inside a block and go to the next block, click Step Out \( \text{F10} \).
   Clicking Step Out when you are on a block, rather than inside it, causes the chart to resume. In a subroutine, clicking Step Out takes you out of the subroutine.

### Auto Stepping

Auto stepping lets you watch a chart’s or a subroutine’s logic in slow motion, one block at a time. A chart or subroutine does not have to be paused before auto stepping can begin. To begin auto stepping, click the Auto Step icon \( \text{F8} \), press F8, or select Debug \( \Rightarrow \) Auto Step Chart.

Step Auto appears in the status bar. The hatch marks move from block to block as each block’s commands are executed. When you reach a block whose code is currently being executed, the highlight around the block becomes changing shades of green instead of solid red (unless the block is executed very quickly).

A chart that contains flow-through logic stops when it has been stepped through. In a chart that contains loop logic, the auto stepping continues until you stop it by pressing the Auto Step icon again.

### Setting and Removing Breakpoints

Sometimes you want to see the action at one or two blocks without having to step through an entire chart or subroutine. You can use a breakpoint to stop a running chart or subroutine just before a block is executed.

You can set a breakpoint at any block in any chart or subroutine, whether it is running or stopped, paused or auto stepped. The strategy does not need to be running. You can set up to 16 breakpoints in one chart or subroutine.

You can also set a breakpoint inside an OptoScript block, but not inside other types of blocks.

To set a breakpoint, follow these steps:
1. With the chart or subroutine open and in Debug mode, click the Breakpoint tool \( \text{F11} \).
   The pointer turns into a hand.
2. To set a breakpoint on a block, click the target block to mark it with the breakpoint hand.
A red square appears around the block and Break On appears in the status bar.

To set a breakpoint within an OptoScript block:

- With the Select tool, double-click the block to open it.
- In the PAC Control toolbar, select the Breakpoint tool, place the palm of the breakpoint hand over the line of code where you want the chart to stop, and then click the left mouse button.

A red dot marks the breakpoint. The chart will stop running before executing the marked line of code.

Note that in an OptoScript block, you can set breakpoints only on lines of code—you can't set a breakpoint on a comment or within a comment block.

3. Click other blocks or OptoScript lines to set additional breakpoints, or click blocks or lines currently marked with a hand to remove the breakpoint. (Make sure that the palm of the breakpoint hand is directly over the line you want to select.)
4. When you have finished marking or removing breakpoints, click the Breakpoint icon again or click the right mouse button within the window.
When the chart or subroutine runs, it pauses just before executing the breakpoint block or line. You can inspect variables or I/O points, disable strategy elements, change values, and try other options to see the effect the block has.

5. To single step past the breakpoint, click the Step Block or Step Line button. Or to run the chart or subroutine at full speed after the breakpoint, click the Pause Chart icon.

Managing Multiple Breakpoints

You can see all the breakpoints you have set, and you can remove breakpoints one at a time or all at once. See also, “Setting and Removing Breakpoints” on page 193 to use the breakpoint tool.

1. Press Ctrl+B or click Debug > Breakpoints.
The Breakpoints dialog box appears, showing all the breakpoints set in the strategy.

2. To delete a breakpoint, highlight it and click Remove. To delete all breakpoints in the strategy at once, click Remove All.
3. When you have finished making changes, click OK.
Interpreting Elapsed Times

As you debug your strategy, you may notice elapsed time readings appearing in a chart’s or subroutine’s status bar, as shown below.

Elapsed time readings can help you determine how much time a chart, a subroutine, or a single block takes to execute. The readings have slightly different meanings depending on what you did to make them appear, as described in the table below:

<table>
<thead>
<tr>
<th>When you...</th>
<th>Elapsed time represents...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run a chart or subroutine and pause it</td>
<td>Time since the chart or subroutine started or was last paused</td>
</tr>
<tr>
<td>Single step (by line or block)</td>
<td>Time to execute the previous block</td>
</tr>
<tr>
<td>Auto step</td>
<td>Time to execute the most recently executed block</td>
</tr>
<tr>
<td>Hit a breakpoint</td>
<td>Time since the last pause, or if the chart or subroutine was not paused, elapsed time since it started running</td>
</tr>
</tbody>
</table>

VIEWING AND PRINTING

You can view and print several helpful things in a strategy as described in the following topics:

- “Viewing Strategy Filename and Path” (below)
- “Viewing an Individual Chart or Subroutine” on page 197
- “Viewing All Charts in a Strategy” on page 197
- “Printing Chart or Subroutine Graphics” on page 198
- “Viewing and Printing Strategy or Subroutine Commands” on page 200
- “Viewing and Printing Strategy or Subroutine Elements” on page 201
- “Viewing and Printing a Cross Reference” on page 202
- “Viewing and Printing a Bill of Materials” on page 202
• “Viewing and Printing I/O Point Mappings” on page 203

For information on viewing and changing I/O units, see “Inspecting, Monitoring, and Changing I/O in Debug Mode” on page 153. For variables, see “Viewing Variables in Debug Mode” on page 244.

Viewing Strategy Filename and Path

To see an open strategy’s file name and path, choose File > Strategy Information. A dialog box appears showing the path and file name.

Viewing an Individual Chart or Subroutine

To view an individual chart or subroutine, double-click its name on the Strategy Tree, or choose Chart > Open or Subroutine > Open. You can open as many of these windows as you need. The names of open windows appear on tabs at the bottom of the PAC Control main window. Click a tab to bring its window into view.

Viewing All Charts in a Strategy

You can see the status of all charts at once and change a chart’s status without having to open it.

1. Make sure the strategy is open and in Debug mode. On the Strategy Tree, double-click the Charts folder. The View Chart Status dialog box appears, showing every chart in the strategy:

   ![View Chart Status dialog box]

2. To change the status of a chart, double-click the chart name. The View Chart dialog box appears, showing the chart name, chart status, run mode, and breakpoint status. If the chart is paused (mode is Step On), the block at which it is paused is shown in the Paused At field. In the figure below, the chart is not paused:

   ![View Chart dialog box]

   The title bar shows whether scanning is occurring. Scanning stops when you click one of the changeable fields (Status, Mode, and Breakpoints) and resumes once you click Apply, another button, or one of the other fields. If scanning resumes before you click Apply, any changes you made are lost.

3. To stop, run, or suspend a chart, click an arrow in the Status field to select the option. Click Apply.
4. To turn pausing on or off, click an arrow in the Mode field to select Step On or Step Off. Click Apply.
5. To observe or ignore any breakpoints set in the chart, click an arrow in the Breakpoints field to select Break On or Break Off. Click Apply.
   This action does not clear or set breakpoints, but just determines whether the chart stops at breakpoints when it is running.
   Chart changes occur as soon as you click Apply.
6. To add the chart to a watch window so you can monitor it with other strategy elements, click Add Watch.
   In the dialog box, choose what to watch. Select an existing watch window to add this chart to, or create a new watch window.
   See “Using Watch Windows for Monitoring” on page 170 for more information on watch windows.
7. When you have finished making changes, click Close to return to the View Chart Status dialog box.

**Printing Chart or Subroutine Graphics**

You can print a chart or subroutine just as it appears on screen. You can also print all charts within a strategy. When printing a single chart or subroutine, you can preview the image to make sure it’s what you want before you print it.

*NOTE: If you have trouble printing graphics, set your printer for PostScript emulation.*

**Setting Up the Page**

Before printing graphics, you should verify your page setup, which determines how each graphic appears on a page.
1. In Configure mode, select File > Page Setup.
   The Page Setup dialog box appears.

![Flowchart Graphics - Page Setup dialog box](image)

2. In the Graphics Scaling area, choose whether you want each flowchart to print at a fixed percentage of normal size or to span a specific number of pages.
   - To print at a fixed percentage, click the Adjust To option and specify any scaling from one percent to 1,000 percent.
     You can type in a number or click the arrows to go up or down to the next increment of 25 percent.
     Typically, percentages between 50 percent and 200 percent work the best.
   - To print to a specific number of pages, click the Fit To option and select the number of pages wide and tall you would like each chart to print.
     If you choose one for each dimension, each chart prints to a single page. For each dimension, you can specify any integer between one and 255, but be careful. Selecting values of five and five, for example, would cause each chart to print five pages wide and five pages long, a total of 25 pages.
3. (Recommended) To print a header on each page, put a check mark in the Print Header box.
CHAPTER 7: WORKING WITH STRATEGIES

The header lists the strategy name, chart or subroutine name, date and time of printing, page number, and column and row of the page with respect to the full chart printout.

4. Click OK to save your settings.

Previewing a Flowchart Printout

1. To see how a chart or subroutine will print before actually printing it, open the chart or subroutine window.
2. From the Chart or Subroutine menu, select Print Preview Graphics.
   The preview window appears, showing the image as it will print. The cursor becomes a magnifying glass.

   3. To zoom in at 200 percent, click where you want to see more closely. Click again to zoom in at 400 percent. Click a third time to return to 100 percent view.

   You can also use the Zoom In and Zoom Out buttons at the top of the window to zoom in or out with respect to the top left corner of the image.

   4. If the image spans more than one page, click the Next Page or Prev Page buttons to view the next or previous page. To switch between a single-page view and a double-page view, click the Two Page/One Page button.

   5. To print, click the Print icon to open the standard Windows Print dialog box. To change settings before printing, click Close and see “Setting Up the Page” on page 198.

Printing One Chart or Subroutine

1. To print one chart or subroutine, open its window.
2. From the Chart or Subroutine menu, select Print Graphics.
3. In the standard Windows Print dialog box, do one of the following:
   – To print to a printer, select the printer, page range, and number of copies. Click OK.
   – To print to a file, select Print to file and click OK. In the dialog box, type the file name and location.
Printing All Charts in a Strategy

**CAUTION:** You can print all charts included in a strategy, but be sure that’s what you want to do before you begin. You cannot cancel once printing has started.

1. To print all charts within a strategy, open the strategy and check the page setup. For help, see “Setting Up the Page” on page 198.
2. Select File > Print All Graphics.
   Printing begins immediately; no Print dialog box appears. Messages inform you of each chart’s printing progress. To skip printing a particular chart, click Cancel when its message appears.

Viewing and Printing Strategy or Subroutine Commands

You must be in Configure mode to view and print commands.

1. To view all commands (instructions) in a chart or subroutine, open its window and select View/Print Instructions from the Chart or Subroutine menu. Choose whether to sort instructions by block name or block ID number.
2. To view all instructions in an entire strategy, select File > View/Print > All Chart Instructions.
   **NOTE:** Subroutine instructions are not included; you can print them separately.

   PAC Control processes the information and displays it in the Instructions window. You may need to resize the window and use the scroll bar to see all the data. Blocks and their instructions are listed in alphabetical or ID number order by type of block: action blocks first, then OptoScript blocks, then condition blocks, and finally continue blocks.

3. To print the data, click the Print icon on the toolbar. To save it to a text file, click the Save icon. To search the data, click the Search icon. When finished, close the window.
Viewing and Printing Strategy or Subroutine Elements

You must be in Configure mode.

1. To view a summary of I/O elements and variables configured in a strategy, select File > View/Print > Database.

2. To view the same summary for a subroutine, open the subroutine window and select Subroutine > View/Print > Database. The View/Print Database dialog box appears.

3. Make sure all element types you want to include are checked. Click to uncheck any elements you do not want.

4. To include descriptive comments associated with the elements, click to put a check mark next to Descriptions.

5. Click OK.

PAC Control processes the database and puts the data in the Database window.
You may need to resize the window and use the scroll bar to see all the data. For each element the name and reference count (that is, how many times the element is used in strategy commands) are shown, plus other information depending on the element type. The figure above shows numeric variables and communication handles.

6. To print the data, click the Print icon on the toolbar. To save it to a text file, click the Save icon. To search the data, click the Search icon. When finished, close the window.

**Viewing and Printing a Cross Reference**

You can view and print a report of every operand in your strategy or subroutine—charts, I/O units, analog points, digital points, communication handles, numeric variables, string variables, pointer variables, numeric tables, string tables, and pointer tables. The operands are cross-referenced to the charts, blocks, and instructions in which they are used.

1. To produce a cross reference for a strategy, open it and select File > View/Print > Cross Reference.
2. To view a similar report for a subroutine, open the subroutine window and select Subroutine > View/Print > Cross Reference.

PAC Control processes the data and puts it in the Cross Reference window.

![Cross Reference Window](image)

You may need to resize the window and use the scroll bar to see all the data. Notice that the Instruction column (at right) shows the line number the operand appears in when it is in OptoScript code.

3. To print the data, click the Print icon on the toolbar. To save it to a text file, click the Save icon. To search the data, click the Search icon. When finished, close the window.

**Viewing and Printing a Bill of Materials**

You can view and print a bill of materials (BOM) that lists all the I/O units and I/O modules (analog and standard digital) required to run the strategy. (Special-purpose modules, such as serial and high-density digital modules, are not included in the BOM.)

1. To produce a BOM for a strategy, open it and select File > View/Print > Bill of Materials.
PAC Control processes the data and puts it in the Bill of Materials window.

You may need to resize the window and use the scroll bar to see all the data.

2. To print the data, click the Print icon on the toolbar. To save it to a text file, click the Save icon. To search the data, click the Search icon. When finished, close the window.

**Viewing and Printing I/O Point Mappings**

You can view and print a report that shows the location and mappings of I/O points. You can use this report as a look-up table for programming purposes. This can be useful with some commands that use different point mappings such as Move I/O Unit to Numeric Table Ex, Move Numeric Table to I/O Unit Ex, and IVAL Move Numeric Table to I/O Unit Ex.

This report basically provides the same information provided in “Table Index Offset Examples,” in the PAC Control Command Reference (form 1701) but for the actual points in the strategy.

1. To produce an I/O point mappings report for a strategy, open the strategy and select File > View/Print > I/O Point Mappings.
On the View/Print I/O Point Mappings dialog box, select the report style, either Formatted or Comma-separated, and select the position and mappings types, then click OK. A report window appears.

What the columns mean:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOD</td>
<td>The module number on the rack</td>
</tr>
<tr>
<td>CH</td>
<td>The channel number within the module</td>
</tr>
<tr>
<td>4</td>
<td>4-channel mapping</td>
</tr>
<tr>
<td>8</td>
<td>8-channel mapping</td>
</tr>
<tr>
<td>16</td>
<td>16-channel mapping</td>
</tr>
<tr>
<td>32</td>
<td>32-channel mapping</td>
</tr>
</tbody>
</table>

SEARCHING AND REPLACING

You can search a chart, subroutine, or strategy for missing connections, empty condition blocks, or any command or operand. An operand is anything that can be affected by a command, including charts, I/O units, analog points, digital points, and all kinds of variables. Searching includes OptoScript code within OptoScript blocks.

You can also replace instructions or operands with similar items.

Searching

You can search a strategy or one of its charts, or you can search a subroutine.

1. Open the strategy or subroutine and select Edit > Find.
The Find dialog box appears.

![Find dialog box](image)

Also, if the item you want to find is listed in the strategy tree (such as a variable, table, or point), you can right-click the item and select Find in the pop-up menu.

![Strategy tree with Find option highlighted](image)

The item appears in the Find dialog box automatically.

2. Under Search Scope, to search the entire strategy, click Global. To search one chart only, click Local and choose the chart name from the drop-down list.

   If you are searching a subroutine, the search is Local and the subroutine’s name is shown.

3. Under Search For, choose one of the following:
   - To search for a chart, I/O unit, analog or digital point, variable, table, timer, PID loop, pointer, counter, or communication handle, click Operand. In the Type and Name fields, choose the operand you want from the drop-down list.
   - To search for an instruction, click Instruction. Click Action or Condition, and choose the instruction you want from the drop-down list.
   - To search for blocks that are not connected to other blocks, click Missing Connections.
   - To search for condition blocks that have no instructions, click Empty Cond. Blocks.

4. Click Find.
The dialog box expands and the search results appear at the bottom.

For more information on any item in the search results, try double-clicking the item.

5. To save the search results to a file or to print them, click Print. In the window that opens, click the Save icon to save or the Print icon to print your search results.

6. When you have finished your search, close the Find dialog box.

Replacing

You can also replace any operand, instruction, or tag with a similar item. As in searching, you can replace items in a strategy or one of its charts, or you can replace items in a subroutine.

1. Open the strategy or subroutine, and select Edit > Replace.

The Find and Replace dialog box appears.
Or, if the item you want to find is listed in the strategy tree, such as a variable, table, or point, right-click the item and select Replace in the pop-up menu.

The item appears in the Find and Replace dialog box automatically.

2. Under Search Scope, to search the entire strategy, click Global. To search one chart only, click Local and choose the chart name from the drop-down list. If you are searching a subroutine, the search is Local and the subroutine’s name is shown.

3. Under Search For, choose one of the following:
   - To search for a chart, an I/O unit or point, or a variable, click Operand. In the Find Type and Name fields, choose the operand you want to replace from the drop-down list. In the Replace With Type and Name fields, choose the operand you want to use instead.
   - To search for an instruction, click Instruction. Click Action or Condition, and choose the instruction you want to replace from the Find drop-down list. In the Replace With drop-down list, choose the instruction you want to use instead.
   - To search for a substring within tag names, click Tag. In the “Find what” text box under Substrings, enter the substring you want to replace. In the “Replace with” text box, enter the replacement text. For example, if you have several tag names that contain the substring, “Generic,” such as `nGenericCount`, `fGenericTemperature`, and `diGenericInput`, you could replace “Generic” with “Station1,” and the tagnames would become `nStation1Count`, `fStation1Temperature`, and `diStation1Input`.

4. Click Find Next. When the first occurrence of the operand or instruction is found, the Instructions dialog box it appears in is displayed.

5. To replace this occurrence, click Replace. To skip it and find the next one, click Find Next. If you are replacing operands, you can replace all occurrences at once by clicking Replace All. If you are replacing instructions, you must verify each one.
6. If the Edit Instructions dialog box appears, make any necessary changes and click OK to save them before moving on.

7. When replacements are finished, close the Find and Replace dialog box.

**LEGACY OPTIONS**

The term *legacy product* refers to a hardware or software product originally designed to work with pre-SNAP PAC systems. For example, brains that were designed for *mistic* or Optomux® systems are legacy products. Controllers designed to run FactoryFloor or ioProject software (and not capable of running PAC Project software) are also legacy products. FactoryFloor and ioProject are legacy products, too. Legacy products are listed in the SNAP PAC System Migration technical note (form 1688), available on the Opto 22 website.

When you create a new strategy, PAC Control by default shows only SNAP PAC I/O units and the commands used with them. When you’re using the SNAP PAC system only, hiding legacy I/O units and commands makes it simpler and less confusing to build your strategy. However, if you’re using legacy hardware, you can configure PAC Control to display legacy options in the strategy. For details, see “Enabling Legacy Options” on page 209.

**NOTE:** If you enable legacy I/O units and commands in PAC Control, see the legacy versions of the PAC Control guides for information on how to use them:

- The PAC Control Command Reference, Legacy Edition (form 1711)
- The PAC Control Command Quick Reference (form 1713)

**Existing Strategies**

When you open an existing ioControl strategy in PAC Control, either Basic or Professional, PAC Control will automatically show the I/O units and commands appropriate to that strategy.

For example, if you have been using SNAP Ultimate I/O, SNAP Ultimate I/O units will be visible in the strategy. In addition, commands used with SNAP Ultimate I/O but which are now deprecated (obsolete) because they are not needed with SNAP PACs are also available.

Similarly, if you open an existing strategy that contains *mistic* serial I/O units, all the *mistic* I/O unit types and commands—such as event/reaction and *mistic* PID commands—are automatically shown.

**New Strategies**

When you create a new strategy in PAC Control, either Basic or Professional, the strategy will show only the SNAP PAC System. This means:

- When you use a command such as Get I/O Unit as Binary Value, the only I/O units shown for Argument 1 will be SNAP PAC I/O units (SNAP-PAC-R1, SNAP-PAC-R1-B, SNAP-PAC-R2, SNAP-PAC-EB1, SNAP-PAC-EB2, SNAP-PAC-SB1, and SNAP-PAC-SB2).
- Commands that are used only with legacy hardware (such as Enable Communication to Mistic PID Loop or Get All HDD Module Off-Latches) won’t be listed.

Since some Opto 22 customers work with multiple systems, legacy options can be set individually for each strategy or subroutine. If you are using legacy hardware, you can choose the options that apply to each strategy you’re working with, without affecting other strategies.

**IMPORTANT:** Once you have enabled a legacy option for a specific strategy or subroutine, you cannot disable it later for the same strategy or subroutine.
Enabling Legacy Options

Here’s how to set legacy options:
1. In PAC Control, open the strategy or subroutine for which you want to change options.
2. Choose File > Strategy Options. Click the Legacy tab.
   Depending on the hardware you’re using, you can set one or more of the following options:
   – Enable Ethernet, Ultimate, and Simple I/O units and commands (see page 209).
   – Enable high-density digital commands (see page 209).
   – (Pro only) Enable mistic I/O units and commands (see page 209).
3. Click the option you want to enable. At the confirmation dialog box, make sure it is correct, and then click Yes. Repeat to enable other options.
   The options are changed for the strategy or subroutine.

Enable Ethernet, Ultimate, and Simple I/O Units and Commands

If you’re using any of the I/O unit types shown in the following table, you should enable Ethernet, Ultimate, and Simple I/O units and commands. When you do, both the I/O unit types and the commands shown in the table will become available in the strategy.

<table>
<thead>
<tr>
<th>I/O Unit Types</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNAP-ENET-D64</td>
<td>IVAL Set Digital-64 I/O Unit from MOMO Masks [DEPRECATED]</td>
</tr>
<tr>
<td>SNAP-B3000-ENET</td>
<td>IVAL Set Mixed 64 I/O Unit from MOMO Masks [DEPRECATED]</td>
</tr>
<tr>
<td>SNAP-ENET-RTC</td>
<td>IVAL Set Mixed 64 I/O Unit from MOMO Masks [DEPRECATED]</td>
</tr>
<tr>
<td>SNAP-UP1-D64</td>
<td>IVAL Set Simple 64 I/O Unit from MOMO Masks [DEPRECATED]</td>
</tr>
<tr>
<td>SNAP-UP1-ADS</td>
<td>Set Digital-64 I/O Unit from MOMO Masks [DEPRECATED]</td>
</tr>
<tr>
<td>SNAP-UP1-M64</td>
<td>Set Mixed 64 I/O Unit from MOMO Masks [DEPRECATED]</td>
</tr>
<tr>
<td>SNAP-ENET-S64</td>
<td>Set Mixed I/O Unit from MOMO Masks [DEPRECATED]</td>
</tr>
<tr>
<td></td>
<td>Set Simple 64 I/O Unit from MOMO Masks [DEPRECATED]</td>
</tr>
</tbody>
</table>

Enable High-Density Digital Module Commands

All SNAP high-density digital modules are fully supported by the SNAP PAC System using regular digital point commands. However, three of our older HDD modules can also be used with analog-capable SNAP Ultimate, SNAP Ethernet, and SNAP Simple I/O units, if you use the older “legacy” HDD commands.

If you are using SNAP-ODC-32-SNK, SNAP-ODC-32-SRC, or SNAP-IDC-32 HDD modules with these older I/O units, you should enable High-Density Digital module commands. When you do, the following commands become available in the strategy:

<table>
<thead>
<tr>
<th>Commands</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear HDD Module Off-Latches</td>
<td>Get All HDD Module On-Latches</td>
</tr>
<tr>
<td>Get &amp; Clear All HDD Module Off-Latches</td>
<td>Get HDD Module Counters</td>
</tr>
<tr>
<td>Get &amp; Clear All HDD Module On-Latches</td>
<td>Get HDD Module Off-Latches</td>
</tr>
<tr>
<td>Get &amp; Clear HDD Module Counter</td>
<td>Get HDD Module On-Latches</td>
</tr>
<tr>
<td>Get &amp; Clear HDD Module Counters</td>
<td>Get HDD Module States</td>
</tr>
<tr>
<td>Get &amp; Clear HDD Module Off-Latches</td>
<td>Set HDD Module from MOMO Masks</td>
</tr>
<tr>
<td>Get &amp; Clear HDD Module On-Latches</td>
<td>Turn Off HDD Module Point</td>
</tr>
<tr>
<td>Get All HDD Module Off-Latches</td>
<td>Turn On HDD Module Point</td>
</tr>
</tbody>
</table>

Enable mistic I/O Units and Commands

If you’re using legacy mistic hardware with a SNAP PAC S-series controller and PAC Control Professional, you should enable mistic I/O units and commands. When you do, the following I/O unit types and commands will become available in the strategy.
Very few applications require changes to the “Advanced” options, which involve adding and changing variables and points in the strategy. However, these options can be useful for strategies with a very large number of charts.

Three options are available. Unless you are certain you need these options, do not select them.
1. To see the options, choose Configure > Options. Click the Advanced tab. By default, these options are not selected:

![PAC Control Options](image)

2. If you are sure you require one or more options, choose the one(s) you need.
   - **When adding Points and Variables, do not check OptoScript blocks**: If you check this box, when you add a point or variable, OptoScript blocks will not be searched to see if it is already being used in the block. That makes it faster to add points and variables in a strategy that has a large number of charts. However, reference counts are not updated during this process. When you have finished adding all the points and variables, choose Tools > Regenerate Reference Counts.
   - **When renaming Points and Variables, do not update OptoScript blocks**: If you check this box, you can rename a variable or point in the Strategy Tree, and it will not be renamed in any OptoScript block. Renaming points and variables is faster in a strategy with a large number of charts that have no OptoScript blocks; but if any renamed items exist in OptoScript blocks, the strategy will not compile. You will have to manually edit those OptoScript blocks.
   - **Allow Points and Variables with references to be deleted**: Use this feature on variables or points that are used only in OptoScript blocks. If the variable or point is used in an Action or Condition block, the strategy will not compile.

**NOTE**: If you want to delete a variable or point that shows a reference count greater than zero, but it is not being used in the strategy, don’t use this advanced option. Instead, choose Tools > Regenerate Reference Counts to recalculate all reference counts. Then you will be able to delete the variable or point.
8: Working with Flowcharts

INTRODUCTION

This chapter shows you how to work with flowcharts, the building blocks of your strategy. When you create a new strategy, one chart is created for you: the Powerup Chart. You must create all the other charts to do the work of the strategy.

In This Chapter
Creating a New Chart .............................................................. page 213
Working with Chart Elements .................................................. page 214
Opening, Saving, and Closing Charts ....................................... page 223
Copying, Renaming, and Deleting Charts ................................. page 224
Printing Charts ........................................................................ page 225
Exporting and Importing Charts ................................................ page 225

CREATING A NEW CHART

1. With your strategy open and in Configure mode, select Chart > New, or right-click the Charts folder on the Strategy Tree and select New from the pop-up menu.
   The Add New Chart dialog box appears.

2. Enter a name for the new chart.
   The name must start with a letter, but may also include numbers and underscores. If you type spaces, they are converted to underscores. All other characters are ignored.
3. (Optional) Type a description.
4. Click OK.

The new chart is listed on the Strategy Tree under the Charts folder, and the new chart window appears. Block 0, the starting block, is shown automatically. No matter how many other blocks you add or where you place them, block 0 is always the first block to be executed in the chart.

!!!NOTE!! Because chart windows show a small portion of a potentially large chart, a small movement with the scroll bar can mean a big change in what you see. If you lose your flowchart in the window, select View > Center on Block and choose the block you want to see in the middle of the screen. Or just right-click inside the flowchart and choose Center on Block from the popup menu.

WORKING WITH CHART ELEMENTS

Chart Components

Charts can contain five kinds of flowchart blocks, lines connecting the blocks, and text.

**Action Blocks** are rectangles that contain one or more commands (instructions) that do the work of the strategy, such as turning things on or off, setting variables, and so on. See "9: Using Variables and Commands" for more information. Action blocks can have more than one entrance but only one exit.

**Condition Blocks** are diamonds containing questions that control the logical flow of a strategy. Condition blocks can have many entrances, but only two exits: True and False.

**OptoScript Blocks** are hexagons containing OptoScript code, a procedural language you may want to use to simplify certain tasks. See "11: Using OptoScript" for more information. OptoScript blocks can have more than one entrance but only one exit.

**Continue Blocks** are ovals that contain no commands, but simply route chart logic to a new location, such as to the top of a chart. These blocks help keep charts neat by avoiding awkward connections between two blocks that are far apart.

**Sync Blocks** are used in charts that control systems with controller redundancy. When a sync block is encountered, the redundant controllers are synchronized. For more information, see the SNAP PAC Redundancy Option User’s Guide (form 1831).

**Connections** are lines with arrows that connect one block to the next, directing the flow of strategy logic.
Text explains the chart’s purpose and elements for anyone who needs to understand them later.

Using the Drawing Toolbar

The drawing toolbar includes tools for each of the elements plus a Select tool, or pointer, for manipulating elements:

Changing the Appearance of Elements in a Chart Window

You can change the background appearance of charts or subroutines, the color and size of blocks and text, and the color of connection lines. Depending on the scope you want to affect, you can change these window properties at three levels:

- Across PAC Control—to change the appearance of all new charts in all new strategies, and all new subroutines.
- Across a strategy—to change the appearance of all new charts in the open strategy.
- For the open chart or subroutine—to change the appearance of all new elements in the open chart or subroutine window.

IMPORTANT: Note that most changes affect only new charts and their elements. Existing charts, subroutines, and elements are not changed. To avoid having to go back and change each item individually, make sure you set the defaults the way you want them before you create new charts. Once you have changed the defaults, see “Changing Existing Elements to Match New Defaults” on page 217 to change existing elements to match the new defaults.

To change the appearance of charts and elements, follow these steps:

1. Choose one of the following, depending on the scope you want to change:
   - To change all new charts in all new strategies and all new subroutines, choose Configure > Default Properties to open the Configure PAC Control Default Properties dialog box.
   - To change all new charts in the open strategy only, choose File > Strategy Properties to open the Configure Strategy Properties dialog box.
   - To change new elements in the open chart or subroutine only, choose Chart > Properties or Subroutine > Properties to open the Configure Chart Properties or Configure Subroutine Properties dialog box.

   The dialog box that opens looks like this, except that its title may be different.

2. Complete the fields as described in “Configure Chart Properties Dialog Box” below.

3. When you have made all the changes, click OK.
Configure Chart Properties Dialog Box

**A—Flowchart Properties.** Specify general chart display in this area. To apply these changes to existing charts as well as to new ones, click All charts in D.

- To change the chart background color from the default of white, click the Background Color box. Choose a new color from the Color dialog box.
- To change the chart’s grid color from the default of black, click the Grid Color box.
- The grid and block ID numbers are displayed by default. To remove them, click Display Grid or Display Block ID’s to remove the check mark.
- To enable or disable smooth scrolling in a flowchart, click Smooth Scrolling; this option is disabled by default.

**B—Action Block Parameters.** Define the appearance of action blocks, condition blocks, OptoScript blocks, and continue blocks in this area. These changes affect new blocks only, not existing blocks. (To change existing blocks, see “Changing Existing Elements to Match New Defaults” below.)

- In the Width and Height fields, type the block size in pixels. For action and continue blocks, the default width is 96 and the default height is 48; the minimum parameters are 48 (width) and 32 (height). For condition blocks, the default height is 64. (Note that the numbers you enter are rounded down to be evenly divisible by 16; for example, if you enter 81, click OK and then reopen the dialog box, the parameter reads 80.)
- To change the color of the blocks from the default, click the Color box.
- To change block name text formatting, click the Font box. In the Font dialog box, change the font, font style, size, effects, and color. The default font is black 10-point Arial bold.
- To change text alignment, right-click the Font box and choose left, center, or right from the pop-up menu.
- To change the color of connection lines, click a Connection line at the far right. Choose the new color from the Color dialog box.
**C—Text.** Define width, height, and font of text blocks that appear as comments in a chart or subroutine. Default width is 192; default height is 128; the minimum for both is 16. The default font is black 10-point Arial bold.

**D—Also Apply To.** To expand the scope of the changes you've made, click these boxes. Click PAC Control to apply the changes to all new strategies and subroutines in PAC Control. Click Strategy to apply the changes to all new charts in the current strategy. Click All Charts to apply the changes to all new charts and all new graphic objects added to the current strategy.

Depending on which dialog box you are in and what is currently open, one or more of these options may be grayed out. For example, if you are in the Configure PAC Control Default Properties dialog box, it is assumed that the changes are to be applied throughout PAC Control, and that option is therefore grayed out.

**E—Reset All.** To reset all parameters and options to their factory default settings, click Reset All.

### Changing Existing Elements to Match New Defaults

Once you have changed the defaults for the way elements appear in a chart, you can update existing blocks, connections, and text to match.

**CAUTION:** When you update existing objects to match, you cannot undo the update.

1. Right-click an empty space in the chart whose elements you want to change. Choose Select from the pop-up menu. From the sub-menu, choose the item type you want. For example, to select all action blocks, choose Select > Action Blocks.
2. Right-click again in the chart, and choose Properties > Copy from Default from the pop-up menu. The color, size, and font of all selected items change to match the flowchart defaults.

### Drawing Blocks

Action, condition, OptoScript, and continue blocks are all drawn the same way.

1. With the chart open and the strategy in Configure or Online mode, click the tool you want to use.
   - for an action block
   - for a condition block
   - for an OptoScript block
   - for a continue block.

   As you move the mouse into the window, you see an outline representing the block.

2. Click where you want to place the block.
The new block appears.

3. Click in another location to place other blocks of the same type. When you have finished using the tool, click the right mouse button, click another tool in the toolbar, or press Esc.

**Naming Blocks**

1. With the chart open and the strategy in Configure or Online mode, click the Select tool and click the block to select it.
   Right-click the block and choose Name from the pop-up menu.

   ![Name Block dialog box](image)

2. In the Name Block dialog box, type the name and click OK.

**Renaming Blocks**

1. With the chart open and the strategy in Configure or Online mode, click the Select tool and click the block to select it.
2. Right-click the block and choose Name from the pop-up menu.
3. In the Name Block dialog box, change the name. Click OK.

**Connecting Blocks**

To connect blocks, start with the chart open and the strategy in Configure or Online mode. Remember that action blocks and OptoScript blocks have only one exit, and condition blocks have two.
Action Blocks and OptoScript Blocks

1. To connect an action block or an OptoScript block to the next block in a program sequence, click the Connect tool.

2. First click the source block and then click the destination block. Although you can click anywhere inside the blocks to make a connection, the connection is attached at the side closest to where you clicked. In the figure below, Block 0 is the source block and Block 1 is the destination block:

To keep your charts neat, try to draw the most direct connections possible. To do so, after clicking the source block, move your cursor out of the block at a point closest to its destination.

3. To create a bend or elbow in a connection, click wherever you want the bend while drawing the connection.

For example, to draw the connection in the following figure, we selected the Connect tool, clicked Block 0, moved the cursor out of the block to the right, clicked at point A, clicked again at point B, and then clicked the right side of Block 1:
4. While you’re still drawing a line, to delete an elbow you don’t want, click the right mouse button once to undo it.
   If you created several elbows, you can eliminate them in reverse order with repeated right mouse clicks. If no more elbows remain and you right-click again, you delete the connection. Once you have completed a connection, however, you cannot undo it this way.

Condition Blocks
1. To connect a condition block to the next block in a program sequence, click the Connect tool.
2. Click the source block.
3. Indicate whether you are drawing the True connection or the False connection, and then click OK.
4. Click the destination block you chose (True or False). The connection is labeled T or F depending on its type.
5. Draw another connection to the second destination block. It is labeled the opposite exit type.
   For example, the following figure shows the True and False connections from the condition block, Block 1. If the conditions in Block 1 are true, Block 2 is executed next. If the conditions in Block 1 are false, Block 0 is executed next:

Adding Text
One of the best places to put comments about a strategy is directly on its flowcharts. Start with the chart open and the strategy in Configure or Online mode.
1. To add text to a chart, click the Text tool. When you move the mouse onto the chart, a rectangle representing the text area appears.
2. Click the mouse button and type your comments. If you type in more text than the text frame holds, it expands in length.
3. When you have finished typing, click anywhere on the chart outside the text frame.
CHAPTER 8: WORKING WITH FLOWCHARTS

The frame becomes invisible, and only the text appears. To change the size or shape of the text block, see “Resizing Blocks or Text Blocks” on page 223.

4. Click in another location to create another text frame, or release the tool by right-clicking in the chart or choosing another tool from the toolbar.

Editing Text
1. With the chart open and the strategy in Configure or Online mode, click the Select tool.
2. Double-click the text block you want to change.
   A blinking cursor appears at the beginning of the text.
3. Change the text as needed.
   You can use any standard Windows Ctrl key combinations when editing, including Ctrl+arrow keys and Ctrl+Home or End for navigation. You can also use Ctrl+X (cut), Ctrl+C (copy), and Ctrl+V (paste).
4. When you have finished changing text, click outside the text frame.
   The text block stays the same width but changes length to accommodate additional or deleted text. To change the size or shape of the text block, see “Resizing Blocks or Text Blocks” on page 223.

Selecting Elements

Before you can manipulate most elements, you need to select them. Start with the chart open and the strategy in Configure or Online mode.

1. Click the Select tool.
2. To select an action, OptoScript, condition, continue, or text block, click the block.
   Handles appear around the block:

3. To select a connection, click it.
   Handles appear at the elbows and end points of the connection:

4. To select all connections entering or exiting a block, click the block, click the right mouse button, and choose Select Connections from the pop-up menu.
5. To select more than one element, do one of the following:
   – Select the first element, hold down the Shift key, and select additional elements.
   – Click and drag the mouse to draw a rectangle completely around the elements you want to select.
   – To select all items of the same type, right-click anywhere in the window and choose Select from the pop-up menu. From the sub-menu, choose the item type you want.

Moving Elements

1. With the chart open and the strategy in Configure or Online mode, click the Select tool.
2. To move any action, OptoScript, condition, continue, or text block, click it. Then click and hold the mouse button anywhere on the selected item except on its handles, and drag it to the position you want. You can also use the arrow keys on your keyboard to move a block in any direction. Note that when you move a block, any connections attached to it also move.

3. To move a connection, click it. Then click and drag any handle in any direction. You can also move an end point from one block to another, as long as the result is a valid connection. A disallowed move is ignored.

4. To move several elements at once, select them, and then click and drag them. If elements end up stacked on top of each other, you may need to change their z-order before you can move them. See the following section.

Moving Elements in Front of or Behind Other Elements (Changing Z-Order)

If elements are stacked on top of each other, you can select only the one in front. To change their position (z-order), follow these steps:

1. Click the element to select it.

2. Right-click the element. From the pop-up menu, choose Z-order. From the sub-menu, choose the action you want to take:
   - Bring Forward—moves the element one position closer to the front.
   - Bring To Front—moves it all the way to the front.
   - Send Backward—moves the element one position closer to the back.
   - Send To Back—moves it all the way to the back.

Cutting, Copying, and Pasting Elements

You can cut, copy, and paste most chart or subroutine elements. Cut or copied elements are placed on the Windows Clipboard, and they can be pasted in the same chart or subroutine, in a different chart or subroutine, or in a different strategy.

A connection can be cut or copied, but it cannot be pasted unless its original source and destination blocks have also been pasted. Block 0 cannot be cut.

1. With the chart open and the strategy in Configure or Online mode, click the Select tool .

2. To cut or copy element(s), click them. Press Ctrl+X to cut or Ctrl+C to copy.
   You can also select the element(s) and then click Edit > Cut or Edit > Copy, or click the right mouse button and choose Cut or Copy from the pop-up menu.

3. To paste blocks, press Ctrl+V. You can also paste by clicking Edit > Paste, or right-clicking anywhere on a chart and then select Paste from the pop-up menu.
   Text blocks are pasted immediately. For action, condition, or continue blocks, a message appears asking if you want to keep the original name of the block being pasted.
   If you paste to a different strategy or to a subroutine, PAC Control checks the referenced variables to make sure they match. Variables that do not exist are created. Variables that exist but are different—for example, a table with the same name but a different table length—are noted in a log file that appears when the paste is complete.

Deleting Elements

1. Make sure the chart is open and the strategy is in Configure or Online mode.

2. Click the Select tool . Click the element(s) to select them.

   **CAUTION:** Make sure you have selected the element you want. You cannot undo a deletion!

3. Press Delete.
You can also select the element(s), right-click them, and select Delete from the pop-up menu. Block 0 cannot be deleted. If you delete a block, you'll be asked to verify the deletion.

**Changing Element Color and Size**

You can change the colors and sizes of blocks, connections, and text in your chart. To change one element (for example, the color of one block), use the steps in this section. To change more than one at a time, see “Changing the Appearance of Elements in a Chart Window” on page 215.

Start with the chart open and the strategy in Configure or Online mode.

**Resizing Blocks or Text Blocks**

1. Click the Select tool and click the block to select it.
2. Click one of the handles, then drag it in the direction you want. To resize horizontally and vertically at the same time, drag a corner handle.

**Changing Block Colors**

1. Click the Select tool and click the block to select it.
2. Right-click the block and choose Color from the pop-up menu.
3. Pick the color you want and click OK.

**Changing Text**

You can change the size, font, font style, or color of the text in any block.

1. Click the Select tool and click the block to select it.
2. Right-click the block and choose Font from the pop-up menu.
3. In the Font dialog box, make the changes you want. Click OK.
4. To change whether text appears at the left, the center, or the right of a block, select the block and click the right mouse button. From the pop-up menu, choose Justify; from the sub-menu, choose Left, Center, or Right.

**Changing an Element Back to the Defaults**

1. Select the item and click the right mouse button.
2. From the pop-up menu, choose Properties. From the sub-menu, choose Copy from Default.

To change defaults, see “Changing the Appearance of Elements in a Chart Window” on page 215.

**OPENING, SAVING, AND CLOSING CHARTS**

**Opening a Chart**

Make sure the strategy is open. In the Strategy Tree, double-click the chart you want to open.

You can also open a chart by selecting Chart > Open, and then double-clicking the chart name in the Open Chart dialog box, which lists all charts that are not currently open.

If a chart is open but not visible on the screen, click the chart’s name tab at the bottom of the window to make it visible.

**Saving a Chart**

1. Make sure the chart is open and is the active window.
2. From the Chart menu, choose Save.
Charts are automatically saved when you choose File > Save All. If you choose File > Save Strategy or click the Save Strategy icon on the toolbar, you can choose which charts to save in the Save Strategy dialog box.

**Closing a Chart**

To close a chart, click the close box in the upper-right corner of the chart’s window (not the PAC Control window). You can also close a chart by pressing Ctrl+F4 when the chart window is active. If you have made changes to the chart, you are prompted to save them.

**COPYING, RENAMING, AND DELETING CHARTS**

**Copying a Chart**

If an existing chart is similar to one you want to create, it is easier to copy it than to create a new one from scratch. To copy a chart in the same strategy, follow the steps in this section. To copy a chart to another strategy, see "Exporting and Importing Charts" on page 225.

1. With the strategy open and in Configure mode, select Chart > Copy. The Copy Chart dialog box appears.

2. In the From field, choose the chart you want to copy from the drop-down list.
3. In the To field, enter a name for the new chart. The name must start with a letter and include only letters, numbers, or underscores. (Spaces are converted to underscores).
4. (Optional) Enter a description for the new chart.
5. Click OK. The new chart is created and appears as the active window on the screen.

**Renaming a Chart**

1. Make sure the strategy is in Configure mode and that the chart you want to rename is the active window.
2. From the Chart menu, choose Rename.

3. Enter a new name and description (optional). Click OK.
   The chart is renamed.

Deleting a Chart

You can delete any charts except for the Powerup chart. However, you cannot delete a chart if it is called or used by another chart in your strategy.

1. Make sure the strategy is open and in Configure mode.
2. In the Strategy Tree, right-click the name of the chart you want to delete and choose Delete from the pop-up menu. Or, if the chart is the active window, choose Chart > Delete.
3. At the confirmation message, make sure you are deleting the correct chart.
   **CAUTION:** You cannot undo a deletion!
4. Click Yes to delete the chart.
   The chart window disappears (if it was open), the chart is removed from the Strategy Tree, and the strategy is saved.

PRINTING CHARTS

You can print any flowchart. To print a chart as it appears on the screen, see “Printing Chart or Subroutine Graphics” on page 198. To print commands (instructions) for the chart, see “Viewing and Printing Strategy or Subroutine Commands” on page 200.

EXPORTING AND IMPORTING CHARTS

To copy a chart to another strategy, you must export it as a PAC Control chart export file (.cxf file) and then import it into the strategy where you want it.

Exporting a Chart

1. With the strategy open and in Configure or Online mode, choose Chart > Export.
The Export Chart dialog box appears.

2. In the From section of the dialog box, select the chart to be exported from the Name drop-down list.
3. In the To section of the dialog box, click Select.

4. Navigate to where you want the exported chart file to be saved. In the File name field, enter a name for the exported chart. Click Save.

   You return to the Export Chart dialog box, which now shows the path and file name in the To section.

5. (Optional) Enter a description for the new chart.
6. Click OK.

   The exported chart is saved. You can import it into any PAC Control strategy. See the next section for information on importing charts.
Importing a Chart

Use the Automatic Chart Import dialog box to import a chart previously exported. Also see “Exporting a Chart” on page 225.

1. With the strategy open and in Configure mode, choose Chart > Import. The Automatic Chart Import dialog box appears.

2. At the top of the dialog box, click Create new chart or Replace existing chart. **CAUTION:** If you choose Replace existing chart, the old chart will be completely overwritten with the chart you are importing.

3. Click Select. Navigate to the exported chart. Click OK.

4. In the To section of the dialog box, enter a name for the new chart. If you wish, enter a description. If you are replacing an existing chart, select it from the list. To copy the imported chart description, select the text in the left description field, copy it, and paste it in the right description field.

5. Click OK.

The chart is imported. A Chart Import Report window shows you how the tags in the chart match with those already in the strategy. Any tags from the chart that do not already exist in the strategy are created and added.
INTRODUCTION

This chapter discusses the seven types of variables used in PAC Control: numeric, string, pointer, numeric table, pointer table, string table, and communication handle variables.

This chapter also shows you how to use the commands, or instructions, in PAC Control and discusses the mechanics of adding commands to your strategy flowcharts.

- For command information to help you program your strategy effectively, see Chapter 10: Programming with Commands.
- To find out how to use commands in OptoScript code, see Chapter 11: Using OptoScript.
- For a list of all standard PAC Control commands and their OptoScript equivalents, see Appendix E: OptoScript Language Reference.

ABOUT VARIABLES

As Chapter 2 mentions, variables store pieces of information in a strategy. You create a variable for each piece of information in your control process that must be acted upon. These pieces of information might include the name of a chart, the on or off state of a switch, communication parameters for a peer on the network, or a table that holds a series of numbers.

Each variable has a name and a value. You assign the variable’s name in plain English, so you know what it is. The variable’s value is the current information it represents. As a strategy runs, the variable’s name remains the same, but its value may change. For example, the name of the variable Oven_Temperature stays the same, but its value (the temperature of the oven) may change several times while the strategy is running.
About Variables

To illustrate variables, suppose you are regulating the amount of water in a tank. You must keep the tank filled beyond a minimum level, but you cannot let it get too full.

You’ve already configured the I/O points:
- Level_Meter is an analog input point that registers the quantity of water in the tank.
- Pump_1 is a digital output point that turns the pump on or off.
- Drain_1 is a digital output point that opens or closes the drain.

Next, you configure variables as places to hold information that these I/O points must work with:
- To avoid constantly polling Level_Meter to find out the quantity of water in the tank, you create a variable called Tank_Level_Reading in which to store the level. The input point Level_Meter is periodically checked and the value of Tank_Level_Reading updated.
- To establish the maximum and minimum levels, you create variables called Tank_Max_Level and Tank_Min_Level. The value in Tank_Level_Reading can be compared to the values in these two variables to determine whether the pump should be turned on or off, or the drain opened or closed, to maintain the proper level. (You could create constant values, called literals, for the minimum and maximum levels, but creating them as variables lets you change their values in Debug mode.)

Types of Data in a Variable

A variable stores one of six types of data: floating point, integer, timer, string, pointer, or communication handle. When you create the variable, you designate the type of data it contains. It is always best to choose the most appropriate data type for the information you are storing. PAC Control can store an integer in a floating point variable, but it has to convert the data first. Unnecessary data conversions take up processor time.

- **Numeric** data stores numbers and can be one of the following types:
  - A **floating point** (or float) is a numeric value that contains a decimal point, such as 3.14159, 1.0, and 1,234.2. A good example of a float variable is one that stores readings from an analog input such as a thermocouple. PAC Control uses IEEE single-precision floats with rounding errors of no more than one part per million.
  - An **integer** is a whole number with no fractional part. Examples of integer values are -1, 0, 1, 999, and -4,568. The state of a switch, for example, could be stored in an integer variable as 1 (on) or 0 (off).
    - Most integers used in PAC Control are **32-bit signed integers** (usually referred to as an Int 32) which have a range from -2,147,483,648 to 2,147,483,647. These 32-bit integers should be used for general integer use, such as status variables, mathematics, and indexes.
    - **64-bit signed integers** (also known as an Int 64) are used for values larger than an Int 32 can handle. The range of an Int 64 is from -9,223,372,036,854,775,808 through 9,223,372,036,854,775,807.
  - A **timer** stores elapsed time in units of seconds with resolution in milliseconds. Up Timers count up from zero, and Down Timers start from a value you set and count down to zero. Timers can range from 0.001 to 4.611686 x 10^15.
  - A **string** stores text and any combination of ASCII characters, including control codes and extended characters. For instance, a string variable might be used to send information to a display for an operator to see. A string variable is also used to set parameters for peer-to-peer communication. When defining most string variables, you must specify the width of the string. The width is the maximum number of characters that the variable may hold.
A string variable can contain numeric characters, but they no longer act as numbers. To use them in calculations, you must convert them into floating point or integer numbers. Conversely, a numeric value to be displayed on a screen must first be converted into a string.

- A **pointer** does not store the value of a variable; instead, it stores the memory address of a variable or some other PAC Control item, such as a chart or an I/O point. You can perform any operation on the pointer that you could perform on the object the pointer points to. Pointers are an advanced programming feature and are very powerful, but they also complicate programming and debugging.

- A **communication handle** stores information used to communicate with other entities, for example other devices on the network or files that store data. The communication handle’s value is a string containing the parameters needed to make a connection with a specific entity. For outgoing Ethernet communication, for example, these parameters usually include the protocol, the IP address of the device you are communicating with, and the port number used on the device.

  After the initial connection is made, the communication handle is referenced during communication with the entity, and then used to close communication.

**Variables in PAC Control**

In PAC Control there are seven types of variables:

- Numeric
- Numeric table
- String
- String table
- Pointer
- Pointer table
- Communication handle

Numeric, string, and pointer variables contain individual pieces of data. Numeric table, string table, and pointer table variables contain several pieces of related data in the form of a table. (A programmer would know this type of data structure as an array.) Communication handle variables contain parameters used by PAC Control for communicating with other devices and files.

**Table Variables**

In a table variable, the variable name represents a group of values, not just one. Table variables are one-dimensional arrays, which means that each table is like a numbered list of values. You refer to each item in the list by its number, or index. Indexes start at 0, not at 1. Here are two table examples:

In a float table, values are floating point numbers:

<table>
<thead>
<tr>
<th>Index</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>82.0</td>
</tr>
<tr>
<td>1</td>
<td>86.1</td>
</tr>
<tr>
<td>2</td>
<td>85.0</td>
</tr>
<tr>
<td>3</td>
<td>74.8</td>
</tr>
<tr>
<td>4</td>
<td>72.3</td>
</tr>
<tr>
<td>5</td>
<td>72.7</td>
</tr>
</tbody>
</table>
In a string table, values are strings:

<table>
<thead>
<tr>
<th>Index</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Maria</td>
</tr>
<tr>
<td>1</td>
<td>Tom</td>
</tr>
<tr>
<td>2</td>
<td>Siu</td>
</tr>
<tr>
<td>3</td>
<td>Andre</td>
</tr>
</tbody>
</table>

When you define a table, you must specify its length, which is how many values the table can store. The length of a table is NOT the value of the last index. Since indexes start at 0, a table with a length of 100 contains indexes 0 through 99. Table length is limited only by the amount of memory in the control engine. For more information on available memory, see “If You Have Memory Problems” on page 376.

Numeric tables store either integer values or floating point numbers (but not both in the same table). String tables store strings. Because pointers can point to any data type (for example, an I/O point, a chart, or even another table), pointer tables can store an assortment of data types.

**Persistent Data**

Most variables can be either global or persistent in scope. Global variables are set to an initial value (which you specify during configuration) either whenever the strategy is run or whenever it is downloaded.

A persistent variable, however, is initialized only the first time a strategy containing that particular persistent variable is downloaded. Numeric variables (and tables) are initially set to 0. String variables (and tables), pointer variables (and tables), and communication handles are initialized as blank, or empty. The key point about a persistent variable is that its value is saved in the controller's battery-backed memory; it does not get re-initialized when the strategy is run, stopped, or started, and it does not get re-initialized if the strategy is modified and downloaded again. A persistent variable’s value is retained until one of these events occurs:

- A strategy with a different name is downloaded.
- The RAM on the controller is cleared.
- New firmware is downloaded to the controller.
- A strategy download is canceled during the download process.
- The persistent object is changed as follows:
  - A persistent table’s length (integer, 64-bit integer, float, and string) was modified (either longer or shorter).
  - A persistent string variable’s width was modified.
  - A persistent string table’s width was modified.
  - A persistent variable’s type has changed. For example, a persistent float variable is deleted and a new persistent integer variable is created with the same name.

Persistent data can be very useful in certain situations. For example, suppose you have a PID setpoint that is fine-tuned as your process runs. If the setpoint is configured as persistent, its value won’t be lost if you must re-download the strategy after making a program change.

Pointer variables, pointer tables, and timers are not allowed to be persistent; but all other variables and tables can be. Persistent variables cannot be configured on-the-fly.

**Literals**

A literal is used like a variable, but it is constant data that never changes. A literal has no variable name, only a fixed value, which may be a floating point number, an integer, or a string.

If you are using subroutines, see the information on literals in “Data Types for Subroutines” on page 362.
ADDING VARIABLES

See also “Setting Initial Values in Variables and Tables During Strategy Download” on page 240.

1. With the strategy or subroutine open in Configure mode, choose Configure > Variables.

   The Configure Variables dialog box opens. This dialog box lists all the variables in the strategy or subroutine that are of the type shown in the Type field. You can sort the data in this dialog by clicking any of the column headers.

2. In the Type drop-down list, choose the type of variable you want to configure.

   If you select a type of Table, the column headings in the dialog box change depending on the table type.

3. If you are adding the variable to a subroutine, select Subroutine in the Scope drop-down list.

4. To add a new variable, click Add.

   The Add Variable dialog box is displayed.

5. Complete the fields as described in “Add Variable Dialog Box”.

6. Click OK.

   The Add Variable dialog box closes and the new variable appears in the Configure Variables dialog box.
Add Variable Dialog Box

The fields in this dialog box depend on the type of variable you select. The image below shows the dialog box for a string variable.

The fields in this dialog box depend on the type of variable you select. The image below shows the dialog box for a string variable.

And this image shows the dialog box for an Int 32 table variable.
A—**Name.** Enter a name for the variable. The name must start with a letter and may contain letters, numbers, and underscores. (Spaces are converted to underscores.)

B—**Description.** (Optional) Enter a description of the variable.

C—**Type.** In the Type drop-down list, select the type of data for the variable. Possible types are shown in the following table. For more information, see "Types of Data in a Variable" on page 230.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Possible Data Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric</td>
<td>Integer 32, integer 64, floating point, up or down timer</td>
</tr>
<tr>
<td>Numeric table</td>
<td>Integer 32, integer 64, or floating point</td>
</tr>
<tr>
<td>String</td>
<td>String</td>
</tr>
<tr>
<td>String table</td>
<td>String</td>
</tr>
<tr>
<td>Pointer</td>
<td>Pointer to any data type</td>
</tr>
<tr>
<td>Pointer table</td>
<td>Pointer to any data type, and the data type may change over time</td>
</tr>
<tr>
<td>Communication handle</td>
<td>Communication handle</td>
</tr>
</tbody>
</table>

D—The fields in this area of the dialog box depend on the variable type. Available fields are:

- **String Width:** Enter the maximum number of characters permitted in the string. The number must be an integer between one and 1024. The greater the number, the more memory required to store the string.

- **Table Length:** Enter an integer between 1 and 1,000,000 representing the number of elements in the table. The greater the number, the more memory required to store the table.

- **Pointer to Type:** From the drop-down list, select the type the pointer points to. Note that void pointers are not allowed; a pointer must point to a specific type. Also note that you cannot point a pointer to another pointer; PAC Control has only one level of indirection for pointers. If you try to point to a pointer, PAC Control assigns to the new pointer the address of the object being pointed to.

E—**Initialization.** (For all variables except up timers and down timers)

Select one of the following:

- **Initialize on Strategy Run:** Sets the variable to the initial value (F) each time the strategy is run (either manually from the debugger or automatically via the autorun flag).

- **Initialize on Strategy Download:** Sets the variable to the initial value (F) only when a strategy is downloaded. The variable retains its current value when the strategy is stopped and then run again, either through the debugger or autorun. It also retains its value if power is cycled. Note that this choice means the variable is stored in battery-backed RAM, which is limited in size. To keep a variable’s current value through both power cycles and strategy download, make the variable a persistent variable (see the Persistent option below and “Persistent Data” on page 232). See also “If You Have Memory Problems” on page 376.

- **Persistent:** (Not applicable to pointer variables, pointer tables, and timers.) Data in the variable, including data in tables will be persistent. For details, see “Persistent Data” on page 232.

The following table shows how your choices about variable initialization and persistence affect what happens to variables (applies to all variables and tables except up timers and down timers).

<table>
<thead>
<tr>
<th>Variable</th>
<th>What happens to the variable’s value when...?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable initialized on strategy run (default)</td>
<td>Strategy stops, then starts (through debugger or autorun)</td>
</tr>
<tr>
<td></td>
<td>Power is cycled</td>
</tr>
<tr>
<td></td>
<td>Same strategy is downloaded</td>
</tr>
<tr>
<td></td>
<td>Set to initial value</td>
</tr>
<tr>
<td></td>
<td>Set to initial value</td>
</tr>
<tr>
<td></td>
<td>Set to initial value</td>
</tr>
</tbody>
</table>
ADDING VARIABLES

**F—Initial Value.** (For all variables except pointers, up timers, and down timers) Enter the value to which the variable is to be set initially. You can use either decimal or hexadecimal form. If you leave this field blank, the initial value is set to zero.

For **tables**, each value in the table is set to the initial value. You can set individual table elements to differing values initially in the Powerup chart. To use an initialization file to initialize the values on strategy download, see “Setting Initial Values in Variables and Tables During Strategy Download” on page 240.

For **pointer variables**: When you have selected the Pointer to Type, the drop-down list in this field shows all the valid objects for that type that are currently defined in your strategy. Choose one or leave the initial value as NULL. A NULL value means that the pointer is created but does not initially point to anything.

For **communication handles**: Enter a string containing communication parameters in the correct format for the type of communication handle you are using. The type (for example, `tcp`, `ftp`, `file`) must be in lowercase letters, and parameters are separated by colons and commas according to the format required. See “Communication Commands” on page 257 for information and examples.

1. To communicate with a serial module, use the IP address of the brain the module is attached to, and use the serial module’s port number according to its position on the rack, for example: `tcp:10.192.55.185:22502`. For port numbers, see “Establishing an Ethernet Connection” in the SNAP Serial Communication Module User’s Guide (form 1191). See also, TCP and UDP Port Assignments (form 1940).
2. To communicate with another SNAP PAC brain, be aware of port numbers that are reserved for a specific protocol. For more information, see TCP and UDP Port Assignments (form 1940).
3. For other peers on the Ethernet network, be aware of port numbers they may use for specific purposes. Ports 22000 and 22001 are reserved for the control engine. For a list of standard Ethernet port numbers, refer to http://www.iana.org/assignments/port-numbers. See also, TCP and UDP Port Assignments (form 1940).
4. If you are using the Accept Incoming Communication command to listen for communication requests, leave out the IP address and use the following format: `tcp:port`

**G—Public Access (Optional).** This option allows the variable to be accessed by certain third-party applications. By default, public access is disabled. For more information, see “Public Access” on page 239.

The fields for this option depend on the type of variable. If the dialog box shows check boxes for **Make Public (Readable)** and **Allow Write Capability**:

1. Select Make Public Readable to allow the point to be read by certain third-party applications.
2. Select Allow Write Capability to allow the applications to write to the point. Note that you must make the point public (readable) before you can allow writing.

---

<table>
<thead>
<tr>
<th>Variable</th>
<th>What happens to the variable’s value when...?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Strategy stops, then starts (through debugger or autorun)</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Variable initialized on strategy download</td>
<td>Retains current value</td>
</tr>
<tr>
<td>Persistent variable</td>
<td>Retains current value</td>
</tr>
</tbody>
</table>
If the dialog box has a blank pane and buttons for Add, Modify, and Remove, follow these steps:

**TIP:** To enable the Add button, type a name for the variable in the Name field.

- If the variable is a table, you must also enter the table length.
- If the variable is a string table, you must also enter the table length and string width.

1. Click the Add button. The Add Public Access Attribute Representation dialog box is displayed.

   *Note: The fields are the same on this dialog box and on the Edit Public Access Attribute Representation dialog box.*

2. Select Make Public (Readable). The Allow Write Capability and (for some variables) Represent As options are now available to select.
3. (Optional.) Select Allow Write Capability to allow other applications to write to the variable.
4. (Optional.) If the variable’s data type allows you to represent the data to the other system as a different type, you can select a different type from the Represent As list.
   For a list of data representation options by variable type, see “Public Access” on page 239.
   This image shows how to configure public access for a specific bit in an Int 32:

   ![Image of public access configuration for a specific bit in an Int 32]

   This image shows how to configure a specific range of elements in a table:

   ![Image of public access configuration for a specific range of elements in a table]

   This image shows a specific bit of an element in a table:

   ![Image of public access configuration for a specific bit of an element in a table]

   For a list of data representation options by variable type, see “Public Access” on page 239.
5. Repeat steps 3 and 4 to create different combinations of public access and data representations. For details, “Public Access” on page 239.
6. When you’ve finished, click OK to close the dialog box and save the settings.
The image below shows an Int 32 variable that’s been configured with different public access setting for two different bits.

To change a representation, select it in the list, and then click Modify. The Edit Public Access Attribute Representation dialog box is displayed. It has the same fields as the Add Public Access Attribute Representation dialog box.

To delete a representation, highlight it in the list, and then click Delete.

PUBLIC ACCESS

(Applicable to PAC Control R10.a and higher.) Public access is an option that allows applications using the Sparkplug specification for MQTT (such as Ignition by Inductive Automation) or the groov EPIC and SNAP PAC Driver module by Cirrus Link Solutions to read and write to PAC Control tags. Ignition can even detect publicly accessible PAC Control tags automatically; this means you don’t need to manually add tags to an Ignition HMI.

NOTE: When reading PAC Control R10.0a (or higher) tag names with Ignition Edge for groov, be sure to:

- Configure tags with public access from within PAC Control.
- Use version 3.4.1 (or higher) of the Opto 22 groov EPIC and SNAP PAC Driver.

For details, see KB87534.

By default, PAC Control disables public access to tags. You can allow public access when you add or edit a point or variable in a PAC Control strategy. You can make the tag readable, or readable and writable. (Exception: Up and down timers are readable only.)

1 For more information about the groov EPIC and SNAP PAC Driver module, see the Cirrus Link documentation website: https://docs.chariot.io/display/CLD/Opto+22+groov+EPIC+and+SNAP+PAC+Driver.
Some variables also let you select the data type to be represented in the other system. For example, you can choose to send the value of a specific Integer 32 variable to the other system as an Int 32, or as a Boolean (where 0 is False and non-zero is True), or you can send only one of the Int 32’s bits to represent a Boolean.

The options for data representations differ by variable type:

<table>
<thead>
<tr>
<th>Variable type*</th>
<th>Data type</th>
<th>Data representation options</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>String</td>
<td>None</td>
<td>Strings are 7-bit ASCII format</td>
</tr>
<tr>
<td>String Table</td>
<td>String Table</td>
<td>All Elements</td>
<td>All elements in the table are accessible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Range of Elements</td>
<td>Only elements in the range are accessible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One Element</td>
<td>Only the specified element is accessible</td>
</tr>
<tr>
<td>Numeric</td>
<td>Integer 32</td>
<td>Boolean</td>
<td>0 is False; any non-zero number is True</td>
</tr>
<tr>
<td>Numeric Table</td>
<td>Integer 32 Table</td>
<td>All Elements</td>
<td>All elements in the table are accessible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Range of Elements</td>
<td>Only elements in the range are accessible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One Element</td>
<td>Only the specified element is accessible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One Bit of One Element</td>
<td>Only the specified bit of the specified element is accessible</td>
</tr>
<tr>
<td>Numeric</td>
<td>Integer 64</td>
<td>One Bit</td>
<td>0 is False; 1 is True</td>
</tr>
<tr>
<td>Numeric Table</td>
<td>Integer 64 Table</td>
<td>All Elements</td>
<td>See Integer 32 Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Range of Elements</td>
<td>See Integer 32 Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One Element</td>
<td>See Integer 32 Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One Bit of One Element</td>
<td>See Integer 32 Table</td>
</tr>
<tr>
<td>Numeric</td>
<td>Float</td>
<td>None</td>
<td>Timers are read-only</td>
</tr>
<tr>
<td>Numeric Table</td>
<td>Float Table</td>
<td>All Elements</td>
<td>See Integer 32 Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Range of Elements</td>
<td>See Integer 32 Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One Element</td>
<td>See Integer 32 Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One Bit of One Element</td>
<td>See Integer 32 Table</td>
</tr>
</tbody>
</table>

*Public access is not an option for pointers, pointer tables, and communication handle variables.

**SETTING INITIAL VALUES IN VARIABLES AND TABLES DURING STRATEGY DOWNLOAD**

When you are adding table variables in PAC Control, you can set all table elements to one initial value in the Add Variables dialog box. If you want to set each individual table element to its own value, however, you need to create an initialization file and download it with your PAC Control strategy.

In addition to setting initial values for table elements, sometimes it is easier to initialize all variables during strategy download using an initialization file.

This section shows you how to create an initialization file and download it with your strategy.
Creating the Initialization File

A sample initialization file, Init.txt, is copied to the local hard drive when you install PAC Control. The file's location is C:\Users\Public\Documents\Opto 22\PAC Project <version number>\Control Basic Examples <or Control Pro Examples, if you have PAC Control Professional>\InitVariables.

You can open this file with a text editor to see the proper syntax for each initialization entry, and then modify it as necessary for your strategy.

**IMPORTANT:** Every initialization file should include the following line near the top:

```
\ "DOWNLOAD_COMPRESSION_OFF
```

Make sure to enter a backslash and a space at the beginning of the line. Download compression removes the newlines necessary for string initialization. This line tells PAC Control to turn off download compression so strings can be initialized.

**IMPORTANT:** Each file must end with a carriage return so that the last line in the file is blank, and each line within the file must end with a carriage return. If you add comments to the file, they must be preceded by a backslash (\) and a space.

Text Examples

**NOTE:** Variable names are case-sensitive and can include both upper- and lower-case letters.

**Integer Example.** To set an initial value of 123 for the variable INTEGER_VARIABLE, you would include the following text in the initialization file:

```
123 ^INTEGER_VARIABLE @!
```

**Float Example.** Floating point values must contain a decimal point. To set an initial value of 456 for the variable FLOAT_VARIABLE, you would include the following text (with the decimal point and zero) in the initialization file:

```
456.0 ^FLOAT_VARIABLE @!
```

**String Example.** To set an initial value of "String Variable Test String" for STRING_VARIABLE, you would include the following text in the initialization file. The spaces and newline are very important:

```
*STRING_VARIABLE $INN
String Variable Test String
```

**Communication Handle Example.** To add the parameters of a communication handle named COMM_Handle, you would include the following text in the initialization file. The spaces and newline are very important:

```
*COMM_Handle $INN
tcp:10.0.0.1:1000
```

**Pointer Example.** To have the pointer PTR_POINTER_VARIABLE point initially to INTEGER_VARIABLE, you would include the following text in the initialization file:

```
^INTEGER_VARIABLE MoveToPointer PTR_POINTER_VARIABLE
```

**Integer 32 Table Example.** To set initial values of 10, 20, 30, 40, and 50 for elements zero through four of an integer table named My_Int_32_Table, include the following text:

```
10 0 }My_Int_32_Table TABLE!
20 1 }My_Int_32_Table TABLE!
30 2 }My_Int_32_Table TABLE!
40 3 }My_Int_32_Table TABLE!
50 4 }My_Int_32_Table TABLE!
```
**Integer 64 Table Example.** To set initial values of 10, 20, 30, 40, and 50 for elements zero through four of an integer table named My_Int_64_Table, include the following text:

```
10.. 0 }My_Int_64_Table 2TABLE!
20.. 1 }My_Int_64_Table 2TABLE!
30.. 2 }My_Int_64_Table 2TABLE!
40.. 3 }My_Int_64_Table 2TABLE!
50.. 4 }My_Int_64_Table 2TABLE!
```

**Float Table Example.** For a float table, the initial values must include a decimal point. To set initial values of 1.1, 2.2, 3.3, 4.4, and 5.5 for elements zero through four of a float table named My_Float_Table, include the following text:

```
1.1 0 }My_Float_Table TABLE!
2.2 1 }My_Float_Table TABLE!
3.3 2 }My_Float_Table TABLE!
4.4 3 }My_Float_Table TABLE!
5.5 4 }My_Float_Table TABLE!
```

**String Table Example.** To set initial values of “zero”, “one”, “two”, “three”, and “four” for elements 0–4 of a string table named My_String_Table, include the following text. Make sure you turn off download compression and use new lines as shown:

```
0 }My_String_Table $TABLE@ $INN
  zero
1 }My_String_Table $TABLE@ $INN
  one
2 }My_String_Table $TABLE@ $INN
  two
3 }My_String_Table $TABLE@ $INN
  three
4 }My_String_Table $TABLE@ $INN
  four
```

**Pointer Table Example.** Each index in a pointer table points to another item within the strategy, for example an I/O point, a variable, or a chart. Setting initial values for pointer tables means designating the items the pointer table initially points to. For example, you would include the following text to have a pointer table named My_Ptr_Table initially point to Oven_Temperature (a variable), Alarm_Handler (a chart), Thermocouple (an analog input), Fuel_Pump (an analog output), and Fan_1 (a digital output):

```
^Oven_Temperature 0 PTBL_My_Ptr_Table TABLE!
&Alarm_Handler 1 PTBL_My_Ptr_Table TABLE!
~Thermocouple 2 PTBL_My_Ptr_Table TABLE!
~Fuel_Pump 3 PTBL_My_Ptr_Table TABLE!
~Fan_1 4 PTBL_My_Ptr_Table TABLE!
```

**Special Characters in the Initialization File.** Note that the initial character on each line of the initialization file is a special character that identifies the object type. Possible characters include the following:

<table>
<thead>
<tr>
<th>Character</th>
<th>Object Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>^</td>
<td>float, integer, or timer</td>
</tr>
<tr>
<td>*</td>
<td>string</td>
</tr>
<tr>
<td>PTR_</td>
<td>pointer variable</td>
</tr>
<tr>
<td>~</td>
<td>I/O point</td>
</tr>
<tr>
<td>&amp;</td>
<td>chart</td>
</tr>
<tr>
<td>}</td>
<td>float table or integer table</td>
</tr>
<tr>
<td>{</td>
<td>string table</td>
</tr>
<tr>
<td>PTBL_</td>
<td>pointer table</td>
</tr>
<tr>
<td>%</td>
<td>I/O unit</td>
</tr>
</tbody>
</table>
**Saving the Initialization File.** When you have finished modifying the file, save it as a text file (.txt file extension) to your strategy directory. You can name the file anything you like. (You can also save it to any directory you like, but it is good practice to save each initialization file to the directory of the strategy that references it.)

**Downloading the Initialization File**

To use the file, you need to download it with your strategy.

1. With the strategy open in Configure or Online mode, choose Configure > Control Engines, or double-click the control engine’s name.
2. Highlight the control engine and click the Download Options button.
   The Download Options dialog box appears. The initialization file must be downloaded immediately after your strategy is downloaded.
3. Click Add.
4. Navigate to the initialization file you created. Double-click the file name.
   The file appears in the Download Options dialog box.
5. Click OK.
   The initialization file sets values for the variables and table elements immediately after your next full strategy download.

**IMPORTANT:** When you create each variable in the strategy, you must check “Initialize on Strategy Download” in the Add Variable dialog box.

Since download options are specific to each control engine, make sure you set the initialization file as a download option for every control engine on which the strategy will run. Because control engines have separate initialization files, you can use the same master strategy for two or more control engines and configure differences in variables by customizing the initialization files.

**Starting the Strategy Automatically**

If you want your strategy to start automatically as soon as the strategy finishes downloading to the controller using PAC Control Debug mode, modify the Init.txt file as follows:

1. Add the following to the end of the Init.txt file:
   ```
   _RUN
   ```
2. Add 1 or more blank lines after the _RUN line
   This is required; it won’t work without at least 1 blank line at the end of the file.

If you are not using the other features of the Init.txt file to initialize variables after strategy download, you can delete the rest of the content of the file.
CHANGING A CONFIGURED VARIABLE

You can change a variable, but you cannot change a variable’s type.

1. To change a configured variable, make sure the strategy or subroutine is open and in Configure or Online mode.

2. If you are working in a strategy, on the Strategy Tree, expand the Variables folder until you see the name of the variable you want to change. Double-click its name to open the Edit Variable dialog box.

3. If you are working in a subroutine, choose Configure > Variables. In the Configure Variables dialog box, double-click the name of the variable you want to change.

4. In the Edit Variable dialog box, make the necessary changes and click OK.

   If you need help, see “Adding Variables” on page 233 or “Public Access” on page 239.

You can also change a variable from the Configure Variables dialog box by double-clicking the variable’s name or by highlighting it and clicking Modify.

DELETING A VARIABLE

You cannot delete a variable that is referenced within the strategy or subroutine. Be careful when deleting variables, since you cannot undo a deletion.

1. Make sure the strategy is open and in Configure mode.

2. On the Strategy Tree, expand the Variables folder until you see the name of the variable you want to change. Right-click the name and choose Delete from the pop-up menu.

   The variable is deleted.

You can also delete a variable from the Configure Variables dialog box by highlighting the variable’s name and clicking Delete.

VIEWING VARIABLES IN DEBUG MODE

While the strategy is running in Debug mode, you can view its variables and modify the value of a variable or of entries in a table. You can also view several variables at once—as well as other strategy elements—by putting them into a watch window.

Viewing Numeric, String, and Communication Handle Variables

1. Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the variable you want to view.

   The Inspect Variables dialog box opens. The animated icon at the upper left assures you that the data is fresh. The title bar includes the name of the variable and indicates whether scanning is occurring.

   Maximize button
2. To view more options, click the Maximize button.

3. To view the configuration information about the variable, click More Info.

4. To select the display format, click the button to the right of the Watch button.

5. To change the value of the variable, type the new value in the Value field and click Apply.

   For a string variable, if your change lengthens the string beyond its maximum width, the string is truncated to fit.

   For a communication handle variable, changing the value of the variable here has the same effect as using a Set Communication Handle Variable command. If the communication handle is currently open, the value will be changed but will not affect the connection.

6. To monitor the variable in a watch window, click Watch.

   If you have only one watch window and it is already open, the variable appears immediately in the window for monitoring.
Otherwise, the Add Watch Entry dialog box appears.

7. Check the items you want to watch.
   Items to watch vary depending on the variable type.
8. In the Add Watch Entry dialog box, do one of the following:
   – If the watch window you want to use to monitor the variable is open, choose it from the Select Watch Window drop-down list.
   – If the watch window you want is not open, click Open. Navigate to it and double-click it to open it.
   – If you want to monitor the variable in a new watch window, click New. (For help, see “Creating a Watch Window” on page 170.)
9. When the Add Watch Entry dialog box shows the correct items to watch and the watch window you want, click OK.
   The variable appears in the watch window.

Viewing Pointer Variables

1. Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the pointer variable you want to view.
   The View Pointer dialog box appears, showing the pointer’s name, type, and item pointed to.

2. To view the status or value of the item pointed to, click the Inspect icon.
   If you need help, follow the steps in “Viewing Numeric, String, and Communication Handle Variables” on page 244.
Viewing Numeric and String Tables

1. Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the table variable you want to view.
   The View Table dialog box appears, showing the table's name, length (maximum number of entries), width for a string table, initialization method, and security level. It also lists the index and value of each table entry. The title bar includes the name of the variable and indicates whether scanning is occurring. Here's an example for a string table.

   ![Example of a string table dialog box](image)

   Scanning for an individual table element stops whenever you select an element in the table. It resumes for that element if no changes are made and another table element is selected, or when you click Apply. A magenta background indicates that scanning is stopped.

2. To change the format of the elements, click the button to the right of the Watch button.

   ![Change format button](image)

   For string tables, you can select either ASCII or Hexadecimal. For numeric tables, you can select Decimal, Hexadecimal, or Binary.

3. To view the configuration information, click More Info.

   ![Configuration information](image)

   4. To change a table entry, click its index number, highlight the value, and type in a new value. Click Apply.

   5. To monitor the table in a watch window, click Watch.
The Add Watch Entry dialog box appears.

![Add Watch Entry dialog box]

6. In the Add Watch Entry dialog box, do one of the following:
   - If the watch window you want to use to monitor the table variable is open, choose it from the Select Watch window drop-down list.
   - If the watch window you want is not open, click Open. Navigate to it and double-click it to open it.
   - If you want to monitor the variable in a new watch window, click New. (For help, see “Creating a Watch Window” on page 170.)

7. Select the indexes you want to watch.

8. When the Add Watch Entry dialog box shows the correct items to watch and the watch window you want, click OK.
   The table variable appears in the watch window.

Viewing Pointer Tables

1. Make sure the strategy is running in Debug mode. On the Strategy Tree, double-click the pointer table you want to view.
   The View Table dialog box appears, showing the pointer table's name, length, and the items pointed to.
   You cannot change a pointer table entry in this dialog box.

![View Table dialog box]

2. To view the status or value of the item pointed to, highlight it in the table and click More Info. If you need help, follow the steps in “Viewing Numeric and String Tables” on page 247.
ADDINg Commands

To make a block in a strategy flowchart do the work it’s intended to do, you add one or more commands. Commands use the I/O points and variables you’ve already configured, as well as other elements in your strategy. A command, for example, might turn on a digital point, move a value to a variable, or check to see whether a chart is running. PAC Control contains more than 500 commands you can use. A command in PAC Control is often called an instruction.

You can add commands to action blocks, condition blocks, and OptoScript blocks. Continue blocks just move flowchart logic to another block. (See “Configuring a Continue Block” on page 254.)

To add commands to an action or condition block, follow the steps below. (To add commands to an OptoScript block, see “OptoScript Functions and Commands” on page 342 and “Using the OptoScript Editor” on page 354.)

1. With the strategy open in Configure or Online mode and the flowchart open, double-click the block to which you want to add a command.
   The Instructions dialog box appears. The highlighted area shows where the new command will be added.

2. Click Add to open the Add Instruction dialog box.

The Operator group appears in the dialog box only for condition blocks, not for action blocks.
3. If you know the command you want, enter its name in the Instruction field by typing it in or by choosing it from the drop-down list. Skip to step 7.

If you don’t know the command name, click Select.

4. Click the name of a command group in the left column to display all the commands in that group. In the right column, click the command you want.

For more information on any command, click the command name and click Command Help to open help. You can also look up the command in the PAC Control Command Reference (form 1701).

5. When the command you want is highlighted, click OK to return to the Add Instruction dialog box.

6. (Optional) Enter a comment about the purpose of the instruction.

Comments help explain the command’s purpose in this block and are helpful to anyone who debugs or updates the strategy later.

7. Complete each argument for the command by typing in the Type and Name fields or by choosing from the drop-down lists.

If the argument type is a literal (or constant), you must type it in. You can use either decimal or hexadecimal form.
If you type in the name of an item that doesn’t exist, for example a variable or I/O point, you are prompted to add it to the strategy.

Each command requires a certain number of arguments, from zero to eight. For help in completing arguments, see the PAC Control Command Reference or the online help for the specific command you’re using.

8. When the arguments are complete, click OK.

You return to the Instructions dialog box, which now shows the command you just added. Notice that the comment you entered appears just above the command. The arguments you entered appear as part of the instruction. The highlight shows where the next command will be placed if you add another command to this block.

Here is an example of an Instructions dialog box for an action block:

9. To add another command, click to place the highlight where you want the command to appear. Click Add and repeat the steps in this section.

If you highlight a command that’s already in the dialog box, the new command will appear just before it.

**TIP:** If you are adding commands to several blocks at once, you can quickly move from block to block in the chart by clicking the Next Block or Previous Block buttons in the Instructions dialog box.

If you’re working with a condition block, clicking Next Block opens a dialog box so you can select which block to choose, since condition blocks have two exits. The same dialog box appears if you click Previous Block and the block you’re working with has connections coming from more than one block.

10. If you put more than one command in a condition block, complete the Operator group as follows:
   - If both commands must be true to exit the block true, click AND.
   - If only one of the commands must be true to exit the block true, click OR.
Here is an example of an Instructions dialog box for a condition block with two commands. In this case, the block will exit true if either of the commands is true.

Either the first command OR the second command can be true for this condition block to exit true.

**CHANGING A COMMAND**

1. With the strategy open in Configure or Online mode and the flowchart open, double-click the block containing the command you want to change.

   *NOTE:* To change commands in OptoScript blocks, see “Using the OptoScript Editor” on page 354.

2. In the Instructions dialog box, double-click any line of the command you want to change. You can also click the command to highlight it and click Modify.

3. In the Edit Instruction dialog box, make the necessary changes. For help, see “Adding Commands” on page 249.

4. Click OK to return to the Instructions dialog box, where you can see the changed command.

**DELETING A COMMAND**

You can delete a command permanently, or you can comment out a command so it is temporarily skipped, usually for debugging purposes.

**Permanently Deleting a Command**

1. With the strategy in Configure or Online mode and the flowchart open, double-click the block containing the command you want to delete.

   *NOTE:* To delete commands in OptoScript blocks, see “Using the OptoScript Editor” on page 354.

2. In the Instructions dialog box, click any line of the command you want to delete.

   *CAUTION:* Make sure you select the correct command. You cannot undo a deletion!

3. Click Delete or press Delete on the keyboard.
Commenting Out a Command

You can mark certain commands so that the strategy temporarily ignores them. Commenting out one or more commands can help you pinpoint problems in a strategy.

1. With the strategy in Configure or Online mode and the flowchart open, double-click the block containing the command(s) you want to comment out.

   *NOTE: To comment out commands in OptoScript blocks, see “Using the OptoScript Editor” on page 354.*

2. In the Instructions dialog box, click the first command you want to comment out. Click Add.

3. In the Add Instructions dialog box, choose the instruction Comment (Block). Click OK.
   
   You return to the Instructions dialog box, and all the instructions in the block from that point on are grayed out, indicating that they will be ignored when the strategy runs.

4. Click just beyond the last command you want to comment out. Add another Comment (Block) instruction.
   
   When you return to the Instructions dialog box, all commands between the two Comment (Block) instructions are grayed out.

5. When you no longer want the strategy to ignore the command(s), delete the two Comment (Block) instructions.

   *NOTE: The Comment (Block) command is used for this purpose. The Comment (Instruction) command just places an explanatory comment in the Instructions dialog box. It does not affect any commands.*

CUTTING OR COPYING A COMMAND

For commands in action, condition, and continue blocks you can cut or copy commands to the Windows clipboard and then paste them in the same block or in another block, or even in a block of another chart within the same strategy. For OptoScript blocks, see “Using the OptoScript Editor” on page 354.

1. With the strategy in Configure or Online mode and the flowchart open, double-click the block containing the command you want to cut or copy.

2. In the Instructions dialog box, click any line of the command you want to cut or copy.
   
   To cut or copy more than one command, hold down the Shift key while you click all the commands to be cut or copied at once.

   *NOTE: To cut and paste all commands in a block, copy and paste the entire block, and then change its name if necessary.*

3. Press Ctrl+X to cut the command(s) or Ctrl+C to copy them.
   
   You can also click the right mouse button and choose Cut or Copy from the pop-up menu.
   The command is cut or copied to the Windows clipboard.

PASTING A COMMAND

Once you have cut or copied a command, you can paste it into any block in the same strategy.

Choose one of the following, and then press Ctrl+V:

- To paste the command in the same block, click where you want to insert the command.
- To paste the command at the end of the instruction block, move the cursor just below the last instruction and click to highlight the empty space.
- To paste the command to another block, click Close to exit the current Instructions dialog box and double-click the block where you want to place the command. Click where you want to insert the command.
CONFIGURING A CONTINUE BLOCK

Continue blocks do only one thing: jump to another block. Thus, the only information you need to provide in a continue block is the name of the block to jump to.

1. With the strategy in Configure or Online mode and the flowchart open, double-click the continue block you want to configure.
   You can also click the block, click the right mouse button, and choose Detail from the pop-up menu. The Select Continue Block Destination dialog box appears, listing all blocks in the chart.

   ![Select Continue Block Destination Dialog Box]

2. Click the destination block and click OK.

VIEWING AND PRINTING CHART INSTRUCTIONS

To view or print commands in a chart, see “Viewing and Printing Strategy or Subroutine Commands” on page 200.
10: Programming with Commands

INTRODUCTION

Commands (or instructions) in PAC Control are roughly grouped by function. This chapter tells you what you need to know about each group in order to program your PAC Control strategy effectively. For detailed information on using a command, see the PAC Control Command Reference (form 1701) or for legacy commands, see the PAC Control Command Reference, Legacy Edition (form 1711).

In This Chapter

- Analog Point Commands .......................................................... page 256
- Chart Commands ........................................................................ page 257
- Communication Commands ......................................................... page 257
- Control Engine Commands .......................................................... page 302
- Digital Point Commands ............................................................... page 303
- Error Handling Commands .......................................................... page 307
- I/O Unit Commands ................................................................. page 309
- I/O Unit—Event Message Commands ..................................... page 310
- I/O Unit—Memory Map Commands ........................................ page 311
- I/O Unit—Scratch Pad Commands ............................................. page 311
- Logical Commands ............................................................. page 313
- Mathematical Commands ........................................................... page 314
- Miscellaneous Commands ........................................................ page 317
- PID—Ethernet Commands ......................................................... page 318
- Pointer Commands ................................................................. page 321
- Simulation Commands ............................................................... page 322
- String Commands ................................................................. page 323
- Time/Date Commands ............................................................. page 330
- Timing Commands ................................................................. page 330
The following commands are used with analog points:

**Offset and Gain**
- Calculate & Set Analog Gain
- Calculate & Set Analog Offset
- Set Analog Gain
- Set Analog Offset

**Minimum/Maximum Values**
- Get Analog Maximum Value
- Get Analog Minimum Value
- Get & Clear Analog Maximum Value
- Get & Clear Analog Minimum Value

**Others**
- Get & Clear Analog Totalizer Value
- Get Analog Totalizer Value
- Get HART Unique Address
- Ramp Analog Output
- Receive HART Response
- Receive HART Burst Response
- Send/Receive HART Command
- Set Analog Filter Weight
- Set Analog Load Cell Fast Settle Level
- Set Analog Load Cell Filter Weight
- Set Analog Totalizer Rate
- Set Analog TPO Period

**Offset and Gain Commands**

Although you normally calibrate analog points in PAC Manager, PAC Control provides commands to set the values for a point’s offset and gain. (For more information about calibrating offset and gain, see “Reading and Writing to Analog Points” in the PAC Manager User’s Guide (form 1704).

If you already know a point’s offset and gain, you can set the values in PAC Control by using the Set Analog Offset and Set Analog Gain commands. If you don’t know the offset and gain, you can use the Calculate & Set Analog Offset command, and then use Calculate & Set Analog Gain to have the brain calculate the offset and gain for you—but again, calibration is typically performed in PAC Manager, and not within a strategy’s logic.

**Analog Totalizers**

Analog totalizers are used to track total volume or quantity. For example, if an analog point measures gallons per minute, you could use an analog totalizer to determine the total number of gallons moved over time.

To read the value and leave the totalizer running, use the command Get Analog Totalizer Value. To read the value and set the totalizer back to zero, use the command Get & Clear Analog Totalizer Value.

**Minimum/Maximum Values**

The Opto 22 brain automatically keeps track of minimum and maximum values for analog input points. Min/max values are often used to monitor pressure or temperature.

To read the minimum or maximum value and leave it as is, use Get Analog Minimum Value or Get Analog Maximum Value. To read the minimum or maximum value and clear it—for example, to record the minimum pressure in each 24-hour period—use Get & Clear Analog Minimum Value or Get & Clear Analog Maximum Value.

**Analog Points and OptoScript Code**

In OptoScript code, an analog I/O point can be used directly, wherever a float variable can be used. For example, you can assign an analog point a value, or use points directly in mathematical expressions and control structures. For more information, see “Using I/O in OptoScript” on page 342.
Reading or Writing Analog Points

The Move command is the main command used to read or write analog points.

CHART COMMANDS

The following commands control charts in the strategy:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Chart</td>
<td>Continue Calling Chart</td>
</tr>
<tr>
<td>Calling Chart Running?</td>
<td>Continue Chart</td>
</tr>
<tr>
<td>Calling Chart Stopped?</td>
<td>Get Chart Status</td>
</tr>
<tr>
<td>Calling Chart Suspended?</td>
<td>Start Chart</td>
</tr>
<tr>
<td>Chart Running?</td>
<td>Stop Chart</td>
</tr>
<tr>
<td>Chart Stopped?</td>
<td>Suspend Chart</td>
</tr>
<tr>
<td>Chart Suspended?</td>
<td></td>
</tr>
</tbody>
</table>

For information about charts in a PAC Control strategy, see “PAC Control Terminology” on page 49.

About the Task Queue

How do subroutines fit into the task queue?

Whenever a chart calls a subroutine, the subroutine temporarily inherits the task in use by the calling chart along with its priority.

Does a task always use all of its allocated time?

Not always. If a chart or subroutine runs in a loop, all allocated time is used. If a chart or subroutine does not need all of its allocated time to complete its job, all remaining time (including any portion of a time slice) is given up.

The following conditions cause a chart to use less than a full time slice:

- The chart or subroutine stops.
- The chart or subroutine is suspended.
- A Delay command is used.

Using the command Delay (mSec) with a value of 1 millisecond is a handy way to give up the time slice while waiting in a loop for a condition to become True. For more information, see Optimizing PAC Project System Performance.

When does the requested change to a chart or task status take effect?

Not immediately. In any multitasking system, timing and synchronization issues are always a concern. The time required for a particular request to be implemented depends on the number of tasks currently running and the specified chart’s location in the task queue. We recommend using commands such as Calling Chart Suspended? and Chart Running? to determine the status of a chart.

COMMUNICATION COMMANDS

The following commands refer to moving data among entities that store and transfer data:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept Incoming Communication</td>
<td>Receive Pointer Table</td>
</tr>
<tr>
<td>Clear Communication Receive Buffer</td>
<td>Receive String</td>
</tr>
<tr>
<td>Close Communication</td>
<td>Receive String Table</td>
</tr>
</tbody>
</table>
A communication handle (also known as comm handle or COM handle) is a variable in PAC Control that stores the parameters needed to connect to a specific entity for the purpose of exchanging data. The entity may be another device on the network, a file located on the control engine, or some other thing that stores or transfers data. The value of a communication handle variable is a string consisting of communication parameters, separated by colons and commas.

Communication handles are used to open and close communication channels, and to transmit and receive data. You can use communication handles to:

- Communicate with devices (including serial communication modules) via an Ethernet connection
- Communicate with devices via a physical serial port on a SNAP PAC controller
- Create, read, and write data to local and remote files and tables

For example, you might use a UDP communication handle to communicate with another device on the network via a UDP/IP connection, and use an FTP communication handle to send data from a controller to a file on a PC.

**NOTE:** A communication handle is not required to use the SNAP PAC REST API. To configure HTTPS access to your PAC's RESTful server and learn how to call the API, visit developer.opto22.com.

In many cases you’ll define a communication handle variable and never change it, because the parameters rarely change. However, in some cases it might be useful to change it.

PAC Control provides these types of communication handles:

<table>
<thead>
<tr>
<th>Communication Open?</th>
<th>Send Communication Handle Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Communication Handle Value</td>
<td>Send Email</td>
</tr>
<tr>
<td>Get End-Of-Message Terminator</td>
<td>Send Email with Attachments</td>
</tr>
<tr>
<td>Get Number of Characters Waiting</td>
<td>Set Communication Handle Value</td>
</tr>
<tr>
<td>HTTP Get</td>
<td>Set End-Of-Message Terminator</td>
</tr>
<tr>
<td>HTTP Post Calculate Content Length</td>
<td>Transfer N Characters</td>
</tr>
<tr>
<td>HTTP Post From String Table</td>
<td>Transmit Character</td>
</tr>
<tr>
<td>Listen for Incoming Communication</td>
<td>Transmit NewLine</td>
</tr>
<tr>
<td>Open Outgoing Communication</td>
<td>Transmit Numeric Table</td>
</tr>
<tr>
<td>Receive Character</td>
<td>Transmit Pointer Table</td>
</tr>
<tr>
<td>Receive N Characters</td>
<td>Transmit String</td>
</tr>
<tr>
<td>Receive Numeric Table</td>
<td>Transmit String Table</td>
</tr>
<tr>
<td>Receive Numeric Table Ex</td>
<td>Transmit String Table</td>
</tr>
<tr>
<td>Receive Numeric Variable</td>
<td>Transmit/Receive String</td>
</tr>
</tbody>
</table>

### Communication Handles

A communication handle (also known as comm handle or COM handle) is a variable in PAC Control that stores the parameters needed to connect to a specific entity for the purpose of exchanging data. The entity may be another device on the network, a file located on the control engine, or some other thing that stores or transfers data. The value of a communication handle variable is a string consisting of communication parameters, separated by colons and commas.

Communication handles are used to open and close communication channels, and to transmit and receive data. You can use communication handles to:

- Communicate with devices (including serial communication modules) via an Ethernet connection
- Communicate with devices via a physical serial port on a SNAP PAC controller
- Create, read, and write data to local and remote files and tables

For example, you might use a UDP communication handle to communicate with another device on the network via a UDP/IP connection, and use an FTP communication handle to send data from a controller to a file on a PC.

**NOTE:** A communication handle is not required to use the SNAP PAC REST API. To configure HTTPS access to your PAC’s RESTful server and learn how to call the API, visit developer.opto22.com.

In many cases you’ll define a communication handle variable and never change it, because the parameters rarely change. However, in some cases it might be useful to change it.

PAC Control provides these types of communication handles:

<table>
<thead>
<tr>
<th>Communication Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP (page 260)</td>
<td>For Ethernet communication via TCP/IP, or with SNAP PAC serial modules. Note that outgoing (client) TCP communication handles in PAC firmware R9.5a (or higher) support secure data exchange via SSL/TLS. Currently, SSL is not supported in incoming (server) TCP communication handles.</td>
</tr>
<tr>
<td>UDP (page 267)</td>
<td>For lightweight Ethernet communication via UDP/IP.</td>
</tr>
<tr>
<td>File (page 275)</td>
<td>For creating files to be stored on a control engine, and for reading or writing to files on a control engine.</td>
</tr>
<tr>
<td>FTP (page 282)</td>
<td>For accessing files on a local file system (like a network drive), or on an FTP server. Also used to transfer files between two servers.</td>
</tr>
</tbody>
</table>
IMPORTANT: If you are using TCP/IP or UDP connections, consult commercially available texts on TCP/IP or UDP that discuss client/server architectures, so you'll understand how the protocol works and what to expect during communication.

Communication Timeout Values

Each type of communication handle has a default timeout value (the amount of time the system waits for a command to complete). Timeouts prevent systems from wasting resources when something is wrong.

<table>
<thead>
<tr>
<th>Communication Handle Type</th>
<th>Default Timeout Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP</td>
<td>10 seconds</td>
</tr>
<tr>
<td>UDP</td>
<td>10 seconds</td>
</tr>
<tr>
<td>File</td>
<td>1 second</td>
</tr>
<tr>
<td>FTP</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Serial</td>
<td>1 second</td>
</tr>
</tbody>
</table>

For the TCP, UDP, and Serial communication handles, you can set a different timeout value and read the current timeout value for an already open communication handle. For TCP and UDP only, you can also set the timeout values for receiving data, and for opening both incoming and outgoing communications. For details, see the “Communication Commands” section in the PAC Control Command Reference (form 1701).

Adding Communication Handles

Using the Add Variable dialog box, you can create variables for each type of communication handle. For more information about variables, see “Adding Variables” on page 233.

To add a communication handle:

1. In the Strategy Tree, under Variables, right-click Communication Handles, and then choose Add to open the Add Variable dialog box.

2. At the minimum, complete the following fields:
   - Name: Create an appropriate name, such as TCP_Handle.
   - Type: Select Communication Handle.
   - Initial Value: Varies with type.
     - For TCP, see page 260.
     - For UDP, see page 267.
     - For File, see page 275.
TCP Communication Handles

TCP communication handles exchange data with accessible devices anywhere on a network and even over the Internet. Use TCP when you need reliable data transmission with error handling and message retries.

- When bandwidth is a concern and possible data loss is not an issue, you may prefer to use UDP communication handles. For details, see page 267.
- If the devices sharing data are both control engines, it may be easier to use the Scratch Pad areas on each to transfer data (instead of using communication commands). For details, see “I/O Unit—Scratch Pad Commands” on page 311.

Because SNAP serial communication modules are IP-addressable, you communicate with them by using a TCP (or UDP) communication handle rather than a Serial communication handle. This way, a strategy running on a PC or SNAP PAC device can access serial devices connected to modules on a remote SNAP PAC R-series or EB-series device (which in this case, acts as an Ethernet-to-Serial converter).

TCP Connections

TCP is a connection-oriented protocol, which means a connection must be established between the client (the device requesting the data) and the server (the device providing the data) before the devices exchange data. This connection is typically called a handshake. TCP ensures reliable data transmission, but the handshake and reliable data transmission require more bandwidth than UDP.

Outgoing (client) TCP communication handles in PAC firmware (R9.5a and higher) support secure data exchange via SSL/TLS1—two similar types of Internet protocols that provide authentication (that is, established proof of identification) over an encrypted network channel. Lower versions of PAC Control and PAC firmware support SSL over TCP only with these commands:

- HTTP Get
- HTTP Post
- Send Email
- Send Email With Attachment commands.

For more information about SSL/TLS, see “Step 4: Install a new CA Root Certificate” on page 292.

---

1 UDP protocol does not support SSL/TLS.
Incoming and Outgoing Communication

TCP communication is normally requested by the device that needs the data.

For example, when a PAC Control strategy running on a SNAP PAC I/O unit needs the value of a set of variables from another strategy running on a different SNAP PAC controller:

- The controller (the client) requests communication using the command, Open Outgoing Communication.
- The second controller (the server) uses the Listen for Incoming Communication command, and then the Accept Incoming Communication command to establish the connection.

Once connected, data is transmitted and received in both directions.

Depending on the situation, you may want to have both devices request communication and establish two connections between them. That way if one device goes offline and then comes online, you can have the flowchart logic set up to immediately open communication again.

In some cases, however, one of the devices may be incapable of requesting communication; for example, a serial device such as a barcode reader attached to a serial communication module on a controller. The serial device is incapable of requesting Ethernet communication; essentially it can only listen and provide data when asked. In cases like this, the controller must use Open Outgoing Communication to initiate communication. (For serial devices attached directly to a serial port on a SNAP PAC controller or brain, see “Communicating with Serial Devices” on page 286.)

**Outgoing Communication.** For outgoing communication (that is, communication initiated by the client), the communication handle’s value follows these patterns:

<table>
<thead>
<tr>
<th>Basic TCP</th>
<th>tcp:&lt;Server’s IP address or hostname&gt;:&lt;port listening for requests&gt;</th>
<th>Example using hostname: tcp:rhino.acme.com:23456</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSL/TLS over TCP</td>
<td>tcp:&lt;Secure server’s IP address or hostname&gt;:&lt;port listening for requests&gt;,ssl[]</td>
<td>Example: tcp:rhino.acme.com:23456,ssl[]</td>
</tr>
<tr>
<td></td>
<td>Note the comma after the port number.</td>
<td></td>
</tr>
</tbody>
</table>

**Notes**

- “tcp” is lowercase.
- A hostname is user-friendly name for the IP address. Hostnames are usually created by a company’s IT department. (Before you substitute a hostname for a controller’s IP address, use PAC Manager to configure the DSN parameter for the controller. For details, see the PAC Manager User’s Guide, form 1704).
- For information about ports, see page 262.
- Only TCP supports outgoing (client) communication with SSL/TLS authentication and encryption. To use SSL/TLS, your controller must have an installed security certificate. (For information about security certificates, see “Step 4: Install a new CA Root Certificate” on page 292.)

**Examples:**

<table>
<thead>
<tr>
<th>Outgoing Communication</th>
<th>Communication Handle Value Protocol:Server’s IP Address or Hostname:Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet TCP - to a serial communication module on another rack</td>
<td>tcp:10.192.54.10:22506</td>
</tr>
<tr>
<td>Ethernet TCP - to a remote server (using the server’s hostname)</td>
<td>tcp:my_server:255</td>
</tr>
<tr>
<td>Ethernet TCP (with secure SSL/TLS) - to a remote server</td>
<td>tcp:10.192.56.185:443,ssl[]</td>
</tr>
<tr>
<td>Ethernet TCP - to a serial communication module on the same rack (uses SNAP PAC R-series IP address or loopback IP address)</td>
<td>tcp:10.192.55.90:22511</td>
</tr>
</tbody>
</table>
To add a communication handle to a PAC Control strategy, see the steps starting on page 259. In the Add Variable dialog box, enter the communication handle value in the Initial Value field.

Port Numbers. To communicate with other control engines or other devices on a network, you can use any port number that is not already in use by that device. For example, you can safely use ports 22004 and 22005, which have been assigned to Opto 22 by the Internet Assigned Numbers Authority (IANA). Opto 22 has allocated these Ethernet port numbers for customer use. In general, anything below 1024 is already predefined and shouldn’t be used unless you are implementing a predefined protocol that already has a reserved port.

If you do not know what port number to use, ask your network administrator or check the list of standard reserved Ethernet port numbers at www.iana.org/assignments/port-numbers to see ports that may apply to your devices on your network.

The following port numbers are the defaults, reserved by Opto 22 devices for the purposes shown.

<table>
<thead>
<tr>
<th>Port #</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>FTP (file transfer protocol) for get, send, and dir functions</td>
</tr>
<tr>
<td>21</td>
<td>FTP (file transfer protocol)</td>
</tr>
<tr>
<td>25</td>
<td>SMTP (simple mail transfer protocol)</td>
</tr>
<tr>
<td>161</td>
<td>SNMP-based enterprise management systems</td>
</tr>
<tr>
<td>502</td>
<td>Modbus/TCP</td>
</tr>
<tr>
<td>2001</td>
<td>Main command processor, OptoMMP-based (also used by SNAP PAC controllers and brains)</td>
</tr>
<tr>
<td>2222 and 44818</td>
<td>Ethernet/IP</td>
</tr>
<tr>
<td>22000</td>
<td>Opto 22 controllers and brains</td>
</tr>
</tbody>
</table>
| 22001  | Host port
For information on configuring the host port, see the PAC Manager User's Guide (form 1704). |
| 22002  | Opto 22 controllers and brains |
| 22003  | Opto 22 controllers and brains |
| 22500–22531 | Serial communication modules |
| 50000–50999 | Internal messaging |

Note that port numbers on the SNAP PAC controllers and brains are the default ports; some may have been changed for security reasons. (For details, see the section on Security in the PAC Manager User’s Guide, (form 1704).)
Incoming Communication. For incoming communication (that is, communication requested by another device), the communication handle value is the protocol and the port number separated by a colon (:). Note that only TCP tracks senders so there is no mix up in the data sent and received.

Example:

| Ethernet TCP (for example, to use a controller as an HTTP server) | tcp:80 |

To add a communication handle, see the steps starting on page 259. In the Add Variable dialog box, enter the communication handle value in the Initial Value field.

Opening and Closing TCP Communication Handles

When using TCP communication handles, keep in mind that the controller has a limited amount of TCP/IP resources, so you need to be careful about how frequently these communication handles are opened and closed. TCP communication handles are meant to be left open as long as possible.

Per the TCP/IP specification, each time one of these resources is closed, the closed resource unavailable for 120 seconds. Rapidly attempting to open and close TCP communication handles quickly places all available resources in the unavailable condition.

Once this unavailable state occurs, a communication handle will be unable to gain a resource upon the next Open Outgoing Communication command. This effectively causes a lock out of any new TCP/IP connections to be made with the controller (whether from the strategy or externally).

The lock out affects applications such as PAC Control, PAC Display, PAC Manager, OptoOPCServer, and PAC Terminal. These applications will either have intermittent or no connectivity with the controller.

The solution to this dilemma is to control the rate at which TCP communication handles are opened and closed. When a TCP communication handle is closed (whether a result of a prior successful or unsuccessful opening), it should be reopened no sooner than 3 seconds. If this reopening fails to succeed, double the delay to 6 seconds. If this subsequent reopening fails, double the delay to 12 seconds. And thereafter, subsequent reconnections should be performed no shorter than every 24 seconds. This throttling of the opening allows several TCP/IP resources to expire their closing timer.
TCP Communication Handle Examples

The following diagram shows an example of a communication handle value for outgoing communication:

**Outgoing Communication**

SNAP R-series I/O  
IP address: 10.192.59.45

Device A  
IP address: 10.192.59.31

Communication Handle value:

tcp:10.192.59.31:22004

For incoming communication, the communication handle value could be:

**Incoming Communication**

SNAP R-series I/O  
IP address: 10.192.59.45

Device A  
IP address: 10.192.59.31

Communication Handle value:

tcp:22004

**Communication Handles for Serial Communication Modules.** For communication with serial devices through a serial communication module, the communication handle value consists of the IP address of the brain the module is attached to, plus the serial module’s port number according to its position on the rack.

*NOTE: For port number information, see “Establish an Ethernet Connection” in the SNAP Serial Communication Module User’s Guide (form 1191).*
Here are two examples of communication handles for communicating with serial modules, the first showing communication through a module on the same rack as a SNAP PAC R-series controller, and the second showing communication through a module on a different rack.

**To a Serial Module on the Same Rack**

SNAP R-series I/O
IP address: 10.192.59.45
SNAP-SCM
port 22507

Serial Device

Communication Handle value:
tcp:127.0.0.1:22507
or tcp:10.192.59.45:22507

For a serial module on the same rack, use the loopback IP address 127.0.0.1, which tells the brain to talk to its own rack. You can also use the brain’s own IP address (in this example, 10.192.59.45), but the loopback address allows you to change the IP address of the brain without having to change the communication handle.

**To a Serial Module on a Different Rack**

SNAP R-series I/O
IP address: 10.192.59.45
SNAP-SCM
port 22507

Serial Device

Communication Handle value:
tcp:10.192.59.62:22507

To a Serial Module on a Different Rack

SNAP EB-series I/O
IP address: 10.192.59.62
SNAP-SCM
port 22507

Ethernet network

For a serial module on a different rack, you need to use an IP address of the other rack to communicate through the Ethernet network. You can also use the brain’s own IP address (if the brain can communicate across the network), but it’s more convenient to use an IP address of the other rack.

**Using Flowcharts to Control TCP Communication**

When a control engine is communicating with another device using TCP, it runs a PAC Control flowchart or charts to control communication.

- **For outgoing communication on controller COM ports and serial modules**, the flowchart uses the command Open Outgoing Communication to request a connection.
- **For incoming communication on controller COM ports**, which is requested by another device, the flowchart must first use Listen for Incoming Communication and then use Accept Incoming Communication to establish a connection.
- **For incoming communication on serial modules**, which is requested by another device, the flowchart uses the Open Outgoing Communication and Communication Open? commands to establish a connection.
The control engine’s TCP/IP flowcharts should open communication once and then continue to transmit or receive using the communication handle. Constantly opening and closing communication for each transaction wastes time and is inefficient.

As a simple example, the flowchart at right is designed to receive data from a serial device, such as a barcode reader, through a serial communication module on the same rack as a SNAP PAC R-series I/O unit.

Communication with serial modules in this example is done via TCP. It can be done from the SNAP PAC R-series system itself, as in this example, or from another TCP/IP device on the network.

In this example, the R-series I/O unit establishes communication through the serial module using the communication handle: tcp:127.0.0.1:22507 The loopback IP address is used, since the serial module is on the same rack.

When characters are detected in the receive buffer, the I/O unit receives the string and processes it, and then after a short delay checks for another message. Communication remains open for additional messages.

This simple flowchart illustrates the basics of handling communication, without any error checking. However, while receiving and transmitting, TCP/IP control charts should also monitor the status value returned by commands such as Transmit Numeric Table and Receive Numeric Table, and close communication if there are errors. If your PAC Control application opens sessions but does not close unused or bad sessions, the maximum number of sessions could be used up. Note that communication should not be closed for timeout errors from Receive commands (error numbers –37 and –39), however, because these errors simply mean that there was no data waiting in the receive buffer for the specified session.

To save time, before using a Receive command (such as Receive String or Receive Numeric Table), TCP/IP charts should use the command Get Number of Characters Waiting. If there are zero characters waiting, then there is no reason to use the Receive command. It is also a good idea to start a down timer, and then loop on the Get Number of Characters Waiting command until either there are more than zero characters waiting, or the timer expires.

The following chart is also an example of TCP/IP communication on controller COM ports, but with three differences: in this case another device is requesting communication, the peer will both transmit and receive, and error checking is shown for the commands Get Number of Characters Waiting and Receive Numeric Table.
Similar error checking should be used for transmit commands, which in this strategy are in another chart.

If the devices communicating with each other are all SNAP R-series, be careful not to have one of them send information to another faster than the receiving system can pull it out of its receive buffer. When a control engine receives data from the Ethernet network, it holds the data in memory (the buffer) until the PAC Control flowchart removes it with a Receive command. If the data is not removed fast enough, the receive buffer will fill up. You can prevent this problem by transmitting the information less frequently. If the same chart is transmitting and receiving, you can alter the chart so that it receives more often than it transmits.

Ethernet Connections and Ports

The number of Ethernet connections available varies by hardware, type, and in some cases firmware version, such as 80 on current SNAP PAC R-series I/O systems.

The host connection is on port 22000 or 22001 and is used to communicate with the PC that runs PAC Control. These port numbers are reserved for this purpose, but they can be configured. For information see the PAC Manager User’s Guide (form 1704).

Peer-to-peer connections can be on any other port number that is not already used on the network; these connections are used to communicate with other control engines or other devices on the network. When you assign port numbers for peer-to-peer connections, make sure you do not assign port numbers that devices on your network may use for specific purposes. For a list of standard Ethernet port numbers, see www.iana.org/assignments/port-numbers.

UDP Communication Handles

The User Datagram Protocol (UDP) is a fast, lightweight communications protocol that is sometimes used as an alternative to TCP (see page 260). UDP is used to transmit messages—called datagrams—across an IP network from a source IP address and source UDP port to a destination IP address and destination UDP port. UDP communication handles most often used when bandwidth is a concern and reliable data transmission is not required.
**Important Characteristics of UDP**

- Uses port numbers to help distinguish different types of requests.
- Has an optional checksum function to ensure the datagram is delivered intact.
- Uses a connectionless transmission model, which means it doesn’t do a “handshake” or otherwise ensure that the receiving IP address is available and ready to receive.
- Does not guarantee datagram delivery. If a delivery fails, it does not perform retries.
- Does not preserve datagram sequencing. Datagrams may arrive at the destination in a different order than they were sent.
- Is unaware of congestion at the receiving IP address. If the receiver’s queue becomes full, subsequent datagrams are dropped.

*NOTE: When using UDP, if packet sizes are larger than about 1200 bytes and the data transmission interval is about 1 millisecond or faster, SNAP PAC hardware controllers may not be able to receive the data, and communication handles in SNAP PAC Sim and SoftPAC software controllers may close unexpectedly.*

**UDP Communication Handle Categories**

<table>
<thead>
<tr>
<th>Handle Category</th>
<th>Local Characteristics</th>
<th>Remote Characteristics</th>
<th>Communication Handle Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Bound</td>
<td>The local UDP port is specified by the communication handle.</td>
<td>May be used to communicate with multiple remote IP addresses and ports by using Send Communication Handle Command, &quot;set.dst:&lt;ip address&gt;:&lt;port&gt;&quot; or &quot;set.dst:&lt;hostname with fully qualified domain name&gt;:&lt;port&gt;&quot;.</td>
<td>udp:&lt;local port&gt;</td>
</tr>
<tr>
<td>Remote Bound</td>
<td>Local UDP port is chosen by the operating system.</td>
<td>Communicates with the communication handle’s specified remote IP address and port.</td>
<td>udp:&lt;remote IP address&gt;:&lt;remote port&gt;</td>
</tr>
<tr>
<td>Unbound</td>
<td>Local UDP port is chosen by the operating system.</td>
<td>Can be used to communicate with multiple remote IP addresses and ports by using Send Communication Handle Command with a destination string like &quot;set.dst:&lt;ip address&gt;:&lt;port&gt;&quot; or &quot;set.dst:&lt;hostname with fully qualified domain name&gt;:&lt;port&gt;&quot;.</td>
<td>udp:</td>
</tr>
</tbody>
</table>
CHAPTER 10: PROGRAMMING WITH COMMANDS

Configuring a Local Bound UDP Communication Handle

A local bound communication handle is used to receive UDP datagrams through a known UDP port. You can also configure the communication handle to transmit data to a specific destination. For details, see the “Set Communication Handle Value” command in the PAC Control Command Reference (form 1701).

To add a communication handle to a PAC Control strategy, see the steps starting on page 259. When using the Add variable dialog box, the initial value follows this pattern:

udp:<local bound port number>

In OptoScript, the instruction follows this pattern:

SetCommunicationHandleValue("udp:23456", cmhMyLocalBoundCommHandle);

In this example, data sent via UDP to UDP port 23456 is received by the PAC Control strategy. UDP datagrams sent to the bound port will be received on all active Ethernet or Wireless Ethernet interfaces.

Configuring a Remote Bound UDP Communication Handle

A remote bound UDP communication handle is typically used to communicate to another device that receives UDP datagrams on a bound (preset) port number. The remote port number allows transmitters to direct the datagram’s destination.

To add a communication handle to a PAC Control strategy, see the steps starting on page 259. In the Add Variable dialog box, enter the communication handle value in the Initial Value field.

The remote bound communication handle value has the following format:

udp:<remote IP Address>:<remote port number>

Example:

udp:192.168.1.100:23456

OptoScript example:

SetCommunicationHandleValue("udp:192.168.1.100:23456", cmhMyRemoteBoundCommHandle);
Action block example:

```
config the remote bound communication handle value
Set Communication Handle Value
From

To

"udp:192.168.1.100:23456"

_cmosMyRemoteBoundCommHandle
```

The example configures a communication handle that transmits data to the destination host IP address 192.168.1.100, UDP port 23456.

Configuring an Unbound UDP Communication Handle

The unbound communication handle is very similar to the remote bound category. The only difference is the communication handle value does not specify the local port.

To add a communication handle to a PAC Control strategy, see the steps starting on page 259. In the Add Variable dialog box, enter the communication handle value in the Initial Value field.

The unbound UDP communication handle value has this format:

```
udp:
```

OptoScript example:

```
SetCommunicationHandleValue("udp:", cmhMyUnboundCommHandle);
```

Action block example:
Opening the UDP Communication Handle

To open either an unbound or bound communication handle, use the OpenOutgoingCommunication command.

OptoScript example:

```optoscript
i32OpenUnboundResult =
OpenOutgoingCommunication(cmhMyRemoteBoundCommHandle);

i32OpenBoundResult =
OpenOutgoingCommunication(cmhMyLocalBoundCommHandle);
```

Action block example:

To find out if the handle opened successfully, inspect the result from the OpenOutgoingCommunication command. A zero result means the opening succeeded. A negative value indicates the communication handle was not opened.

Closing the UDP Communication Handle

To close any communication handle, use the command “CloseCommunication.”

OptoScript example:

```
CloseCommunication(cmhMyRemoteBoundCommHandle);
```
Many applications never close a communication handle once they are opened. If a communication fault were to occur on an unbound communication handle, the handle continues to remain open and may still be used to resume communications. If the communication handle was bound, it too remains open and datagrams will be received once the network problem is corrected.

Transmitting Datagrams with a Remote Bound Communication Handle

The following commands may be used to transmit data with an open UDP communication handle.

- Transmit Character*
- Transmit Numeric Table
- Transmit Pointer Table
- Transmit String
- Transmit String Table
- Transmit/Receive String

*If transmitting several sequential characters of a string, use Transmit String instead.

When using these commands, the data may be transmitted to the IP address and UDP port specified when the UDP communication handle was opened.

To add a communication handle to a PAC Control strategy, see the steps starting on page 259. In the Add Variable dialog box, enter the communication handle value in the Initial Value field.

OptoScript example:

```opto
i32TransmitResult = TransmitNumTable(4, 2, i32tMyDataTable, cmhMyRemoteBoundCommHandle);
```
Action block example:

This example transmits elements 2, 3, 4, and 5 of table i32tMyDataTable to the IP address 192.168.1.100, UDP port 23456. All four elements are transmitted in a single datagram over the network.

Transmitting Datagrams with a Local Bound Communication Handle

Transmitting with a bound communication handle requires the communication handle’s destination (the IP address and port) to be set. Use the command “Send Communication Handle Command” to configure these destination parameters. Once the destination is set, the same data transmit commands may be used.

To add a communication handle to a PAC Control strategy, see the steps starting on page 259. In the Add Variable dialog box, enter the communication handle value in the Initial Value field.

OptoScript example:

```
i32SendResult = SendCommunicationHandleValue(cmhMyLocalBoundCommHandle, "set.dst:192.168.1.101:12345");
i32TransmitResult = TransmitNumTable(4, 2, i32tMyDataTable, cmhMyLocalBoundCommHandle);
```

Action block example:
This example first configures the local bound UDP communication handle to transmit the data to the IP address 192.168.1.101, UDP port 12345. Subsequent data transmissions will be sent to the same IP address and UDP port until a SendCommunicationHandle with a new destination IP address or UDP port is commanded.

Determining when a Datagram Has Arrived

Use the command “Get Number of Characters Waiting” to determine if datagrams have arrived on the UDP communication handle.

OptoScript example:
i32BytesWaiting = GetNumberOfCharsWaiting(cmhMyLocalBoundCommHandle);

Action block example:

The strategy should inspect the result value from the command. When positive, this indicates the amount of data pending. When receiving a positive result, the value indicates the amount of data contained in the current datagram.

In some cases, a timer is used to limit how long the chart will wait for data to arrive. This is usually configured as a loop and includes either an up- or down-timer to monitor the elapsed time. Within the loop, checking for the number of characters waiting, include a “Delay Millisecond” command with a reasonable delay time to allow the chart to release its timeslice.

Receiving Datagrams

Use the following commands to receive datagrams from a bound or unbound UDP communication handle.

- Receive Character
- Receive N Characters
- Receive Numeric Table
- Receive Numeric Table Ex
- Receive Numeric Variable
- Receive Pointer Table
- Receive String
- Receive String Table

When the chart logic has determined that a datagram is pending on the communication handle, the data may be received.
When receiving the datagram, ensure that all of the bytes contained within the current datagram reported by the command “Get Number Of Characters Waiting” are received. Once all the data of the current UDP datagram is received, the next datagram may be received. The reading of the entire datagram within PAC Control’s implementation of UDP messaging differs from typical programming environment “socket” implementations.

Retrieving The Received Datagram’s Source IP address and Source UDP port

When a datagram is received, the identity of the transmitter can be retrieved using the “Send Communication Handle Command” command. The command returns the values in a numeric format. To set a destination address and port so that a reply can be sent on the same communication handle, these values must be converted to strings and formatted into a command string understandable by Send Communication Handle Command.

OptoScript example:

```opscript
// retrieve the datagram’s source IP address and source port
i32SourceIpAddress = SendCommunicationHandleCommand(cmhMyBoundCommHandle, "get.src");
i32SourcePort = SendCommunicationHandleCommand(cmhMyBoundCommHandle, "get.srcport");

// convert numeric source values to strings
Int32ToIpAddressString(i32SourceIpAddress, sSourceIpAddress);
NumberToString(i32SourcePort, sSourcePort);

// create a command string for the "Send Communication Handle Command"
sReplyAddress = "set.dst:" + sSourceIpAddress + ":" + sSourcePort;
```

The result stored in sReplyAddress (for example “set.dst:192.168.1.100:54321”) is used as the command string to set the next transmission destination to send a datagram to IP address “192.168.1.100,” port 54321.

Managing and Accessing Files in the Control Engine’s File System

The internal storage available for file storage depends on the device:

- About 2 GB on a groov EPIC processor
- About 4 MB on a PAC S-series controller
- About 2 MB on a PAC R-series controller
- File storage on a SoftPAC controller is limited only by the size of your hard drive and the drives available on your network.

Any type of file can be stored on the device, and files can be sorted into directories or folders just as they can on a PC. The control engine can read them, add data to them, and even send data from them via several different methods to another device on the network.

If you want more storage, you can add external storage devices:

- groov EPIC processors allow you to store files on USB storage devices. For more information about connecting a USB storage device, see the groov EPIC User’s Guide (form 2267).

2The amount of memory available on a groov EPIC processor can vary. To find out how much is available, go to groov Manage and click Info & Help, then System Status. The amount currently available is displayed in the Resources section, in the Memory Available row.
SNAP PAC controllers allow you to store data or files on a microSD card. For more information about accessing a microSD card, see the user’s guide for the controller.

NOTE: For SNAP PAC controllers, certain FTP commands may also be useful when dealing with files, even if the files are all local. For example, the dir command is available with comm handles.

Understanding Private, Secured, and Unsecured Areas (groov EPIC Processors Only)

The groov EPIC processor subdivides the file system into three areas:

- **private** — This area is visible only to the control engine. Any files that you create in your PAC Control strategy are stored in the private area, unless you explicitly indicate that they be stored in the unsecured area. You cannot access this area from groov Manage; therefore, you cannot upload files to the private area through groov Manage.

- **secured** — Files stored in the secured area are accessible only to control programs that use authentication over a secure protocol. You cannot access these areas from PAC Control strategies. You can upload files to the secured area through groov Manage. For instructions on uploading files, see the groov EPIC User’s Guide (form 2267).

- **unsecured** — Files stored in the unsecured area are accessible by the PAC strategy or any control program. You can also upload files to the unsecured area through groov Manage. For instructions on uploading files, see the groov EPIC User’s Guide (form 2267).

Before you begin programming commands that create files, determine in which of these areas you want to store your files. Your decision may affect the format of the file name, as well as the availability of those files to other programs, like Node-RED flows.

Format of the Communication Handle Value for File Access

To create, write to, and read from files on the control engine, use a file communication handle. The format for the handle’s value is: \texttt{file:<open mode>,<filename>}

Note that \texttt{file} is lowercase.

**Values for open mode.** Open modes are:

<table>
<thead>
<tr>
<th>Open mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>r</td>
<td>Opens a file for reading. If the file does not exist or cannot be found, an error is returned.</td>
</tr>
<tr>
<td>w</td>
<td>Creates a new file and opens it for writing. If the file already exists, its contents are deleted.</td>
</tr>
<tr>
<td>a</td>
<td>Opens a file for writing at the end of the file (appending). If the file doesn’t exist, it is created.</td>
</tr>
</tbody>
</table>

**Formats for filename.** You can use the following formats for groov EPIC processors; SNAP PAC, SoftPac, SNAP-LCE, or SNAP Ultimate controllers; and SNAP Ultimate controllers:

- \texttt{filename.extension} — The path to the file is the current working directory. For the groov EPIC processor, the file is stored or located in the private area.
- \texttt{/path/filename.extension} — If the path does not exist, it is created. For the groov EPIC processor, the path and file are stored or located in the private area.

You can use the following formats only for groov EPIC processors. The ~ mark indicates the home directory of the private area:

- \texttt{~filename.extension} — The file is stored or located in the home directory of the private area.
- \texttt{~/path/filename.extension} — If the path does not exist, it is created. The path and file are stored or located from the home directory of the private area.
- \texttt{~/unsecured/filename.extension} — The file is stored or located off the root directory of the unsecured area, where control programs and PAC Control strategies can access it.
• ~/unsecured/path/filename.extension—if the path does not exist, it is created. The path and file are
  stored or located off the root directory of the unsecured area, where control programs and PAC Control
  strategies can access it.

Note that you can’t specify that a file or path be created in the secured area nor access a file in the secured area of the
groov EPIC processor. This area is not accessible to PAC Control strategies.

Examples of File Communication Handle Values (groov EPIC and SNAP PAC)

In the following examples of file communication handle values, remember that the groov EPIC processor adds
the corresponding file (and path, if applicable) to the private area:

<table>
<thead>
<tr>
<th>Description</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creates the file myfile.txt and opens it for writing.</td>
<td>file:w,myfile.txt</td>
</tr>
<tr>
<td>Opens the existing file myfile.txt so data can be appended to it.</td>
<td>file:a,myfile.txt</td>
</tr>
<tr>
<td>Creates the file Temperature_data.txt in the directory Data_files and opens it for writing. If the directory doesn’t exist, it is created.</td>
<td>file:w,Data_files/Temperature_data.txt</td>
</tr>
<tr>
<td>Opens the file Temperature_data.txt in the directory Data_files for reading.</td>
<td>file:r,Data_files/Temperature_data.txt</td>
</tr>
</tbody>
</table>

Examples of File Communication Handle Values (groov EPIC only)

The following examples apply to the private area, which is accessible only to control programs with
authentication over secure protocols.

<table>
<thead>
<tr>
<th>Description</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creates the file Fuel_level.txt in the home directory and opens it for writing.</td>
<td>file:w,~/Fuel_level.txt</td>
</tr>
<tr>
<td>Opens the existing file Fuel_level.txt in the sub-directory tank1 of the private area so data can be appended to it.</td>
<td>file:a,~/tank1/Fuel_level.txt</td>
</tr>
</tbody>
</table>

The following examples apply to the unsecured area of internal storage, which is accessible to PAC Control
strategies and control programs.

<table>
<thead>
<tr>
<th>Description</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creates the file Fuel_level.txt in the home directory of the unsecured area and opens it for writing.</td>
<td>file:w,~/unsecured/Fuel_level.txt</td>
</tr>
<tr>
<td>Opens the file Fuel_level.txt in the sub-directory tank1 of the unsecured area for reading.</td>
<td>file:r,~/unsecured/tank1/Fuel_level.txt</td>
</tr>
</tbody>
</table>

The following examples apply to a USB storage device that is assigned to the unsecured area. A couple of
things to know about these examples:

• When the USB storage device was mounted to the groov EPIC processor, it was configured as Unsecured.
• A portion of the path was assigned by groov Manage; specifically, the /run/media/sdb1 part. When
  you try this example, you’ll want to check in groov Manage for the name that it assigned to that portion
  of the path.

For more information or instructions on either of these points, see groov EPIC User’s Guide (form 2267):

<table>
<thead>
<tr>
<th>Description</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens the file Fuel_level.txt in the home directory.</td>
<td>file:r,/run/media/sdb1/Fuel_level.txt</td>
</tr>
<tr>
<td>Opens the file Fuel_level.txt in the sub-directory tank1.</td>
<td>file:w,/run/media/sdb1/tank1/Fuel_level.txt</td>
</tr>
</tbody>
</table>

NOTE: Data written to a file may not be written immediately. Once the communication handle is closed, all of
the data is finalized and saved to the file. For this reason, you should close the communication handle before trying to
read data from the file.
Adding a Communication Handle

To add a communication handle, see the steps starting on page 259. In the Add Variable dialog box, enter the communication handle value in the Initial Value field.

![Add Variable Dialog Box](image)

Communication handle value

Limitations and Usage Notes for Files Stored on a Processor or Controller

Keep the following limitations in mind as you program the file communication handle to access the controller’s file system:

<table>
<thead>
<tr>
<th>Limitation</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum length for file names and directory names</td>
<td>127 characters</td>
</tr>
<tr>
<td>File name characters allowed</td>
<td>All ASCII characters except * . ? , null, and /</td>
</tr>
<tr>
<td>Path name component separator</td>
<td>/</td>
</tr>
<tr>
<td>Maximum number of files and directories that can be open simultaneously</td>
<td>16</td>
</tr>
<tr>
<td>Maximum directory depth</td>
<td>For groov EPIC processors: The length of a path name is limited to approximately 254 characters. Therefore, if you create short path names, the directory depth can be deeper. If you create long path names, the directory depth is shorter. For SNAP PAC controllers: Limited only by available memory</td>
</tr>
<tr>
<td>Maximum number of files</td>
<td>Limited only by available memory. Each file uses 516 bytes of overhead plus its number of bytes rounded up to the nearest multiple of 516 bytes.</td>
</tr>
<tr>
<td>Maximum number of directories</td>
<td>Limited only by available memory. Each directory uses 516 bytes.</td>
</tr>
<tr>
<td>Maximum amount of memory available in the control engine’s file system</td>
<td>Approximately:</td>
</tr>
<tr>
<td></td>
<td>• 2 GB on groov EPIC processora</td>
</tr>
<tr>
<td></td>
<td>• 4 MB on a SNAP-PAC-S1</td>
</tr>
<tr>
<td></td>
<td>• 2 MB on a SNAP PAC R-series controller</td>
</tr>
<tr>
<td></td>
<td>These values can vary slightly depending on the control engine firmware version.</td>
</tr>
</tbody>
</table>

*aThe amount of memory available on a groov EPIC processor can vary. To find out how much is available, go to groov Manage and click Info & Help, then System Status. The amount currently available is displayed in the Resources section, in the Memory Available row.

If power to the control engine is turned off, files are destroyed unless they have been saved to flash memory. For information on saving files to flash using PAC Control commands, see “Commands Relating to Permanent Storage” on page 303.
Limitations and Usage Notes for Files Stored on a USB Storage Device (groov EPIC only)

If your groov EPIC processor has a USB storage device inserted into a USB port, you can use PAC Control commands with files on a USB storage device just as you would with any other file in the processor’s file system. Before programming the commands, review the requirements and instructions on connecting and configuring USB storage devices in the groov EPIC User’s Guide (form 2267). You will also want to find the path name that groov EPIC assigns to the USB storage device.

Limitations and Usage Notes for Files Stored on a microSD Card (SNAP PAC only)

If your SNAP PAC controller has a microSD card slot in the top of the controller’s case, you can use PAC Control commands with files on a microSD card just as you would with any other file in the controller’s file system. Just keep these helpful tips in mind:

- Include the card’s directory name in the path in the file communication handle, for example:
  `file:a,/sdcard0/VoltLog.txt`

- Filename length: See your controller’s user’s guide for card compatibility information. Filenames up to 127 characters can be used on higher-capacity microSDHC cards. However, on lower-capacity standard microSD cards (2GB or less, formatted with FAT16), all files you store on the card must be named with a maximum of eight characters in the name plus three characters in the extension (8 dot 3 format), for example: `datafile.txt`

- Instead of allowing multiple charts in your strategy to access the microSD card, use just one chart for handling all calls (for example, communicating, reading, and writing) to the card. Allowing multiple charts to access the card can cause conflicts and potentially slow down processing.

- Too many files in a directory can cause slow processing. Minimize the number of files in each directory on the microSD card; for example, keep less than 1,000 files in each directory—including the root directory. Periodically remove any files that are no longer needed in order to keep the quantity down, or consider storing files in subdirectories.

- Consider using a persistent table (at least initially) to keep frequently accessed data, and then write the data to the microSD card every hour or so. Logging data directly to a microSD card is much slower than storing the data in a persistent table.

For more information on using the microSD card, see the controller’s user guide.

Working with Files in Your Strategy

The commands you use with a communication handle vary according to the action (the open mode) defined in the handle’s value. To change actions—from read to write, for example—you can use Set Communication Handle Value to change the handle’s value.

<table>
<thead>
<tr>
<th>Use these command with any file communication handle</th>
<th>Use these command with file comm handles in Read mode</th>
<th>Use these command with file comm handles in Write or Append mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Communication</td>
<td>Receive Numeric Table</td>
<td>Transfer N Characters</td>
</tr>
<tr>
<td>Communication Open?</td>
<td>Receive Pointer Table</td>
<td>Transmit Character</td>
</tr>
<tr>
<td>Get Available File Space</td>
<td>Receive String</td>
<td>Transmit NewLine</td>
</tr>
<tr>
<td>Get Number of Characters Waiting</td>
<td>Receive String Table</td>
<td>Transmit Numeric Table</td>
</tr>
<tr>
<td>Open Outgoing Communication</td>
<td>Send Communication Handle Command (delete, getpos, or setpos)</td>
<td>Transmit Pointer Table</td>
</tr>
<tr>
<td>Send Communication Handle Command</td>
<td>Set Communication Handle Value</td>
<td>Transmit String</td>
</tr>
<tr>
<td>(delete, getpos, or setpos)</td>
<td>Set End-of-Message Terminator</td>
<td>Transmit String Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To work with files in your strategy, first use the command Open Outgoing Communication.

Writing to a File. For example, suppose you have data in your strategy in a string table (Product_Table) that you want to write to a file (Products.txt) in a directory (Company Data) on the control engine. Here’s how you would do it:

1. Use Open Outgoing Communication to open a file communication handle. The value of the handle would be: `file:w,Company Data/Products.txt`
2. Use the condition Communication Open? to make sure the communication handle opened.
3. To put the data from the string table into a comma-delimited file (which is easy to open in database software), use the command Set End-Of-Message Terminator to indicate that a comma should be used as the delimiting character. Or, if you want each line of your data to end with a LF (line feed), set the EOM (end-of-message) terminator to 10 (decimal), which is the ASCII code for LF. See “ASCII Table” on page 329 for other EOM characters.
4. Use the command Transmit String Table to transmit data from Product_Table directly into the Products.txt file. Items from the string table are separated by commas in the file.

```
<table>
<thead>
<tr>
<th>Product_Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
</tbody>
</table>
```

5. Use the command Close Communication to close the communication handle.

**Reading a File.** As another example, suppose you have a file on the control engine that was placed there via FTP. (See the next section for details on using the FTP communication handle.) You want to read this file (New_Data.txt) and place the data in it into a string table (Data_Table) in your strategy.
6. Use Open Outgoing Communication to open a file communication handle. The value of the handle would be: `file:r,New_Data.txt`
7. Use the condition Communication Open? to make sure the handle opened.
8. Use the command Set End-Of-Message Terminator to indicate what character in the New_Data.txt file should be read as the delimiting character. (In the example shown below, it’s a slash.)

**TIP:** If the lines of data in the text file end with LF (line feed), set the EOM (end-of-message) terminator to 10 (decimal), which is the ASCII code for LF.

9. Use the command Receive String Table to receive the data from New_Data.txt directly into Data_Table. To read the whole file, use a value of -1 for the Length parameter.

```
<table>
<thead>
<tr>
<th>Data_Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
</tbody>
</table>
```

Notice the numbers used in this example. These are numbers represented as strings. For the purpose of storing and sending data, this is the simplest way to represent them. If you need to use them in calculations, however, you must first convert them to numeric values. You can do so in your PAC Control.
strategy by using a command such as Convert String to Float or Convert String to Integer 32. (See “String Commands” on page 323 for more information.)

10. It might also be helpful to use the command Send Communication Handle Command which provides the following commands that you can use when accessing files.
   - find: locates data in the file if each line has a unique identifier.
   - getpos returns an integer that indicates the current position in the file.
   - setpos:<position> jumps to the specified position within the file.
   - find:<mystring> (strings only) searches for the string within the file and returns its location as an offset from the current position in the file. The file must have been opened in r (read) mode.

11. Finally, close the communication handle by using the command Close Communication.

A More Complex Example. Here’s a more complex example which shows the actual OptoScript code. In this example, someone on the network needs the value of several variables in the PAC Control strategy running on the control engine. This person has sent to the control engine via FTP a comma-delimited text file (ProductRequest.txt) containing the names of the variables. (See “Moving Files via FTP” on page 282 for information on FTP.)

This section of the PAC Control strategy reads the variable names from the text file in the control engine’s file system and places the names in a string table (Product_Names). Next, the strategy uses the command Get Value From Name to place the values of the variables into another table (Product_Info). The data from this table is then written to another text file (ProductInfo.txt) on the control engine, which can later be sent via FTP to the person who requested the data.

The whole operation (including the FTP portions, which are not covered in this example), might look like this:
The OptoScript code in this example also makes use of the command Set Communication Handle Value to change the value of a specific communication handle during the operation.

<table>
<thead>
<tr>
<th>Sets the value for the communication handle chAFile.</th>
<th>SetCommunicationHandleValue(&quot;file:r,ProductRequest.txt&quot;,chAFile);</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens the communication handle and checks to make sure it opened.</td>
<td>status = OpenOutgoingCommunication(chAFile); if (status == 0) then</td>
</tr>
<tr>
<td>Sets the end-of-message terminator to a comma because the file to be read is comma-delimited.</td>
<td>SetEndOfMessage Terminator(chAFile, ',');</td>
</tr>
<tr>
<td>Reads the contents of the file Product_Names into a string table.</td>
<td>status = ReceiveStrTable(4,0,Product_Names,chAFile);</td>
</tr>
<tr>
<td>Loops through the items in Product_Names table and places the values they represent into another string table, Product_Info. (Note that the “numbers” in the Product_Info table are not true numbers, but string representations of numbers.)</td>
<td>index = 0; while ((index &lt; 4) and (status == 0)) status = GetValueFromName(Product_Names[index], Product_Info[index]); index = index + 1;wend</td>
</tr>
<tr>
<td>Closes communication.</td>
<td>status = CloseCommunication(chAFile);</td>
</tr>
<tr>
<td>Changes the value of the communication handle; it is now set to write to the file ProductInfo.txt on the control engine.</td>
<td>SetCommunicationHandleValue(&quot;file:w,ProductInfo.txt&quot;,chAFile);</td>
</tr>
<tr>
<td>Opens the communication handle and checks to make sure it opened.</td>
<td>status = OpenOutgoingCommunication(chAFile); if (status == 0) then</td>
</tr>
<tr>
<td>Makes the ProductInfo.txt file comma-delimited, too.</td>
<td>SetEndOfMessage Terminator(chAFile, ',');</td>
</tr>
<tr>
<td>Writes the data from the Product_Info string table into the ProductInfo.txt file on the control engine.</td>
<td>status = TransmitStrTable(4,0,Product_Info,chAFile); endif</td>
</tr>
</tbody>
</table>

Deleting Files and Moving Within Them. Another command you’ll find useful with file communication handles is Send Communication Handle Command. It provides a way for you to send a series of file manipulation commands to delete files, find a position within the file, or jump to a specific position within the file. For syntax and usage notes on the Send Communication Handle Command, see the PAC Control Command Reference (form 1701) or online help.

For example, in order to find specific data in a file, you can program a series of Send Communication Handle Commands that sends each of the following commands.

- **find:<mystring>**  
  (for strings only) Use this command to search for a string within the file and return its location as an offset from the current position in the file. The file must have been opened in r (read) mode.

- **getpos**  
  Returns an integer that indicates the current position in the file.

- **setpos:position**  
  Jumps to the specified position within the file.

Moving Files via FTP

As explained in the previous section (“Managing and Accessing Files in the Control Engine’s File System,” starting on page 275) the control engine’s memory includes a substantial area available for file storage. You can move files to and from file storage using the File Transfer Protocol (FTP):
To move files to and from file storage using another device such as a PC, use any standard FTP software. See instructions in the PAC Manager User’s Guide (form 1704). A maximum of five devices can FTP files to a control engine simultaneously.

To move data to and from file storage programmatically, a strategy can request or send a file using an FTP communication handle, explained in this section. A maximum of 16 communication handles can be used simultaneously to move data via FTP.

FTP also allows you to get a directory listing of files on a remote server or in the local file storage area. In addition, if your SNAP PAC controller has a microSD card slot in the top of the controller’s case, you can use the FTP communication handle to manipulate files on a microSD card.

**FTP Communication Handle Examples**

The value for the FTP communication handle is in the format:

```
ftp:<IP address>:<port>,<username>,<password>,<optional timeout>
```

Here are two examples of FTP communication handle values:

- `ftp:10.22.55.35:21,jsmith,2towers,60`  (timeout increased to 60 seconds)
- `ftp:10.192.54.195:21,m,m`  (no timeout specified)

To add a communication handle, see the steps starting on page 259. In the Add Variable dialog box, enter the communication handle value in the Initial Value field.

### Setting the FTP Mode

If you are connecting to an FTP site behind a firewall, you may need to set a mode for the session. After the communication handle is open, you can set the FTP mode by issuing one of the following commands:

- For Active FTP:
  ```
i32ResultCode = SendCommunicationHandleCommand(cmh, "active");
```
For Passive FTP:
`i32ResultCode = SendCommunicationHandleCommand(cmh, "passive");`

**Using FTP Communication Handles in Your Strategy**

Suppose you have data you need to send via FTP to a device on the network whose IP address is 10.192.56.45. Your user name on this device is JoeG and your password is hello. You expect the default timeout of 30 seconds to be adequate.

There are two ways you can send the data: all at once, or in pieces over time. If your data file is less than 1 MB in size, you can send it all at once. If it is larger, or if you want to append additional data to a file that already exists, you send it in pieces.

**Sending or Retrieving the Data All At Once.** This method is better for small data files; files larger than 1 MB may take a long time to transfer, and the control engine may become unresponsive during the process.

**For Sending:** Suppose you want to send the data currently in the file SendThisData.txt on the control engine to a file HunkoData.txt on the device.

Here’s how you would send the data in your PAC Control strategy.

1. Use the command Open Outgoing Communication to open an FTP communication handle. The value of the handle would be: `ftp:10.192.56.45:21,JoeG,hello`
2. Use the condition Communication Open? to make sure the communication handle opened.
3. Use the command Send Communication Handle Command to specify the file name and send the file in one step.
   Use the communication handle command `send:<local filename>, <remote filename>` as follows:
   ```
   send:SendThisData.txt,HunkoData.txt
   ```
   If the remote file name already exists, it is overwritten.
4. When you have finished sending data to the file, use the command Close Communication to close the communication handle.

**For Retrieving:** Suppose you want to get the data from the file GetThisData.txt on the device, and retrieve it to the file HunkoData.txt on the control engine.

Here’s how you would retrieve the data in your PAC Control strategy.

1. Use the command Open Outgoing Communication to open an FTP communication handle. The value of the handle would be: `ftp:10.192.56.45:21,JoeG,hello`
2. Use the condition Communication Open? to make sure the communication handle opened.
3. Use the command Send Communication Handle Command to specify the file name and retrieve the file in one step.
   Use the communication handle command `get:<remote filename>,<local filename>` as follows:
   ```
   get:GetThisData.txt,HunkoData.txt
   ```
   If the local file name already exists, it is overwritten.
4. When you have finished retrieving data from the file, use the command Close Communication to close the communication handle.

**Sending the Data in Pieces.** To append data to an existing file, or to send a very large file (larger than 1 MB), you can send data in pieces.

Suppose you want to append data from a strategy variable or table to an existing file named HunkoData.txt on the device. Here’s how you would send the data:

1. Use the command Open Outgoing Communication to open an FTP communication handle. The value of the handle would be: `ftp:10.192.56.45:21,JoeG,hello`
2. Use the condition Communication Open? to make sure the communication handle opened.
3. To specify the file name on the remote server, use the command Send Communication Handle Command. The communication handle command you send is:
   dest:HunkoData.txt
4. Use a Transmit command (such as Transmit String or Transmit Numeric Table) to send the data. In the command, use the name of the FTP communication handle you just opened.
   Data is appended to the file. (If the remote file name is new, the file is created and the data placed in it.)
5. When you have finished sending data, use the command Close Communication to close the communication handle.

If you are sending a large file from the control engine to the device, you would need to open up two communication handles: an FTP handle just like the one in the example above, and a File handle for the file on the control engine. Then use the Transfer N Characters command to send the file in chunks.

For another example, see the diagram in “A More Complex Example” on page 281, which shows how FTP communication handles and file communication handles might be used together. See the PAC Control Command Reference or online Help for detailed information on commands.

**Retrieving a Directory Listing**

The OptoScript code in this example makes use of the command Set Communication Handle Value and the dir option to retrieve a directory listing.

<table>
<thead>
<tr>
<th>Sets the value for the communication handle chAFile.</th>
<th>// Configure the chFTP comm handle to log into itself. The username and // password don't matter—they just can't be left empty. We'll use the // loopback address of 127.0.0.1 so this code is more portable. SetCommunicationHandleValue(&quot;ftp:127.0.0.1:21,noimporta,whocares&quot;, chFTP);</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens the communication handle and checks to make sure it opened.</td>
<td>// Open the communication handle (log in to the local server) nStatus = OpenOutgoingCommunication( chFTP );</td>
</tr>
<tr>
<td>Requests directory listing, returns number of listings.</td>
<td>if (nStatus == 0) then</td>
</tr>
<tr>
<td>Makes sure “dir” worked. Firmware must be version R7.1 or greater.</td>
<td>nStatus = SendCommunicationHandleCommand( chFTP, &quot;dir&quot; );</td>
</tr>
<tr>
<td>Reads in listings to stList. NOTE: Each listing from an Opto 22 device server ends with these hex bytes: 0D 0A and is delineated from the next by a 00.</td>
<td>if (nStatus &gt;= 0) then</td>
</tr>
<tr>
<td>Optional: Parses each listing into separated tables for: 1. date/time stamp (first 17 characters) 2. file size (next 21 characters) 3. file name (remaining characters) and removes the 0D 0A left over on the end of the file name.</td>
<td>nFileCount = nStatus;</td>
</tr>
<tr>
<td>Further parsing could be done on the date/time stamps, depending on how those values will be used.</td>
<td>// Set the EOM character to 00 SetEndOfMessageTerminator( chFTP, 0x00 );</td>
</tr>
<tr>
<td></td>
<td>nStatus = ReceiveStrTable( nStatus, 0, stList, chFTP );</td>
</tr>
<tr>
<td></td>
<td>if ( nStatus == 0 ) then</td>
</tr>
<tr>
<td></td>
<td>for nIndex = 0 to (nFileCount - 1) step 1</td>
</tr>
<tr>
<td></td>
<td>GetSubstring( stList[nIndex], 0, 17, stDateTimeStamps[nIndex] ) ;</td>
</tr>
<tr>
<td></td>
<td>GetSubstring( stList[nIndex], 18, 21, sTemp ); nSizes[nIndex] = StringToInt32( sTemp ) ;</td>
</tr>
<tr>
<td></td>
<td>GetSubstring( stList[nIndex], 39, 1000, stFilenames[nIndex] ); nLength = GetStringLength( stFilenames[nIndex] ) ;</td>
</tr>
<tr>
<td></td>
<td>GetSubstring( stFilenames[nIndex], 0, nLength - 2, stFilenames[nIndex] ) ;</td>
</tr>
<tr>
<td></td>
<td>next</td>
</tr>
<tr>
<td></td>
<td>endif</td>
</tr>
<tr>
<td></td>
<td>endif</td>
</tr>
<tr>
<td></td>
<td>CloseCommunication( chFTP );</td>
</tr>
</tbody>
</table>
Communicating with Serial Devices

There are several ways to connect serial devices to a groov or SNAP PAC system:

- Directly to a processor or controller
- Through a serial module

After you connect the devices, you can send or receive data directly from a serial device, such as barcode readers, weigh scales, or any intelligent device.

Your PAC Control strategy communicates with these intelligent devices through communication handles (serial or TCP).

<table>
<thead>
<tr>
<th>If you are connecting serial devices...</th>
<th>...then the PAC Control strategy will...</th>
<th>Follow the instructions...</th>
</tr>
</thead>
<tbody>
<tr>
<td>to a groov EPIC processor, SNAP PAC controller, or a groov serial module</td>
<td>communicate through a serial communication handle.</td>
<td>in the rest of this section.</td>
</tr>
<tr>
<td>to a SNAP PAC serial module</td>
<td>communicate through a TCP communication handle.</td>
<td>on page 260.</td>
</tr>
</tbody>
</table>

The rest of this section describes how to enable communication with serial devices connected as described in the first situation above:

1. Connect the device.
   - “Connecting Serial Devices Directly to a Processor or Controller” on page 286
   - “Connecting Serial Devices to a groov Serial Module” on page 287.
2. Configure the serial port as described on page 287.
3. Identify the port number or numbers as described on page 287.
4. Create the communications handle in PAC Control as described on page 287.
5. Program the communications flow as described on page 290.

Connecting Serial Devices Directly to a Processor or Controller

Several Opto 22 SNAP PAC controllers and the groov EPIC processor (GRV-EPIC-PR1) provide a way to directly connect a serial device:

**groov EPIC processor.** On the bottom, through the USB ports. You connect the serial device to a USB-to-serial adapter, which then connects to one of these ports. You can expand the number of serial devices you can connect to the processor by first connecting a USB hub to one of these ports, then attaching adapters to each port in the hub. For a description of how this works, see “Connecting Serial Devices” in the **groov EPIC User’s Guide** (form 2267).
SNAP PAC, SNAP-LCE, and SNAP Ultimate controllers. On the top. The following diagram shows some examples:

Connecting Serial Devices to a groov Serial Module
The groov serial module provides serial data communications for a variety of applications. For specific instructions on connecting serial devices to these modules, see the groov Serial Modules Data Sheet (form 2296).

Configuring the Serial Port
For serial devices connected through a groov serial module, you don’t need to do any port configuration in groov Manage.

For serial devices connected to a SNAP PAC, SNAP-LCE, or SNAP Ultimate controller, configure the serial port as instructed in the following sections:

- For SNAP PAC R-series and SNAP Ultimate controllers: “Configuring Serial Ports on an On-the-Rack Controller” of either the PAC Manager User’s Guide (form 1704)
- For SNAP PAC S-series controllers: “Configuring Serial Ports on a Standalone Controller” of either the PAC Manager User’s Guide (form 1704)
- For SNAP LCE controllers: “Configuring Serial Devices” of the SNAP-LCE User’s Guide (form 1475)

IMPORTANT: For SNAP PAC, SNAP-LCE, and SNAP Ultimate controllers, be sure to use PAC Manager to set the control function of any serial port you want to use to None. Otherwise, you will get a -20, (Resource Busy), error.

Identifying the Port Name or Number Assigned to a Serial Device
Each of the ports (whether they be on the processor, controller, or a groov serial module) is assigned a port name or number. PAC Control communication handles need to know that name or port number. To find that name:

- For SNAP PAC, SNAP-LCE, and SNAP Ultimate controllers, see the section that describes port numbering in the respective controller’s user’s guide.
- For groov EPIC, see “Finding the device name and port number assigned to a serial device” in groov EPIC User’s Guide (form 2267).

Creating a Communication Handle for Serial Devices
In your PAC Control strategy, create a variable with the type Communication Handle. This variable will represent the serial device. (For instructions on adding a communication handle, see the steps starting on page 259.)

NOTE: Be sure to use a single communication handle for each of a controller’s physical serial ports. If two charts were to run simultaneously while sharing an open communication handle, it is possible for one serial port to transmit data (on the wire) at the same time the remote device is transmitting a response.

You can specify the initial value for the variable in one of the following formats:

- **Format 1**—For serial devices connected to SNAP PAC and SNAP-LCE controllers. You must use this format for serial devices connected to SNAP Ultimate controllers. For instructions, see “Format 1” on page 288.
• **Format 2**—For serial devices connected to SNAP PAC and SNAP-LCE controllers. You must use this format for serial devices connected to groov EPIC processors and groov serial modules. For instructions, see “Format 2” on page 288.

**Format 1.** You can use this format for serial devices connected to SNAP PAC and SNAP-LCE controllers. You must use this format for serial devices connected to SNAP Ultimate controllers.

The format for the communication parameters is:

```
ser: <port number>, <baud rate>, <parity>, <data bits>, <stop bits>
```

The valid values for these parameters are:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Valid Values</th>
</tr>
</thead>
</table>
| **port number** | SNAP-PAC-S1: 0, 1, or 2  
                 | SNAP-PAC-S2: 0, 1, 2, or 3  
                 | SNAP-PAC-R1, R1-B, and R2: 0  
                 | SNAP-LCE: 0 or 1  |
| **baud rate**   | 230400, 115200, 76800, 57600, 38400, 19200, 9600, 4800, 2400, 1200, or 300 |
| **parity**      | n, o, or e (none, odd, or even) |
| **data bits**   | 8 or 7 |
| **stop bits**   | 1 or 2 |

**EXAMPLE OF FORMAT 1**

Here is an example of a serial communication handle value for a device connected to a SNAP PAC controller:

```
ser: 0, 115200, n, 8, 1
```

(port 0, baud rate of 115,200, no parity, 8 data bits, and 1 stop bit)

In the Add Variable dialog box, enter the communication handle value in the Initial Value field.

---

**Format 2.** SNAP PAC and SNAP-LCE controllers. You must use this format for serial devices connected to groov EPIC processors and groov serial modules.

With this format, you prefix the parameter values with keywords. This format:

- offers more flexibility because you can specify keywords in any order. Each keyword must be lowercase and followed by an equal sign and a value, with no spaces (even after commas), and
- offers more parameters that you can specify; for example, you can specify RTS / CTS on a serial port on a SNAP S-series or R-series controller.
The format for the communication parameters is:

- For groov serial modules:
  @<channel name>:<keyword>=<value>,<keyword>=<value>,...

  *Note that you do not specify the port number.*

- For groov EPIC processors or SNAP PAC controllers:
  ser:<keyword>=<value>,<keyword>=<value>,...

  *NOTE: You must include at the minimum the port number and one parameter. Otherwise, it will not work.*

If a parameter is not specified, the current value is used, so if you are unsure of the current value for a parameter, you should specify it.

The keywords and possible values are:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Valid Values</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>port</td>
<td>groov EPIC processor and SNAP PAC and SNAP-LCE controllers: see documentation</td>
<td>For a list of available ports, see the documentation that came with your processor or controller.</td>
</tr>
<tr>
<td></td>
<td>groov serial module: do not use</td>
<td></td>
</tr>
<tr>
<td>baud</td>
<td>230400, 115200, 76800, 57600, 38400, 19200, 9600, 4800, 2400, 1200, or 300</td>
<td></td>
</tr>
<tr>
<td>parity</td>
<td>E, e, O, o, N, n, 9*</td>
<td>* A value of 9 is used for RS-485 multi-drop communications.</td>
</tr>
<tr>
<td>data</td>
<td>8, 7</td>
<td>The number of data bits</td>
</tr>
<tr>
<td>stop</td>
<td>1, 2</td>
<td>The number of stop bits</td>
</tr>
<tr>
<td>mode</td>
<td>0, 522*</td>
<td>* 522 enables I/O mode. 0 should be used for everything else.</td>
</tr>
<tr>
<td>rts-cts</td>
<td>0, 1, 2</td>
<td>This is only for RS-232 mode.</td>
</tr>
<tr>
<td></td>
<td>0 turns rts/cts off.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 enables symmetrical (full-duplex) rts-cts flow control.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 enables asymmetrical (half-duplex) rts-cts flow control. By default the system waits up to one second for cts to be asserted.</td>
<td></td>
</tr>
<tr>
<td>timeout</td>
<td>an integer or float value</td>
<td>A length of time in seconds. The default is 1 second.</td>
</tr>
</tbody>
</table>

**EXAMPLES OF FORMAT 2**

- For a device connected to a groov EPIC processor’s USB port 0:
  ser:port=0,baud=115200,data=8,parity=n,stop=1,rts-cts=0

- For a device connected to port #2 of a USB hub connected to USB port 1 on the groov EPIC processor:
  ser:port=0,baud=115200,data=8,parity=n,stop=1,rts-cts=1,timeout=1.5

- For a device connected to a groov serial module:
  Watt_Meter:port=1,baud=115200,parity=n,mode=0,timeout=1.5

  *Note that no port number is specified.*

- For devices connected to a SNAP PAC controller:
  ser:port=0,baud=115200,parity=n,stop=1,rts-cts=0
  ser:baud=115200,parity=n,mode=0,timeout=1.5
In the Add Variable dialog box, enter the communication handle value in the Initial Value field. (Due to the long value, part of the value is not visible.)

Programming the Serial Communications Flow

Program the communication flow in your PAC Control strategy as follows:

1. Add the command Open Outgoing Communication.
2. Verify that the communication handle opened by adding the Communication Open? command.
3. Add Transmit, Transfer, and Receive commands to send or receive data as necessary. Remember to check for any errors. Make sure your strategy receives data promptly:
   - For SNAP PAC, SNAP LCE, and SNAP Ultimate controllers: Incoming serial communication is buffered up to 127 characters. If more than 127 characters come in before the strategy receives them, the additional characters are lost.
   - For groov serial modules: Incoming serial communication is buffered up to 4096 characters. If more than 4096 characters come in before the strategy receives them, the additional characters are lost.

   NOTE: Leave the communication handle open for as long as you expect communication, instead of closing it after each transaction.

4. When you have finished sending and receiving data, add the Close Communication command to close the communication handle.

See the PAC Control Command Reference (form 1701) or online Help for details on using specific commands.

Sending an Email

There are two email commands that you can add to a strategy that instruct the control engine to send an email to recipients via SMTP:

- **Send Email** sends a text-only email.
- **Send Email with Attachments** sends text and one or more attached files such as log files, status reports, and images.

The following examples are just a few of the many possible uses for these commands:

- Send out updates of a system’s status.
- A critical system sends hourly status emails; if no email arrives after an hour, it means something is wrong.
- Send an email in case of an alarm condition.
Send a daily status report.

The rest of this section describes what you need to do to prepare your groov EPIC processor or SNAP PAC controller to send an email, then shows you an example of how to add programming to your strategy that creates and sends an email.

Configuring Your Controller or Processor to Send Emails

There are a few things you must do and some decisions you must make before you can start programming your strategy to send emails:

Step 1: Make sure the controller or processor has an IP address.

Step 2: Choose between a corporate email account or a free email account

Step 3: Collect SMTP server information for the corporate email account

Step 4: Install a new CA Root Certificate, and then install it.

**Step 1: Make sure the controller or processor has an IP address.** In addition to an IP address, make sure the controller or processor are assigned an appropriate Subnet Mask, DNS, and Gateway for the network.

- For SNAP PAC controllers, see the instructions on assigning an IP address in the PAC Manager User’s Guide (form 1704).
- For groov EPIC processors, see the instructions on connecting the processor to a network in the groov EPIC User’s Guide (form 2267).

**Step 2: Choose between a corporate email account or a free email account.** The Send Email commands require an existing email account.

If you want to use a corporate email account, discuss the following items with your network administrator:

- Determine if the company’s SMTP server supports either AUTH LOGIN or AUTH PLAIN authentication. The Send Email commands require one of these authentication methods. The commands do not support AUTH MD5 nor AUTH CRAM-MD5.
- Determine if the company SMTP server implements SSL or TSL security.
- If the company SMTP server implements SSL (Secure Sockets Layer) or TSL (Transport Layer Security), determine whether the root certificates in your SNAP PAC controller or groov EPIC processor are trusted by the SMTP server.

If you want to use a free email account such as Outlook.com® or Yahoo!® Mail, you’ll need to verify that the root certificate installed in your SNAP PAC controller or groov EPIC processor is trusted by the SMTP servers of your email service provider.

**Step 3: Collect SMTP server information for the corporate email account.** If you will be using a corporate email account, ask your network administrator for the following information about the SMTP server:

- **Outgoing SMTP server name or IP address**
- **Port**
- **Security type:** SSL and TLS are standard security technologies for establishing an encrypted link between a web server and a browser. Make note of which technology is implemented on your company SMTP server because you’ll be specifying this information in the server information table (see “Send Email with Attachments Example” on page 293).

If your company SMTP server does not implement any security, you’ll be specifying “none” in the server information table and the connection will not be authenticated. However, be aware of the following situations:

- If the target mail server doesn’t require SSL or TLS, the login will succeed.
- If the target mail server does require SSL or TLS, the login will fail.
Most servers require encryption, so unless you’re using an in-house server, you’ll probably be specifying SSL or TLS and need a root certificate.

- **Root certificate** (if applicable): A root certificate validates an SSL or TLS secure connection. (If you are unfamiliar with how root certificates work, see “Understanding root certificates” on page 292.) If you and your network administrator determine that the root certificate installed in the SNAP PAC controller or groov EPIC processor is not trusted by the company’s SMTP server, you must obtain a new root certificate and install it on your controller or processor.

You don’t need to install a root certificate to send email if:

- You’re using a SoftPAC controller. (SoftPAC uses the certificates installed in Windows).
- Your email service provider uses the Equifax® or Digicert® certificates built-in to PAC firmware (available in R9.5a and higher).

### UNDERSTANDING ROOT CERTIFICATES

You must install a *security certificate* if you want to have secure network communications using SSL/TLS Internet protocols. A security certificate is a digital tool used by Web browsers and other network services to validate the identity of the server your computer is connecting to. For example, before you access email or make a payment over an HTTPS Internet connection, the server and your computer verify their identities by exchanging information about their security certificates. If something is wrong with the certificates, your browser typically displays a warning that the connection is not secure.

A **CA certificate** is a type of security certificate that is issued by a Certificate Authority, which is a trusted entity (for example, Digicert® and GoDaddy®) that issues legitimate digital security certificates. A **root certificate** is a kind of security certificate that ensures the certificate’s authenticity by identifying the root CA (that is, the original source of the certificate’s verification). Root certificates use a special kind of cryptography known as *public key infrastructure*.

PAC firmware R9.5a and higher include certificates for Equifax and Digicert. This means that if you are using PAC firmware R9.5a (or higher) and PAC Manager R9.5a (or higher), you may not have to install a separate CA root certificate to send emails. However, you may need to install a CA root certificate if:

- Your email service provider doesn’t use the same certificates in PAC firmware.
- You want to use an HTTPS Get or HTTPS Post communication handle.
- You want to use a SNAP PAC device (as a client) to make a connection to other secure devices via a TCP communication handle.

Before you can install a CA root certificate, you must:

- Have a CA root certificate that uses Base64 ASCII format. (Your company’s IT department should be able to provide this, as they will know the server it needs to match. For example, if the certificate is for email, it must match the email server.)
  - You can tell a certificate file is Base64 ASCII format if:
    - The file has a .PEM extension; or
    - You open the file in a text editor (such as Notepad) and you see the line:
      “-----BEGIN CERTIFICATE-----”

      SNAP PAC controller can accept only one certificate per file. You can tell whether there is only one certificate in a file by opening the file in a text editor and verifying there is only one line that says, “-----BEGIN CERTIFICATE-----”

- Know where to locate the certificate on your network (that is, its path and filename).

**Step 4: Install a new CA Root Certificate.** If you need to install a new root certificate into a groov EPIC processor, see the instructions on managing certificates in the groov EPIC User’s Guide (form 2267).

For a SNAP PAC controller, you use PAC Manager to place the certificate in the /pki/roots-certs folder.
NOTE: As part of the process of installing the certificate on the controller, the controller will be restarted to activate the certificate. You may need to schedule a system shutdown to coordinate putting the certificate on the controller and rebooting the controller.

To place a root certificate in the /pki/root-certs folder on your controller:

1. In the PAC Manager menu bar, click Maintenance .
2. In the Command list, select Upload File To I/O Unit.
3. Click the Browse button  and browse to the location of the certificate. Select the certificate, and then click OK.
4. In the Destination field, type /pki/root-certs/ and the name you want the certificate to have on the controller; for example:
   /pki/root-certs/Equifax_Secure_CertificateAuthority.cer
5. Select the IP address of the SNAP PAC device that you want to install the certificate on.
6. Click Execute.
7. (Optional) Repeat steps 2–6 if you have additional certificates to install.
8. Select the Save Files To Flash command, and then click Execute.
9. Restart the SNAP PAC device to activate the certificates.

Send Email with Attachments Example

The simple example strategy below demonstrates how to use OptoScript to create and send an email using the Send Email with Attachments command. You can of course use the PAC Control versions of the Send Email commands. However, with OptoScript you can more easily see and edit each of the email components—the Server information, Recipients, Message Body, and Attachment File Names. For a description of the syntax and a list of the options available for these commands, see the PAC Control Command Reference (form 1701).
A sample chart to send email is available at www.opto22.com. Go to Support > Downloads and then search for Sample PAC Control Basic Chart to Send Email in Samples and Freeware.

The strategy is comprised of only one chart, the Powerup chart, which has two OptoScript blocks, Init Tables and SMTP Send. The first OptoScript block, Init Tables, contains the email body. The second one, SMTP Send, uses the Send Email with Attachments command to send the email and attachments.

Here’s how you build this example:

1. Create a new strategy and then choose Configure > Control Engine to configure a control engine. For instructions on configuring a control engine, see “Associating the Control Engine with Your Strategy” on page 98.

2. Create a numeric variable and a string variable as follows. For instructions on creating variables, see “Adding Variables” on page 233.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>nResult</td>
<td>Integer32</td>
</tr>
</tbody>
</table>

3. Create a string variable as follows.

<table>
<thead>
<tr>
<th>Name</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRLF</td>
<td>256</td>
</tr>
</tbody>
</table>
4. Create the following string tables. For instructions on creating string tables, see “Adding Variables” on page 233.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table Length</th>
<th>String Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>arrstrAttach</td>
<td>10</td>
<td>256</td>
</tr>
<tr>
<td>arrstrBody</td>
<td>100</td>
<td>1024</td>
</tr>
<tr>
<td>arrstrRecipients</td>
<td>10</td>
<td>256</td>
</tr>
<tr>
<td>arrstrServer</td>
<td>10</td>
<td>256</td>
</tr>
</tbody>
</table>

5. To the Powerup chart, add an Action Block followed by two OptoScript Blocks and then one more Action Block.

<table>
<thead>
<tr>
<th>Position</th>
<th>Name</th>
<th>Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>Begin</td>
<td>Action</td>
<td>Start</td>
</tr>
<tr>
<td>Second</td>
<td>Init Tables</td>
<td>OptoScript</td>
<td>Contains the email body</td>
</tr>
<tr>
<td>Third</td>
<td>SMTP Send</td>
<td>OptoScript</td>
<td>Sends the email and attachments</td>
</tr>
<tr>
<td>Fourth</td>
<td>End</td>
<td>Action</td>
<td>End</td>
</tr>
</tbody>
</table>

6. Connect the blocks starting with the first Action Block.

```
0. Begin

1. Init Tables — Init Tables contains the email body

2. SMTP Send — SMTP Send sends the email and attachments

3. End
```

7. Add code to the InitTables OptoScript Block.

This block creates the contents of the string tables which include server information, a recipient list, the body of the email, and a list of attached files.

The first line in the block defines CRLF as a carriage-return / linefeed combination, chr(13)+chr(10), which starts a new line in the email body. Defining this value allows you to use CRLF instead of having to spell out the chr(13)+chr(10) combination each time. For a double carriage-return / linefeed combination, use CRLF+CRLF.
NOTE: If multiple emails with the similar subject and body text are sent through the same email account, the emails may be flagged as SPAM by the email service provider and not be delivered. To avoid this, you may need to add code to the subject and body text that changes the text dynamically with each new email.

A—Server Information. The first five elements of the server table are required. The sixth element is optional.

- Element 0 (shown as arrstrServer[0] in the example): User account
  Here are the ways that you can specify the user account and “from” names in element 0:

<table>
<thead>
<tr>
<th>If you want this:</th>
<th>Use this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>No user account and no “from”</td>
<td>arrstrServer[0] = &quot;&quot;;</td>
</tr>
<tr>
<td>User Account only, (“from” uses the account name)</td>
<td>arrstrServer[0] = “MyAccount”;</td>
</tr>
</tbody>
</table>

---

```c
CRLF = chr(13)+chr(10); // For convenience
arrstrServer[0] = "myaccount@speedmail.com"; // User Account
arrstrServer[1] = "mypassword"; // Password
arrstrServer[3] = "587"; // Port#
arrstrServer[5] = "to.tx:2000"; // These are optional:
                             "to.tx:nnnn", "to.rx:nnnn", "to.cx:nnnn", "badcert:0", "revoked:0",
                             "expired:0", "matched:0", "knownca:0"
arrstrRecipients[0] = "xyz@mymail.com"; // Recipient list
arrstrRecipients[1] = "abc@yourmail.com";
arrstrRecipients[2] = ""; // This blank ends the recipient list
arrstrRecipients[3] = "johndoe@hismail.com"; // This recipient will be ignored
arrstrBody[0] = "Opto Email Example"; // Subject line
arrstrBody[1] = "Hello:"+CRLF; // Body starts here
arrstrBody[2] = CRLF; // Could have been combined above
arrstrBody[3] = "This is an example of an email that can be sent from a PAC ";
arrstrBody[4] = "controller. It includes three attachments: two JPG images, ";
arrstrBody[5] = "and this strategy."+CRLF+CRLF;
arrstrBody[10] = "Opto Controller";
arrstrBody[11] = ""; // This blank denotes end of body
arrstrBody[12] = "This is not included in the body.";
arrstrAttach[0] = "My_image_file.jpg"; // List of files to attach
arrstrAttach[1] = "Another_image_file.jpg"
arrstrAttach[3] = ""; // This blank ends the attachment list
arrstrAttach[4] = "Attachment.jpg"; // This attachment will be ignored
```
CHAPTER 10: PROGRAMMING WITH COMMANDS

For a **corporate email** account, the values you specify for the next three elements (Server, Port, and Security) are based on information you obtained from your network administrator when you completed “Step 3: Collect SMTP server information for the corporate email account” on page 291.

**Element 1** (shown as `arrstrServer[1]` in the example): Password

**Element 2** (shown as `arrstrServer[2]` in the example): Server

**Element 3** (shown as `arrstrServer[3]` in the example): Port number

**Element 4** (shown as `arrstrServer[4]` in the example): Security

Remember: specify “none” only after reviewing “Step 3: Collect SMTP server information for the corporate email account” on page 291.

**Element 5** (shown as `arrstrServer[5]` in the example): (optional) Transmission timeouts and which SSL errors to ignore.

If you want to change the timeouts for transmitting, receiving, and connecting, see “Setting Timeouts for the Send Email Commands” on page 298. The default is 10,000 milliseconds (10 seconds) for each.

If you want to specify that the control engine ignore certain SSL errors, see “Ignoring SSL errors” on page 298. The default is that no SSL errors are ignored.

**B— Recipients.** Enter the email address for each recipient. Make sure the recipients list contains at least one valid entry.

**C—Message Body.** Element zero is always the subject line. Each line is entered as a separate string. However, they will be concatenated in the body of the email. The email body starts with element one, and continues to the first empty element or the end of the table, whichever comes first. Note that a blank line is not the same as an empty element.

**D—Attachment File Names.** Any files you specify in the attachments table must exist on the SNAP PAC controller’s file system (RAM, flash, or SD card) or the groov EPIC processor’s file system (flash). Specify the path and file name as follows:

- If a file is in the root directory, just specify the file name.
- If the file is in a subdirectory, specify the full path name.
  - For SNAP PAC controllers, if a file is in a subdirectory of the SD card, you must put `/sdcard0` in front of the full path name. For example, `/sdcard0/temp/file.text` indicates that file.txt is in the `temp` subdirectory on the SD card.
  - For a groov EPIC processor, if a file is in the **secure** area, you must put `~` in front of the full path name. For example, `~/temp/file.text` indicates that file.txt is in the `temp` subdirectory of the `secure` area. If a file is in the **unsecured** area, you must put `~/unsecured` in front of the full path name. For example, `~/unsecured/temp/file.text` indicates that file.txt is in the `temp` subdirectory of the `unsecured` area.

You can attach any kind of file, so long as there is room in the file system. However, be cautious about file size; many Internet service providers still have a 10 MB attachment limit.

8. Add code to the SMTP Send OptoScript block.

<table>
<thead>
<tr>
<th>If you want this:</th>
<th>Use this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account only (no “from”)</td>
<td><code>arrstrServer[0] = &quot;MyAccount:\n&quot;;</code></td>
</tr>
<tr>
<td>“from” only (no user account)</td>
<td><code>arrstrServer[0] = &quot;:FromName\n&quot;;</code></td>
</tr>
<tr>
<td>Separate account and “from” names</td>
<td><code>arrstrServer[0] = &quot;MyAccount:FromName\n&quot;;</code></td>
</tr>
</tbody>
</table>
This block invokes the Send Email with Attachments command to send the email with attachments:

```
// Send email with attachments, using the tables set up previously
nResult = SendEmailWithAttachments(
    arrstrServer, // Table with server info
    arrstrRecipients, // List of recipients
    arrstrBody, // Body text
    arrstrAttach ); // List of attachments
```

9. Click Debug, and then click Run Strategy.

The email and attachments are sent to the recipient(s) in your list.

For more information on these commands, see the PAC Control Command Reference (form 1701).

**Setting Timeouts for the Send Email Commands**

The default Send Mail commands timeout for transmitting, receiving, and connecting is 10,000 milliseconds (10 seconds) when you have filled in elements 0–4 of the Server Information table (see page 296). If you want to change one or more timeouts from the default, add an element 5 and specify the value as follows:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Use this command (where “nnnn” is the timeout in milliseconds):</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set transmit timeout</td>
<td>“to.tx:nnnn”</td>
</tr>
<tr>
<td>Set receive timeout</td>
<td>“to.rx:nnnn”</td>
</tr>
<tr>
<td>Set connect timeout</td>
<td>“to.cx:nnnn”</td>
</tr>
</tbody>
</table>

Each timeout command is independent of the others so you can use one, two, or all three of the commands in any order. If you use more than one command, put a space between each one.

The following example sets the transmit timeout to 20 seconds and the receive timeout to 15 seconds. The connect timeout is not changed.

```
arrstrServer[5]=”to.tx:20000 to.rx:15000"
```

**Ignoring SSL errors**

You can specify options to ignore certain SSL errors when the strategy attempts to send an email. Before you specify these options, carefully review (preferably with your network administrator) whether the need to send the email outweighs the risk of ignoring certain SSL errors. You can specify any of the following options in element 5 of the server information table:

<table>
<thead>
<tr>
<th>To ignore this error:</th>
<th>Specify this option:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate is corrupt or unusable</td>
<td>“badcert:0”</td>
</tr>
<tr>
<td>Certificate was revoked by the issuing authority</td>
<td>“revoked:0”</td>
</tr>
<tr>
<td>Current date is beyond the certificate’s end date</td>
<td>“expired:0”</td>
</tr>
<tr>
<td>Neither the certificate’s common name nor subject alternate name matches the name of the host you’re talking to</td>
<td>“matched:0”</td>
</tr>
<tr>
<td>The authority that issued the certificate isn’t in the database of known issuers</td>
<td>“knownca:0”</td>
</tr>
</tbody>
</table>
If you specify more than one option, put a space between each one. The following example instructs the control engine to ignore SSL errors about corrupt certificates or certificate names that don’t match.

```
arrstrServer[5]="badcert:0 matched:0"
```

**Retrieving a Webpage**

Use the HTTP Get command to retrieve non-secure (HTTP) or secure (HTTPS) content from a web page. The example provided here uses the HTTP Get command in OptoScript to retrieve secure content from www.google.com. For more information on this command, see the **PAC Control Command Reference** (form 1701).

To retrieve HTTPS content from a website, you will first need to:

- Obtain the root certificate used by the target website to validate an SSL secure connection. (Your company’s IT department should be able to provide this, as they will know the server it needs to match.)
- Install the root certificate on your SNAP PAC controller. For instructions, see “Step 4: Install a new CA Root Certificate” on page 292.

**NOTE:** If you are using a SoftPAC controller, you don’t need additional root certificates to use HTTP Get— the necessary certificates are preinstalled with Windows.

For this example, you’ll need to install the Equifax Secure Certificate Authority (DER encoded X.509) root certificate, which is available at [www.opto22.com](http://www.opto22.com). (Go to Support > Downloads and then search for Equifax Root Certificate in Samples and Freeware.) For instructions to install the certificate, see page 292.

1. Make sure the controller is assigned an IP address as well as the appropriate Subnet Mask, DNS, and Gateway for the network. For more information on how to do this, see the **PAC Manager User’s Guide** (form 1704).
2. In PAC Control, create a new strategy.
3. Create the following numeric (Integer 32) variables set to "Initialize on strategy run." For more information, see "Adding Variables" on page 233.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>nHttpStatus</td>
<td>Integer32</td>
</tr>
<tr>
<td>nPortSSL</td>
<td>Integer32</td>
</tr>
<tr>
<td>nSendStatus</td>
<td>Integer32</td>
</tr>
</tbody>
</table>

4. Create the following string variables.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Type</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>strCmd</td>
<td>String</td>
<td>100</td>
</tr>
<tr>
<td>strURL</td>
<td>String</td>
<td>256</td>
</tr>
</tbody>
</table>

5. Create the following string tables. For more information, see "Public Access" on page 239.

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Type</th>
<th>Length</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>DstStrTblBody</td>
<td>String</td>
<td>100</td>
<td>1024</td>
</tr>
<tr>
<td>DstStrTblHdr</td>
<td>String</td>
<td>100</td>
<td>1024</td>
</tr>
<tr>
<td>HTTP_SrcStrTblBody</td>
<td>String</td>
<td>10</td>
<td>256</td>
</tr>
</tbody>
</table>

6. Add an Action Block named Begin, and an OptoScript Block named Get Content to the Powerup chart.

7. Connect the Begin block to the Get Content block.
8. Add the following code to the OptoScript Block.

```plaintext
MoveToStrTableElements("", 0, -1, HTTP_SrcStrTblBody);
MoveToStrTableElements("", 0, -1, DstStrTblHdr);
MoveToStrTableElements("", 0, -1, DstStrTblBody);

strURL = "www.google.com";
strCmd = "/";
nPortSSL = 443;

nSendStatus = HttpGet(
    DstStrTblBody, // Return body data dest string table
    DstStrTblHdr,  // Return header data dest string table
    HTTP_SrcStrTblBody, // Source body data string table (may be empty)
    1, // 0 for non-secure, <>0 for SSL
    strCmd, // URL
    nHttpStatus, // Status returned by HTTP server
    nPortSSL,  // Port to which you want to connect
    strURL );  // Address, (numeric or www.google.com, etc)
```

**A—MoveToStrTableElements.** These lines ensure that the tables are empty.

**B—Web address.** The text string used for argument 7. For example "www.google.com".

**C—Sub-page.** A forward slash (/) indicates the root level.

**D—Port number.** 80 is the standard port if you want to retrieve HTTP content. 443 is the standard port if you want to retrieve HTTPS content.

**E—Timeouts.** Use element [0] of the table for Argument 2 to change the timeouts for transmitting, receiving, and connecting. For details, see “Setting Timeouts for the HTTP Get and HTTP Post from String Table Commands” on page 302.

**F—Security mode.** Use 0 to retrieve non-secure connection HTTP content. Use a number other than zero (such as 1) to retrieve secure HTTPS content.

9. Click Debug, and then click Run Strategy.
10. Double-click the DstStrTblBody table to see whether the webpage content was retrieved. If content was retrieved, you will see HTML code.

Setting Timeouts for the HTTP Get and HTTP Post from String Table Commands

The default timeout for transmitting, receiving, and connecting is 10,000 milliseconds (10 seconds). If you want to change one or more timeouts from the default, specify the value in element [0] of the table for Argument 2, as follows:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Use this command (where “nnnn” is the timeout in milliseconds):</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set transmit timeout</td>
<td>“to.tx:nnnn”</td>
</tr>
<tr>
<td>Set receive timeout</td>
<td>“to.rx:nnnn”</td>
</tr>
<tr>
<td>Set connect timeout</td>
<td>“to.cx:nnnn”</td>
</tr>
</tbody>
</table>

Each timeout command is independent of the others so you can use one, two, or all three of the commands in any order. If you use more than one command, put a space between each one.

The following example sets the transmit timeout to 20 seconds and the receive timeout to 15 seconds. The connect timeout is not changed.

HTTP_SrcStrTblBody[0]="to.tx:20000 to.rx:15000"

CONTROL ENGINE COMMANDS

The following commands refer to the control engine:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Strategy CRC</td>
<td>Get Redundant Controller State</td>
</tr>
<tr>
<td>Erase Files In Permanent Storage</td>
<td>Get Redundant Controller Status</td>
</tr>
<tr>
<td>Get Available File Space</td>
<td>Get Strategy Name</td>
</tr>
<tr>
<td>Get Control Engine Address</td>
<td>Load Files From Permanent Storage</td>
</tr>
<tr>
<td>Get Control Engine Type</td>
<td>Retrieve Strategy CRC</td>
</tr>
<tr>
<td>Get Firmware Version</td>
<td>Save Files To Permanent Storage</td>
</tr>
<tr>
<td>Get Number of Charts</td>
<td>Start Alternate Host Task</td>
</tr>
</tbody>
</table>
CHAPTER 10: PROGRAMMING WITH COMMANDS

Commands Relating to Permanent Storage

The term "Permanent Storage" in three of the commands listed above refers to the control engine’s flash memory. Files that are saved to flash memory remain in the control engine even when power to it is turned off. On a SoftPAC controller, files are saved to the PC's hard drive.

These commands do NOT affect firmware files, configuration data, or strategy files saved to flash; they affect only files at the root of the control engine's file system. For more information on the file system, see "Managing and Accessing Files in the Control Engine's File System" on page 275. For the specifics on individual commands, see online help or the PAC Control Command Reference (form 1701).

CAUTION: Since these commands write to flash memory, use them sparingly within your strategy and make sure they do not end up in a loop. You can literally wear out flash memory if you save to it or erase it too many times.

DIGITAL POINT COMMANDS

The following commands are used with digital points:

<table>
<thead>
<tr>
<th>Basic Commands</th>
<th>Latches</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off?</td>
<td>Clear All Latches</td>
</tr>
<tr>
<td>On?</td>
<td>Clear Off-Latch</td>
</tr>
<tr>
<td>Turn Off</td>
<td>Clear On-Latch</td>
</tr>
<tr>
<td>Turn On</td>
<td>Get Off-Latch</td>
</tr>
<tr>
<td></td>
<td>Get On-Latch</td>
</tr>
<tr>
<td>Totalizers</td>
<td>Get &amp; Clear Off-Latch</td>
</tr>
<tr>
<td>Get Off-Time Totalizer</td>
<td>Get &amp; Clear On-Latch</td>
</tr>
<tr>
<td>Get On-Time Totalizer</td>
<td>Off-Latch Set?</td>
</tr>
<tr>
<td>Get &amp; Restart Off-Time Totalizer</td>
<td>On-Latch Set?</td>
</tr>
<tr>
<td>Get &amp; Restart On-Time Totalizer</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Counters</th>
<th>Pules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Counter</td>
<td>Generate N Pulses</td>
</tr>
<tr>
<td>Get Counter</td>
<td>Get Off-Pulse Measurement</td>
</tr>
<tr>
<td>Get &amp; Clear Counter</td>
<td>Get Off-Pulse Measurement Complete Status</td>
</tr>
<tr>
<td>Start Counter</td>
<td>Get &amp; Restart Off-Pulse Measurement</td>
</tr>
<tr>
<td>Stop Counter</td>
<td>Get On-Pulse Measurement</td>
</tr>
<tr>
<td>Get &amp; Restart Period</td>
<td>Get On-Pulse Measurement Complete Status</td>
</tr>
<tr>
<td>Get Period Measurement Complete Status</td>
<td>Get &amp; Restart On-Pulse Measurement</td>
</tr>
<tr>
<td>Get TPO Percent</td>
<td>Start Continuous Square Wave</td>
</tr>
<tr>
<td>Get TPO Period</td>
<td>Start Off-Pulse</td>
</tr>
<tr>
<td>Set TPO Percent</td>
<td>Start On-Pulse</td>
</tr>
<tr>
<td>Set TPO Period</td>
<td></td>
</tr>
</tbody>
</table>

1 Some digital point commands are available only in PAC Control Professional. Some commands are available only on some I/O units. For more information for each command, see the PAC Control Command Reference (form 1701) or online Command help.
States, Latches, and Counters

The following diagram illustrates states, latches, and counters. While states and latches apply to digital points on all I/O units, counters depend on the capability of the brain. See the brain’s data sheet for specifications.

Latches

Latches are an extremely high-speed digital function. Both on-latches and off-latches are available. Latches are automatic and do not have to be configured.

When the value of a digital input point changes from off to on, an on-latch is automatically set. While the value of the point may return to off, the on-latch remains set until cleared, as a record of the change. Similarly, an off-latch is set when the value of a digital point changes from on to off, and it remains set until cleared.

To read a latch and clear it at the same time, use the command Get & Clear On-Latch or Get & Clear Off-Latch.

Counters

Most standard digital inputs can be used as counters to count the number of times the input changes from off to on. The availability of counters depends on the brain's capabilities, and the speed of counters depends on the module.

For information on brain capabilities, see the SNAP PAC Brains Data Sheet (form 1689).

For more information on module counting speed, see the module’s specifications at www.opto22.com. On the website, select Products > SNAP PAC System > Brains and I/O > Digital I/O.

**NOTE:** You can use counters on high-density modules with SNAP-PAC-R1 and SNAP-PAC-R1-B controllers, and SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware R8.1 or higher.

Before using a counter, you must configure the point as a counter. (See “Adding I/O Points” on page 124 or use PAC Manager.) Counters on Ethernet and SNAP PAC I/O units do not need to be started, and they cannot be stopped. Therefore, do not use the Start Counter and Stop Counter commands with SNAP PAC I/O units. However, you can use Get Counter and Get & Clear Counter.
Quadrature Counters

Quadrature counters require a special module and configuration, but once they are configured, you use the same commands (such as Start Counter and Clear Counter) for them as for regular counters.

**NOTE:** You can use counters on high-density modules with SNAP-PAC-R1 and SNAP-PAC-R1-B controllers, and SNAP-PAC-EB1 and SNAP-PAC-SB1 brains with firmware R8.1 or higher.

Before using a counter, you must configure the point as a counter. (See “Adding I/O Points” on page 124 or use PAC Manager.) Counters do not need to be started, and they cannot be stopped. Therefore, do not use the Start Counter and Stop Counter commands. However, you can use Get Counter and Get & Clear Counter. A positive value means that phase A leads phase B. See additional details in the *PAC Control Command Reference* or online Help.

Totalizers

Digital totalizers track the total time a specific input point has been on or off. For example, you could track how long a pump, fan, or motor has been on. Digital totalizers are useful for periodic maintenance. Before using a totalizer, you must configure the point with this feature. (See “Manually Adding groov I/O Modules & Channels or SNAP I/O Modules & Points” on page 126 for help.) The availability of totalizers depends on the brain; see the brain’s data sheet for more information.

To check total time and leave the totalizer running, use Get Off-Time Totalizer or Get On-Time Totalizer. To check total time and reset the totalizer to zero, use Get & Restart Off-Time Totalizer or Get & Restart On-Time Totalizer.

Pulses

Pulsing commands send on- and off-pulses to an output point. The availability of pulsing depends on the brain; see the brain’s data sheet for specifications.

**Generate N Pulses.** The command Generate N Pulses is frequently used to flash a light or sound an alarm. For example, you could sound a two-second alarm four times. In the arguments, you set the number of times the on-pulse is sent, the length of the on-pulse, and the length of the off-pulse. Generate N Pulses always starts with an off-pulse. If you resend this command, make sure to leave sufficient time in between so it does not interfere with itself.

**Start On Pulse and Start Off Pulse.** The commands Start On Pulse and Start Off Pulse send a single pulse cycle:

- Start On Pulse starts with an on-pulse of a length you determine, and ends with an off-pulse.
- Start Off Pulse starts with an off-pulse of a length you determine, and ends with an on-pulse.

Both of these commands can be used as time delays. For example, if a light is on and you want to turn it off after 30 seconds, you can send a Start On Pulse command, setting the on-pulse to be 30 seconds long. At the end of that time, the off-pulse is sent to turn off the light.

You can also use this type of command in a loop to turn a digital point on or off for short intervals. For example, you could create a loop that checks the level of liquid in a tank and pulses on a drain if the level is too high. The advantages of using a pulse command are that the point does not have to be turned off, and if communication is lost to the point, the point does not remain on.

**Pulse Measurement commands** measure pulses on digital input points. For details, see the specific command in the *PAC Control Command Reference* or online Help.
IVAL and XVAL

In PAC Control, all I/O points have two values:

- **XVAL**—The external value, or XVAL, is the “real” or hardware value and it is located on the I/O unit (the brain). This value is external to the control engine and strategy logic.

- **IVAL**—The internal value, or IVAL, is a logical or software copy of the XVAL that is located in the control engine. The IVAL may or may not be current, since it is only updated when strategy logic accesses the I/O point.

As you run your programs in Debug Mode and monitor I/O points, you’ll see that IVAL and XVAL usually match. If the IVAL does not match the XVAL, it just means that your strategy logic is not reading from or writing to the I/O point in question at the moment.

How the XVAL and IVAL Values Help You Debug, Simulate, and Test

To test output performance, you may want to force an I/O point to a particular value. If the program is actively writing to that I/O point, you need to disable the communication from the control engine to the I/O point. Then you can change the XVAL to force the output to a particular value. If the program is stopped, there is no need to disable the communication.

To test program logic, you may want to force an I/O point to a particular value. However, doing so may be difficult or inconvenient. (For example, if an I/O point monitors daylight, switching between day and night would require waiting for sunrise and sunset.) In these situations, you can disable the communication from the control engine to the I/O point. Then, you can change the IVAL of an I/O point to simulate a particular value.

You can disable the communication from the control engine to the I/O point in two ways:

- The more common way is from within Debug mode, by double-clicking a point on the Strategy Tree and modifying the point’s settings and values through the Inspection dialog box. (See “Inspecting and Changing Discrete I/O Points or Channels” on page 155.)

- The second way is from within the strategy, using commands such as Disable Communication to Digital Point, Disable Communication to Analog Point, or Disable Communication to I/O Unit. (See “Simulation Commands” on page 322.)

Additional Commands to Use with Standard Digital Points

Although not listed under Digital Point commands, several other commands can be used for digital operations:

- **Use Move** to cause an output to assume the state of another input or output. A digital input or output that is on returns a True (non-zero). A True (non-zero) sent to a digital output turns it on.

- **Use NOT** to cause an output on one I/O unit to assume the opposite state of an input on another I/O unit.

- **Use Get I/O Unit as Binary Value** to get the state of all points at once. Then use **Bit Test** to determine the state of individual points. This method is much faster than reading each point individually.

- **Use Set I/O Unit From MOMO Masks** to control all outputs at once.

Standard Digital Points and OptoScript Code

In OptoScript code, a standard digital I/O point can be used directly, wherever a numeric variable can be used. For example, you can turn a point off by assigning it a value of zero, or turn it on by assigning it a non-zero value. You can also use standard digital points directly in mathematical expressions and control structures. For more information, see “Using I/O in OptoScript” on page 342.
CHAPTER 10: PROGRAMMING WITH COMMANDS

Reading or Writing Digital Points
The Move command is the main command used to read or write digital points.

ERROR HANDLING COMMANDS
The following commands refer to handling errors:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Message to Queue</td>
<td>Get Error Code of Current Error</td>
</tr>
<tr>
<td>Add User Error to Queue</td>
<td>Get Error Count</td>
</tr>
<tr>
<td>Add User I/O Unit Error to Queue</td>
<td>Get ID of Block Causing Current Error</td>
</tr>
<tr>
<td>Caused a Chart Error?</td>
<td>Get Line Causing Current Error</td>
</tr>
<tr>
<td>Caused an I/O Unit Error?</td>
<td>Get Name of Chart Causing Current Error</td>
</tr>
<tr>
<td>Clear All Errors</td>
<td>Get Name of I/O Unit Causing Current Error</td>
</tr>
<tr>
<td>Copy Current Error to String</td>
<td>Get Severity of Current Error</td>
</tr>
<tr>
<td>Disable I/O Unit Causing Current Error</td>
<td>Remove Current Error and Point to Next Error</td>
</tr>
<tr>
<td>Enable I/O Unit Causing Current Error</td>
<td>Stop Chart on Error</td>
</tr>
<tr>
<td>Error on I/O Unit?</td>
<td>Suspend Chart on Error</td>
</tr>
</tbody>
</table>

All good programmers must deal with errors. These error handling commands are used to monitor errors, figure out which I/O unit caused an error, disable or re-enable communication to the I/O unit, and clear errors and other messages from the message queue. For a simple example of an error handler chart, see page 85. For more on the message queue, see “Queue Messages” on page 384.

You can use the command Add User Error to Queue to add your own information, warning, or error message to the queue. This command can be helpful in troubleshooting.

IO Enabler Sample Strategies
Sample “IO Enabler” strategies are available on the Opto 22 website. The logic in these sample strategies is designed to automatically recover communications to any I/O unit that temporarily goes offline (that is, has communications disabled) for any reason. Choose a sample that is compatible with your system configuration. Each sample has the same basic code:

- I/O Enabler for Ethernet, SNAP PAC, and Multifunction and Remote Simple (RS) mistic Brains
- I/O Enabler for Ethernet, SNAP PAC, and Multifunction mistic Brain
- I/O Enabler for Ethernet and SNAP PAC Brains

I/O QUALITY COMMANDS

NOTE: Applicable only to groov I/O in PAC Control R10.0a and higher only.

I/O Quality commands let you know if an exception condition has happened on a groov I/O channel.
groov I/O modules that report quality continuously poll their channels for current data values and identify deviations between reported and expected values. For example, when a channel on a GRV-IV-24 reports a value greater than 10% above range, the module sets a quality indicator code 15 (Input is more than 10% above the maximum range) on the channel. When the issue is resolved, the quality indicator code returns to 0 (zero). For a list of quality indicator codes and descriptions, see “Quality Indicator Codes” on page 308.

Not all modules report data quality. The ones that do are:

<table>
<thead>
<tr>
<th>I/O Module</th>
<th>Quality Indicator Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRV-IMA-24</td>
<td>0, 15, 16</td>
</tr>
<tr>
<td>GRV-ITMI-8</td>
<td>0, 15, 16</td>
</tr>
<tr>
<td>GRV-IV-24</td>
<td>0, 15, 16</td>
</tr>
<tr>
<td>GRV-OAC-12</td>
<td>0, 9</td>
</tr>
<tr>
<td>GRV-OACI-12</td>
<td>0, 9</td>
</tr>
<tr>
<td>GRV-OVMALC-8</td>
<td>0, 18, 21, 22</td>
</tr>
</tbody>
</table>

A quality indicator doesn’t always mean a serious problem, but it’s definitely something you should investigate. It may indicate a configuration issue or an issue with a field device or field wiring. For example, if you write a maximum output value that’s higher than a channel’s normal range, the module may report a quality indicator code of 21 (Output is at positive range limit); that is, the output channel is functioning normally at its maximum positive range, despite the fact that your configuration tried to set its maximum range to an out-of-range value.

### Quality Indicator Codes

A brief description of a channel’s quality indicator is visible when you are scanning the channel in PAC Control’s Debug mode. When you use a PAC Control I/O Quality command, a code is returned instead of the description. The following is a list of valid quality indicator codes and their definitions.

0 = Data quality is good. No exception conditions occurred.

9 = Digital output is on, but current is not flowing. May indicate an open circuit or blown fuse in field equipment.

15 = Analog input is above 110% of channel’s range. Applicable to unipolar (zero and positive values only) and bipolar (can include negative and positive values) signal ranges.

16 = Analog input is below -110% of channel’s range. Applicable to unipolar (zero and positive values only) and bipolar (can include negative and positive values) signal ranges.

18 = Analog output fault.

- When configured for voltage, indicates the load resistance is too low (that is, the load is drawing too much current to maintain the voltage).
- When configured for current, indicates very high resistance or possible open current loop.

21 = Analog output is at the positive range limit. Applicable only when the value written exceeds the maximum limit. Indicates the module has clamped the output to the limit. Can be caused by a configuration or logic error; for example, the strategy sent a value to the channel that is above the channel’s maximum range.

22 = Analog output is at the minus range limit. Applicable only when the value written exceeds the minimum limit. Indicates the module has clamped the output to the limit. Can be caused by a configuration or logic error; for example, the strategy sent a value to the channel that is below the channel’s minimum range.

30 = Node not found.
I/O UNIT COMMANDS

The following commands are used to communicate with an I/O unit, which controls a group of I/O points:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear I/O Unit Configured Flag</td>
<td>Move I/O Unit to Numeric Table Ex</td>
</tr>
<tr>
<td>Get I/O Unit as Binary Value</td>
<td>Move Numeric to I/O Unit</td>
</tr>
<tr>
<td>Get I/O Unit as Binary Value 64</td>
<td>Move Numeric to I/O Unit Ex</td>
</tr>
<tr>
<td>Get Target Address State (^1)</td>
<td>Set All Target Address States (^1)</td>
</tr>
<tr>
<td>I/O Unit Ready?</td>
<td>Set I/O Unit Configured Flag</td>
</tr>
<tr>
<td>I/VAL Move Numeric Table to I/O Unit</td>
<td>Set I/O Unit from MOMO Masks</td>
</tr>
<tr>
<td>I/VAL Move Numeric Table to I/O Unit Ex</td>
<td>Set Target Address State (^1)</td>
</tr>
<tr>
<td>Move I/O Unit to Numeric Table</td>
<td>Write I/O Unit Configuration to EEPROM</td>
</tr>
</tbody>
</table>

\(^1\) PAC Control Professional only

**CAUTION:** Write I/O Unit Configuration to EEPROM is not the recommended method for saving configuration to flash memory. If it is used too often or in a loop within a strategy, flash memory can literally wear out. Instead of using this command in the strategy, it is better to store configurations to flash manually using either PAC Manager (see the PAC Manager User’s Guide, form 1704, for instructions) or PAC Control in Debug mode (see “Inspecting I/O Units” on page 154).

Commands for Ethernet Link Redundancy

(Pro only) The three target address commands (Get Target Address State, Set Target Address State, and Set All Target Address States) are used to manually change the path of communication between the controller and the I/O unit(s), based on the IP address used for the I/O unit. These commands let you switch communication from a primary to a secondary IP address (or vice versa) or enable or disable communication to the primary or secondary address.

Ethernet link redundancy to I/O units is available only in PAC Control Professional. The secondary IP address for an I/O unit may be for the second Ethernet network interface on a SNAP PAC R-series controller, or it may be for a separate I/O unit. If it is a separate unit, the primary and secondary I/O units must be the same type (for example, SNAP-PAC-EB1) and have exactly the same points, because they are configured together under one name.

One or both target addresses (primary and secondary) can be enabled, but only one address (the active address) will be used by the controller at one time. For link redundancy, both the primary and secondary addresses must be enabled. When an I/O unit is configured with two IP addresses, the default is for both to be enabled and the primary address to be active.

One address is always active. If communication fails through the primary address, the control engine automatically switches to the secondary address. It continues to use the secondary address until communication fails through the secondary address or until you change the active address using Set Target Address State (for one I/O unit) or Set All Target Address States (for all I/O units on the control engine).

You may also want to use these commands to disable one address, for example if you are doing maintenance or repair on a network segment and need to switch communication to another segment temporarily. Disabling one address, of course, means that you no longer have link redundancy.

If both addresses are disabled or unavailable, then communication is not possible and communication to the I/O unit becomes disabled. If both addresses are disabled, and you want to bring the I/O unit back online, you must first enable one or both of the addresses and then enable communication to the I/O unit.

You can find out which addresses are enabled for an I/O unit and which address is currently active by using Get Target Address State. If an address is enabled but is not functional when a strategy is started or when communication for an I/O unit is changed from Disabled to Enabled, an error is posted in the controller’s error queue.
To use these commands, you must have already designated primary and secondary IP addresses when configuring I/O units. For steps, see “Adding an I/O Unit” on page 119. For additional information about link redundancy, see “Creating Redundant Ethernet Links in PAC Control” on page 100.

**Table Commands**

The table commands for I/O units affect the states or values of all points on the I/O unit at once. For example, you can use the command Move I/O Unit to Numeric Table to read the states of all digital points and the values of all analog points on one I/O unit and place them into a table for easy retrieval. Table commands move data very quickly for faster throughput.

Three of the table commands—IVAL Move Numeric Table to I/O Unit Ex, Move I/O Unit to Numeric Table Ex, and Move Numeric Table to I/O Unit Ex—provide support for high-density points. A Points per Module parameter lets you specify the number of points required. For example, if you are using 32-channel modules, you would pass a 32. But if you are only using 8-channel modules, you could pass an 8 instead. This allows table sizes to be as small as possible.

Other commands relating to tables can be found in the following topics:

- “Miscellaneous Commands” on page 317
- “Logical Commands” on page 313
- “Mathematical Commands” on page 314
- “Pointer Commands” on page 321
- “String Commands” on page 323.

**I/O UNIT—EVENT MESSAGE COMMANDS**

The following commands refer to event messages sent from SNAP PAC I/O units.

<table>
<thead>
<tr>
<th>Get I/O Unit Event Message State</th>
<th>Set I/O Unit Event Message State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get I/O Unit Event Message Text</td>
<td>Set I/O Unit Event Message Text</td>
</tr>
</tbody>
</table>

A SNAP PAC I/O system can send a message as a response to an event that occurs within strategy logic. For example, if pressure in a pipe reaches a certain level, the system can send a warning email message to a technician. Or data about a process can be streamed to a computer every 30 seconds for monitoring.

**CAUTION:** Events and reactions (including event messages that are processed separately from your strategy) can conflict with strategy logic. If you are using PAC Control, use strategy logic instead of local events and reactions on the I/O unit, or be very careful that local events and reactions do not conflict.

Use PAC Manager to configure event messages, following the steps in the PAC Manager User’s Guide (form 1704). You can configure the following types of event messages:

- Email or paging messages sent to a person
- Simple Network Management Protocol (SNMP) traps sent to an enterprise management system
- Serial messages sent through a serial communication module to a serial device
- Streamed data sent to a device for processing by a software application.

**I/O Unit—Event Message commands** are commonly used to find out the state or text of an event message, or to set its state. Event messages can be in the following states:

- **Active**—The message has been triggered by the event. If it was configured to be sent just once, it has been sent. If it was configured to be sent at intervals, it is continuing to be sent.
- **Inactive**—The message is not currently triggered by the event.
- **Acknowledged**—The message has been triggered by the event but has been acknowledged by the receiver so it will not be sent again. (Acknowledgments occur only if the receiving application writes
them to the brain’s memory map.) Acknowledged is functionally equivalent to Inactive, but can be useful in some cases to determine whether the receiver has received the message.

The command Set I/O Unit Event Message Text is used to dynamically change a message or to “recycle” a message if you run out of event messages on an I/O unit (128 event messages are available for each I/O unit). For more information, see individual commands in the PAC Control Command Reference or online help.

## I/O UNIT—MEMORY MAP COMMANDS

The following commands refer to the memory map in an Opto 22 memory-mapped device, either a controller or an I/O unit. In the case of a controller/brain, they can refer to the device’s own memory map or a memory map on another device.

<table>
<thead>
<tr>
<th>Read Number from I/O Unit Memory Map</th>
<th>Write Number to I/O Unit Memory Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Numeric Table from I/O Unit Memory Map</td>
<td>Write Numeric Table to I/O Unit Memory Map</td>
</tr>
<tr>
<td>Read String from I/O Unit Memory Map</td>
<td>Write String Table to I/O Unit Memory Map</td>
</tr>
<tr>
<td>Read String Table from I/O Unit Memory Map</td>
<td>Write String to I/O Unit Memory Map</td>
</tr>
</tbody>
</table>

Memory map commands make it possible for advanced users to read from or write to any Opto 22 memory-mapped device, such as a SNAP PAC controller or brain. You can use these commands to read or write to any address within the memory map. The commands are especially useful for reading data from a SNAP device using newer features that may be available in the memory map but are not yet incorporated into PAC Control.

**NOTE:** If you are reading or writing to the device’s Scratch Pad area, use the I/O Unit—Scratch Pad commands instead (see page 311). If you are changing event messages, use the I/O Unit—Event Message commands instead (page 310).

In order to use these commands with a SNAP PAC S-series or SoftPAC controller, first you need to create an I/O Unit of the type Generic OptoMMP Device to represent the controller. Use the controller’s IP address or the loopback address, 127.0.0.1.

When you use these commands, make sure that you read or write the correct type of data (integer, float, string) to match the specified memory map address. The control engine doesn’t know what type of data is in any particular address, so it cannot convert the data type.

Since these are I/O unit commands, remember to check all return values and errors to make sure the command was successful. If a command variable contains a value that is obviously wrong—for example, a memory map address in an incorrect format—communication to the I/O unit will be automatically disabled.

See the OptoMMP Protocol Guide (form 1465) to determine the memory map addresses and data types you need.

## I/O UNIT—SCRATCH PAD COMMANDS

The following commands are used for peer-to-peer communication for sharing strategy data with other Opto 22 memory-mapped controllers on the network. These commands are used by PAC Control to read or write to the Scratch Pad area in the memory map of a SNAP PAC controller.

Since each read (get) or write (set) command is completed before another occurs, commands cannot interfere with each other. For example, a get command won’t read a partial string while a set command is writing the string.

<table>
<thead>
<tr>
<th>Get I/O Unit Scratch Pad Bits</th>
<th>Set I/O Unit Scratch Pad Bits from MOMO Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get I/O Unit Scratch Pad Float Element</td>
<td>Set I/O Unit Scratch Pad Float Element</td>
</tr>
<tr>
<td>Get I/O Unit Scratch Pad Float Table</td>
<td>Set I/O Unit Scratch Pad Float Table</td>
</tr>
</tbody>
</table>

PAC Control User’s Guide 311
Because these are I/O unit commands, in order to use these commands with a SNAP PAC S-series or SoftPAC controller, first you need to create an I/O Unit of the type Generic OptoMMP Device to represent the controller. Use the controller’s IP address or the loopback address, 127.0.0.1.

Also because these are I/O unit commands, remember to check all return values and errors to make sure the command was successful. If a command variable contains a value that is obviously wrong—for example, a memory map address in an incorrect format—communication to the I/O unit will be automatically disabled.

Each controller running a PAC Control strategy can place data in its own or another’s Scratch Pad area, and each can retrieve data that has been placed in the Scratch Pad area by other devices using other applications. Using these commands eliminates the need to open communication handles (see “Communication Commands” on page 257), thus speeding up peer-to-peer communication.

The memory map Scratch Pad area supports four data types: bits, integer 32s, floats, and strings.

- For details on the Scratch Pad area, see the PAC Manager User’s Guide (form 1704).
- For the complete memory map, see the OptoMMP Protocol Guide (form 1465).
- For details on using the Scratch Pad for peer-to-peer communication with a controller, see the controller’s user’s guide.

The following page shows a simple example of how Scratch Pad area data exchange would work between two SNAP R-series I/O systems.

Create two tables for PAC_R_A, one for its own data that will be shared (A_Shared_Data) and another for data it will read from PAC_R_B (B_Data). Also create two tables for PAC_R_B, one for its own data (B_Shared_Data) and one for PAC_R_A’s data (A_Data).

Suppose PAC_R_A and PAC_R_B are sharing 600 integer elements of the 10,240 integer elements available in the Scratch Pad.

PAC_R_A writes data from its own PAC Control strategy table to its own Scratch Pad area, which SPAC_R_B can then read.

Meanwhile, PAC_R_B writes data from its B_Shared_Data table to its Scratch Pad area, which PAC_R_A reads.

NOTE: When the SNAP R-series I/O unit is writing to its own Scratch Pad, use the loopback IP address, 127.0.0.1.
This portion of the flowchart in PAC_R_A (without error checking) might look like this:

As you can see, PAC_R_A uses the Set I/O Unit Scratch Pad command to write the data from its own table to its own memory map. PAC_R_A also reads data from PAC_R_B’s memory map and places it in table B_Data.

A similar flowchart would be in PAC_R_B’s strategy, to handle writing to its own Scratch Pad area and reading from PAC_R_A.

LOGICAL COMMANDS

The following commands perform logical functions.

Commands ending a question mark (for example, AND? and OR?) indicate an instruction for a condition block.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>Int32 to Float Bits</td>
</tr>
<tr>
<td>AND?</td>
<td>Less Than Numeric Table Element?</td>
</tr>
<tr>
<td>Bit AND</td>
<td>Less Than or Equal to Numeric Table Element?</td>
</tr>
<tr>
<td>Bit AND?</td>
<td>Less Than or Equal?</td>
</tr>
<tr>
<td>Bit Change</td>
<td>Less?</td>
</tr>
<tr>
<td>Bit Clear</td>
<td>Make Integer 64</td>
</tr>
<tr>
<td>Bit Copy</td>
<td>Move 32 bits</td>
</tr>
<tr>
<td>Bit NOT</td>
<td>NOT</td>
</tr>
<tr>
<td>Bit NOT?</td>
<td>Not Equal to Numeric Table Element?</td>
</tr>
<tr>
<td>Bit Off in Numeric Table Element?</td>
<td>Not Equal?</td>
</tr>
<tr>
<td>Bit Off?</td>
<td>NOT</td>
</tr>
<tr>
<td>Bit On in Numeric Table Element?</td>
<td>Numeric Table Element Bit Clear</td>
</tr>
<tr>
<td>Bit On?</td>
<td>Numeric Table Element Bit Set</td>
</tr>
<tr>
<td>Bit OR</td>
<td>Numeric Table Element Bit Test</td>
</tr>
<tr>
<td>Bit OR?</td>
<td>OR</td>
</tr>
</tbody>
</table>
Understanding Logical Commands

For condition blocks, the Instructions dialog box provides options to designate AND or OR for multiple commands. If you have more than one command in the same condition block and you choose the AND option, all of the commands must evaluate true for the block to exit true. If you have more than one command in a condition block and choose the OR option, the block exits true if any of its commands evaluates true.

Logical actions and conditions work with integers, individual bits within an integer, a single digital I/O point, or a digital I/O unit. These values are treated as Boolean; that is, they are either True or False.

For complex logical operations, you may find OptoScript code easier to use than standard PAC Control commands. See "Using Logical Operators" on page 350 for more information.

Logical True and Logical False

PAC Control always returns a value of +1 to indicate True in an integer variable.

A digital input or output that is on also returns a True (+1). Any non-zero value sent to a digital output turns it on. False is defined as zero (0).

For individual bits within an integer variable, bits that are set (1) indicate on. Bits that are cleared (0) indicate off.

While floats can be used in logic, integers are strongly recommended whenever any bits are referenced. Since PAC Control does not permit bits in a float value to be altered, float values must be converted to integers before bits can be evaluated. See "Mathematical Commands" on page 314 for further information on integers and floats.

MATHEMATICAL COMMANDS

The following commands perform mathematical functions:

<table>
<thead>
<tr>
<th>Absolute Value</th>
<th>Raise to Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Round</td>
</tr>
<tr>
<td>Clamp Float Table Element</td>
<td>Seed Random Number</td>
</tr>
</tbody>
</table>
Using Integers

In PAC Control, an integer 32 is a 32-bit signed number ranging from -2,147,483,648 to 2,147,483,647 (±2 billion). An integer 64 ranges from -9,223,372,036,854,775,808 to 9,223,372,036,854,775,807. An integer can only be a whole number (-1, 0, 1, 2, 3, etc.). In other words, integers do not include a decimal point. The result of an integer operation is always an integer, even if it is placed in a float variable. For example, if 9 is divided by 10, the result is zero (0.9 truncated to an integer). To receive a float result, at least one of the operators would have to be a float. Use the Truncate command to round down to the nearest whole number.

Controlling Rounding

Use the Round command to round up or down to the nearest whole number. Note that 1.50 rounds up to 2.0, and 1.49 rounds down to 10.

Using Floats

While computers, CPUs, and electronic devices (such as Opto 22 controllers) store numbers in binary format, most often they represent real numbers as floating point numbers, or floats. For example, in industrial automation applications, all analog values read from an I/O unit are floats. Floats represent real numbers in scientific notation: as a base number and an exponent.

The IEEE Standard for Binary Floating-Point Arithmetic (IEEE 754) is the most widely used standard for floating-point computation. It defines how to store real numbers in binary format and how to convert between binary and float notations.

Opto 22’s SNAP PAC System uses IEEE single-precision floats, which have 32 binary digits (bits). The IEEE 754 32-bit float format is as follows:

<table>
<thead>
<tr>
<th>1 bit</th>
<th>8 bits</th>
<th>23 bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sign</td>
<td>Exponent</td>
<td>Significand</td>
</tr>
</tbody>
</table>

Float calculation: \((-1)^{\text{Sign}} \times \left[1 + \text{Significand}/2^{23}\right] \times 2^{(\text{Exponent}-127)}\)

While this is an excellent standard for the purpose, it has limitations that could cause issues if you’re not aware of them. Squeezing infinitely many real numbers into a finite number of bits requires an approximate
representation. Most floats cannot be exactly represented using this fixed number of bits in a 32-bit IEEE float. Because of this, rounding error is inherent in floating-point computation.

In PAC Control (and in PAC Manager and the OptoMMP protocol), a float is a 32-bit IEEE single-precision number ranging from $\pm 3.402824 \times 10^{-38}$ to $\pm 3.402824 \times 10^{+38}$. These single-precision floats give rounding errors of less than one part per million (1 PPM). You can determine the limit of the rounding error for a particular float value by dividing the value by 1,000,000.

This format guarantees about six and a half significant digits. Therefore, mathematical actions involving floats with seven or more significant digits may incur errors after the sixth significant digit. For example, if the integer 555444333 is converted to a float, the conversion yields $5.554444e+8$ (note the error in the 7th digit). Also, converting $5.554444e+8$ back to an integer yields 555444352 (note the error starting in the 7th digit).

**Float Issues and Examples**

Accumulation of Relatively Small Floating-point Values. When adding float values, the relative size of the two values is important. For example, if you add 1.0 to a float variable repeatedly, the value of the float variable will correctly increase in increments of 1.0 until it reaches $1.677722e+7$ (16,777,220).

Then the value will no longer change, because 1.0 is too small relative to $1.677722e+7$ to make a difference in the significant digits. The same thing will occur if you add 0.0001 to 2,048.0, or add 1,000.0 to $1.717987e+10$. The key is the relative size of the numbers.

Here’s another way to think of it. Suppose your bank could keep track only of seven digits. If you were fortunate enough to have one million dollars ($1,000,000) in your account and tried to add 10 cents ($0.10) to it, you would not be able to, because the 10 cents is not big enough relative to the total to be significant. Since the bank has only seven digits to keep track of your money (in this example), one digit has to fall off the end: either the 10 cents falls off the right side or the million digit falls off the left side. Which would you rather see in your bank account?

<table>
<thead>
<tr>
<th>Seven digits available:</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount in account:</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Add 10 cents (0.10)? (digit falls off on right)</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Add 10 cents (0.10)? (digit falls off on left)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

Note that moving the point indicator doesn’t help, because the exponent is separate. If the seven digits for the account represent millions of dollars ($1,000,000) rather than dollars ($1,000,000), the 10 cents would be $0.0000001$—still too small to be represented by the seven digits:

<table>
<thead>
<tr>
<th>Seven digits available:</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount in account</td>
<td>1.</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Add 10 cents (0.000001)? (digit falls off on right)</td>
<td>1.</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Add 10 cents (0.000001)? (digit falls off on left)</td>
<td>.0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

The key is that it is not the size of the numbers that matter, but rather their relative size.

So if you are accumulating relatively small values in a float variable over a long period of time, at some point, the float value will stop increasing even though you continue to try to add to it.

Comparing Floating-point Values for Equality. Due to rounding errors and the way floating-point calculations are performed, comparing two floats for equality can yield inaccurate results. The precision of comparisons depends on the relative size of the float values as compared to the difference between them.

For example, if 2,097,151.0 is compared for equality with 2,097,152.0, the result will indicate that the two floats are equal, even though it’s obvious they are not. The reason is that the difference between the two values is 1.0, and 1.0 compared to one of the compared values (2,097,151.0) is too small; it is less than one part per million.
In this case, 2,097,152.0 divided by 1,000,000 is 2.1. If the difference between the two values is at least 2.1, then the equality comparison is guaranteed to be correct. So if 2,097,152.0 and 2,097,149.0 were compared for equality, the result will indicate they are not equal, because the difference (3.0) is greater than one part per million (2.1). Any time the difference is at least one part per million, the result is guaranteed to be accurate. If the difference is less than 1 PPM, it may or may not be accurate.

One method that programmers use to work around this issue is to subtract one float from the other and then compare the absolute value of the result to a limit.

For example:

```
Float_Diff = Float1 - Float2;
If (AbsoluteValue(Float_Diff) < 1.0 ) then
    SetVariableTrue(EqualityFlag);
Else
    SetVariableFalse(EqualityFlag);
Endif
```

**Helpful Links for More Information**

- Rounding error: [http://docs.sun.com/source/806-3568/ncg_goldberg.html](http://docs.sun.com/source/806-3568/ncg_goldberg.html)

**Mixing and Converting Integers and Floats**

An analog value read from an I/O unit and put into an integer is converted from float to integer automatically.

To maintain the integrity and accuracy of a numeric type (float or integer), keep all item types the same. For example, use the Move command to copy an integer value to a variable float when you want float calculations.

**MISCELLANEOUS COMMANDS**

The following commands are used with tables and for other purposes. Many of them are commonly used.

<table>
<thead>
<tr>
<th>Command (Block)</th>
<th>Command (Single Line)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment (Block)</td>
<td>Get Value From Name</td>
</tr>
<tr>
<td>Comment (Single Line)</td>
<td>Move</td>
</tr>
<tr>
<td>Flag Lock</td>
<td>Move from Numeric Table Element</td>
</tr>
<tr>
<td>Flag Unlock</td>
<td>Move Numeric Table Element to Numeric Table</td>
</tr>
<tr>
<td>Float Valid?</td>
<td>Move Numeric Table to Numeric Table</td>
</tr>
<tr>
<td>Generate Reverse CRC-16 on Table (32 bit)</td>
<td>Move to Numeric Table Element</td>
</tr>
<tr>
<td>Get Length of Table</td>
<td>Move to Numeric Table Elements</td>
</tr>
<tr>
<td>Get Type From Name</td>
<td>Shift Numeric Table Elements</td>
</tr>
</tbody>
</table>

**Comment Commands**

The comment commands listed above are used with standard PAC Control commands in action blocks and condition blocks. For information on using comments in OptoScript blocks, see step 10 in “Using the OptoScript Editor” on page 354.
Comment (Single Line) and Comment (Block) commands are used in two entirely different ways:

- **Comment (Single Line)** enters a comment to help explain a block or an instruction within a block. Usually block names and comments within instructions are sufficient, but you can use Comment (Single Line) if you need more room for explanations.

- **Comment (Block)** comments out instructions. In other words, it tells the strategy to temporarily ignore certain instructions within a block. It can be useful in debugging or for saving work when a strategy is temporarily changed.

To use it, place one Comment (Block) command at the beginning of the area you want to ignore, and place another Comment (Block) command at the end of the area. If you do not place the second Comment (Block) command, all the remaining instructions in that block are ignored. Areas that are commented out appear in the Instructions dialog box as gray.

**PID—ETHERNET COMMANDS**

The following commands are used with PID loops on SNAP PAC I/O units. Since PID loops are configured and tuned in Configure Mode while creating your PAC Control strategy, you may not need to use these commands. PID commands are typically used to change input or output location (for example, if the input is on another I/O unit) or to change tuning parameters based on a change that occurs while the strategy is running (such as a recipe change).

For steps to configure and tune PIDs, see “Configuring PID Loops” on page 148. For more information about PID loops, how to tune them, and how to use them in PAC Control, see the OptoTutorial: SNAP PAC PID (form 1641).

<table>
<thead>
<tr>
<th>Get PID Configuration Flags</th>
<th>Get PID Tune Integral</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get PID Current Input</td>
<td>Get PID Feed Forward</td>
</tr>
<tr>
<td>Get PID Current Setpoint</td>
<td>Get PID Feed Forward Gain</td>
</tr>
<tr>
<td>Get PID Feed Forward</td>
<td>Get PID Forced Output When Input Over Range</td>
</tr>
<tr>
<td>Get PID Feed Forward Gain</td>
<td>Get PID Forced Output When Input Under Range</td>
</tr>
<tr>
<td>Get PID Forced Output When Input Over Range</td>
<td>Set PID Gain</td>
</tr>
<tr>
<td>Get PID Forced Output When Input Under Range</td>
<td>Set PID Input</td>
</tr>
<tr>
<td>Get PID Gain</td>
<td>Get PID Input</td>
</tr>
<tr>
<td>Get PID Input</td>
<td>Get PID Input High Range</td>
</tr>
<tr>
<td>Get PID Input High Range</td>
<td>Get PID Input Low Range</td>
</tr>
<tr>
<td>Get PID Input Low Range</td>
<td>Get PID Max Output Change</td>
</tr>
<tr>
<td>Get PID Max Output Change</td>
<td>Get PID Min Output Change</td>
</tr>
<tr>
<td>Get PID Min Output Change</td>
<td>Get PID Mode</td>
</tr>
<tr>
<td>Get PID Mode</td>
<td>Get PID Output</td>
</tr>
<tr>
<td>Get PID Output</td>
<td>Get PID Output High Clamp</td>
</tr>
<tr>
<td>Get PID Output High Clamp</td>
<td>Get PID Output Low Clamp</td>
</tr>
<tr>
<td>Get PID Scan Time</td>
<td>Get PID Scan Time</td>
</tr>
<tr>
<td>Get PID Setpoint</td>
<td>Get PID Setpoint</td>
</tr>
<tr>
<td>Get PID Status Flags</td>
<td>Get PID Tune Derivative</td>
</tr>
<tr>
<td>Get PID Tune Derivative</td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 10: PROGRAMMING WITH COMMANDS

What is a PID?

A proportional integral derivative (PID) control system (often referred to as a PID loop) monitors a process variable, compares the variable’s current value to a desired value (a setpoint), and calculates an output to correct error between the setpoint and the variable. Because the calculation is complex, it is done by a mathematical formula that is adjusted (tuned) for each PID loop. The mathematical formulas vary, but all PID systems share these fundamental concepts:

- They evaluate a process variable against its setpoint.
- They control an output to correct the process variable.
- The output comprises proportional, integral, and derivative calculations.
- The effect of proportional, integral, and derivative calculations is modified by user-determined P, I, and D constants.
- The P, I, and D constants need to be tuned for each system.

PID Loops on I/O Units

SNAP PAC controllers and brains provide 96 PID loops per I/O unit. Because PIDs run on the I/O side of the SNAP PAC R-series controller, not on the control side, these PIDs will keep running on the SNAP PAC R-series I/O unit even if the PAC Control strategy stops.

In PAC Control, you can configure each of the PID loops with unique settings for a large number of parameters. For a simple PID loop, you must configure at least the following:

- Input (the process variable being monitored)
- Setpoint (the desired value)
- Output (the I/O point that effects change in the system)
- Scan time (how often the input is sampled)
- PID algorithm used (four algorithms are available; see “Algorithm Choices” on page 319.
- Valid range for input
- Upper and lower clamps for output
- Minimum and maximum change for output

You can also configure the following parameters if necessary:

- Forced output value or use of manual mode if input goes out of range
- Feed forward gain
- Square root of input

In the SNAP PAC, the derivative is applied only to the process variable (the input) and not to the setpoint. This means you can change the setpoint without causing spikes in the derivative term. These PIDs also prevent integral windup by back calculating the integral without the derivative term. The feed forward term (“bias”) is added before output clamping and has a tuning factor.

If desired, you can cascade PIDs by simply using the output point of one PID loop as the input point for another.

Algorithm Choices

(Does not apply to groov I/O units or groov RIO modules.) When you configure a PID loop, choose one of these algorithms:\n
- Velocity (Type C)
- ISA
- Parallel
• Interacting

Velocity (Type C) is typically used to perform velocity control. The ISA, Parallel, and Interacting algorithms are derived from the article "A Comparison of PID Control Algorithms" by John P. Gerry in *Control Engineering* (March 1987). These three equations are the same except for the tuning coefficients; converting from one equation to another is merely a matter of converting the tuning coefficients.

### Key to Terms Used in Equations

<table>
<thead>
<tr>
<th>PV</th>
<th>Process variable; the input to the PID</th>
</tr>
</thead>
<tbody>
<tr>
<td>SP</td>
<td>Setpoint</td>
</tr>
<tr>
<td>InLo, InHi</td>
<td>Range of the input</td>
</tr>
<tr>
<td>OutLo, OutHi</td>
<td>Range of the output</td>
</tr>
<tr>
<td>Gain</td>
<td>Proportional tuning parameter. Unitless. May be negative.</td>
</tr>
<tr>
<td>TuneI</td>
<td>Integral tuning parameter. In units of seconds. Increasing magnitude increases influence on output.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TuneD</th>
<th>Derivative tuning parameter. In units of seconds. Increasing magnitude increases influence on output.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>Output from the PID</td>
</tr>
<tr>
<td>Err_prev</td>
<td>The Error (PV – SP) from the previous scan</td>
</tr>
<tr>
<td>Integral</td>
<td>Integrator. Anti-windup is applied after the output is determined to be within bounds.</td>
</tr>
<tr>
<td>PV1, PV2</td>
<td>PV from the previous scan and the scan before that.</td>
</tr>
<tr>
<td>ScanTime</td>
<td>Actual scan time (time since previous scan)</td>
</tr>
</tbody>
</table>

### Equations Common to All Algorithms

\[
Err = PV - SP
\]

\[
Span = (OutHi - OutLo) / (InHi - InLo)
\]

\[
Output = Output + FeedForward \times TuneFF
\]

### Equations Common to ISA, Parallel, and Interacting

\[
Integral = Integral + Err
\]

\[
TermP = Err
\]

\[
TermI = TuneI \times ScanTime \times Integral
\]

\[
TermD = (TuneD / ScanTime) \times (PV - PV1)
\]

### Velocity (Type C) Algorithm

\[
\Delta TermP = (PV - PV1)
\]

*In this part of the formula, you adjust TuneI.*

\[
\Delta TermI = TuneI \times ScanTime \times Err
\]

*In this part of the formula, you adjust TuneD.*

\[
\Delta TermD = TuneD / ScanTime \times (PV - 2 \times PV1 + PV2)
\]

*In this part of the formula, you adjust Gain.*

\[
\Delta Output = Span \times Gain \times (\Delta TermP + \Delta TermI + \Delta TermD)
\]

---

3 The following obsolete algorithms support PID loops configured before PAC Project R9.5. For details, see the Opto 22 KnowledgeBase article KB82058

- Velocity (Type B) Obsolete
- ISA (Obsolete)
- Parallel (Obsolete)
- Interacting (Obsolete)

You can continue to use these obsolete algorithms, but Opto 22 recommends you use the new algorithms when configuring new PID loops.
ISA (or "Ideal") Algorithm
Output = Span * Gain * ( TermP + TermI + TermD )

Parallel (or “Independent”) Algorithm
Output = Span * ( Gain * TermP + TermI + TermD )

Interacting (or “Classic”) Algorithm
Output = Span * Gain * ( TermP + TermI ) * ( 1 + TermD )

To enable legacy I/O units and commands in PAC Control, see “Legacy Options” on page 208.

POINTER COMMANDS

The following commands are used with pointers:

<table>
<thead>
<tr>
<th>Clear Pointer</th>
<th>Move to Pointer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Pointer Table Element</td>
<td>Move to Pointer Table Element</td>
</tr>
<tr>
<td>Get Pointer From Name</td>
<td>Pointer Equal to NULL?</td>
</tr>
<tr>
<td>Move from Pointer Table Element</td>
<td>Pointer Table Element Equal to NULL?</td>
</tr>
</tbody>
</table>

Understanding Pointers

Like integer and float variables, a pointer variable stores a specific number. However, the number is not data—it is the memory location (address) of data. The pointer “points” to data rather than containing the data.

A pointer in PAC Control can point to many different types of objects:
- Another variable
- A digital point or object
- An analog point or object
- An I/O unit
- A chart

Pointers cannot point to other pointers, however. If you try to move a pointer to a pointer, PAC Control just duplicates the existing pointer.

The following table lists the objects that pointers can point to.

<table>
<thead>
<tr>
<th>Digital Objects</th>
<th>Analog Objects</th>
<th>I/O Units</th>
<th>Variables</th>
<th>Other Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Input</td>
<td>Analog Input</td>
<td>GRV-EPIC-PR1</td>
<td>Integer Variable</td>
<td>Chart</td>
</tr>
<tr>
<td>Digital Output</td>
<td>Analog Output</td>
<td>GRV-R7-MM1001-10</td>
<td>Float Variable</td>
<td></td>
</tr>
<tr>
<td>Counter</td>
<td></td>
<td>SNAP-PAC-R1</td>
<td>String Variable</td>
<td></td>
</tr>
<tr>
<td>Quadrature Counter</td>
<td></td>
<td>SNAP-PAC-R1-B</td>
<td>Pointer Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-R2</td>
<td>Down Timer Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB1</td>
<td>Up Timer Variable</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-EB2</td>
<td>Integer Table</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-SB1</td>
<td>Float Table</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SNAP-PAC-SB2</td>
<td>String Table</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Communication Handle</td>
<td></td>
</tr>
</tbody>
</table>

Advantages of Using Pointers

For certain types of operations, pointers can speed up programming and make the strategy more efficient. Pointers are usually recommended only for experienced programmers, however, because their misuse can
result in unpredictable behavior. They also complicate strategy debugging. If you use too many pointers, it’s easy to lose track of what’s pointing to what.

If you choose to use pointers, be sure you use the text tool to document your charts in detail.

**Referencing Objects with Pointers**

There are two types of pointers—pointer variables and pointer tables.

* Pointer Variables. A pointer variable contains a single pointer to a single object. You can set the initial value for a pointer variable when you configure it, or you can set it later by using the command Move to Pointer.

Once the initial value is set, you can reference it using any command you would use for that type of object. For example, if the pointer points to a string variable, you can use any command for the pointer that you would normally use for a string variable, such as Append String to String or Convert String to Float.

* Pointer Tables. A pointer table contains a list of objects of different types, each of which can be pointed to. For example, the object at index 0 could be a chart, the object at index 1 a digital point, and the object at index 2 a string variable. An example of using a pointer table for indexing is shown on page 90.

When you create a pointer table, no initial values are set. You can use the Move to Pointer Table command to set individual values in the table.

A pointer table element cannot be directly referenced. It must be copied to a pointer variable first, using the command Move From Pointer Table Element. Once it is in the pointer variable, you can reference it as you would any object of that type. For example, if index 3 in a pointer table points to a counter input, use Move From Pointer Table Element to put the counter input address in a pointer variable. Then you can use any command for the pointer variable that you would normally use with a counter input, such as Start Counter or Clear Counter.

**SIMULATION COMMANDS**

The following commands are used for simulation and program testing:

<table>
<thead>
<tr>
<th>Command</th>
<th>IVAL Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication to All I/O Points Enabled?</td>
<td>IVAL Set Counter</td>
</tr>
<tr>
<td>Communication to All I/O Units Enabled?</td>
<td>IVAL Set Analog Filtered Value</td>
</tr>
<tr>
<td>Disable Communication to All I/O Points</td>
<td>IVAL Set Analog Maximum Value</td>
</tr>
<tr>
<td>Disable Communication to All I/O Units</td>
<td>IVAL Set Analog Minimum Value</td>
</tr>
<tr>
<td>Disable Communication to I/O Unit</td>
<td>IVAL Set Analog Point</td>
</tr>
<tr>
<td>Disable Communication to PID Loop</td>
<td>IVAL Set I/O Unit from MOMO Masks</td>
</tr>
<tr>
<td>Disable Communication to Point</td>
<td>IVAL Set Off-Latch</td>
</tr>
<tr>
<td>Enable Communication to All I/O Points</td>
<td>IVAL Set Off-Pulse</td>
</tr>
<tr>
<td>Enable Communication to All I/O Units</td>
<td>IVAL Set On-Latch</td>
</tr>
<tr>
<td>Enable Communication to I/O Unit</td>
<td>IVAL Set On-Pulse</td>
</tr>
<tr>
<td>Enable Communication to PID Loop</td>
<td>IVAL Set TPO Percent</td>
</tr>
<tr>
<td>Enable Communication to Point</td>
<td>IVAL Set TPO Period</td>
</tr>
<tr>
<td>I/O Point Communication Enabled?</td>
<td>IVAL Turn Off</td>
</tr>
<tr>
<td>I/O Unit Communication Enabled?</td>
<td>IVAL Turn On</td>
</tr>
<tr>
<td>PID Loop Communication Enabled?</td>
<td>PID Loop Communication Enabled?</td>
</tr>
</tbody>
</table>

The Disable commands disconnect the strategy from the real-world device, so that it can be tested without affecting field devices. While the real-world devices are disabled (or if they don’t exist) the IVAL commands can
be used for testing and simulation. For details on individual commands, see the PAC Control Command Reference (form 1701) or online help.

STRING COMMANDS

The following commands are used with strings:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append Character to String</td>
<td>Generate Reverse CRC-16 on String</td>
</tr>
<tr>
<td>Append String to String</td>
<td>Get Nth Character</td>
</tr>
<tr>
<td>Compare Strings</td>
<td>Get String Length</td>
</tr>
<tr>
<td>Convert Float to String</td>
<td>Get Substring</td>
</tr>
<tr>
<td>Convert Hex String to Number</td>
<td>Move from String Table Element</td>
</tr>
<tr>
<td>Convert IEEE Hex String to Number</td>
<td>Move String</td>
</tr>
<tr>
<td>Convert Integer 32 to IP Address String</td>
<td>Move to String Table Element</td>
</tr>
<tr>
<td>Convert IP Address String to Integer 32</td>
<td>Move to String Table Elements</td>
</tr>
<tr>
<td>Convert Number to Formatted Hex String</td>
<td>Pack Float into String</td>
</tr>
<tr>
<td>Convert Number to Hex String</td>
<td>Pack Integer 32 into String</td>
</tr>
<tr>
<td>Convert Number to String</td>
<td>Pack Integer 64 into String</td>
</tr>
<tr>
<td>Convert Number to String Field</td>
<td>Pack String into String</td>
</tr>
<tr>
<td>Convert String to Float</td>
<td>Set Nth Character</td>
</tr>
<tr>
<td>Convert String to Integer 32</td>
<td>String Equal to String Table Element?</td>
</tr>
<tr>
<td>Convert String to Integer 64</td>
<td>String Equal?</td>
</tr>
<tr>
<td>Convert String to Lower Case</td>
<td>Test Equal Strings</td>
</tr>
<tr>
<td>Convert String to Upper Case</td>
<td>Trim String</td>
</tr>
<tr>
<td>Find Character in String</td>
<td>Unpack String</td>
</tr>
<tr>
<td>Find Substring in String</td>
<td>Verify Checksum on String</td>
</tr>
<tr>
<td>Generate Checksum on String</td>
<td>Verify Forward CCITT on String</td>
</tr>
<tr>
<td>Generate Forward CCITT on String</td>
<td>Verify Forward CRC-16 on String</td>
</tr>
<tr>
<td>Generate Forward CRC-16 on String</td>
<td>Verify Reverse CCITT on String</td>
</tr>
<tr>
<td>Generate Reverse CCITT on String</td>
<td>Verify Reverse CRC-16 on String</td>
</tr>
</tbody>
</table>

Using Strings

NOTE: All numbers in this discussion of strings are decimal unless otherwise stated.

A PAC Control string is a sequence of characters that can be grouped together. Characteristics of strings include the following:

- Strings are always referred to by name (and, if in a table, by index).
- Each character is represented by one byte.
- Each character is represented by its ASCII code (0 to 255).
- A string containing no characters is referred to as an empty string.
- Strings are frequently used in serial communication as a container for moving numeric characters from one device to another.
- Although a string may appear to contain numeric values, it does not. Digits “0” through “9” are characters just as much as “A” through “Z”; they do not represent numeric values.

To illustrate, let’s look at the number 22. This is a decimal number representing a quantity of 22. The number 22 can be represented in a string in several ways; here are two of them:

- As “22”: two character 50’s (The ASCII code for 2 is 50.)
– As “16”: a character 49 (‘1’) and a character 54 (‘6’). (The hex value of 22 is 16.)

Note that the string representation of the number 22 is no longer a number. It is simply one or two ASCII characters. The string representation of a number must be converted to a numeric value if it is to be used in calculations. Several Convert commands are available for this purpose.

- In standard PAC Control commands, do not use double quotes around string literals. You can use single quotes, but they are not required.
- In OptoScript code, you must use double quotes for string literals. See “11: Using OptoScript” for more information.

**String Length and Width**

The width of a string is the maximum length a string can be; length is the actual number of characters contained in the string. A string with a width of 100 may currently be empty, which means its length is zero. A string with a width of 10 containing the characters “Hello ” has a length of six (five for “Hello” and one for the space after the “o”). Although a string’s length may change dynamically as the string is modified by the program, its width remains constant.

When you configure a string variable or string table, you set the width of the string. All the strings in a PAC Control string table must be of the same width.

PAC Control supports a maximum string width of 1024. For applications requiring wider strings, you can use several strings to hold the data, use string tables, or use numeric tables, as described in the next section.

**Using Numeric Tables as an Alternative to Strings**

Since a string is nothing more than a sequence of characters, you can store a string in a numeric table, with each table element holding a character. The advantage of using numeric tables for strings is that a numeric table can store strings of any size. The disadvantages are:

- Memory usage is much greater.
- No string conversion functions are available for numeric tables. An intermediate temporary string would be required to use string commands for these tables.

Strings in PAC Control can have a width of up to 1024.

**Strings and Multitasking**

Although string commands are completed before the current task loses its time slice, it is important to note that a string that is constructed in more than one step may require more than one time slice to complete.

For example, if a string is being constructed in two steps (such as Move String “Hello” and Append String to String “World”), after the first step a task switch could occur, and another chart looking at the resulting string might see “Hello” rather than “Hello World.”

If another chart is relying on a completed string, you can use a temporary string for building the string, and then move it to the final string. This idea is illustrated in the following example, where a string variable named MSG_String is built in two steps using a temporary string:

1. Move the string literal “The pressure is “ to a temporary variable named sTemp.
2. Append a string variable, sPressure, to sTemp.
3. With the complete string now built, move sTemp to MSG_String.
Adding Control Characters to a String

You can input most control characters in a string by typing a backslash (\) followed by the two-character hex value of the character. For example, to add an ACK (Ctrl+F) character, enter \06 as part of the string.

This technique works for all control characters except null (\00), carriage return (\0D), line feed (\0A), backspace (\08), and Ctrl+Z (\1A). To add these characters to a string, you must use the Append Character command.

To input a single backslash in a string, type in a double backslash (\\).

Sample String Variable

- Declared Name: String_1
- Declared Width: 22
- Maximum Possible Width: 1024
- Bytes of Memory Required: Declared Width + 4 = 22 + 4 = 26

A string is referred to by its name. Initially the previous string is empty, giving it a length of zero. Later, during program execution, seven characters are added to String_1, increasing its length to seven:

A string table is a collection of strings. Each string is referred to by the name of the table it is in and the index where it can be found. The length of the table is the number of strings it can hold. Because string table indexes start with zero, indexes can range from zero to the table length minus one.

The width of each string in the table is the same. The length of each string can vary from zero to the configured width of the table.

Sample String Table

- Declared Name: Promo_Messages
- Declared Width: 26
- Maximum Possible Width: 1024
- Declared Length (Number of indexes, or items, in table): 5
- Maximum Possible Length (Size): 1,000,000
- Bytes of Memory Required: (Declared Width + 4) x Declared Length = (26 + 4) x 5 = 150

A string table is a collection of strings. Each string is referred to by the name of the table it is in and the index where it can be found. The length of the table is the number of strings it can hold. Because string table indexes start with zero, indexes can range from zero to the table length minus one.

The width of each string in the table is the same. The length of each string can vary from zero to the configured width of the table.
String Data Extraction Examples

To extract various pieces of information from a string, use the command Find Substring in String. Consider the following example:

```
0 1 2 3 4 5 6
String_1 O P T O 2 2
```

One way to get two separate pieces of information from this string is to get characters 0–3 and then get characters 5 and 6, as shown in the following examples.

Find Substring in String: Example 1

```
Start At 0
Number Of 4
Move To Sub_String1
```

Results in:

```
0 1 2 3 4
Sub_String1 O P T O
```

Find Substring in String: Example 2

```
Start At 5
Number Of 2
Move To Sub_String2
```

Results in:

```
0 1 2 3 4
Sub_String2 2 2
```

String Building Example

Strings are assembled using commands Move String, Append Character to String, and Append String to String. Consider the following original string and the examples that follow:

```
0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
String_1 S N A P P A C
```

Move String

```
From OPTO
To String_1
```

Results in (note that Move String erased the previous contents of the string):

```
0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
String_1 O P T O
```

Append Character to String

```
From 32
To String_1
```

```
Results in (note the space character in position 4):

```
<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
<th>19</th>
<th>20</th>
<th>21</th>
</tr>
</thead>
<tbody>
<tr>
<td>O</td>
<td>P</td>
<td>T</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Length is 5

Append String to String

From:
```
| 22 |
```

string literal

To:
```
| String_1 |
```

string variable

Results in:

```
<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
<th>19</th>
<th>20</th>
<th>21</th>
</tr>
</thead>
<tbody>
<tr>
<td>O</td>
<td>P</td>
<td>T</td>
<td>O</td>
<td>2</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Length is 8

Append Character to String

From:
```
| 13 |
```

integer literal (carriage return)

To:
```
| String_1 |
```

string variable

Results in:

```
<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
<th>19</th>
<th>20</th>
<th>21</th>
</tr>
</thead>
<tbody>
<tr>
<td>O</td>
<td>P</td>
<td>T</td>
<td>O</td>
<td>2</td>
<td>2</td>
<td>¶</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Length is 8

Comparison to Visual Basic and C

The following table lists PAC Control string commands and their equivalents in Microsoft Visual Basic® and C. If you are using OptoScript, see "E: OptoScript Language Reference," for additional comparisons.

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>Visual Basic</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append Character to String</td>
<td>S$ = S$ + Chr$(MyChar%)</td>
<td>i = strlen(str); str[i] = MyChar; str[i + 1] = 0;</td>
</tr>
<tr>
<td>Append String to String</td>
<td>S$ = S$ + &quot;Hello&quot;</td>
<td>strcat(str, &quot;Hello&quot;);</td>
</tr>
<tr>
<td>Convert Hex String Number</td>
<td>1% = &quot;&amp;h&quot; + S$</td>
<td>sscanf(str, &quot;%x&quot;, &amp;iNum);</td>
</tr>
<tr>
<td>Convert Number to Formatted Hex String</td>
<td>S$ = Hex$(1%)</td>
<td>sprintf(str, &quot;%x&quot;, iNum);</td>
</tr>
<tr>
<td>Convert Number to String</td>
<td>S$ = CStr(1%)</td>
<td>sprintf(str, &quot;%d&quot;, iNum);</td>
</tr>
<tr>
<td>Convert String to Float</td>
<td>F = CSng(S$)</td>
<td>sscanf(str, &quot;%f&quot;, &amp;fNum);</td>
</tr>
<tr>
<td>Convert String to Integer 32</td>
<td>I% = CInt(S$)</td>
<td>sscanf(str, &quot;%d&quot;, &amp;iNum);</td>
</tr>
<tr>
<td>Get Nth Character</td>
<td>MyByte% = ASC(MID$(Str$,n%,1))</td>
<td>MyByte = str[n];</td>
</tr>
<tr>
<td>Get String Length</td>
<td>MyLENGTH% = LEN(STR$)</td>
<td>iLEN = strlen(str);</td>
</tr>
<tr>
<td>Get Substring</td>
<td>SubStr$ = MID$(STR$,i,n)</td>
<td>strncpy(subStr, &amp;str[i], n);</td>
</tr>
<tr>
<td>Move String</td>
<td>STR$ = &quot;Hello&quot;</td>
<td>strcpy(strDest,&quot;Hello&quot;);</td>
</tr>
<tr>
<td>Test Equal Strings</td>
<td>Equal% = (STR$ = &quot;Hello&quot;)</td>
<td>i = strcmp(str1,&quot;Hello&quot;);</td>
</tr>
</tbody>
</table>
### Convert-to-String Commands

The five convert-to-string commands are typically used when printing a number to a port. The ASCII table on the following page shows how various parameters affect the string as it is converted. Note the following:

- Some commands add leading spaces to achieve the specified length. These spaces are indicated with underscores (_).
- Floats (if used) are automatically rounded to integers before conversion except when using the command Convert Number to Formatted Hex String.

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>Visual Basic</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>String Equal?</td>
<td>if STRS = &quot;Hi&quot; then...</td>
<td>if(strcmp(str1,&quot;Hi&quot;))</td>
</tr>
<tr>
<td>String Equal to String Table Element?</td>
<td>if STRS(n%) = &quot;Hi&quot; then...</td>
<td>if(strcmp(str1[n],&quot;Hi&quot;))</td>
</tr>
</tbody>
</table>

#### Command Parameters

<table>
<thead>
<tr>
<th>Numeric value to be converted</th>
<th>Number of digits right of decimal point</th>
<th>Length</th>
<th>Convert Number to Formatted Hex String (Length 8 required for floats)</th>
<th>Convert Float to String</th>
<th>Convert Number to Hex String</th>
<th>Convert Number to String Field</th>
<th>Convert Number to String</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Floats</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16.0</td>
<td>1</td>
<td>4</td>
<td>418000000000000</td>
<td>16.0</td>
<td>10</td>
<td>1.6e+01</td>
<td>1.6e+01</td>
</tr>
<tr>
<td>16.0</td>
<td>2</td>
<td>4</td>
<td>418000000000000</td>
<td>****</td>
<td>10</td>
<td>1.6e+01</td>
<td>1.6e+01</td>
</tr>
<tr>
<td>-16.0</td>
<td>1</td>
<td>4</td>
<td>C180000000000000</td>
<td>****</td>
<td>FFFFFFFF0</td>
<td>-1.6e+01</td>
<td>-1.6e+01</td>
</tr>
<tr>
<td>1.23</td>
<td>1</td>
<td>4</td>
<td>3F9D70A4_1.2</td>
<td>1</td>
<td>1.23e+00</td>
<td>1.23e+00</td>
<td></td>
</tr>
<tr>
<td>12.3</td>
<td>1</td>
<td>4</td>
<td>4144C4CD12.3</td>
<td>C</td>
<td>1.23e+01</td>
<td>1.23e+01</td>
<td></td>
</tr>
<tr>
<td>0.0</td>
<td>1</td>
<td>4</td>
<td>00000000_0.0</td>
<td>0</td>
<td>0</td>
<td>0.0e+00</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Integers</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>4</td>
<td>0010_16.0</td>
<td>10</td>
<td>_ _16</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>2</td>
<td>4</td>
<td>0010_16.0</td>
<td>****</td>
<td>_ _16</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>-16</td>
<td>1</td>
<td>4</td>
<td>FFF0****</td>
<td>FFFFFFFF0</td>
<td>_ _16</td>
<td>-16</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>4</td>
<td>0000_0.0</td>
<td>0</td>
<td>_ _0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>1</td>
<td>2</td>
<td>****</td>
<td>3E8</td>
<td>1000</td>
<td>1000</td>
<td></td>
</tr>
</tbody>
</table>

**** Indicates an overflow. The whole-number portion of the resulting string is too long for its space.
### ASCII Table

The following table shows ASCII characters with their decimal and hex values. For characters 0–31, equivalent control codes are also listed; for example, a carriage return (character 13) is equivalent to CTRL+M (shown in the table as ^M).

<table>
<thead>
<tr>
<th>Dec</th>
<th>Hex</th>
<th>CC</th>
<th>Char</th>
<th>Dec</th>
<th>Hex</th>
<th>Char</th>
<th>Dec</th>
<th>Hex</th>
<th>Char</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>00</td>
<td>^@</td>
<td>NUL</td>
<td>32</td>
<td>20</td>
<td>Space</td>
<td>64</td>
<td>40</td>
<td>@</td>
</tr>
<tr>
<td>1</td>
<td>01</td>
<td>^A</td>
<td>SOH</td>
<td>33</td>
<td>21</td>
<td>!</td>
<td>65</td>
<td>41</td>
<td>A</td>
</tr>
<tr>
<td>2</td>
<td>02</td>
<td>^B</td>
<td>STX</td>
<td>34</td>
<td>22</td>
<td>”</td>
<td>66</td>
<td>42</td>
<td>B</td>
</tr>
<tr>
<td>3</td>
<td>03</td>
<td>^C</td>
<td>ETX</td>
<td>35</td>
<td>23</td>
<td>#</td>
<td>67</td>
<td>43</td>
<td>C</td>
</tr>
<tr>
<td>4</td>
<td>04</td>
<td>^D</td>
<td>EOT</td>
<td>36</td>
<td>24</td>
<td>$</td>
<td>68</td>
<td>44</td>
<td>D</td>
</tr>
<tr>
<td>5</td>
<td>05</td>
<td>^E</td>
<td>ENQ</td>
<td>37</td>
<td>25</td>
<td>%</td>
<td>69</td>
<td>45</td>
<td>E</td>
</tr>
<tr>
<td>6</td>
<td>06</td>
<td>^F</td>
<td>ACK</td>
<td>38</td>
<td>26</td>
<td>&amp;</td>
<td>70</td>
<td>46</td>
<td>F</td>
</tr>
<tr>
<td>7</td>
<td>07</td>
<td>^G</td>
<td>BEL</td>
<td>39</td>
<td>27</td>
<td>'</td>
<td>71</td>
<td>47</td>
<td>G</td>
</tr>
<tr>
<td>8</td>
<td>08</td>
<td>^H</td>
<td>BS</td>
<td>40</td>
<td>28</td>
<td>(</td>
<td>72</td>
<td>48</td>
<td>H</td>
</tr>
<tr>
<td>9</td>
<td>09</td>
<td>^I</td>
<td>HT</td>
<td>41</td>
<td>29</td>
<td>)</td>
<td>73</td>
<td>49</td>
<td>I</td>
</tr>
<tr>
<td>10</td>
<td>0A</td>
<td>^J</td>
<td>LF</td>
<td>42</td>
<td>2A</td>
<td>*</td>
<td>74</td>
<td>4A</td>
<td>J</td>
</tr>
<tr>
<td>11</td>
<td>0B</td>
<td>^K</td>
<td>VT</td>
<td>43</td>
<td>2B</td>
<td>+</td>
<td>75</td>
<td>4B</td>
<td>K</td>
</tr>
<tr>
<td>12</td>
<td>0C</td>
<td>^L</td>
<td>FF</td>
<td>44</td>
<td>2C</td>
<td>,</td>
<td>76</td>
<td>4C</td>
<td>L</td>
</tr>
<tr>
<td>13</td>
<td>0D</td>
<td>^M</td>
<td>CR</td>
<td>45</td>
<td>2D</td>
<td>-</td>
<td>77</td>
<td>4D</td>
<td>M</td>
</tr>
<tr>
<td>14</td>
<td>0E</td>
<td>^N</td>
<td>SO</td>
<td>46</td>
<td>2E</td>
<td>.</td>
<td>78</td>
<td>4E</td>
<td>N</td>
</tr>
<tr>
<td>15</td>
<td>0F</td>
<td>^O</td>
<td>SI</td>
<td>47</td>
<td>2F</td>
<td>/</td>
<td>79</td>
<td>4F</td>
<td>O</td>
</tr>
<tr>
<td>16</td>
<td>10</td>
<td>^P</td>
<td>DLE</td>
<td>48</td>
<td>30</td>
<td>0</td>
<td>80</td>
<td>50</td>
<td>P</td>
</tr>
<tr>
<td>17</td>
<td>11</td>
<td>^Q</td>
<td>DC1</td>
<td>49</td>
<td>31</td>
<td>1</td>
<td>81</td>
<td>51</td>
<td>Q</td>
</tr>
<tr>
<td>18</td>
<td>12</td>
<td>^R</td>
<td>DC2</td>
<td>50</td>
<td>32</td>
<td>2</td>
<td>82</td>
<td>52</td>
<td>R</td>
</tr>
<tr>
<td>19</td>
<td>13</td>
<td>^S</td>
<td>DC3</td>
<td>51</td>
<td>33</td>
<td>3</td>
<td>83</td>
<td>53</td>
<td>S</td>
</tr>
<tr>
<td>20</td>
<td>14</td>
<td>^T</td>
<td>DC4</td>
<td>52</td>
<td>34</td>
<td>4</td>
<td>84</td>
<td>54</td>
<td>T</td>
</tr>
<tr>
<td>21</td>
<td>15</td>
<td>^U</td>
<td>NAK</td>
<td>53</td>
<td>35</td>
<td>5</td>
<td>85</td>
<td>55</td>
<td>U</td>
</tr>
<tr>
<td>22</td>
<td>16</td>
<td>^V</td>
<td>SYN</td>
<td>54</td>
<td>36</td>
<td>6</td>
<td>86</td>
<td>56</td>
<td>V</td>
</tr>
<tr>
<td>23</td>
<td>17</td>
<td>^W</td>
<td>ETB</td>
<td>55</td>
<td>37</td>
<td>7</td>
<td>87</td>
<td>57</td>
<td>W</td>
</tr>
<tr>
<td>24</td>
<td>18</td>
<td>^X</td>
<td>CAN</td>
<td>56</td>
<td>38</td>
<td>8</td>
<td>88</td>
<td>58</td>
<td>X</td>
</tr>
<tr>
<td>25</td>
<td>19</td>
<td>^Y</td>
<td>EM</td>
<td>57</td>
<td>39</td>
<td>9</td>
<td>89</td>
<td>59</td>
<td>Y</td>
</tr>
<tr>
<td>26</td>
<td>1A</td>
<td>^Z</td>
<td>SUB</td>
<td>58</td>
<td>3A</td>
<td>:</td>
<td>90</td>
<td>5A</td>
<td>Z</td>
</tr>
<tr>
<td>27</td>
<td>1B</td>
<td>\</td>
<td>ESC</td>
<td>59</td>
<td>3B</td>
<td>;</td>
<td>91</td>
<td>5B</td>
<td>]</td>
</tr>
<tr>
<td>28</td>
<td>1C</td>
<td>\</td>
<td>FS</td>
<td>60</td>
<td>3C</td>
<td>&lt;</td>
<td>92</td>
<td>5C</td>
<td>\</td>
</tr>
<tr>
<td>29</td>
<td>1D</td>
<td>^]</td>
<td>GS</td>
<td>61</td>
<td>3D</td>
<td>=</td>
<td>93</td>
<td>5D</td>
<td>)</td>
</tr>
<tr>
<td>30</td>
<td>1E</td>
<td>^^</td>
<td>RS</td>
<td>62</td>
<td>3E</td>
<td>&gt;</td>
<td>94</td>
<td>5E</td>
<td>^</td>
</tr>
<tr>
<td>31</td>
<td>1F</td>
<td>_</td>
<td>US</td>
<td>63</td>
<td>3F</td>
<td>?</td>
<td>95</td>
<td>5F</td>
<td>_</td>
</tr>
</tbody>
</table>
TIME/DATE COMMANDS

The following commands refer to time, dates, and days:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Date to String (DD/MM/YYYY)</td>
<td>Get System Time</td>
</tr>
<tr>
<td>Copy Date to String (MM/DD/YYYY)</td>
<td>Get Time Zone Description</td>
</tr>
<tr>
<td>Copy Time to String</td>
<td>Get Time Zone Offset</td>
</tr>
<tr>
<td>Convert Date &amp; Time to NTP Timestamp</td>
<td>Get Year</td>
</tr>
<tr>
<td>Convert NTP Timestamp to Date &amp; Time</td>
<td>Set Date</td>
</tr>
<tr>
<td>Get Date &amp; Time</td>
<td>Set Day</td>
</tr>
<tr>
<td>Get Day</td>
<td>Set Hours</td>
</tr>
<tr>
<td>Get Day of Week</td>
<td>Set Minutes</td>
</tr>
<tr>
<td>Get Hours</td>
<td>Set Month</td>
</tr>
<tr>
<td>Get Julian Day</td>
<td>Set Seconds</td>
</tr>
<tr>
<td>Get Minutes</td>
<td>Set Time</td>
</tr>
<tr>
<td>Get Month</td>
<td>Set Time Zone Configuration</td>
</tr>
<tr>
<td>Get Seconds</td>
<td>Set Year</td>
</tr>
<tr>
<td>Get Seconds Since Midnight</td>
<td>Synchronize Clock SNTP</td>
</tr>
</tbody>
</table>

These commands can be used for timing a process or for making sure things happen according to a set schedule. For example, you could use the command Get Seconds Since Midnight at the beginning of a process and again at the end of the process, and then subtract the two numbers to find out how long the process took.

You can set the time and date on the control engine by synchronizing it with the PC; in PAC Control Debug mode, choose this option while viewing the control engine (Control Engine > Inspect). You can also use these commands to set the time and date on the control engine. Commands with NTP in the name refer to the Network Time Protocol.

TIMING COMMANDS

The following commands are used for timers and delays in a strategy.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Timer</td>
<td>Stop Timer</td>
</tr>
<tr>
<td>Continue Timer</td>
<td>Timer Expired?</td>
</tr>
<tr>
<td>Down Timer Expired?</td>
<td>Up Timer Target Time Reached?</td>
</tr>
<tr>
<td>Get &amp; Restart Timer</td>
<td>Delays</td>
</tr>
<tr>
<td>Pause Timer</td>
<td>Delay (mSec)</td>
</tr>
<tr>
<td>Set Down Timer Preset Value</td>
<td>Delay (Sec)</td>
</tr>
<tr>
<td>Set Up Timer Target Value</td>
<td></td>
</tr>
</tbody>
</table>

Delay Commands

Delay commands are used frequently in strategies to pause the logic. Here are two reasons to use Delay (mSec) or Delay (Sec):

- To allow time for the state of an input to change before it is checked again. For example, a delay could give an operator time to release a button before the state of the button is rechecked, or allow time for an alarm state to change before rechecking.
To let a chart give up the remainder of its time slice, when its logic does not need to run constantly. For more information on using delays in this way, see Optimizing PAC Project System Performance.

Using Timers

Timers are a special type of numeric variable. A PAC Control timer stores elapsed time in units of seconds with resolution of milliseconds. Down timers continuously count down to zero, and up timers continuously count up from zero. Timers can be paused and continued.

To create a timer in PAC Control, configure a numeric variable and select the type Up Timer or Down Timer. You can use any PAC Control command (for example, Move) that references a numeric variable to access a timer. You can view the current value of a timer at any time in PAC Control Debug mode.

Since the timer is independent from the control engine's clock, over thousands of seconds, the timer and the control engine's clock will not match. Timers do not place any additional load on the CPU.

Down Timer Operation

The Set Down Timer Preset Value command sets the time the down timer will start from, but does not start the timer. Use the Start Timer command to start the timer counting down to zero. (Since the default preset value for a down timer is zero, nothing will happen if you use the Start Timer command before setting a value.)

Alternatively, you can use the Move command to set the time the down timer will start from. If you use Move, the down timer begins counting down immediately. If program execution speed is a priority, use the Move command and put an integer value rather than a float into the timer. This action eliminates the float-to-integer conversion time.

Note that if you use the Move command, any value you set using Set Down Timer Preset Value is overwritten, and subsequent Start Timer commands start the timer from the value last sent by the Move command.

To determine if the timer is finished, use the condition Down Timer Expired? This condition is true any time the down timer has a value of zero. Down Timer Expired? is much faster than using the condition Equal? to compare the timer to a value of zero.

The Stop Timer command forces the timer to stop and resets its value at zero. If you want to halt the timer and have it maintain its value at the time it was stopped, use the Pause Timer command instead. When you use Pause Timer, you can move the timer’s value at the time it was stopped to a variable. You can also use the Continue Timer command to resume the timer where it left off.

Up Timer Operation

The Set Up Timer Target Value command sets the time for the Up Timer Target Time Reached? condition. It does not start the timer, however, and the timer does not stop when it reaches the target value. You must start the up timer from zero by using the Start Timer command.

If you use the Move command to move a value to an up timer, the value you moved becomes the target value and the up timer starts timing immediately. (Note that the timer does not start from the value you moved; it always starts at zero.)

The up timer does not stop when it reaches the target value. To determine if the timer has reached its target value, use the condition Up Timer Target Time Reached? This condition tests the timer to see if it is greater than or equal to the target time.

The Stop Timer command forces the timer to stop and resets it to zero. If you want to halt the timer and have it maintain its value at the time it was stopped, use the Pause Timer command instead. After you use Pause Timer, you can then move the timer’s value at the time it was stopped to a variable. You can also use the Continue Timer command to resume the timer where it left off.
11: Using OptoScript

INTRODUCTION

This chapter shows you how to create and use OptoScript, an optional programming language that can simplify certain types of operations in PAC Control. Modeled after computer languages such as C and Pascal, OptoScript code gives you an alternative to using standard PAC Control commands.

In addition to the examples provided here, see the Control Basic Examples directory on your hard drive for a fully annotated example strategy. OptoScript information is also provided in the SNAP PAC Learning Center User’s Guide (form 1638).

You will find OptoScript easy to use if you already have computer programming experience. Beginning programmers may also want to try it for control operations involving extensive math calculations, string handling, or complex loops and conditions.

This chapter assumes that you have some programming experience. Experienced programmers may want to see “Notes to Experienced Programmers” on page 403.

In This Chapter

About OptoScript .......................................................... page 333
When to Use OptoScript ................................................ page 334
OptoScript Functions and Commands ................................ page 342
OptoScript Syntax .......................................................... page 343
OptoScript Data Types and Variables ............................... page 344
OptoScript Expressions and Operators ............................ page 349
OptoScript Control Structures ........................................ page 351
Using the OptoScript Editor ............................................. page 354
Troubleshooting “Unable To Find” Errors .......................... page 357
Troubleshooting Syntax Errors ........................................ page 357
Debugging Strategies with OptoScript ............................ page 359

ABOUT OPTOSCERIPT

OptoScript is a procedural type of computer language similar to Pascal, C, or BASIC. It can be used within any PAC Control strategy or subroutine to replace or supplement standard PAC Control commands. It does not add new functions, but offers an alternative method within PAC Control’s flowcharting environment to simplify some common programming tasks.
OptoScript code cannot be mixed with commands in action or condition blocks; it is used in its own hexagonal flowchart block. The following figure shows an example of an OptoScript flowchart block and its contents:

**WHEN TO USE OPTOSCRIPT**

You'll want to use OptoScript for some common programming tasks that can be more difficult to do using standard PAC Control commands than using a procedural language. Extensive math calculations or complex loops, for example, can be done with standard commands but take up a lot of space on a flowchart.

When you use OptoScript, however, be aware that it is not self-documenting. Make sure you frequently use comments to explain what the code does, so that when you come back to it a year later—or when someone who is not as familiar with the code or the strategy must change it—it can be easily interpreted.

This section shows examples of using OptoScript for:
- Math expressions
- String handling
- Complex loops
- Case statements
- Conditions
- Combining math expressions, loops, and conditions

**For Math Expressions**

OptoScript is especially useful for mathematical computations. Math expressions are simpler and easier, and many of them are built right into the language, instead of requiring commands such as Add or Multiply. OptoScript has no limitations on the number of parentheses you can use in math expressions.

Here's an example of a mathematical expression in OptoScript:

\[
\text{integer1} = (\text{integer2} + 2) \times (\text{float1} / (\text{float2} - 2) - 3);
\]
To accomplish the same computation using standard PAC Control commands, you would need to create at least two intermediate variables and use five instructions, as shown below.

As you can see, the OptoScript version of this math expression is not only simpler to create, but also easier to understand once created.

**For String Handling**

If your strategy transmits and receives serial data, you will want to try using OptoScript code. In standard PAC Control, forming and parsing (decoding) serial data can take several blocks. In OptoScript, string handling can be easier.

The following figure shows a flowchart designed to send the string request, “What type of plane?” and parse the response.
Compare these blocks and instructions with the ones on the following page, done in OptoScript.

The OptoScript version of the String_Handler flowchart is more compact. The string request can be built more easily, and parsing the response takes up much less space.
If you handle more complex serial data than in the String_Handler example, you will find OptoScript code even more useful.

For Complex Loops

Strategies that use complex loops—for example, to repeat an operation while a condition remains true—are easier to create and take up less space in a flowchart when done in OptoScript. While loops, repeat loops, and for loops are all available.

- **While loops** repeat a process while a test is true (the test comes at the beginning of the process).
- **Repeat loops** repeat a process until a test is false (the test comes at the end of the process). This kind of loop is guaranteed to execute at least once.
- **For loops** repeat a process for a specified number of times.
Below is an example of a while loop as it would appear in standard flowchart commands, contrasted with the way it could be handled in an OptoScript block.

In standard PAC Control commands, the loop takes several blocks, each containing one or more instructions.

In OptoScript, the loop is in a single block that contains one condensed instruction.
For Case Statements

Case or switch statements create multiple decision points. They can also be easier to do using OptoScript. Here is an example of a case statement:

In standard PAC Control commands, the case statement requires several sets of condition and action blocks, each containing commands.

In OptoScript, the code is all in one block.

Using OptoScript for case statements saves space in the flowchart and lets you see all the possible cases in one dialog box.
For Conditions

Like loops and case statements, conditions can be simpler when done in OptoScript code. If/then, if/then/else, and if/then/elseif statements can all be mixed and nested as needed. Here's an example of a simple if/then/else statement as it could be done in standard PAC Control commands and in OptoScript:

In OptoScript, a single block contains the statement.

OptoScript is even more useful for more complex conditions, such as the following:

In OptoScript, all the condition and action blocks and their commands are consolidated into one block.
For Combining Expressions, Operators, and Conditions

The real power of OptoScript can be seen in complex operations.

```
/* Set Grass and Trees sprinklers to run on Tuesdays and Fridays as long as it’s not raining */
if (((GetDayOfWeek() == 2) or (GetDayOfWeek() == 5)) and (Humidity < 90)) then
  if ((Max_Temp > 80) or (Max_Temp == Yesterday_Temp + 10)) then
    Grass = 1;
    DelaySec (1200); // Water grass for 20 mins
    Grass = 0;
  else
    Grass = 1;
    DelaySec (600); // Water grass for 10 mins
    Grass = 0;
endif
while (Soil_Moisture < 30)
  Trees = 1; // Water trees
  wait
else
  DelaySec (3600); // Wait one hour before checking the day again
endif
```

Generally speaking, the more complex the combination of math expressions, logical and comparison operators, loops, and conditions, the more convenient it is to use OptoScript code rather than standard blocks and commands.
OPTOSCRIPT FUNCTIONS AND COMMANDS

Since functions in OptoScript are provided by commands almost identical to the standard commands in PAC Control, you have the same complete range of functions. There are no additional functions for OptoScript code, and you cannot make your own functions.

Standard and OptoScript Commands

In many cases you can easily recognize OptoScript commands, because they are almost the same as standard PAC Control commands. All spaces are removed from the OptoScript commands, however, and in some cases words in the command are abbreviated or left out. Commands are case sensitive. Here are some examples of the same commands in PAC Control and in OptoScript:

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Counter</td>
<td>GetCounter</td>
</tr>
<tr>
<td>Set Down Timer Preset Value</td>
<td>SetDownTimerPreset</td>
</tr>
<tr>
<td>Delay (mSec)</td>
<td>DelayMsec</td>
</tr>
<tr>
<td>Convert Float to String</td>
<td>FloatToString</td>
</tr>
<tr>
<td>Get Number of Characters Waiting</td>
<td>GetNumCharsWaiting</td>
</tr>
</tbody>
</table>

Some commands are built into OptoScript functionality. Some of these have OptoScript commands and some do not; you can use either the built-in functionality or the OptoScript command, if it exists. Here are some examples:

<table>
<thead>
<tr>
<th>PAC Control Command</th>
<th>OptoScript Command</th>
<th>Built-In Equivalent</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move</td>
<td>=</td>
<td>item1 = value</td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>+</td>
<td>1 + 2</td>
<td></td>
</tr>
<tr>
<td>Less?</td>
<td>&lt;</td>
<td>value1 &lt; value2</td>
<td></td>
</tr>
<tr>
<td>Turn On</td>
<td>TurnOn</td>
<td>= [non-zero]</td>
<td>digital3 = 1</td>
</tr>
<tr>
<td>Turn Off</td>
<td>TurnOff</td>
<td>= 0</td>
<td>digital3 = 0</td>
</tr>
<tr>
<td>Comment (Single Line)</td>
<td>//</td>
<td>// comment</td>
<td></td>
</tr>
<tr>
<td>Set Nth Character</td>
<td>SetNthCharacter</td>
<td>s1[5] = ‘c’</td>
<td></td>
</tr>
</tbody>
</table>

See Appendix E: OptoScript Language Reference for a table of all PAC Control commands and their OptoScript equivalents. In addition, OptoScript equivalents for each command are shown in the PAC Control Command Reference and in the online command help.

Using I/O in OptoScript

One advantage of OptoScript is that any named I/O point can be used directly, wherever a numeric variable can be used, rather than requiring a variable. Digital points behave like integer variables that have only two possible states: zero (off) or non-zero (on). Analog points behave like float variables.

For example, you can turn a digital point off by simply assigning it a value of zero:

`Light_Switch = 0;`

You can turn a digital point on by assigning it any value other than zero:

`Light_Switch = 1;`
`Light_Switch = -1;`
`Light_Switch = 486;`

You can use I/O points directly in mathematical expressions:

`fLimit = Pressure_Input + 50;`
Or use them directly in control structures, for example to turn off the light if the door is closed:

```pascal
if (not Door) then
    Light_Switch = 0;
endif
```

You can set an output based on the value of an input or a variable:

```pascal
LED01 = Switch_A;
Proportional_Valve = fPressure_Control
```

You can use a point directly with a command:

```pascal
fRange = GetAnalogMaxValue(Temp_Input) - GetAnalogMinValue(Temp_Input);
TurnOn(Fan_A);
IsOn(Fan_A);
```

### OPTOSCRIPT SYNTAX

Here is a sample section of OptoScript code to illustrate syntax.

```pascal
fPressure = 300.0;
nTotal = ntTable[0] + ntTable[1] + ntTable[2];
while ((GetHours() >= 8) and (GetHours() < 17))
    Fan_A = 1;
wend

// Send alarm if oven temperature too hot.
if (Oven_Temperature >= 450) then
    Oven_Alarm = 1; // Set the oven alarm
else
    Oven_Alarm = 0; // Clear the oven alarm
endif

nCheck = GenerateChecksumOnString (0, sMessage);
nError_Block = GetIdOfBlockCausingCurrentError();
RemoveCurrentError();
sGreeting = "Hello, world!";
nPos = FindCharacterInString('!', 0, sGreeting);
```

Each statement is followed by a semicolon.

Table elements are put in square brackets next to the table name.

Parentheses are used as separators for expressions and operators. You can use an unlimited number of parentheses.

Line comments appear on a separate line or after a statement. They are preceded by two slashes and a space. Block comments (not illustrated) are preceded by /* and followed by */.

Parameters (arguments) for a command are listed in order within parentheses following the command. Commands that have no arguments must still include the parentheses.

An individual character can be in single quotes or in double quotes, depending on its type. A string must be in double quotes.

**NOTE:** Each block has only one exit point. It is not possible to use `return` to jump out of the current block.
More About Syntax with Commands

As noted in the previous sample, arguments for a command are listed in the parentheses following the command. Arguments are listed in order beginning with argument 1. To find out the arguments for any command, see the PAC Control Command Reference or online command help.

SetDownTimerPresetValue (60.0, Minute_Timer)

command (argument 1, argument 2)

EnableIOUnitCausingCurrentError ()

command (no arguments)

There are two types of OptoScript commands: procedure commands and function commands.

Procedure commands accomplish an action and return no value. Here are some examples:
RemoveCurrentError();
ClampInt32TableElement(10, 0, 5, x1);

Function commands return a value from their action, so the value can be placed somewhere. In the following examples, the value is placed in the variable at the beginning of the statement:
nMonth = GetMonth();
fSquare_Root = SquareRoot(99);
nPosition = FindCharacterInString('S', 0, sName);

When you compare these examples to the identical commands in standard PAC Control, you’ll notice that the returned value for the standard PAC Control command is an argument. In OptoScript the returned value is not an argument, thus reducing the number of arguments by one. In the first example, the standard command Get Month has one argument, which is where the result is placed. The OptoScript command equivalent, GetMonth, has no arguments and places the result in the variable.

In most cases you will use the value a function command returns by placing it in a variable, a control structure, or a mathematical expression. Occasionally, however, you may not need to use the result. For example, the command StartChart returns a status. If you do not need to track the status, you can ignore it by not placing the result anywhere, for example:
StartChart(Fan_Control);

OPTOSCRIPT DATA TYPES AND VARIABLES

Unlike most procedural languages, PAC Control maintains a database of all declared variables, which is shared with PAC Display. Variables are not declared in OptoScript code, but are created (declared) within PAC Control. (See “9: Using Variables and Commands.”) Variables are not declared in OptoScript because local variables are not allowed. All variables are global for the strategy (or global within a subroutine).

If you use a variable in OptoScript code that does not currently exist in the strategy, you’ll receive an error message when you test compile the code and can add the variable then.

Variable Name Conventions

With OptoScript and in PAC Control generally, it’s a good idea to get into the habit of indicating the variable type in each variable’s name. Some variable types may be obvious in the name itself, but others are not. For more information, see “Naming Conventions” on page 83.
Using Numeric Literals

Here are examples of how to use numeric literals in OptoScript. Formats are automatically converted if they don't match the variable type. For example, if a value of 300.2 were assigned to an integer 32, the value would be converted to 300.

<table>
<thead>
<tr>
<th>Decimal Integer 32 Literals assigned to variables.</th>
<th>Decimal Integer 64 Literals assigned to variables. Integer 64s have an i64 at the end.</th>
</tr>
</thead>
<tbody>
<tr>
<td>nVariable1 = 0;</td>
<td>dVariable1 = 0i64;</td>
</tr>
<tr>
<td>nVariable2 = 10;</td>
<td>dVariable2 = 10i64;</td>
</tr>
<tr>
<td>nVariable3 = -123;</td>
<td>dVariable3 = -123i64;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hexadecimal Integer 32 Literals assigned to variables. Hex notation starts with 0x. Digits A–F may be upper or lower case.</th>
<th>Hexadecimal Integer 64 Literals assigned to variables.</th>
</tr>
</thead>
<tbody>
<tr>
<td>nVariable1 = 0x0;</td>
<td>dVariable1 = 0x0i64;</td>
</tr>
<tr>
<td>nVariable2 = 0x10;</td>
<td>dVariable2 = 0x10i64;</td>
</tr>
<tr>
<td>nVariable3 = 0x12AB34CD;</td>
<td>dVariable3 = 0x1234567890ABCDEFi64;</td>
</tr>
<tr>
<td>nVariable3 = 0x12ab34cd;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Float Literals assigned to variables. (Float literals may use scientific notation.)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>fVariable1 = 0.0;</td>
<td></td>
</tr>
<tr>
<td>fVariable2 = 12.3;</td>
<td></td>
</tr>
<tr>
<td>fVariable3 = -123.456;</td>
<td></td>
</tr>
<tr>
<td>fVariable3 = -1.23456e2;</td>
<td></td>
</tr>
<tr>
<td>fVariable3 = -12345.6e-2;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Simple Integer 32 assignments.</th>
<th>Simple Integer 64 assignments.</th>
</tr>
</thead>
<tbody>
<tr>
<td>n1 = 1;</td>
<td>nn1 = 2164;</td>
</tr>
<tr>
<td>n2 = n1;</td>
<td>nn2 = nn1;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Simple Float assignments.</th>
<th>Simple assignments between different data types. (Types will be automatically converted to match.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>f1 = 3.0;</td>
<td>nl = 4.0;</td>
</tr>
<tr>
<td>f2 = f1</td>
<td>nnl = nl;</td>
</tr>
</tbody>
</table>

Making Assignments to Numeric Variables

Values are easily assigned to variables.

Using Strings

As noted in the section on syntax, a string in OptoScript must be in double quotes. An individual character can be used either as a string (in double quotes) or as an integer value representing that character in ASCII (in single quotes). When you assign a single character to a string, use double quotes to avoid a syntax error; for example: sString = "a";

To change a single-character integer into a string, use the Chr() keyword as shown below:

```
  sString = Chr('a');
  sString = Chr(97);
  n = 97;
  sString = Chr(n);  
```

NOTE: If you intend to retrieve the string data in either PAC Display or OptoOPCServer, to avoid an error do not use the Chr() keyword character to insert an embedded null, e.g. Chr(0).
Strings can be used in the following ways.

<table>
<thead>
<tr>
<th>As string literals (must be all on one line).</th>
<th>As string variables.</th>
</tr>
</thead>
<tbody>
<tr>
<td>sGreeting = &quot;Hello, world!&quot;</td>
<td>sOutgoing = sIncoming;</td>
</tr>
</tbody>
</table>

When you use the Chr() keyword to assign a character value to a string variable, you can either quote a character or give its ASCII value. For example, the following two statements are equivalent:

```
sString1 = Chr('A');
sString1 = Chr(65);  
```

A string can be thought of as a table of characters. The number in square brackets is the character’s index. (Note that the index starts with the number zero.) The following code would result in sGreeting equaling “Hello!!!”

```
sGreeting = "Hello...";
sGreeting[5] = '!' ;
sGreeting[6] = '!' ;
sGreeting[7] = sGreeting[6];  
```

A character element of a string variable may be treated like an Integer 32 value.

```
nNumber = sString2[1] * sString2[2];  
```

Clear a string using empty quotation marks.

```
sString1 = "";  
```

The + operator is used to paste strings together. There is no limit to the number of + operators you can use on a line. The + operator must be used in an assignment statement.

```
sString1 = "Hello ";
sString2 = "world";
sString3 = "!";  
```

After the three lines above, the following two lines would produce the same result:

```
sString4 = sString1 + sString2 + sString3;
sString4 = sString1 + "world" + sString3;
```

Use the += operator to append one string to another and change the value of one of them into the result. In the following example, the value of sName would change to “Smith, John”:

```
sName = "Smith, ";
sFirstName = "John";
sName += sFirstName;
```

The Chr() keyword can be used to convert a numeric value into a one-element string.

```
sString5 = sString1 + sString2 + Chr('!');
sString5 = sString1 + sString2 + Chr(33);  
```

**Working with Pointers**

The use of pointers is an advanced programming technique that is very powerful. For more information on using pointers, see “Pointer Commands” on page 321.

*NOTE: Except for the equal operator (==), the comparison operators (see page 349) can be used only with a numeric expression. They cannot be used with a null which is not considered to be a number.*

For the following examples, assume that:

```
n1 = 5;
f1 = 9.2;
s1 = "test 123";  
```

**Using the "&" Character to Point to a Tag’s Address**

A pointer variable or pointer table element contains the address of the object (tag) it is pointing to; this is different than the tag itself. In OptoScript, the "&" means *address of*. It is used as a prefix to a tag in OptoScript when moving the address of a tag into a pointer. PAC Control commands were designed to act on tags and not just the address of the tags. The "&" prefix tells the controller to use the address of the tag and not the tag itself.
Set the pointer. The types must match or the control engine will generate an error.

```plaintext
pn1 = null;
pn1 = &n1;
pf1 = &f1;
ps1 = &s1;
pcht1 = &Powerup;
```

**Using the "&" Character to Move a Pointer**

When moving a pointer to pointer, use the "&&" prefix.

**To move a value from a pointer to another pointer:**

```plaintext
pVariable0 = &*pVariable1;
```

**To move a value from a pointer to a pointer table:**

```plaintext
ptTable[0] = &*pVariable4;
```

**Using the "** Character to De-reference a Pointer**

Use the asterisk ( * symbol) to de-reference a pointer. It will then behave just like the variable to which it is pointing. The following two statements are equivalent:

```plaintext
n2 = *pn1 + *pf1
n2 = n1 + f1;
```

The "*" character has to be used as a prefix to a pointer in OptoScript so that the tag that is pointed to will be used instead of the address of the tag. When using a pointer with normal PAC Control commands you need to de-reference the pointer because PAC Control commands are designed to use tags instead of the address of the tags.

**Using the Comparison Operator "=="**

To see if a pointer is pointing to something, use the comparison operator == (see page 349) to compare it to null. This use is similar to standard PAC Control condition commands such as Pointer Equal to NULL?

For example:

```plaintext
n2 = pn1 == null;
n2 = null == pn1;
if (pt1[0] == null) then
```

**Determining Which Variable to Use**

Pointers are very useful when you don’t know what variables need to be used until runtime. For instance, the next example uses a switch statement (see page 352) to determine which variable to use based on the day of the week. It then uses a pointer to perform a calculation using the correct variable.

```plaintext
switch (GetDayOfWeek())
    case 0: // Sunday
        pn1 = n2;
        break
    case 6: // Saturday
        pn1 = n3;
        break
    default: // Monday-Friday
        pn1 = n4;;
        break
endswitch
```
OPTOSCRIPT DATA TYPES AND VARIABLES

Use the pointer to set the chosen variable.
*pnl = n5 * f1 - 5;

For More Information

For more information and examples of using pointers in OptoScript, see:
- Pages “Pointer Commands” on page 321 and “Pointers and Indexing” on page 90.
- See Appendix E: OptoScript Language Reference
- Download the OptoScript Examples: click here, or go to the Opto 22 website and search for “OptoScript Examples.”

Working with Tables

Following are some examples for using numeric, string, and pointer tables.

<table>
<thead>
<tr>
<th>Numeric tables.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ntTable1[0] = 1;</td>
</tr>
<tr>
<td>ntTable1[1] = 2.0;</td>
</tr>
<tr>
<td>ntTable1[2] = nVar1;</td>
</tr>
<tr>
<td>ntTable1[3] = ntTable1[2];</td>
</tr>
<tr>
<td>ntTable1[4] = ntTable1[ntTable1[0]];</td>
</tr>
<tr>
<td>ntTable1[5] = nVar1 + ntTable1[2] * 3.1;</td>
</tr>
<tr>
<td>nVar1 = ntTable1[0];</td>
</tr>
<tr>
<td>nVar1 = (ntTable1[0] + ntTable1[1]) * ntTable1[2];</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>String tables.</th>
</tr>
</thead>
<tbody>
<tr>
<td>stStrT1[0] = &quot;Hello, &quot;;</td>
</tr>
<tr>
<td>stStrT1[1] = &quot;world&quot;;</td>
</tr>
<tr>
<td>stStrT1[2] = stStrT1[0] + &quot; &quot; + stStrT1[1] + Chr('!');</td>
</tr>
<tr>
<td>sString1 = stStrT1[2];</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pointer tables.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ptTable6[0] = &amp;*pVariable2;</td>
</tr>
<tr>
<td>ptTable6[1] = &amp;nVar1;</td>
</tr>
<tr>
<td>ptTable6[2] = &amp;stStrT1[0];</td>
</tr>
<tr>
<td>stStrT1[0] = *ptTable6[2];</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pointer tables. Note that types are not checked when putting pointers into a pointer table. However, when a pointer is moved from a pointer table element into a pointer variable, the types are checked at runtime by the control engine and must match. For example, assume that the following elements have been placed in table ptPointT:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ptPointT[0] = null;</td>
</tr>
<tr>
<td>ptPointT[1] = &amp;nLED_A;</td>
</tr>
<tr>
<td>ptPointT[2] = &amp;fTemp;</td>
</tr>
<tr>
<td>ptPointT[3] = &amp;sString1;</td>
</tr>
</tbody>
</table>

Based on this information, the first two of the following statements are good. The third one is bad and will cause a control engine error, because the element at ptPointT[3] is a string and therefore does not match the variable pntl, which is defined as an integer 32:
- pn1 = ptPointT[1];
- pf1 = ptPointT[2];
- pn1 = ptPointT[3];
CHAPTER 11: USING OPTOSCRIPT

OPTOSCRIPT EXPRESSIONS AND OPERATORS

OptoScript includes mathematical expressions as well as comparison, logical, and bitwise operators. Because expressions and operators are built into the OptoScript language, several standard PAC Control commands such as Multiply, Bit Shift, and Greater Than or Equal? are not used.

Using Mathematical Expressions

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
<td>nCount = nLast_Count + 2;</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
<td>nNumber_A = nNumber_B - 250;</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
<td>nQuantity = nBoxes * 12;</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
<td>nBoxes = nCount / 6;</td>
</tr>
<tr>
<td>%</td>
<td>Modulo division</td>
<td>nVar1 = nVar2 % 2;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>nVar1 = nVar2 % nVar3;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fFloat1 = fFloat2 % 2.5;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>nVar1 = 2 % nVar2 % nVar3;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fFloat1 = fFloat2 % 2.5;</td>
</tr>
</tbody>
</table>

Use parentheses to clarify groupings and meaning. You can use an unlimited number of parentheses.

nVar1 = nVar2 * (fFloat2 - 2.0);  
nVar1 = (nVar2 + 2) * (nVar3 + (fFloat1 / (fFloat2 - 2)) - 3);

The *, /, and % operators have greater precedence than + and -. For order of precedence, see “Operators” on page 404. In the following lines, line #1 is equivalent to line #3, not to #2.

n1 = n2 + n3 * n4;  
n1 = n2 + (n3 * n4);  
n1 = (n2 + n3) * n4;

Using Comparison Operators

All OptoScript comparison operators return an Integer 32 value of zero (false) or of non-zero (true). OptoScript supports the following comparison operators for comparing two numeric values:

NOTE: Except for the equal operator (==), the comparison operators can be used only with a numeric expression. They cannot be used with a null which is not considered to be a number.

<table>
<thead>
<tr>
<th>Operator and Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>==</td>
<td>nVar1 = nVar2 == fFloat3;</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>nVar1 = nVar2 &lt;&gt; fFloat3;</td>
</tr>
<tr>
<td>&lt;</td>
<td>nVar1 = nVar2 &lt; fFloat3;</td>
</tr>
<tr>
<td>&lt;=</td>
<td>nVar1 = nVar2 &lt;= fFloat3;</td>
</tr>
<tr>
<td>&gt;</td>
<td>nVar1 = nVar2 &gt; fFloat3;</td>
</tr>
<tr>
<td>&gt;=</td>
<td>nVar1 = nVar2 &gt;= fFloat3;</td>
</tr>
</tbody>
</table>

More complex examples.

nVar1 = (nVar2 * 2) == (fFloat3 / 9.5);  
nVar1 = (nVar2 * 2) < (fFloat3 / 9.5);  

You can also use a comparison operator to test whether two strings are equal. For example:

nVar1 = sString1 == sString2;  
nVar1 = sString1 == "abc";}  
nVar1 = sString1 == stStrT1[0];  
nVar1 = stStrT1[0] == stStrT1[1];
Using Logical Operators

All OptoScript logical operators return an integer 32 value of zero (false) or of non-zero (true). OptoScript supports the following logical operators for numeric values:

<table>
<thead>
<tr>
<th>Operator and Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>and</td>
<td>nVar1 = nVar2 and nVar3;</td>
</tr>
<tr>
<td>or</td>
<td>nVar1 = nVar2 or nVar3;</td>
</tr>
<tr>
<td>xor</td>
<td>nVar1 = nVar2 xor nVar3;</td>
</tr>
<tr>
<td>not</td>
<td>nVar1 = not nVar2;</td>
</tr>
</tbody>
</table>

Any number of logical operators can be chained together.

nVar1 = nVar2 and nVar3 and nVar4;
nVar1 = nVar2 or nVar3 or nVar4;

The **not** operator precedes a value (it takes a value only on its right-hand side):

nVar1 = not nVar2;

Logical operators can be combined with comparison operators to create complex logical expressions.

nVar1 = (nVar2 < 1) and (nVar3 == 6.5);
nVar1 = (nVar2 < 1) and (sString1 == "abc");
nVar1 = ((nVar2 < 1) and (nVar4 xor nVar5) or (not (fFloat1 == fFloat2));
nVar1 = not (nVar2 < 5); // same as "nVar1 = nVar2 >= 5;"

When you use a logical operator in an if statement, it isn’t necessary to put the result in a variable because the result is used (consumed) by the if:

if (Motor_1 or Motor_2) then
  Motor_3 = 0;
endif

Using Bitwise Operators

All OptoScript bitwise operators operate on integer values. OptoScript supports these bitwise operators:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>bitand</td>
<td>bitwise and</td>
<td>n1 = n2 bitand 2;</td>
</tr>
<tr>
<td>bitxor</td>
<td>bitwise xor</td>
<td>n1 = n2 bitxor 2;</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>left shift</td>
<td>n1 = n2 bitand 0x0002;</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>right shift</td>
<td>n1 = n2 bitxor 0x0002;</td>
</tr>
</tbody>
</table>

Use the **bitand** operator to and together the two values bit by bit.

n1 = n2 bitand 2;
n1 = n2 bitand n3;

Use the **bitxor** operator to xor together the two values bit by bit.

n1 = n2 bitxor 2;
n1 = n2 bitxor 0x0002;
n1 = n2 bitxor n3;
Precedence

For a list of operators from highest to lowest precedence, see “Operators” on page 404.

OPTOSCRIPT CONTROL STRUCTURES

OptoScript provides the following structures to control the flow of logic in the code:

- “If Statements” (below)
- “Switch or Case Statements” on page 352
- “While Loops” on page 352
- “Repeat Loops” on page 353
- “For Loops” on page 353

If Statements

If statements offer branching in logic: if statement A is true, then one action is taken; if statement A is false (or statement B is true), a different action is taken. If statements are very flexible; here are several examples of ways you can use them.

<table>
<thead>
<tr>
<th>left-shift operator</th>
<th>right-shift operator</th>
</tr>
</thead>
<tbody>
<tr>
<td>n1 = n2 &lt;&lt; 2;</td>
<td>n1 = n2 &gt;&gt; 2;</td>
</tr>
<tr>
<td>// left shift n2's value by 2</td>
<td>// right shift n2's value by 2</td>
</tr>
</tbody>
</table>

The left-shift operator shifts the left value’s bits to the left by the right value.

The right-shift operator shifts the left value’s bits to the right by the right value.

Any numeric value can be tested by the if statement.

NOTE: The value is first converted to an Int32.

if (n1) then
  f1 = 2.0;
endif

Since a comparison operator returns an Integer 32 value, it can be used as the test value.

if (n1 > 3) then
  f1 = 2.0;
  f2 = 6.5;
endif

Complex logical operations can also be used.

if ((n1 > 3) and (not n1 == 6)) then
  f1 = 2.0;
  f2 = 6.5;
endif

An optional else statement can be added.

if (n1 > 3) then
  f1 = 2.0;
  f2 = 6.5;
else
  f3 = 8.8;
endif
Switch or Case Statements

A switch or case statement also offers branching logic and can be used in place of if statements when the expression can match one of a number of numeric values. The value for each case can be a numeric constant or a mathematical expression only. Comparisons and logical operators cannot be used in cases, nor can strings. If a case involves a float, the float is converted to an integer before use. Notice that only one case can be tested at a time.

Here’s an example of a switch statement.

```plaintext
switch (nNumber)
  case 1:
    f1 = 10;
    break
  case 2:
    f1 = 15;
    break
  case (n2 * 2):
    f1 = 20;
    break
  default:
    f1 = 0;
    f2 = -1;
    break
endswitch
```

The value of the expression in parentheses, nNumber, is compared to each of the cases. If the case matches the value of nNumber, the action is taken.

Make sure you use a colon (:) after each case.

If a case matches the value of nNumber, the break statement after citation immediately exits the switch. Notice that a semicolon is not used after break.

You can use a mathematical expression as a case.

If no case matches, the default action is taken. Using a default is optional; if you use it, it must be at the end of the list.

A switch statement must be followed by endswitch.

While Loops

The while loop is used to execute a list of statements while a given condition is true. The condition is tested at the beginning of each loop.

For example, this loop sets the first five elements (elements 0 through 4) of a table (ntTable) to a value of 10:

```plaintext
nIndex = 0;
while (nIndex < 5)
  ntTable[nIndex] = 10;
  nIndex = nIndex + 1;
wend
```

Initialize the counter.

Execute loop if condition is true.

Set the table element.

Increment the counter.
While loops can be nested and can contain other kinds of program statements. Each while needs a matching wend at the end. For example:

```pascal
n1 = 0;
while (n1 < 100)
    while ((n1 > 50) and (n1 < 60))
        nt1[n1] = n1 * 100;
        n1 = n1 + 1;
    wend
    nt1[n1] = n1;
    n1 = n1 + 1;
wend
```

**Repeat Loops**

Repeat loops, in contrast to while loops, are used to execute a list of statements until a given condition is true. Because the condition is tested at the end of each loop, the content of the loop will always be executed at least once.

This example sets the first five elements of ntTable to 10. Compare this example to the example for while loops to see the difference.

```pascal
nIndex = 0;
repeat
    ntTable[nIndex] = 10;
    nIndex = nIndex + 1;
until (nIndex >= 5);
```

**For Loops**

For loops can be used to execute a list of statements a certain number of times.

The for line sets up a predefined initial value and a predefined final value for the counter that counts the repetitions. The line also includes the steps by which the counter gets from its initial value to its final value (step 1 counts by ones; step 2 counts by twos, and so on). The step is required. The counter can be any numeric variable or I/O point, but its value will always be a whole number. The initial value, final value, and step can be any numeric expression; they are converted to integer 32s.

**CAUTION:** A step value of zero creates an infinite loop. A float step value between –0.5 and 0.5 also creates an infinite loop, since it is rounded to zero when converted to an integer 32.
This example results in nVariable equaling 6:

```plaintext
nVariable = 1;
for nCounter = 0 to 4 step 1
    nVariable = nVariable + 1;
next
```

The counter starts at zero, and its final value is 4. It will count up one step at a time. The for loop must end with next.

The for loop counter can be used in the loop. This example sets the first five elements of table ntTable to 10:

```plaintext
for nIndex = 0 to 4 step 1
    ntTable[nIndex] = 10;
next
```

Other step amounts can be used, including negative steps. Do not use a zero step, which creates an infinite loop. This example sets elements 0, 2, and 4 of ntTable to 20:

```plaintext
for nIndex = 0 to 4 step 2
    ntTable[nIndex] = 20;
next
```

Predefined values can be a numeric expression, but they are evaluated only at the beginning of the loop. For instance, the following example will loop 0 to 15 because the upper limit of nSide*3 is evaluated only at the beginning of the loop, not each time through the loop:

```plaintext
nSide = 5;
for nLength = 0 to (nSide * 3) step 1
    nSide = 1;
next
```

For loops can be nested and can contain other types of statements. Each for requires a next at the end.

### USING THE OPTOSCRIPT EDITOR

1. To use the editor, create an OptoScript block in the flowchart where you want the code to appear. (For more information on creating charts and blocks, see “8: Working with Flowcharts.”) Double-click the OptoScript block to open the editor.

The editor is similar to the editor for Microsoft Visual Basic®. You can resize the editor window as needed to see the code.
The following tools are provided in the OptoScript toolbar:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td>Insert Action Command</td>
</tr>
<tr>
<td>Condons</td>
<td>Insert Conditions Command</td>
</tr>
<tr>
<td>Variables</td>
<td>Insert Conditions Command</td>
</tr>
<tr>
<td>Test Compile</td>
<td>Test Compile</td>
</tr>
<tr>
<td>Cut</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>Redo</td>
<td></td>
</tr>
</tbody>
</table>

2. Begin typing OptoScript code in the top area. You’ll notice that what you type is automatically color-coded to help you:
   - Blue—operators and control structures
   - Purple—values
   - Green—comments
   - Black—commands and names of variables, I/O points, charts, and other items
   - Red—string literals.

   If you want to see white-space marks to help line up code, click the Toggle Whitespace button in the toolbar. To hide the marks, click the button again.

3. To use a command, place your cursor in the OptoScript code where you want the command to appear. Click the Insert Actions or Conditions button in the toolbar.
4. In the Select Instruction dialog box, select the command group from the left-hand column, and then select the command name from the right-hand column.
For information on any command, highlight it and click Command Help, or just double-click the command name.

NOTE: If you know the command name, you can just type it into the OptoScript code. Remember that OptoScript command names may be different from standard PAC Control commands. See “E: OptoScript Language Reference,” for more information.

5. To include information about the instruction in the OptoScript code, select “Include parameter helps.”

6. Click OK.
The command appears in the OptoScript code.

7. To use a variable, table, I/O unit or point, chart, counter, timer, or similar item, place your cursor where you want the item to appear in the code. If you know the item’s exact name, enter it and skip to step 9. If you’re not sure of the item’s name, locate it in the Strategy Tree, enter it, and skip to step 9. Or for a variable, click the Add Variable icon  in the toolbar.

8. In the Select Variable dialog box, select the variable type from the left-hand column, and then select the variable name from the right-hand column.
The item appears in the code.

9. Use the Tab key on the keyboard as you type to indent lines as needed. To increase or decrease indentation for a line of code you’ve already typed, highlight the line and click the Increase Indent or Decrease Indent button in the toolbar.

10. Enter comments to document what the code does, so anyone who must debug or maintain the code can clearly see your intentions.
Comments appear in green. Line comments must be preceded by two slashes, for example:
// This is a line comment.
Block comments must be preceded by one slash and an asterisk, and be followed by the same two elements in reverse. For example:
/* This is a block comment that goes beyond one line. */
11. Use the Bookmark buttons in the toolbar as needed to set or clear temporary bookmarks within the code and to move between them.

Bookmarks mark lines of code so you can easily find them and jump from one bookmark to the next. Bookmarks remain only while the editor is open; they are not saved when the dialog box is closed.

12. When you have finished entering all the code for an OptoScript block, click the Test Compile button in the toolbar to compile the code for this block.

The code is compiled, and the results appear in the bottom part of the OptoScript window:

![OptoScript Code](image)

**NOTE:** The next time the chart is compiled, all OptoScript code within the chart will be compiled again.

If errors are found, you can fix them now or later. Begin with the first one (the one on the lowest-numbered line), since later errors are often a result of earlier errors. To check a command, place the cursor anywhere in the command name and click the Command Help button. If you need to add variables or other items that don’t exist in the strategy, do so after step 12.

13. When you have finished with the code in this OptoScript block, click OK to save your work and close the editor. You return to the flowchart.

**TROUBLESHOOTING “UNABLE TO FIND” ERRORS**

Also see “Troubleshooting Syntax Errors” below.

If you test compile an OptoScript block and receive “unable to find” errors, try the following suggestions.

**For Commands**

Check the exact spelling of the command, including upper and lower case. OptoScript commands are similar to standard PAC Control commands, but contain no spaces and some abbreviations.

Also check that the command is necessary in OptoScript. Some common commands, including comparison commands such as Less? and mathematical commands such as Add, are replaced with operators built into the OptoScript language. Check Appendix E: OptoScript Language Reference the PAC Control User’s Guide for equivalent OptoScript commands.
TROUBLESHOOTING “UNABLE TO FIND” ERRORS

The easiest way to make sure the command you enter is valid is to enter it by clicking one of the Insert Command buttons in the OptoScript Editor and choosing the command from the Select Instruction dialog box.

For Variables or Other Configured Items

Variables, I/O units and points, counters, and other configured items in your strategy—as well as charts—have usually been created before you use them in OptoScript code. Check their exact spelling, including underscores and upper and lower case, to make sure they are correct in the code. The easiest way to make sure spelling is correct is to enter the variable or other item by clicking the Insert Variable button in the OptoScript Editor and choosing the item from the drop-down lists.

If the item has not yet been configured or created, use the normal PAC Control methods to do so. For help, see the chapters in this guide on configuring I/O and using variables.

IMPORTANT: In nearly all applications, you want points and variables to be identical in the Strategy Tree and in OptoScript blocks. For example, if you change the name of a variable or point in the Strategy Tree, you want the name changed in OptoScript blocks as well.

However, it is possible to turn off some of these automatic updates and cross-checks. To check whether they’ve been turned off:

1. With the strategy open in Configure mode, choose Configure > Options.
2. Click the Advanced tab.
3. Look to see if any boxes are checked. If they are, you may need to make manual adjustments. (See more information in “Advanced Options” on page 210.)
TROUBLESHOOTING SYNTAX ERRORS

Check for the following common syntax errors:

**Missing Code**

Check for obvious errors first. For example, make sure nothing essential has been left out of (or unnecessarily added to) a statement:

<table>
<thead>
<tr>
<th>Sample Statement</th>
<th>Should Be</th>
<th>Missing Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>iTotal = x + y + ;</td>
<td>iTotal = x + y + z;</td>
<td>Last operator missing a variable</td>
</tr>
<tr>
<td>iTotal = x + y + z</td>
<td>iTotal = x + y + z;</td>
<td>Semicolon missing</td>
</tr>
<tr>
<td>sGreeting = Hello!&quot;</td>
<td>sGreeting = &quot;Hello!&quot;</td>
<td>First quotation mark missing on the string</td>
</tr>
<tr>
<td>iTTime = Get Hours;</td>
<td>iTTime = GetHours();</td>
<td>Extra space in command name; parentheses missing after the command</td>
</tr>
<tr>
<td>x = (1 + (x - y);</td>
<td>x = (1 + (x - y));</td>
<td>Parentheses mismatched (last half missing)</td>
</tr>
</tbody>
</table>

Check to make sure operators are used correctly. You may want to review “OptoScript Expressions and Operators” on page 349.

If you are using control structures such as loops or if statements, especially if they are nested, make sure all required elements are present. For example, every if must have a then and an endif. See “OptoScript Control Structures” on page 351 for more information.

**Type Conflicts**

Type conflicts are caused when different data types are incorrectly mixed. For example, you cannot assign an integer to a string. Make sure data types are correct. It is easier to keep track of data types if you use Hungarian notation when naming variables. See “Variable Name Conventions” on page 344 for help.

DEBUGGING STRATEGIES WITH OPTOSCRIPT

Before trying to debug strategies containing OptoScript code, make sure the code has been compiled within each block, or choose Compile All to do all blocks at once.

When you begin debugging the strategy, start by stepping through whole blocks. If you run across a problem, then step within that block. Stepping within the block is discussed in “Choosing Debug Level” on page 189.
DEBUGGING STRATEGIES WITH OPTOScript
INTRODUCTION

This chapter shows you how to create and use subroutines.

In This Chapter

- About Subroutines ........................................ page 361
- Creating Subroutines ...................................... page 362
- Using Subroutines ........................................... page 368
- Viewing Subroutines ....................................... page 372
- Printing Subroutines ........................................ page 373

ABOUT SUBROUTINES

A subroutine is a custom command that represents a series of commands. Subroutines are useful anytime you have a group of commands that is repeated in a strategy or used in more than one strategy. Subroutines are built using the same tools and logic used to create charts. Once built, you can call them at any time from any chart in any strategy or from another subroutine. (You cannot call subroutines recursively, though; that is, a subroutine cannot call itself, nor can a subroutine called by a subroutine call the original subroutine.)

**NOTE:** To call a subroutine from another subroutine, you need SNAP PAC firmware R9.5a or higher.

Like charts, subroutines start at block 0 and move sequentially through command blocks to the end. They use variables, inputs, and outputs. They can use OptoScript code. Each subroutine is displayed in its own window, and you can open and view several subroutine windows at once.

Unlike charts, however, subroutines are independent from a strategy. You don’t need to have a strategy open to create or change a subroutine. And if you do have a strategy open, creating a subroutine has no effect on the open strategy unless you specifically link them together. (Debugging a subroutine, however, requires that it be called from a strategy.)

A second important difference between subroutines and charts is that subroutines offer two ways to work with variables and other logical elements: they can be passed in or they can be local to the subroutine.

- **Passed-in items** are passed into the subroutine by the strategy. They are referenced when the subroutine is executed. If a parameter is passed by reference, the subroutine will pass the value back to the strategy. For example, you could create a subroutine to add 3.0 to a passed-in float variable. If they are passed by value, the updated value is not passed back to the strategy by the subroutine. For more information, see the next section, "Data Types for Subroutines."

When the subroutine ends, the float variable will contain a new value. Passed-in items are called subroutine parameters, and you can use up to 12 of them in a subroutine.
Local items are created when a subroutine begins, and they are destroyed when it ends. For example, a subroutine could take a passed-in item, copy it to a local variable, and add 3.0 to that local variable for use within the subroutine. The local variable is created when the subroutine is called, and it disappears when the subroutine ends.

Data Types for Subroutines

The following data types may be used in subroutines for both passed-in items and local items:

- Numeric variables (integers, floats, and timers)
- Numeric literals (integers and floats). If you are familiar with other programming languages, literals are similar to "passed by value" parameters, while variables are like "passed by reference" parameters. Other types besides numeric can be passed into the subroutine through literals, however; see below for more information.
- Numeric tables
- String variables
- String literals
- String tables
- Communication handles

The following data types are also supported:

- For passed-in items: I/O points, I/O units, and pointer tables
- For local items: pointer variables

The following data types are not supported in subroutines: PID loops and charts.

Although most variables passed in and out of a subroutine must be of a specific type, literals that are passed into subroutines can take several types. Using a string literal, you can pass in either a string literal or a string variable. Using a numeric literal, you can pass in an analog point, a digital point, an integer variable, a float variable, or a timer variable.

This flexibility in using literals makes it easier to use a subroutine in multiple strategies. For example, a literal passed into a subroutine from two strategies might be a float value in one strategy and an analog point in the other.

CREATING SUBROUTINES

Tips for Subroutines

As a general rule, keep subroutines as small as possible to do the job they're intended for. Extra variables and unnecessarily large table sizes can affect the memory available for running subroutines.

A Put Status In parameter appears automatically in every subroutine. This parameter is used to let you know whether the subroutine was called successfully, in the same way that function commands return a status. Make sure that you always check the status code after calling a subroutine. Subroutine status codes are:

<table>
<thead>
<tr>
<th>Status Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Success</td>
</tr>
<tr>
<td>-67</td>
<td>Out of memory</td>
</tr>
<tr>
<td>-69</td>
<td>Null object error. Make sure you are not passing a pointer that points to null.</td>
</tr>
<tr>
<td>-72</td>
<td>Nesting too deep</td>
</tr>
<tr>
<td>-73</td>
<td>Invalid subroutine or parameters. In configure mode, choose Edit &gt; Find, select Global and Operand, and then click Find to search for objects with the same name as the subroutine. Rename any objects that you find.</td>
</tr>
</tbody>
</table>
CHAPTER 12: USING SUBROUTINES

Drawing the Flowchart

1. In the PAC Control main window (with or without a strategy open), choose Subroutine > New. The Create New Subroutine dialog box appears.

2. Enter a subroutine name.
   The name must start with a letter, but may also include numbers and underscores. It cannot include spaces or other characters.
   The subroutine name will become a command (instruction) in PAC Control. It’s a good idea to make it a descriptive name indicating the purpose of the subroutine, for example, “Variable_Increase_Notification.” You cannot use the name of any existing command (for example, “Add”).

3. Navigate to the directory where you want to store the subroutine and click Open.
   Unlike strategies, multiple subroutines can be saved to the same directory.
   A new subroutine window is created.
CREATING SUBROUTINES

4. Add blocks and connections and name the blocks as you would in a chart, as shown in the example below.

You can also copy existing flowchart blocks from another subroutine or chart and paste them into the new subroutine. See “Cutting, Copying, and Pasting Elements” on page 222.

5. Save the subroutine by selecting Subroutine > Save.

Configuring Subroutine Parameters

Before you can call a subroutine from a strategy, you must configure the variables and other logical items that are passed into it. These passed-in items, called subroutine parameters, are the only information that is shared between a subroutine and the calling strategy. Twelve parameters can be passed into a subroutine, and since a table can be a parameter, those 12 parameters can include a large amount of data.

An item passed into a subroutine may be called by one name in the strategy and by another name in the subroutine. In fact, if a subroutine is used for more than one strategy, it is good practice to select generic names in the subroutine. For example, if you create a subroutine to average values in any float table, the table might be named Float_Table in the subroutine. You could use this subroutine to average pressures in a table named Pressure_Values from a strategy, and Pressure_Values would be referred to as Float_Table in the subroutine.

1. With the subroutine open, select Subroutine > Configure Parameters.
The Configure Subroutine Parameters dialog box appears.

In this dialog box you determine the way the subroutine is called from the strategy.

2. From the Group drop-down list, choose the command group you want the subroutine to appear in. For example, if you create a subroutine to find the average value of several variables, you could choose Mathematical as the command group. The default group is Subroutines.

3. (Optional) Enter a comment to explain the purpose of the subroutine.

4. Notice that one parameter, Put Status In, has been automatically entered for you. This parameter is used to return status information on the subroutine, and it always appears at the bottom of the parameter list. A subroutine essentially becomes a command within a chart or another subroutine, and subroutines are similar to function commands that return a status. Since the system itself returns this status parameter, the name of the status parameter is not available in the subroutine. When you add the subroutine to a strategy, you choose the variable the status will be placed in.

**IMPORTANT:** Make sure you always check returned status codes for all subroutines. Subroutine status codes and their meanings are:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Success</td>
</tr>
<tr>
<td>-67</td>
<td>Out of memory</td>
</tr>
<tr>
<td>-69</td>
<td>Null object error. Make sure you are not passing a pointer that points to null.</td>
</tr>
<tr>
<td>-72</td>
<td>Nesting too deep</td>
</tr>
<tr>
<td>-73</td>
<td>Invalid subroutine or parameters. In configure mode, choose Edit &gt; Find, select Global and Operand, and then click Find to search for objects with the same name as the subroutine. Rename any objects that you find.</td>
</tr>
</tbody>
</table>

5. For each parameter you add, do the following steps.

**NOTE:** What you enter here appears in the Add Instruction dialog box when the subroutine is called from within the strategy. See page 367 for an example.
a. Highlight the first empty line (below the Put Status In parameter) and click Add to open the Add Subroutine Parameter dialog box.

![Add Subroutine Parameter dialog box]

b. In the Prompt field, enter the prompt text you want to show in the Add Instruction dialog box in the strategy. This field is limited to 16 characters.

c. In the Name field, enter the name of the parameter (the argument) as it will be referred to in the subroutine. This name is used within the subroutine only.

d. From the Type drop-down list, choose the type of item to be passed into the subroutine. Use variables for values the subroutine changes (passed by reference); use literals for values the subroutine uses but does not change (read-only or passed by value).

e. Click OK. The parameter appears in the Configure Subroutine Parameters dialog box, above the Put Status In parameter. (Scroll up to see it if necessary.)

![Configure Subroutine Parameters dialog box]

6. Repeat step 5 for each parameter. To change a parameter, highlight it and click Modify. To change the order of a parameter in the list, highlight it and click the up- or down-arrow button in the dialog box. To delete a parameter, highlight it and click Delete.

**NOTE:** You cannot delete the Put Status In parameter or change its order in the list, and you cannot delete a parameter that has a reference count greater than zero (indicating that it is used in the subroutine). Also, if you add or delete parameters after including a subroutine in a strategy, you may receive an error and will need to add the subroutine to the strategy again.

7. When the parameters appear the way you want them in the list, click OK. The parameters you have named can now be used in the subroutine’s commands.
Configured Parameters Example

Here’s an example of a completed Configure Subroutine Parameters dialog box, showing three parameters to be passed into the subroutine.

When the subroutine is called from the strategy, these parameters appear in the Add Instruction dialog box:

Adding Commands and Local Variables

Adding commands (instructions) to subroutines is exactly like adding instructions to charts. For help, see “Adding Commands” on page 249. If you are using OptoScript code within a subroutine, see Chapter 11 for help on creating code. You can copy and paste instructions from one block to another within the same subroutine; if you have trouble copying and pasting instructions from one chart or subroutine into another, simply paste the entire block and then modify it.

You may also need to add local items to be used in the subroutine only and discarded when the subroutine is finished running. Adding variables to subroutines is also like adding variables to charts. For help, see “Adding Variables” on page 233.

Remember that the subroutine is separate from any strategy and can be called by any strategy. I/O units and points are specific to a strategy, so they cannot be added to a subroutine. Also, note that commands and
OptoScript code within a subroutine can use only the passed-in and local items in the subroutine, not items in the strategy that calls the subroutine.

**Compiling and Saving the Subroutine**

1. With the subroutine open, select Compile > Compile Subroutine. When the subroutine has finished compiling, the cursor returns to its normal form.
2. Select Subroutine > Save.

**Adding a Subroutine to a Strategy**

Since subroutines are independent of strategies, you must add the subroutine to the strategy before you can use it.

1. With the strategy open in Configure mode, double-click the Subroutines Included folder on the Strategy Tree (or in the menu bar, click Configure > Subroutine Included). The Subroutine Files dialog box appears, listing all subroutines currently included in the strategy. The example below shows no subroutines currently included.

2. Click Add.
3. In the Select Subroutine File dialog box, navigate to the folder containing the subroutine you want to add.
4. Click a subroutine to select it, and then click Open.

5. The new subroutine’s name appears in the Subroutine Files dialog box. Click OK to save the change and close the dialog box.
   The new subroutine appears in the Strategy Tree in the Subroutines Included folder.

Removing a Subroutine

If the Remove button is grayed out when you select a subroutine in the Subroutine File dialog box, it means the subroutine is used in the strategy. Before you can remove the subroutine, you must first delete any references to it in the strategy.

1. Open the Subroutine Files dialog box, and then click the subroutine to remove.

2. Click Remove, and then click OK to save your changes and close the dialog box.

Changing a Subroutine’s Folder

The Change Folder button helps when:
- A subroutine is saved in a read-only folder (which can cause errors when you attempt to compile the strategy)
- You simply want to change the location of a subroutine that is being used by a strategy.

To change a subroutine’s folder:

1. Open the Subroutine Files dialog box. The subroutine’s original folder and filename appear.

2. Click the subroutine to select it, and then click Change Folder.
3. In the “Choose a new location for” dialog box, navigate to the folder containing the subroutine.

![Image of Choose a new location for dialog box]

4. Click the subroutine to select it, and then click Open.
5. The subroutine’s name appears in the Subroutine Files dialog box. Click OK to save the change and close the dialog box.

Using a Subroutine in Strategy Logic

You use a subroutine just like a PAC Control command: by adding the subroutine as a command to a block in a chart or subroutine.

NOTE: Subroutines are located in the Subroutine group by default. If you want subroutines in a different group, you must change the group when you configure the subroutine’s parameters. See “Configuring Subroutine Parameters” on page 364.

1. With the strategy open in Configure mode, open the chart or subroutine that will call the subroutine.
2. Double-click the block that will call the subroutine.
   If it is an OptoScript block, list parameters (arguments) in order within parentheses, the same way you enter parameters for PAC Control commands (see “OptoScript Syntax” on page 343). Be sure to use the subroutine’s OptoScript name, using underscores instead of spaces. The Put Status In return value can be consumed by a variable (as shown below), a mathematical expression, or a control structure.
   ```
   nStatus = Variable_Increase_Notification( bCondition, nValue, Output1 );
   ```
   For more information on entering a command (instruction) in OptoScript, see “Using the OptoScript Editor” on page 354.
3. In the Instructions dialog box, click where you want the instruction to be placed, and then click Add.
The Add Instruction dialog box appears.

4. In the highlighted Instruction field, enter the subroutine name (or choose it using the drop-down list, or click the Select button and locate it in the command group you chose).

   NOTE: If you click Select, you will find subroutines located in the Subroutine group by default. If you want subroutines in a different group, you can change the group when you configure the Subroutine's parameters. See “Configuring Subroutine Parameters” on page 364.

   The subroutine command appears in the dialog box, just as any command would, and the prompts you entered when you configured the parameters appear also.

5. Choose the Type and Name for each prompt from the drop-down lists.

   You can configure variables on the fly as you would with any command. Remember that the Type was chosen when the parameters for the command were configured, so your Type choices may be limited.

6. When the Add Instruction dialog box is completed, click OK.

7. Click Close to close the Instructions dialog box and return to the chart.

   The chart or subroutine is now set up to call the subroutine.
VIEWING SUBROUTINES

Debugging Subroutines

Debugging a subroutine is just like debugging a flowchart. When you are debugging a strategy that calls the subroutine, make sure the debug level is Full Debug (see page 189). Then use the Step into button to step inside the block that calls the subroutine. The subroutine window automatically opens, and you can continue to step through blocks or lines inside the subroutine. As you step through blocks, subroutines, and charts, the tabs at the bottom of the window let you know where you are (see “Using Tabs to View Open Windows” on page 57).

You can also set breakpoints on any subroutine block as needed. See “Setting and Removing Breakpoints” on page 193 for more information.

VIEWING SUBROUTINES

Since subroutines appear on the Strategy Tree, it is easy to view information about them. A subroutine appears in two places on the Strategy Tree: in the Subroutines Included folder and in the folder for the chart or subroutine that calls it.

You can view, add, and change variables in a subroutine from the Strategy Tree, just as you would for a chart.

Viewing All Subroutines in a Strategy

To see all the subroutines in a strategy, double-click the Subroutines Included folder on the Strategy Tree. All subroutines associated with the strategy are listed in the Subroutine Files dialog box. Click and drag the right side of the box to see all the information. The path, file name, and reference count (how many times the strategy refers to the subroutine) are shown for each subroutine.
PRINTING SUBROUTINES

For steps to print a subroutine’s graphics, see “Printing Chart or Subroutine Graphics” on page 198. To view and print instructions in the subroutine’s blocks, see “Viewing and Printing Strategy or Subroutine Elements” on page 201.
A: Troubleshooting

This appendix provides general tips for resolving problems you may encounter while running PAC Control or communicating with your hardware. If you encounter problems with permissions in Windows, see page 382.

For information about types of errors and lists of error codes, see “B: Errors and Messages.”

Also check troubleshooting information in the user guide for your device:

- groov EPIC PR-series—the groov EPIC User’s Guide (form 2267)
- SNAP PAC S-series—the SNAP PAC S-Series Controller User’s Guide (form 1592)
- SNAP-PAC R-series—the SNAP PAC R-Series Controller User’s Guide (form 1595)
- SNAP PAC EB and SB brains—the SNAP PAC Brains User’s Guide (form 1690)

HOW TO BEGIN TROUBLESHOOTING

You’ve built your strategy, but now you get errors when you try to download it, or it won’t run properly. How do you begin to figure out what’s wrong? The problem may be in communication with the control engine, in communication between the control engine and I/O, in a command, or in the strategy logic. Following are some steps to help you discover the cause.

1. Read Any Error Message Box

If an error message box appears on the computer running PAC Control, it’s probably a PAC Control error. Here’s an example of a PAC Control error message:

2. Check Communication with the Control Engine

If there is no error message box, or the error indicates that there may be a communication problem, check whether the PC running PAC Control is communicating with the control engine. See “Checking Communication with the Control Engine” on page 377.

3. Check the Message Queue

If communication with the control engine is OK, check the message queue. To open the queue, see “Inspecting Control Engines and the Message Queue” on page 106. In the “List of Common Messages” on
page 385, look up any errors you find in the queue. Errors are listed in numerical order. Queue errors may indicate problems with a command or with communication to I/O. Check the possible causes for help in fixing problems.

- For help with a command, look up details about the command in the PAC Control Command Reference or online help.
- For help with communication to I/O, see “Resolving Communication Problems” on page 378. Many of these suggestions apply to I/O as well as to control engines.

4. Check Status Codes in Your Strategy

If all is well up to this point, double-check Status Codes in your strategy. Status Codes are responses to a command that appear in a variable within your PAC Control strategy or as returned values in OptoScript. Your strategy should routinely check status codes and adjust logic as necessary to respond. It’s especially important to check status codes when you use a command that starts a chart or subroutine, to make sure it started successfully.

Status codes may indicate problems with a command or communication to I/O, or they may indicate a problem in the strategy logic. See “List of Common Messages” on page 385 for more information. Again, look at the possible causes for help in fixing problems.

5. Call Product Support

If you cannot find the help you need in this book, the PAC Control Command Reference, or the SNAP PAC Brains User’s Guide, call Opto 22 Product Support. See “Product Support” on page 4 for contact information.

If You Cannot Delete an Item

Sometimes when you try to delete an item in a strategy—for example, a variable, a chart, an I/O unit, or a point—you may receive a message saying “You cannot delete an item with a reference count greater than zero.” This message means you cannot delete the item because other elements in the strategy use it.

You can use Find to locate all references to the item you want to delete. For help in using Find, see “Searching” on page 204.

Sometimes the reference counts can become incorrect due to cutting and pasting variables or importing charts into a strategy. If a reference count appears to be incorrect, follow these steps to rebuild the strategy database:

1. With the strategy open in Config mode, choose Tools > Regenerate Reference Counts.
2. Choose Compile > Compile All.
3. Choose File > Save All.

The strategy database is rebuilt and the reference counts should be correct. If they are not, you may need to choose Tools > Regenerate Reference Counts more than once.

If You Have Memory Problems

Control engine memory is allocated as shown in detail in form 1646, the SNAP PAC Memory Usage Technical Note.

On your controller, you can see the amount of RAM and the amount of battery-backed RAM available for use by inspecting the control engine in Debug mode (see page 106). Battery-backed RAM stores persistent variables, variables initialized on download, autorun flag, and optionally, a strategy archive (—as opposed to
the “normal” strategy which is not saved in battery-backed RAM). Save your strategy to flash memory so it will be available if the control engine is rebooted. See “Saving a Strategy to Flash” on page 178.

Check Strings and Tables

In general, if you experience memory problems, you can reduce the amount of memory needed by checking strings and tables for lengths and widths that are longer than necessary.

Since the battery-backed RAM contains persistent variables and variables initialized on download and optionally stores a strategy archive, you may need to adjust the length of tables or the width of strings and string tables.

The currently running strategy is not stored in battery-backed RAM. To make sure the strategy will run after a control engine reboot, save the strategy to flash memory after downloading it. See page 178 for information on saving to flash.

Subroutines and Memory

When you use subroutines, use the minimum number of variables and the minimum size of tables that the process requires. Here are some additional things to keep in mind:

- Less memory is used if only one chart in the strategy calls subroutines than if multiple charts call subroutines.
- Using nested subroutines (that is, subroutines that call other subroutines) uses more memory. (To use nested subroutines, you need SNAP PAC firmware R9.5a or higher.)

Make sure your strategy logic checks the value of the “Put status in” variable when starting a chart or calling a subroutine to make sure they start correctly. When a chart or subroutine starts, if there is not enough memory available to process it and all the subroutines called within its logic, you will receive an error in the “Put status in” variable for that command.

Archiving Strategies to Battery-Backed RAM

A strategy archive can optionally be stored in battery-backed RAM on the control engine. In addition to an archived strategy, battery-backed RAM holds persistent variables and variables that are initialized on download. If you have a large strategy, large tables, or wide strings or string tables, you may not have sufficient space for an archived strategy. See page 179 for more information on archiving.

Do You Use Online Mode?

If you use Online mode to change your strategy, you may run out of memory. When you change a chart in Online mode, a new copy of that chart is downloaded to the control engine, causing additional memory to be used.

To avoid memory issues, it may be necessary to periodically do a full download of the strategy.

CHECKING COMMUNICATION WITH THE CONTROL ENGINE

You can test communication with the control engine by using PAC Terminal.

1. Start PAC Terminal:
   - In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 10.3 > Tools > PAC Terminal 10.3.
   - In Windows 10, click the Windows Start button, and then click Opto 22 > PAC Terminal 10.3.
The PAC Terminal window appears, showing all control engines configured on your system:

2. If no control engine is listed, configure one by choosing Configure > Control Engine and following directions on the screen. See “Configuring Control Engines” on page 95 for help.

3. To verify that a control engine in the list is communicating, double-click the control engine’s name. The Comm. Loop Time (communication time) in the Inspect Control Engine dialog box indicates how long it takes to gather the information in the dialog box and is a good relative indicator of communication time.
   This dialog box also shows the status of the current strategy and any errors in communication with the control engine. For further explanation, see “Inspecting Control Engines and the Message Queue” on page 106.

4. If you receive an error indicating a communication problem, go on to the next section.

RESOLVING COMMUNICATION PROBLEMS

Matching PAC Control Configuration to the Real World

I/O unit and point configuration in PAC Control must match actual I/O units and points with which the control engine is communicating. See brain and I/O module data sheets for specifications and information.

Resolving TCP/IP Cannot Connect Errors (-412)

Many problems with Ethernet connections return a TCP/IP Cannot Connect error. Cannot connect errors are probably the most common communication problem with control engines. They indicate that a TCP/IP connection could not be made to the control engine within the specified time interval.

If you receive this error, first check the following:

- Make sure the control engine has been turned on.
- Verify that the correct IP address appears for the control engine.
- Make sure your control engine has been assigned a valid IP address. These controllers and brains come from the factory with a default IP address of 0.0.0.0, which is invalid. For help in assigning an IP address, see the PAC Manager User’s Guide (form 1704).
Make sure you have up-to-date drivers installed on your computer’s Network Interface Card (NIC). Contact your system administrator or the manufacturer of the card for help.

If problems persist, you can increase the length of time before a timeout occurs. Choose Configure > Control Engines and change the Timeout (mSec) field to a larger number.

Pinging the Control Engine

If you still cannot communicate with the control engine after you have checked these items, try to reach it using the Windows PING command.

1. To ping a control engine, open a Windows Command Prompt:
   - For Windows 7, click the Windows Start menu, and then click Programs > Command Prompt.
   - For Windows 10, press the Windows Start key, type cmd and then press the Enter key.

2. At the prompt, type ping and the control engine’s IP address, and then press Enter.
   Example: ping 10.192.54.40

If data is returned from the control engine, the control engine can be found on the network.

If the PING command cannot be found—Verify that the PC has TCP/IP bound to and configured on the network adapter in Windows’ Network and Sharing Center. To open Windows Network and Sharing Center:

3. Open Windows Control Panel.
   - If Control Panel is set to View by: Category, click the View by drop-down list, and then click Large icons.
   - In the Large icons view, click the Network and Sharing Center icon.

4. On the left side of the Network and Sharing Center window, click Change adapter settings.

5. In the Network Connections window, right-click your network connection, and then click Properties on the pop-up menu.


7. Click Internet Protocol Version 4 (TCP/IPv4) to highlight it, and then click the Properties button. If the IP address is not automatically obtained, verify that the IP address, subnet mask, and default gateway are appropriate for your network.

If you see the message “Destination host route not defined,” the control engine probably has an IP address and subnet mask that are incompatible with those on the computer. Subnetwork numbers and netmasks must be identical on the control engine and the computer.

If you see the message “No response from host,” check the following:
   - Are the computer and control engine correctly connected? Is the control engine turned on?
   - Are the IP address and subnet mask on the control engine compatible with those on the computer?

If your host computer has more than one Ethernet card, check your route table to make sure packets are routed to the correct adapter card.

If all else fails, connect the PC and the control engine using an Ethernet crossover cable, and retest the connection.

If you still cannot ping the control engine, contact Product Support. (See page 4.)
Checking Detailed Communication Information Using PAC Message Viewer

For detailed information about each communication transaction, use the PAC Message Viewer tool. To start PAC Message Viewer:

- In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 10.3 > Tools > PAC Message Viewer 10.3.
- In Windows 10, click the Windows Start button, and then click Opto 22 > PAC Message Viewer 10.3.

You can also start PAC Message Viewer from:

- PAC Terminal’s menu bar, by clicking Tools > Start PAC Message Viewer
- PAC Control in Debug mode by clicking Debug > Sniff Communication. The PAC Message Viewer window appears.

In most cases the main window is blank, indicating that no messages are being monitored between the PC and the active control engine. In some cases, for example when PAC Control launches PAC Message Viewer, messages should appear immediately.

1. To start monitoring or change the level of monitoring, choose View > Monitor Levels. The Monitor Levels dialog box lists all the possible levels to monitor. You can click Refresh to make sure the list is up to date.

2. Highlight one or more of the monitor levels in the list, and click Close. You return to the PAC Message Viewer window, where the changes you made are reflected at once. To stop monitoring, click Pause. To start monitoring again, click Resume. To erase all messages from the window, click Clear.
By default, communication messages in PAC Message Viewer are automatically saved to a log file named IOSNIF.LOG. You can toggle saving on and off by choosing File > Log to File.

Also by default, messages are temporarily stored in system cache memory before being saved to the log file. If you are having trouble with system crashes and need to capture messages just before a crash, however, you can choose File > Flush File Always to send messages directly to the log file.

3. To view or edit the log file, choose File > Edit Log File.
   The file opens in a text editor. Logging is turned off when you open the file.

4. View or edit the file as needed, and then close it.
   You return to the PAC Message Viewer window.

5. To resume logging, choose File > Log to File.

6. To rename the log file or change its location, choose File > Select Log File. Navigate to the location where you want to save the file and enter a name. Click OK.

7. When you have finished monitoring communication, close the PAC Message Viewer window.
   If you leave it open, it will normally appear on top of other running programs. If you don’t want it to appear on top of other programs, choose View > Always on Top to toggle that option.

Checking File Versions for Opto 22 Software

Sometimes problems may be caused by older or misplaced files. Product Support may ask you to run OptoVersion to check the versions and paths of your Opto 22 .dll and .exe files. Here’s how:

1. Start OptoVersion:
   – In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 10.3 > Tools > OptoVersion 10.3.
   – In Windows 10, click the Windows Start button, and then click Opto 22 > OptoVersion 10.3.

2. In the OptoVersion window, click Find.
   The utility searches your hard drive and prints a list of Opto-related files found.

3. To see more information on any file, double-click its name. To sort the list in a different order, click any column heading.

4. To email the information to Opto 22 Product Support, click E-mail.
   The utility saves the list to a file named Version.bd in the same directory that contains OptoVersion.exe. If you use Microsoft Outlook as your email program, a new message automatically appears addressed to Product Support, with the version file attached.
5. If you use Microsoft Outlook, add comments to the new message and click Send.
6. If you use another email program, attach the Version bd file to an email message and address the message to support@opto22.com, along with an explanation of the problem you’re experiencing.
7. To save the file, click Save As. Give the file a name and save it in the location you want.
   OptoVersion also creates a tab-delimited file with the same file extension and in the same directory. This file has the same name you gave it but with _Delimited added. For example, if you name the saved file Opto_software.txt, the tab-delimited file is named Opto_software_Delimited.txt. This file can be opened in Microsoft Excel or other programs to easily sort and view its contents.

Problems with Permissions in Windows

When you set up controllers on a computer running the Microsoft Windows operating system, typically you are using the computer with top-level “administrator” privileges. If someone later uses this same computer to run PAC Control or PAC Display, but logs in to the computer with lower-level, non-administrator privileges, the application may not recognize control engines that have been previously configured.

If this problem occurs, you can modify the permissions to let specific users access previously configured control engines without having administrator access. This is done using the Registry Editor utility. Follow the steps below.

**CAUTION:** Use the Windows Registry Editor carefully. It is strongly recommended that you make a backup copy of your Windows Registry before continuing with this procedure. Without a backup copy, if you delete the wrong properties and cannot return the Registry to its original state, application and system files can become unusable and will have to be reinstalled.

1. Log on as an administrator on the computer where PAC Control or PAC Display is installed.
2. On your keyboard, press the Windows Start key, type run and then press Enter. The Run dialog box appears.
3. In the Open field, type regedt32 and then press Enter:
   
   **NOTE:** This is NOT regedit.exe, which is a similar tool.
   
   If a User Account Control window appears, click Yes to continue.
   
   The Registry Editor window appears.
4. In the left pane, double-click the HKEY_LOCAL_MACHINE folder to expand it.
5. In the HKEY_LOCAL_MACHINE folder, double-click the SOFTWARE folder to expand it.
6. Navigate to the Opto 22 folder by following the instructions for your system type.
   – For 32-bit operating systems, in the SOFTWARE folder, click the Opto22 folder to highlight it.
   – For 64-bit operating systems:
     – In the SOFTWARE folder, double-click the WOW6432Node folder to expand it.
     – In the WOW6432Node folder, click the Opto22 folder to highlight it.
7. With the Opto22 folder highlighted, click Edit > Permissions on the Registry Editor menu bar.
   The Permissions for Opto22 dialog box opens.
8. Click Add.
9. In the Select Users, Computers, or Groups dialog box, type the name of the user or group that should have control engine access, and then click OK.
   The Permissions for Opto22 dialog box reappears.
10. If it is not already selected, check the “Full Control—Allow” box in the Permissions area.
11. Click OK to save your changes and close the dialog box.
12. Click File > Exit to close the Registry Editor.

The added users will need to restart their computers for the new permissions to take effect. Then they will be able to use control engines without having administrator access.
INTRODUCTION

This appendix discusses errors and messages you may see in PAC Control and their possible causes. Errors and messages may appear with text only or with a negative number and text. The more common errors and messages are listed in this chapter in numeric order, starting on page 385.

To look up an error in PAC Control, select Help > Error Lookup. In the Error Lookup dialog box, enter the error code (preceded by a minus sign, if applicable), and then click Get Error.

See also, Appendix A: Troubleshooting for additional help in resolving errors.

TYPES OF ERRORS

As you work in PAC Control, you may see three types of errors:

- PAC Control Errors appear in dialog boxes on the computer screen.
- Queue Messages (both errors and other messages) appear in the control engine’s message queue.
- Status Codes appear in variables or as returned values in OptoScript.

PAC Control Errors

PAC Control errors indicate a problem within PAC Control that may have been reported by the control engine or may have occurred before control engine communication.

PAC Control errors appear in dialog boxes on the computer running PAC Control. Some of these errors appear as numbers, some as text, and some show both numbers and text. An example of a PAC Control error is “Timeout. No response from device.” Another example is “TCP/IP: Cannot error” with an error code of -412.
Queue Messages

Queue messages indicate an error or other message during strategy operation, and they appear in the PAC Control message queue. (For information on viewing the queue, see “Viewing the Message Queue” on page 108.) Here’s an example of a message queue:

This queue shows several types of messages that you might see. To see all the information in a column, drag the edge of the column heading to the right.

**Code.** Queue errors generated by the system are shown as negative numbers in the Code column. For example, if you specify a table index that is greater than the number of elements in the table, an error -12, “Invalid table index,” appears, as in message #3 above. Common queue errors for each command are listed in the PAC Control Command Reference and in online help.

If the Code column indicates **User**, the error is one you have placed in the queue using the command Add Message to Queue. User messages can help with troubleshooting. Message #2 above is an example of a message the user placed in the Temperature_Control chart.

**Severity.** The Severity column indicates the type of message: information, warning, or error.

**Chart, Block, Line, Object.** If a PAC Control command in the strategy caused an error, the chart name, block number, and line number (if you are in Full Debug mode) where the command appears are listed. Message #3 above is an example: an invalid table index was used in block 19 of the Temperature_Control chart. The Object column shows the table name.

If an error did not occur in a strategy chart, the Chart column shows <system>. Messages 1 and 2 occurred when the strategy was unable to initialize an I/O unit, so the Chart column shows <system:_INIT_IO>. Block and Line do not apply, but the Object column shows the name and IP address of the I/O unit.

If an error was caused by a subroutine, the Chart column shows the name of the chart that calls the subroutine, and the Block column shows the name of the subroutine and the block number where the error occurred, in the format subroutine name.<block number>. Messages 4, 5, and 6 are examples; these errors occurred in block 1 of the subroutine Variable_Increase_Notification, which was called by the Temperature_Control chart.

**Using Queue Messages**

If a block number is listed for the error, look in that block in the strategy to find the PAC Control command that caused the error. The easiest way to find a block is to open the chart or subroutine, then choose Center on Block from the View menu. You can click the Block column to sort the blocks by number and locate the one with the problem.
To see which line within a block is causing the error, in PAC Control Configure mode, choose Configure > Full Debug. When the error appears in the queue, it will include the line number of the command as well as the block ID.

**Status Codes**

Status Codes indicate the success or failure of a PAC Control command (instruction), and they are reported by the control engine to a variable in your PAC Control strategy or as a returned value in OptoScript. The status code is either zero (indicating a successful command) or a negative number (indicating an error).

For example, suppose you use the command Transmit Numeric Table. You create a variable named Transmit_Status to put the status of the command in. In Transmit_Status you receive either a zero, indicating that the table was successfully transmitted, or you receive a negative number such as -37 or -42.

Status codes that may be returned are listed for each command in the *PAC Control Command Reference* and in online help.

**Naming Conflicts**

During various procedures, PAC Control checks for duplicate names of objects such as variables, charts, subroutines, strategy variables, OptoScript instruction names, and reserved keywords. If a naming conflict is found, you may need to rename an object or perform some other housekeeping procedures. When converting to a newer PAC Project, make sure to update PAC Control strategies first and then PAC Display projects so that PAC Display projects are updated based on changes to the strategy database.

**LIST OF COMMON MESSAGES**

The following messages may appear in PAC Control. They are listed in numeric order.

If a black circle appears in the Q? column, the code number appears in the message queue. If a black circle appears in the I/O? column, the message is an I/O unit error and may appear either in the message queue, as a status code in a variable, or both. For more information on handling I/O unit errors, see "Error Handling Commands" on page 307 and *Optimizing PAC Project System Performance*.

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Possible Cause</th>
<th>Q?</th>
<th>I/O?</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Operation performed successfully.</td>
<td>NOT AN ERROR. Indicates the command was successful.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-1</td>
<td>Undefined command.</td>
<td>An unknown command was sent to the PAC Control engine.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-2</td>
<td>Checksum or CRC mismatch.</td>
<td>When comparing DVFs (Data Verification Fields), a mismatch occurred. Examples of DVFs include checksum and CRC.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-3</td>
<td>Buffer overrun or invalid length error.</td>
<td>In string manipulations, a string was requested that is longer than the string it will be put into, or the destination string length &lt;= 0.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-4</td>
<td>Device has powered up. ('Powerup clear expected' message received.)</td>
<td>NOT AN ERROR. The device has been turned off and then on again since the last communication, and is now ready.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-5</td>
<td>Operation failed.</td>
<td>An attempt to store the strategy to flash failed, or an attempt to do something with a chart failed (like call, continue, suspend, start, initialize threads).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-6</td>
<td>Data field error.</td>
<td>Invalid year entered (must be between 2000 and 2099), or invalid data read from memory when attempting to read the strategy from flash memory.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-7</td>
<td>Watchdog timeout has occurred.</td>
<td>See “Add I/O Unit Dialog Box” on page 120.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Description</td>
<td>Possible Cause</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-8</td>
<td>Invalid data.</td>
<td>Invalid data read when attempting to read a strategy from flash, or an invalid character number was passed to a string function.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-10</td>
<td>Invalid port number.</td>
<td>Valid range for Ethernet is 0–65535. For a communication handle, serial port format may be incorrect.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-11</td>
<td>Could not send data.</td>
<td>A Transmit or Transfer command fails when using a comm handle. For example, an attempt is made to send a file to a remote ftp server that has gone off-line.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| -12| Invalid table index.                             | Typically, a math result too big to fit in the value passed, while doing number conversion functions such as converting a float value to engineering units, a float to an unsigned integer, a float to an integer, a 64-bit integer to a 32-bit integer, a floating point value to a 64-bit integer, a floating point value to an unsigned 64-bit integer, an ASCII value to a float.
<p>|     |                                                  | NOTE: In OptoScript, an If Statement expects a 32-bit number and will automatically convert any other type (such as 64-bit integer or float value) to a 32-bit number. To avoid this overflow error, a slight change to the code can avoid this problem. For example: |
|     |                                                  | if (your_int_64_here) then... becomes: |
|     |                                                  | if (your_int_64_here &lt;&gt; 0) then... |
|     |                                                  | Also math functions such as multiply, exponentiation, hyperbolic sine, hyperbolic cosine, function x to the y, add, subtract, modulo, negate, move/assign. |
|     |                                                  | Time/date functions: setting a month not in the range 1–12, a day not in the range 1–31, hours not in 0–23, minutes 0–59, seconds 0–59. |
|     |                                                  | Number entered on host port (for example, through PAC Terminal) was too big for data types. |
| -13 | Overflow error.                                  | Math resulted in an invalid number (like infinity or an imaginary number): natural log of the floating point number, square root, arc sine, arc cosine of float, function x to the y (with negative x). |
| -14 | Invalid number.                                  | Contact Product Support, 800-835-6786 (toll-free in the U.S. and Canada) or 951-695-3080, or email <a href="mailto:support@opto22.com">support@opto22.com</a>. |
| -15 | Cannot divide by zero.                           | Contact Product Support, 800-835-6786 (toll-free in the U.S. and Canada) or 951-695-3080, or email <a href="mailto:support@opto22.com">support@opto22.com</a>. |
| -16 | Bus error.                                       | Contact Product Support, 800-835-6786 (toll-free in the U.S. and Canada) or 951-695-3080, or email <a href="mailto:support@opto22.com">support@opto22.com</a>. |
| -20 | Device busy. May be in use by another user or another application. | A resource is already acquired by another task or process. |
| -21 | Had to relock host port in 'QUIT'.               | Host port needed relocking. |
| -23 | Destination string too short.                    | In string manipulations, a string was requested that is longer than the string it will be put into, or destination string length &lt;= 0. |
| -25 | Port not locked.                                 | Attempted to transmit or receive on a connection that wasn’t locked, or to unlock a connection that wasn’t locked. |
| -26 | Unknown response from device.                    | OptoMMP-based protocol packet returned by the device was invalid. |
| -29 | Wrong object type. Most likely caused by moving a pointer table element to a pointer of the wrong type. | An object was passed to a command that doesn’t handle that object type. |
| -34 | Invalid I/O command or invalid memory location.  | Contact Product Support, 800-835-6786 (toll-free in the U.S. and Canada) or 951-695-3080, or email <a href="mailto:support@opto22.com">support@opto22.com</a>. |</p>
<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Possible Cause</th>
<th>Q?</th>
<th>I/O?</th>
</tr>
</thead>
<tbody>
<tr>
<td>-35</td>
<td>I/O Point mismatch. The Object field specifies the point name, board name, module number, and point number. For example: BadPoint AIARMS Point Analog (R1: 2, 1)</td>
<td>A point is incorrectly configured (for example, an output point is configured as an input point), or the point type is not supported by the I/O Unit's firmware. Check <a href="http://www.opto22.com">www.opto22.com</a> for firmware updates.</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>-36</td>
<td>Invalid command or feature not implemented.</td>
<td>Feature not yet implemented for this hardware/command combination, or command may not apply to the type of communication handle you are using.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-37</td>
<td>Timeout on lock.</td>
<td>Unable to lock a resource (such as a variable) for exclusive writing within the timeout period.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-38</td>
<td>Timeout on send.</td>
<td>Unable to send communication in the timeout period.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-39</td>
<td>Timeout on receive.</td>
<td>Unable to receive communication in the timeout period.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-42</td>
<td>Invalid limit (on string index, task state, priority, etc.).</td>
<td>A character number greater than the length of the string was used (or the string had a zero length), or an invalid value was passed when setting the state of a chart (running, etc.)</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-44</td>
<td>String too short.</td>
<td>String less than 8 characters used to read time (“hh:mm:ss”), or not 8 or 10 characters for a date, or zero length on a string function.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-45</td>
<td>Null string.</td>
<td>Attempted to use an uninitialized string.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-46</td>
<td>Invalid string.</td>
<td>String not 8 characters long when setting time, or invalid format when setting date, or invalid communication handle string or comm handle command (such as a missing colon).</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-47</td>
<td>Invalid connection. Device drivers might be missing or not loaded/running.</td>
<td>Attempted to open an already open connection.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-49</td>
<td>No more connections are available. Maximum number of connections already in use.</td>
<td>No more sessions available for Ethernet.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-50</td>
<td>Open connection timeout. Could not establish connection within the timeout period.</td>
<td>Unable to open a connection in time.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-52</td>
<td>Invalid connection—not opened.</td>
<td>Communication handle may have been closed by a previous command that failed.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-57</td>
<td>String not found.</td>
<td>Substring not found in the string being searched.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-58</td>
<td>No data received. or Character not found.</td>
<td>Attempted to read an empty buffer (or a connection with no characters waiting); or the I/O unit may be turned off or unreachable; or when searching a string for a particular character, the character wasn’t found.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-59</td>
<td>Could not receive data.</td>
<td>Command may not apply to the type of communication handle you are using; for example, Receive commands cannot be used with ftp comm handles. (Use the get option with Send Communication Handle Command instead.)</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-60</td>
<td>Empty stack error. PAC Control engine attempted to perform an operation that expected data on the PAC Control engine stack.</td>
<td>Contact Product Support, 800-835-6786 (toll-free in the U.S. and Canada) or 951-695-3080, or email <a href="mailto:support@opto22.com">support@opto22.com</a>.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Description</td>
<td>Possible Cause</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----</td>
<td>----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| -61| Dictionary full error. PAC Control engine dictionary is full and no more 'words' can be defined. | A number of things can reduce the amount of dictionary space, such as:  
  • Too many blocks or variables in a strategy  
  • Too many large tables  
  • Using background downloads, which cuts available memory in half |
| -62| Stack full error. PAC Control engine stack has grown too big.               | The PAC Control engine stack is full.                                                                                                                                                                     |
| -64| Execute-only error. A command or 'word' was encountered that cannot be used when compiling. | Contact Product Support, 800-835-6786 (toll-free in the U.S. and Canada) or 951-695-3080, or email support@opto22.com.                                                                                     |
| -66| Requested item in protected dictionary                                      | Attempted to remove a strategy when there was no strategy in the control engine.                                                                                                                             |
| -67| Out of memory. To minimize the size of your strategy, reduce the number and size of variables (especially tables). You can also shrink your strategy by using subroutines to perform common tasks | No room left to create any variables or save any data on the stack. Or an attempt was made to save the strategy to flash, without enough room in flash to save it. |
| -69| Invalid parameter (null pointer) passed to command.                        | Attempted to use an uninitialized pointer, or a null pointer was received by a command.                                                                                                                        |
| -70| Not enough data supplied.                                                   | Table index given is larger than the size of the table.                                                                                                                                                     |
| -71| Out of persistent memory. If applicable, check length of tables.           | Too many persistent variables, variables initialized on download, or too large a strategy archive to fit in battery-backed RAM.                                                                              |
| -72| Subroutine nesting too deep                                                | Reduce the number of layers of subroutines called.                                                                                                                                                         |
| -73| Invalid subroutine or parameters.                                          | In configure mode, choose Edit > Find, select Global and Operand, and then click Find to search for objects with the same name as the subroutine. Rename any objects that you find. |
| -93| Communication to I/O unit not enabled. Previous communication failure may have disabled communication to the unit automatically. Re-enable it and try again. | Communication to the I/O unit may have been disabled by a communication failure that happened earlier.                                                                                                    |
| -95| Stack not empty.                                                           | Contact Product Support, 800-835-6786 (toll-free in the U.S. and Canada) or 951-695-3080, or email support@opto22.com.                                                                                     |
| -103| Port could not be unlocked. Task attempting to unlock the port does not match the task with the current lock on that port.   | Attempted to unlock a connection that was locked by a different task.                                                                                                                                     |
| -203| Driver could not be found or loaded.                                      | Communication command didn’t find the entity listed in the communication handle. An entity can be:  
  • tcp  
  • udp  
  • file  
  • ftp  
  • ser  
  • @<serial channel name> (for groov serial modules only)  
  This could be for any of the following reasons:  
  • The entity is misspelled (for example, tcp must be lower case).  
  • The item the entity represents might have been deleted from the strategy (for example, if you delete the groov serial channel from the strategy tree). |
<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Possible Cause</th>
<th>Q?</th>
<th>I/O?</th>
</tr>
</thead>
<tbody>
<tr>
<td>-407</td>
<td>File not found.</td>
<td>Attempted to save a strategy to flash, but there was no strategy in RAM to save or the directory was not found.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-412</td>
<td>TCP/IP: Cannot connect error</td>
<td>Ethernet “connect” failed. For details, see the PAC Control User’s Guide</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-417</td>
<td>Cannot open file</td>
<td>File does not exist or file name may be incorrect.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-430</td>
<td>Invalid data range. Verify high value is greater than low value.</td>
<td>Invalid data passed to driver (for example, a point number larger than the maximum number of points on the rack).</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-433</td>
<td>Object/device already locked.</td>
<td>Couldn’t set the state of a chart (running, suspended, etc.) because it’s already locked by something else.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-437</td>
<td>No acceptable socket interface found.</td>
<td>An Ethernet &quot;accept&quot; or &quot;open&quot; was attempted, but no more sessions are available.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-438</td>
<td>Could not create socket.</td>
<td>This error is generated when the controller has run out of available TCP sockets (a limited resource). This is most likely caused when the strategy is overaggressive when trying to establish TCP communications to other devices. When sockets are opened and fail or are closed, there is a time period that must expire before the socket resource may be reused. Sockets that are rapidly opened and closed will cause all available socket resources to enter this time period. When this occurs, any attempt to open an outgoing communication will fail with this error code because there are no available sockets to use for this attempt. When an error occurs when trying to open a TCP communication handle, the strategy should back off for a significant amount of time before reattempting. Subsequent failures should have additional delays applied. These delays slow the consumption of TCP resources.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-440</td>
<td>Could not bind socket.</td>
<td>Another device, such as the I/O on the brain, is already using the port. If you are using the Modbus toolkit, make sure to use PAC Manager to set the brain’s Modbus port to a number other than 502. Try 0.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-442</td>
<td>Could not accept on socket.</td>
<td>Ethernet “accept” failed.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-443</td>
<td>Could not receive on socket.</td>
<td>Ethernet “receive” failed.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-444</td>
<td>Could not send on socket.</td>
<td>Ethernet “send” failed.</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>-446</td>
<td>FTP: Login failed.</td>
<td>Incorrect user name or password. The maximum number of login attempts on the server has been exceeded.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-531</td>
<td>Buffer full.</td>
<td>Attempted to write to a full buffer. For a serial communication handle, data is being sent faster than the serial port can send and buffer it. Use a faster baud rate or a delay between Transfer/Transmit commands.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-534</td>
<td>Attempts to communicate with I/O unit failed.</td>
<td>I/O unit may have lost power or network connection.</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>-539</td>
<td>I/O error; performing retry</td>
<td>I/O unit may have lost power or network connection. When communicating with I/O Units, retries are logged in the message queue.</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>
## LIST OF COMMON MESSAGES

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Possible Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>-612</td>
<td>Unable to enqueue sync command</td>
<td>(Applicable only when redundant controller support is enabled.) The synchronization queue contains more than one write command for the same object. In a redundant strategy, write commands (for example, Turn On and Turn Off) are queued until the controller encounters a sync block. When the sync block is executed, the queued commands are processed. New write commands are then queued until the next sync block is executed. A -612 message indicates that an object has been sent more than one write command without a sync block between them. The command that triggered the -612 message can be in any chart in the strategy. To resolve the issue: • Add a sync block between any blocks that send write commands to the same object. • When writing to the same object, put the write commands in the same transactional chart. (This will make it easier to debug -612 errors that are caused when a chart sends a write command to an object in a different chart.)</td>
</tr>
<tr>
<td>-700</td>
<td>PID Loop has been configured outside of this strategy and could conflict with this strategy’s logic.</td>
<td>You are trying to download a new strategy, but a PID loop is currently running on the brain. Start PAC Manager and turn off the loop in Inspect mode by changing its algorithm to None.</td>
</tr>
<tr>
<td>-8607</td>
<td>Invalid protocol.</td>
<td>Attempted to set a port to an unknown mode.</td>
</tr>
<tr>
<td>-8608</td>
<td>Port initialization failed.</td>
<td>While starting up a chart or task, the default host port could not be created. Each command sent by the PAC controller has a sequence ID. Each response from an I/O unit includes the sequence ID of the command it is responding to. This allows the controller to verify that a response from an I/O unit matches the most recent command sent to that I/O unit. An out-of-sync error would occur (and be posted in the PAC controller's message queue) if the response received by the controller is for a previous command rather than the current command. It usually occurs like this: Controller sends a command and waits the timeout period for the response. If no response is received, it sends a re-transmit of the same command, but with a new sequence ID. The controller receives a response to the original command, so the sequence ID does not match the current sequence ID. Possible problems: • <strong>Network problems.</strong> Out-of-sync errors typically occur when communication to the I/O unit is via a network with high latency or inconsistent latency, such as wireless Ethernet, radio modem, cell modem, etc. This usually does not occur on a wired network because normal response times are much shorter than the default timeout period for I/O Units (typically 1 sec). Note: If an Ethernet packet from a controller to an I/O unit gets dropped, you would get a -539 error instead of an out-of-sync error. • <strong>The timeout interval is too short.</strong> Increase the timeout value to reduce out-of-sync errors.</td>
</tr>
<tr>
<td>-8612</td>
<td>Old response to new command</td>
<td>Socket or network problems. Check cables and connections to control engine; cycle power to control engine.</td>
</tr>
</tbody>
</table>

| All -10,000 and -11,000 errors | [Various descriptions] | Socket or network problems. Check cables and connections to control engine; cycle power to control engine. |
LIST OF COMMON MESSAGES
### INTRODUCTION

This appendix lists all of the PAC Control file types and special files. You can use this information to determine what types of files are present in your PAC Control project directory.

### FILES RELATED TO A STRATEGY

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;strategy&gt;.idb</code></td>
<td>PAC Control strategy database</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;.crf</code></td>
<td>Controller Run File (compiled file that is sent to the control engine)</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;.cm</code></td>
<td>Intermediate run file (compiled file that is sent to the control engine)</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;.cm1</code></td>
<td>Intermediate run file (component of the run file)</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;.cm2</code></td>
<td>Intermediate run file (component of the run file)</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;.cm3</code></td>
<td>Intermediate run file (component of the run file)</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;.inc</code></td>
<td>Initialization data for variables with “Init on Download” option (component of the run file)</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;.inf</code></td>
<td>Strategy configuration information</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;$idb</code></td>
<td>Temporary PAC Control strategy database file</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;.ldb</code></td>
<td>PAC Control strategy database lock file</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;.per</code></td>
<td>Persistent variable definitions</td>
</tr>
<tr>
<td><code>&lt;strategy&gt;.&lt;control engine&gt;.cdf</code></td>
<td>Control engine download file for special circumstances (see page 185)</td>
</tr>
<tr>
<td><code>&lt;chart name&gt;.cht</code></td>
<td>Chart</td>
</tr>
<tr>
<td><code>&lt;chart name&gt;.ccd</code></td>
<td>Compiled chart code (component of the run file)</td>
</tr>
<tr>
<td><code>&lt;chart name&gt;.con</code></td>
<td>Online compiled chart code</td>
</tr>
<tr>
<td><code>&lt;chart name&gt;.cxf</code></td>
<td>Exported chart file</td>
</tr>
<tr>
<td><code>&lt;filename&gt;.wth</code></td>
<td>Watch window file (you name the file)</td>
</tr>
<tr>
<td><code>&lt;filename&gt;.otg</code></td>
<td>Exported I/O configuration file (you name the file)</td>
</tr>
<tr>
<td><code>&lt;strategy.date.time&gt;.zip</code></td>
<td>Strategy archive file (automatically named; see “Archiving Strategies on the Computer” on page 179 for file name formats)</td>
</tr>
</tbody>
</table>
## FILES ASSOCIATED WITH A SUBROUTINE

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;subroutine name&gt;.lsb</td>
<td>Subroutine</td>
</tr>
<tr>
<td>&lt;subroutine name&gt;.ini</td>
<td>Subroutine configuration information</td>
</tr>
<tr>
<td>&lt;subroutine name&gt;.isc</td>
<td>Compiled subroutine (component of the run file)</td>
</tr>
<tr>
<td>&lt;subroutine name&gt;.lisb</td>
<td>Subroutine lock file</td>
</tr>
</tbody>
</table>

## FILES IN THE PAC CONTROL DIRECTORY

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;xxx&gt;.io.def</td>
<td>Object definition files (commands, I/O points, and I/O units). You must not modify these files.</td>
</tr>
<tr>
<td>ioCtrl.exe</td>
<td>PAC Control executable file</td>
</tr>
<tr>
<td>PAC Control.cnt</td>
<td>PAC Control help contents file</td>
</tr>
<tr>
<td>PAC Control.GiD</td>
<td>PAC Control help support file (created when you launch the help file)</td>
</tr>
<tr>
<td>PAC Control.hlp</td>
<td>PAC Control help file</td>
</tr>
<tr>
<td>PAC ControlCommands.cnt</td>
<td>Commands help contents file</td>
</tr>
<tr>
<td>PAC ControlCommands.GiD</td>
<td>Commands help support file (created when you launch the help file)</td>
</tr>
<tr>
<td>PAC ControlCommands.hlp</td>
<td>Commands help file</td>
</tr>
<tr>
<td>ioCtrlTools.dat</td>
<td>File that lists software applications you’ve configured in the Tools menu to launch from PAC Control</td>
</tr>
<tr>
<td>ioSnif.log</td>
<td>PAC Message Viewer log file</td>
</tr>
<tr>
<td>OptoScriptTemp.txt</td>
<td>A temporary file</td>
</tr>
<tr>
<td>Readme.txt</td>
<td>README text file containing information about PAC Control</td>
</tr>
</tbody>
</table>
INTRODUCTION

Chapter 2 introduced the Cookies strategy, a sample project used to illustrate how PAC Control works. Although this strategy is based on a mythical factory, you may want to know more about the factory, its process, and its hardware. This appendix gives you that information.

FACTORY SCHEMATIC

The following schematic drawing summarizes the cookie factory:

DESCRIPTION OF THE PROCESS

Dough Vessel

The first station in our process is the dough vessel. This tank contains a pre-made cookie dough mix.
Dough is dispensed onto the conveyor belt through a valve (SV-100B) at the bottom of the vessel. The dough, being somewhat viscous, must be kept under low pressure to dispense properly. To monitor the pressure, we have included a pressure transmitter (PT-100) in the vessel. Our control engine (a SNAP PAC R-series I/O system) maintains the vessel pressure through a plant air valve (SV-100A).

The vessel also includes a level switch (LAL-100) to tell us when the dough level is low. When it is, the process is halted so that an operator can refill the vessel.

**Chip Hopper**

The chip hopper supplies chocolate chips. A chip dispenser valve (SV-101) controls the number of chips dropped on each cookie. Like the dough vessel, this tank also includes a level switch (LAL-101) to stop the system when the chip hopper needs refilling.

**Oven**

After the dough and chips have been dropped onto the conveyor, the conveyor sends the cookie into the oven, and the oven bakes it.

**Inspection Station**

Our freshly baked cookies then move to the inspection station, where someone inspects them. If the cookie does not fall within normal tolerances— for example, it doesn’t have enough chips or is shaped oddly—the inspector closes a switch (XS-103), signaling the bad cookie. A valve (SV-103) then opens to allow plant air to blow the reject cookie into a waste bin.

If the cookie passes the inspection, it moves on to packaging and shipping.

**Conveyor**

The conveyor and its motor continuously move the cookies from the dough vessel to the inspection station. The conveyor speed is controlled through an analog output (SY-104) from a speed controller (SC-104).

**Emergency Stops**

Wired at key locations around our bakery are emergency-stop buttons. If something goes wrong with the process, an operator can press any of these E-STOP buttons.

The buttons are wired in series and are normally closed, so pressing any E-STOP button breaks the circuit. One digital input can monitor all the buttons. The system can be restarted by resetting the button.
# REQUIRED I/O

Here's the list of analog and digital I/O modules required for the cookie factory:

## Analog I/O

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Type</th>
<th>Module</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT-100</td>
<td>Dough Vessel Pressure</td>
<td>Input</td>
<td>SNAP-AIV (-10 to +10 VDC)</td>
<td>0–15 psig</td>
</tr>
<tr>
<td>TT-102</td>
<td>Oven Temperature</td>
<td>Input</td>
<td>SNAP-AICTD (ICTD)</td>
<td>-50–350 °C</td>
</tr>
<tr>
<td>TY-102</td>
<td>Oven Temperature Control</td>
<td>Output</td>
<td>SNAP-AOV-27 (-10 to +10 VDC)</td>
<td>0–100 %</td>
</tr>
<tr>
<td>SY-104</td>
<td>Conveyor Speed Control</td>
<td>Output</td>
<td>SNAP-AOV-27 (-10 to +10 VDC)</td>
<td>0–100 %</td>
</tr>
</tbody>
</table>

## Digital I/O

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Type</th>
<th>Module</th>
<th>States</th>
</tr>
</thead>
<tbody>
<tr>
<td>SV-100A</td>
<td>Pressure Control Valve</td>
<td>Output</td>
<td>SNAP-ODC5SRC (5–60 VDC)</td>
<td>0=Closed 1=Open</td>
</tr>
<tr>
<td>SV-100B</td>
<td>Dough Dispense Valve</td>
<td>Output</td>
<td>SNAP-ODC5SRC (5–60 VDC)</td>
<td>0=Closed 1=Open</td>
</tr>
<tr>
<td>LAL-100</td>
<td>Dough Level Alarm</td>
<td>Input</td>
<td>SNAP-IDC5D (2.5–28 VDC)</td>
<td>0=OK 1=Low</td>
</tr>
<tr>
<td>SV-101</td>
<td>Chip Dispense Valve</td>
<td>Output</td>
<td>SNAP-ODC5SRC (5–60 VDC)</td>
<td>0=Closed 1=Open</td>
</tr>
<tr>
<td>LAL-101</td>
<td>Chip Level Alarm</td>
<td>Input</td>
<td>SNAP-IDC5D (2.5–28 VDC)</td>
<td>0=OK 1=Low</td>
</tr>
<tr>
<td>XS-103</td>
<td>Inspection Signal</td>
<td>Input</td>
<td>SNAP-IDC5D (2.5–28 VDC)</td>
<td>0=OK 1=Reject</td>
</tr>
<tr>
<td>SV-103</td>
<td>Reject Valve</td>
<td>Output</td>
<td>SNAP-ODC5SRC (5–60 VDC)</td>
<td>0=Closed 1=Open</td>
</tr>
<tr>
<td>XS-105</td>
<td>Emergency Stop</td>
<td>Input</td>
<td>SNAP-IDC5D (2.5–28 VDC)</td>
<td>0=Stop 1=OK</td>
</tr>
</tbody>
</table>
INTRODUCTION

This appendix includes the following reference information about the OptoScript language:

OptoScript Compared to Standard Programming Languages ........ page 399
Notes to Experienced Programmers ........................................ page 403
OptoScript Lexical Reference ............................................. page 404
OptoScript Grammar Syntax Reference ................................. page 405

OPTOSCRIPT COMPARED TO STANDARD PROGRAMMING LANGUAGES

The tables on the following pages compare OptoScript functions and variables to those available in Pascal, BASIC, and C. For more information on using OptoScript, see Chapter 11: Using OptoScript on page 333.

General Notes:

1. The BASIC column is based on Microsoft’s Visual Basic language.
2. The Pascal column is based on Borland’s ObjectPascal language.
3. The use of logical statements in BASIC and Pascal is significantly different than in OptoScript and C. BASIC and Pascal have a Boolean data type; OptoScript and C use integers. OptoScript and C treat a zero value as false and a non-zero value as true.
4. In OptoScript, you cannot use a break type of command in a loop.

OptoScript can test only one case in a switch at a time; other languages can test more than one.
<table>
<thead>
<tr>
<th></th>
<th>OptoScript</th>
<th>BASIC¹</th>
<th>C</th>
<th>Pascal²</th>
</tr>
</thead>
<tbody>
<tr>
<td>integer 32 (decimal)</td>
<td>123</td>
<td>123</td>
<td>123</td>
<td>123</td>
</tr>
<tr>
<td>integer 32 (hexadecimal)</td>
<td>0x123ABC</td>
<td>&amp;H123ABC</td>
<td>0x123ABC</td>
<td>&amp;123ABC</td>
</tr>
<tr>
<td>integer 64 (decimal)</td>
<td>12364</td>
<td>Not available</td>
<td>123LL or 12364</td>
<td>123</td>
</tr>
<tr>
<td>integer 64 (hexadecimal)</td>
<td>0x123ABCI64</td>
<td>Not available</td>
<td>0x123ABCLL or 0x123ABCI64</td>
<td>&amp;123ABC</td>
</tr>
<tr>
<td>float (standard)</td>
<td>12.34</td>
<td>12.34</td>
<td>12.34</td>
<td>12.34</td>
</tr>
<tr>
<td>float (scientific)</td>
<td>12.34E+17</td>
<td>1.234E+18</td>
<td>1.234E+17</td>
<td>12.34E+17</td>
</tr>
<tr>
<td>string</td>
<td>&quot;hello&quot;</td>
<td>&quot;hello&quot;</td>
<td>&quot;hello&quot;</td>
<td>'hello'</td>
</tr>
<tr>
<td>character</td>
<td>65</td>
<td>Not available</td>
<td>65</td>
<td>'A'</td>
</tr>
<tr>
<td>block comment</td>
<td>/* */</td>
<td>Not available</td>
<td>/* */</td>
<td>{ }</td>
</tr>
<tr>
<td>line comment</td>
<td>//</td>
<td></td>
<td>//</td>
<td></td>
</tr>
<tr>
<td>numeric assignment</td>
<td>n = 3;</td>
<td>n = 3;</td>
<td>n := 3;</td>
<td></td>
</tr>
<tr>
<td>numeric table assignment</td>
<td>t[0] = 1;</td>
<td>t[0] = 1;</td>
<td>t[0] := 1;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>t[1] = 2;</td>
<td>t[1] = 2;</td>
<td>t[1] := 2;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>t[1+1] = 3;</td>
<td>t[1+1] = 3;</td>
<td>t[1+1] := 3;</td>
<td></td>
</tr>
<tr>
<td>numeric expressions</td>
<td>i = (f * 2.0) + t[3];</td>
<td>i = (f * 2.0) + t[3];</td>
<td>i = (f * 2.0) + t[3];</td>
<td>i := (f * 2.0) + t[3];</td>
</tr>
<tr>
<td>string assignment</td>
<td>s = &quot;hello&quot;;</td>
<td>s = &quot;hello&quot;;</td>
<td>strcp(s, &quot;hello&quot;);</td>
<td>s := 'hello';</td>
</tr>
<tr>
<td></td>
<td>s = s2;</td>
<td>s = s2;</td>
<td>strcp(s, s2);</td>
<td>s := s2;</td>
</tr>
<tr>
<td>string table assignment</td>
<td>st[0] = s;</td>
<td>st[0] = s;</td>
<td>strcp(st[0], s);</td>
<td>st[0] := s;</td>
</tr>
<tr>
<td></td>
<td>st[1+i] = st[5];</td>
<td>st[1+i] = st[5];</td>
<td>strcp(st[1+i], st[5]);</td>
<td>st[1+i] := st[5];</td>
</tr>
<tr>
<td>string characters</td>
<td>n = s[0];</td>
<td>Not available</td>
<td>n = s[0];</td>
<td>s[0] := 'A';</td>
</tr>
<tr>
<td></td>
<td>s[0] = 'A';</td>
<td></td>
<td>s[0] := 'A';</td>
<td></td>
</tr>
<tr>
<td>string expressions</td>
<td>s = &quot;hello&quot; + s2 + s3;</td>
<td>s = &quot;hello&quot; + s2 + s3;</td>
<td>strcp(s, &quot;hello&quot;);</td>
<td>s := 'hello' + s2 + s3;</td>
</tr>
<tr>
<td></td>
<td>s = &quot;hello&quot; + Chr(n);</td>
<td>s = &quot;hello&quot; + Chr(n)</td>
<td>strcat(s, s2);</td>
<td>s := 'hello' + Chr(n);</td>
</tr>
<tr>
<td></td>
<td>sprintf(s, 'hello%c', n);</td>
<td>sprintf(s, 'hello%c', n);</td>
<td>sprintf(s, 'hello%c', n);</td>
<td>sprintf(s, 'hello%c', n);</td>
</tr>
<tr>
<td>equal</td>
<td>x == y</td>
<td>x = y</td>
<td>x == y</td>
<td>x = y</td>
</tr>
<tr>
<td>not equal</td>
<td>x &lt;&gt; y</td>
<td>x &lt;&gt; y</td>
<td>x &lt;&gt; y</td>
<td>x &lt;&gt; y</td>
</tr>
<tr>
<td>less than</td>
<td>x &lt; y</td>
<td>x &lt; y</td>
<td>x &lt; y</td>
<td>x &lt; y</td>
</tr>
<tr>
<td>less than or equal</td>
<td>x &lt;= y</td>
<td>x &lt;= y</td>
<td>x &lt;= y</td>
<td>x &lt;= y</td>
</tr>
<tr>
<td>greater than</td>
<td>x &gt; y</td>
<td>x &gt; y</td>
<td>x &gt; y</td>
<td>x &gt; y</td>
</tr>
<tr>
<td>greater than or equal</td>
<td>x &gt;= y</td>
<td>x &gt;= y</td>
<td>x &gt;= y</td>
<td>x &gt;= y</td>
</tr>
<tr>
<td>logical OR (See Note 3)</td>
<td>x or y</td>
<td>(x &lt;&gt; 0) Or (y &lt;&gt; 0) Or (x &lt;&gt; 0) Or (y &lt;&gt; 0) Or (x &lt;&gt; 0) Or (y &lt;&gt; 0) Or (x &lt;&gt; 0) Or (y &lt;&gt; 0)</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a Or b</td>
<td>(Booleans only)</td>
<td>a Or b (Booleans only)</td>
<td>a Or b (Booleans only)</td>
</tr>
<tr>
<td>logical AND</td>
<td>x and y</td>
<td>(x &lt;&gt; 0) And (y &lt;&gt; 0) And (x &lt;&gt; 0) And (y &lt;&gt; 0) And (x &lt;&gt; 0) And (y &lt;&gt; 0) And (x &lt;&gt; 0) And (y &lt;&gt; 0)</td>
<td>x &amp;&amp; y</td>
<td>(x &lt;&gt; 0) And (y &lt;&gt; 0) And (x &lt;&gt; 0) And (y &lt;&gt; 0) And (x &lt;&gt; 0) And (y &lt;&gt; 0) And (x &lt;&gt; 0) And (y &lt;&gt; 0)</td>
</tr>
<tr>
<td></td>
<td>a And b</td>
<td>(Booleans only)</td>
<td>a And b (Booleans only)</td>
<td>a And b (Booleans only)</td>
</tr>
<tr>
<td>logical XOR</td>
<td>x xor y</td>
<td>(x &lt;&gt; 0) Xor (y &lt;&gt; 0) Xor (x &lt;&gt; 0) Xor (y &lt;&gt; 0) Xor (x &lt;&gt; 0) Xor (y &lt;&gt; 0) Xor (x &lt;&gt; 0) Xor (y &lt;&gt; 0)</td>
<td>Not available</td>
<td>(x &lt;&gt; 0) Xor (y &lt;&gt; 0) Xor (x &lt;&gt; 0) Xor (y &lt;&gt; 0) Xor (x &lt;&gt; 0) Xor (y &lt;&gt; 0) Xor (x &lt;&gt; 0) Xor (y &lt;&gt; 0)</td>
</tr>
<tr>
<td></td>
<td>a Xor b</td>
<td>(Booleans only)</td>
<td>a Xor b (Booleans only)</td>
<td>a Xor b (Booleans only)</td>
</tr>
<tr>
<td>Logical NOT</td>
<td>OptoScript</td>
<td>BASIC</td>
<td>C</td>
<td>Pascal</td>
</tr>
<tr>
<td>------------</td>
<td>------------</td>
<td>-------</td>
<td>---</td>
<td>--------</td>
</tr>
<tr>
<td><code>not x</code></td>
<td><code>Not (x &lt;&gt; 0)</code></td>
<td><code>!x</code></td>
<td><code>Not (x &lt;&gt; 0)</code></td>
<td></td>
</tr>
<tr>
<td><strong>Logical expressions</strong></td>
<td><code>(x &gt;= 0) and (y == 3)</code></td>
<td><code>(x &gt; 0) &amp; &amp; (y == 3)</code></td>
<td><code>(x &gt;= 0) and (y = 3)</code></td>
<td><code>(x &gt; 0) and (y = 3)</code></td>
</tr>
<tr>
<td><code>not ((x&gt;0)or(not y==3))</code></td>
<td><code>Not((x &gt; 0) Or (y &lt;&gt; 3))</code></td>
<td>`!(x &gt; 0)</td>
<td></td>
<td>(y != 3)`</td>
</tr>
<tr>
<td><strong>Bitwise NOT</strong></td>
<td><code>bitnot x</code></td>
<td><code>Not x</code></td>
<td><code>-x</code></td>
<td><code>not x</code></td>
</tr>
<tr>
<td><strong>Bitwise OR (See Note 3)</strong></td>
<td><code>x bitor y</code></td>
<td><code>x Or y</code></td>
<td>`x</td>
<td>y`</td>
</tr>
<tr>
<td><code>x bitand y</code></td>
<td><code>x And y</code></td>
<td><code>x &amp; y</code></td>
<td><code>x and y</code></td>
<td></td>
</tr>
<tr>
<td><code>x bitxor y</code></td>
<td><code>x Xor y</code></td>
<td><code>x ^ y</code></td>
<td><code>x xor y</code></td>
<td></td>
</tr>
<tr>
<td><strong>Bitwise shift left</strong></td>
<td><code>x &lt;&lt; y</code></td>
<td><code>Not available</code></td>
<td><code>x &lt;&lt; y</code></td>
<td><code>x shl y</code></td>
</tr>
<tr>
<td><strong>Bitwise shift right</strong></td>
<td><code>x &gt;&gt; y</code></td>
<td><code>Not available</code></td>
<td><code>x &gt;&gt; y</code></td>
<td><code>x shr y</code></td>
</tr>
<tr>
<td><strong>Bitwise expressions</strong></td>
<td><code>i = x bitand 0x0000FFFF;</code></td>
<td><code>i = x &amp; 0x0000FFFF;</code></td>
<td><code>i := x and &amp;0000FFFF;</code></td>
<td></td>
</tr>
<tr>
<td><code>i = x &lt;&lt; (i * 2);</code></td>
<td><code>i = x &lt;&lt; (i * 2);</code></td>
<td><code>i := x shl (i * 2);</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>If statement</strong></td>
<td><code>if (i == 2) then</code></td>
<td><code>If (i == 2) Then</code></td>
<td><code>if (i == 2)</code></td>
<td></td>
</tr>
<tr>
<td><code>// do something</code></td>
<td><code>// do something</code></td>
<td><code>// do something</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>endif</code></td>
<td><code>End If</code></td>
<td><code>end</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>If/Else statement</strong></td>
<td><code>if (i == 2) then</code></td>
<td><code>If (i == 2) Then</code></td>
<td><code>if (i == 2)</code></td>
<td></td>
</tr>
<tr>
<td><code>// do something</code></td>
<td><code>// do something</code></td>
<td><code>// do something</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>else</code></td>
<td><code>Else</code></td>
<td><code>else</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>// do something else</code></td>
<td><code>// do something else</code></td>
<td><code>// do something else</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>endif</code></td>
<td><code>End If</code></td>
<td><code>end</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>If/Else If statement</strong></td>
<td><code>if (i == 2) then</code></td>
<td><code>If (i == 2)</code></td>
<td><code>if (i == 2)</code></td>
<td></td>
</tr>
<tr>
<td><code>// do something</code></td>
<td><code>// do something</code></td>
<td><code>// do something</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>else if (i &gt;= 5) then</code></td>
<td><code>Else if (i &gt;= 5)</code></td>
<td><code>else if (i &gt;= 5)</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>// do something else</code></td>
<td><code>// do something else</code></td>
<td><code>// do something else</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>else</code></td>
<td><code>Else</code></td>
<td><code>else</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>// do something else</code></td>
<td><code>// do something else</code></td>
<td><code>// do something else</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>endif</code></td>
<td><code>End If</code></td>
<td><code>end</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>For loop (See Note 4)</strong></td>
<td><code>for i = 0 to 5 step 1</code></td>
<td><code>For i = 0 To 5 Step 1</code></td>
<td><code>for (i = 0; i &lt; 5 ; i++)</code></td>
<td></td>
</tr>
<tr>
<td><code>MyTable[i] = i * 2;</code></td>
<td><code>MyTable(i) = i * 2</code></td>
<td><code>{  MyTable[i] = i * 2;}</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>next</code></td>
<td><code>Next</code></td>
<td><code>}</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>for i := 0 to 5 do</code></td>
<td><code>begin</code></td>
<td><code>MyTable[i] := i * 2;</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>begin</td>
<td><code>end</code></td>
<td><code>end</code></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Variable Comparison

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>PAC Control Type</th>
<th>BASIC Example</th>
<th>C Example</th>
<th>Pascal Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>n</td>
<td>integer 32</td>
<td>Dim n as Long</td>
<td>long n;</td>
<td>n: Integer;</td>
</tr>
<tr>
<td>nn</td>
<td>integer 64</td>
<td>Not available</td>
<td>LONGLONG d;</td>
<td>d: Int64;</td>
</tr>
<tr>
<td>f</td>
<td>float</td>
<td>Dim f as Single</td>
<td>float f;</td>
<td>f: Single;</td>
</tr>
<tr>
<td>s</td>
<td>string</td>
<td>Dim as String</td>
<td>char s[128];</td>
<td>s: ShortString;</td>
</tr>
<tr>
<td>p</td>
<td>pointer</td>
<td>not available</td>
<td>long * pn;</td>
<td>pn: ^Integer;</td>
</tr>
<tr>
<td>nt</td>
<td>integer 32 table</td>
<td>Dim nt(10) as Long</td>
<td>long i[10];</td>
<td>nt: array[0..9] of Integer;</td>
</tr>
<tr>
<td>ft</td>
<td>float 32 table</td>
<td>Dim ft(10) as Single</td>
<td>float f[10];</td>
<td>ft: array[0..9] of Single</td>
</tr>
<tr>
<td>st</td>
<td>string table</td>
<td>Dim st(10) as String</td>
<td>char s[10][128];</td>
<td>st: array[0..9] of ShortString;</td>
</tr>
<tr>
<td>pt</td>
<td>pointer table</td>
<td>not available</td>
<td>void * pt[10];</td>
<td>pt: array[0..9] of *Integer;</td>
</tr>
</tbody>
</table>

Notes:

1. Based on Microsoft’s Visual Basic language.
2. Based on Borland’s Object Pascal language.
3. The use of logical statements in BASIC and Pascal is significantly different than in OptoScript and C. BASIC and Pascal have a Boolean data type; OptoScript and C use integers. OptoScript and C treat a zero value as false and a non-zero value as true.
4. OptoScript cannot have a break type of command in a loop as is common with other languages.
5. OptoScript can test only one case at a time.
NOTES TO EXPERIENCED PROGRAMMERS

Variable Database and Other Surprises

PAC Control maintains a database of all declared variables—a notable difference from common procedural languages. Variables are not declared in the programming code, but in the PAC Control tag database. This is a basic concept of PAC Control and how it ties in with PAC Display, but may seem odd to experienced programmers using PAC Control for the first time. Also, all variables and objects are global. Local variables do not exist in PAC Control in the way they do in most procedural languages. Subroutines in PAC Control contain “local” variables, but those local variables apply throughout that subroutine.

Most languages allow you to return from a function before it ends, but OptoScript does not. The same effect can be achieved in other ways, however, such as introducing tests into the code. (Some people argue that this limitation produces better programming, because each function has only one exit point.)

PAC Control’s Target Audience

Because PAC Control is based on OptoControl, which was conceived as a simple programming tool for non-programmers, it is designed to be relatively foolproof. Even though OptoScript provides advanced functionality, this philosophy also influenced the design of OptoScript. OptoScript exists only inside OptoScript blocks, which can exist only inside a flowchart. Flowcharts are the basis of PAC Control.

Even an experienced programmer may want to think twice before using OptoScript blocks extensively. Many programmers like PAC Control’s simplicity not for themselves but for the field technicians and maintenance personnel who will use it in the field. While you could write an entire chart (or conceivably an entire strategy) in one block, doing so would eliminate most of the advantages of using PAC Control. Consider limiting your use of OptoScript to math operations, complex string manipulation, and other logic most suited to scripting, so you retain PAC Control’s advantages for non-programmers.

Language Syntax

In the same way, OptoScript syntax is meant to be simple enough for a beginner to understand but also easy for an experienced programmer to learn quickly.

Some programmers may wonder why OptoScript is not modeled after just one existing language, such as BASIC or C. Instead, one can clearly see influences from Pascal, BASIC, and C. PAC Control’s target audience is one reason; internal consistency with PAC Control commands and the capabilities and limitations of Opto 22 control engines are another.

Some aspects of OptoScript were designed to be consistent with PAC Control commands. For instance, the bitwise and operator was named bitand in OptoScript because there is a command in PAC Control named Bit AND.

OptoScript provides all the functionality of Opto 22 control engines but is subject to their limitations. For instance, OptoScript provides some convenient ways of working with strings, but only to a certain point.

For example, in an assignment statement, strings can be added together like this:
```
strDate = strMonth + "/" + strDay + "/" + strYear;
```

It would certainly be nice to use the same kind of string addition in a procedure call:
```
TransmitString(strMonth + "/" + strDay + "/" + strYear, nPort);
```

However, due to the current abilities of control engines, this type of string addition inside a function call is not possible.
Keywords (Reserved Words)

if  then  else  elseif  endif
for  to  step  next
switch  endswitch  case  break  default
while  do  wend  repeat  until
Chr  null

Operators

The following table lists operators in order of highest to lowest precedence:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Name/ Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>negation</td>
</tr>
<tr>
<td>not</td>
<td>logical not</td>
</tr>
<tr>
<td>bitnot</td>
<td>bitwise not</td>
</tr>
<tr>
<td>*</td>
<td>multiplication</td>
</tr>
<tr>
<td>/</td>
<td>division</td>
</tr>
<tr>
<td>%</td>
<td>modulo division</td>
</tr>
<tr>
<td>-</td>
<td>subtraction</td>
</tr>
<tr>
<td>+</td>
<td>addition</td>
</tr>
<tr>
<td>+=</td>
<td>string append assignment</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>bitwise left shift</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>bitwise right shift</td>
</tr>
<tr>
<td>==</td>
<td>equality</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>non-equality</td>
</tr>
<tr>
<td>&lt;</td>
<td>less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>less than or equal to</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>greater than or equal to</td>
</tr>
<tr>
<td>bitand</td>
<td>bitwise and</td>
</tr>
<tr>
<td>bitor</td>
<td>bitwise or</td>
</tr>
<tr>
<td>bitxor</td>
<td>bitwise exclusive or</td>
</tr>
<tr>
<td>and</td>
<td>logical and</td>
</tr>
<tr>
<td>or</td>
<td>logical or</td>
</tr>
<tr>
<td>xor</td>
<td>logical exclusive or</td>
</tr>
<tr>
<td>not</td>
<td>logical not</td>
</tr>
<tr>
<td>( )</td>
<td>parentheses¹</td>
</tr>
<tr>
<td>[ ]</td>
<td>brackets¹</td>
</tr>
<tr>
<td>:</td>
<td>colon¹</td>
</tr>
<tr>
<td>;</td>
<td>semi-colon¹</td>
</tr>
</tbody>
</table>
Comments

OptoScript has two kinds of comments: single line and block.

Single line comments are indicated by two slashes, followed by any sequence of characters, until the end of the line.

Examples:

```optoscript
i = a + b; // this is a comment
i = a + b; // determine i by adding a and b together
// i = a + b; // This whole line is commented out
```

Block comments are indicated by a slash and an asterisk (`/*`), followed by any sequence of characters, and ending with an asterisk and a slash (`*/`). This type of comment may span multiple lines. Block comments may not be nested.

Examples:

```optoscript
i = a + b; /*determine i by adding a and b together*/
i = a + b; /* determine i by adding a and b together */
/* i = a + b; // determine i by adding a and b together */
```

OPTOSCRIPT GRAMMAR SYNTAX REFERENCE

Tokens are in regular type.
Keywords and operators are in **bold red** type.
Syntax Rules are in *italic* type.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Name/ Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>,</td>
<td>comma separator(^1)</td>
</tr>
<tr>
<td>=</td>
<td>assignment(^1)</td>
</tr>
<tr>
<td>&lt;=</td>
<td>address of(^1)</td>
</tr>
</tbody>
</table>

\(^1\) No precedence

---

<table>
<thead>
<tr>
<th>Operator</th>
<th>Name/ Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>less than or equal</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>greater than or equal</td>
</tr>
<tr>
<td>==</td>
<td>equality</td>
</tr>
<tr>
<td>!=</td>
<td>inequality</td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td>logical and</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>logical not</td>
</tr>
<tr>
<td>(</td>
<td>left parenthesis</td>
</tr>
<tr>
<td>)</td>
<td>right parenthesis</td>
</tr>
<tr>
<td>[</td>
<td>left square bracket</td>
</tr>
<tr>
<td>]</td>
<td>right square bracket</td>
</tr>
<tr>
<td>,</td>
<td>comma separator</td>
</tr>
<tr>
<td>;</td>
<td>semicolon</td>
</tr>
<tr>
<td>:</td>
<td>colon</td>
</tr>
<tr>
<td>.</td>
<td>period</td>
</tr>
<tr>
<td>,</td>
<td>comma separator</td>
</tr>
<tr>
<td>;</td>
<td>semicolon</td>
</tr>
<tr>
<td>:</td>
<td>colon</td>
</tr>
<tr>
<td>.</td>
<td>period</td>
</tr>
</tbody>
</table>

---

OPTOSCRIPT GRAMMAR SYNTAX REFERENCE

Program
> StatementList

StatementList
> Statement
> StatementList Statement

ProcedureCommand
> CommandProcedureNoArgs();
> CommandProcedure (ArgumentList);

NumTableIdentifier
> NumericTable [ NumericExp ]

TableIdentifier
> NumericTable
> StringTable

LogicalUnaryExp
> not NumericExp

FunctionCommand
> CommandFunctionNoArgs ()
> CommandFunction (ArgumentList )

AdditiveExp
> NumericExp + NumericExp
> NumericExp - NumericExp

NumVarIdentifier
> NumericVariable

NotNumExp
> ObjVarIdentifier
> StrIdentifier
<table>
<thead>
<tr>
<th>StringCharIdentifier</th>
<th>NumericLiteral</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; StringVariable [ NumericExp ]</td>
<td>&gt; Integer32Literal</td>
</tr>
<tr>
<td></td>
<td>&gt; Integer64Literal</td>
</tr>
<tr>
<td></td>
<td>&gt; FloatLiteral</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Statement</th>
<th>NumericExp</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; AssignmentStatement</td>
<td>&gt; ( NumericExp )</td>
</tr>
<tr>
<td>&gt; StrAssignmentStatement</td>
<td>&gt; NumericExp</td>
</tr>
<tr>
<td>&gt; PtrAssignmentStatement</td>
<td>&gt; LogicalExp</td>
</tr>
<tr>
<td>&gt; ProcedureCommand</td>
<td>&gt; LogicalUnaryExp</td>
</tr>
<tr>
<td>&gt; FunctionCommand</td>
<td>&gt; AdditiveExp</td>
</tr>
<tr>
<td>&gt; ConditionStatement</td>
<td>&gt; MultiplicativeExp</td>
</tr>
<tr>
<td>&gt; ForStatement</td>
<td>&gt; BitwiseExp</td>
</tr>
<tr>
<td>&gt; WhileStatement</td>
<td>&gt; NumIdentifier</td>
</tr>
<tr>
<td>&gt; RepeatStatement</td>
<td>&gt; FunctionCommand</td>
</tr>
<tr>
<td>&gt; SwitchStatement</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ArgumentList</th>
<th>BitwiseExp</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; NumericExp</td>
<td>&gt; bitnot NumericExp</td>
</tr>
<tr>
<td>&gt; ArgumentList , NumericExp</td>
<td>NumericExp bitand NumericExp</td>
</tr>
<tr>
<td>&gt; StrIdentifier</td>
<td>NumericExp bitor NumericExp</td>
</tr>
<tr>
<td>&gt; ArgumentList , StrIdentifier</td>
<td>NumericExp bitxor NumericExp</td>
</tr>
<tr>
<td>&gt; ObjVarIdentifier</td>
<td>NumericExp &lt;= NumericExp</td>
</tr>
<tr>
<td>&gt; ArgumentList , ObjVarIdentifier</td>
<td>NumericExp &gt;&gt; NumericExp</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LogicalExp</th>
<th>ConditionStatement</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; NumericExp and NumericExp</td>
<td>StatementListOrEmpty</td>
</tr>
<tr>
<td>&gt; NumericExp or NumericExp</td>
<td>EndIfStatement</td>
</tr>
<tr>
<td>&gt; NumericExp xor NumericExp</td>
<td></td>
</tr>
<tr>
<td>&gt; NumericExp == NumericExp</td>
<td></td>
</tr>
<tr>
<td>&gt; NumericExp &lt;&gt; NumericExp</td>
<td></td>
</tr>
<tr>
<td>&gt; NumericExp &lt;= NumericExp</td>
<td></td>
</tr>
<tr>
<td>&gt; NumericExp &gt;= NumericExp</td>
<td></td>
</tr>
<tr>
<td>&gt; StrIdentifier == StrIdentifier</td>
<td></td>
</tr>
<tr>
<td>&gt; null == PointerVariable</td>
<td></td>
</tr>
<tr>
<td>&gt; null == PointerVariable</td>
<td></td>
</tr>
<tr>
<td>&gt; null == PointerTable [ NumericExp ]</td>
<td></td>
</tr>
<tr>
<td>&gt; PointerTable [ NumericExp ] == null</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IfStatement</th>
<th>ElseStatement</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; if ( NumericExp ) then</td>
<td>&gt; else</td>
</tr>
<tr>
<td>ElselfStatement</td>
<td>ElselfList</td>
</tr>
<tr>
<td>&gt; elseif ( NumericExp ) then</td>
<td>ElselfList ElselfStatement</td>
</tr>
<tr>
<td>StatementListOrEmpty</td>
<td></td>
</tr>
<tr>
<td>EndIfStatement</td>
<td>StrAdditiveExp</td>
</tr>
<tr>
<td>&gt; endif</td>
<td>&gt; StrExp + StrExp</td>
</tr>
<tr>
<td>Expression Type</td>
<td>Syntax</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AssignmentStatement</td>
<td>&gt; NumericVariable = NumericExp ;, &gt; NumericTable [ NumericExp ] = NumericExp ;</td>
</tr>
<tr>
<td>PTR AssignmentStatement</td>
<td>&gt; PointerVariable = PointableIdentifier ;, &gt; PointerVariable = PointerTable [ NumericExp ] ;, &gt; PointerTable [ NumericExp ] = PointableIdentifier ;</td>
</tr>
<tr>
<td>StrExp</td>
<td>&gt; StrAdditiveExp, &gt; StrIdentifier, &gt; Chr ( NumericExp )</td>
</tr>
<tr>
<td>Str AssignmentStatement</td>
<td>&gt; StringVariable = StrExp ;, &gt; StringTable [ NumericExp ] = StrExp ;, &gt; StringVariable += StrIdentifier ;, &gt; StringVariable += Chr ( NumericExp ) ;</td>
</tr>
<tr>
<td>ObjVarIdentifier</td>
<td>&gt; ChartVariable, &gt; DigIoUnitVariable, &gt; MixedIoUnitVariable, &gt; TableIdentifier, &gt; CommunicationHandle</td>
</tr>
<tr>
<td>CaseList</td>
<td>&gt; case NumericExp : StatementListOrEmpty break,</td>
</tr>
<tr>
<td>WhileStatement</td>
<td>&gt; while ( NumericExp ) StatementListOrEmpty wend,</td>
</tr>
</tbody>
</table>
F: Software Licensing Information

Some software used by Opto 22 PAC Control is subject to various software licenses. This appendix explains software licensing in more detail.

OPTO 22 LICENSE AGREEMENT FOR EMBEDDED SOFTWARE

* Copyright (C) 2012, 2013, 2014 James McLaughlin et al. All rights reserved.
* https://github.com/udp/json-parser
* 
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
  *
  * 1. Redistributions of source code must retain the above copyright
  *    notice, this list of conditions and the following disclaimer.
  *
  * 2. Redistributions in binary form must reproduce the above copyright
  *    notice, this list of conditions and the following disclaimer in the
  *    documentation and/or other materials provided with the distribution.
  *
  * THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS ``AS IS'' AND
  * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
  * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
  * ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
  * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
  * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
  * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
  * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
* SUCH DAMAGE.
Index

A
action block
definition 214

action command
definition 50

active address 309

adding
analog point 130
command 249
in OptoScript 355

digital point 126
numeric variable 233
PID loop 149
pointer 233
pointer variable to watch window 246
string variable 233


table variable to watch window (numeric and string tables) 247

table variable to watch window (pointer tables) 248
text to chart 220
variable 233
variable to watch window 244

algorithms for PID loops 319
analog
adding I/O point 130
changing I/O while strategy is running 157
copying I/O point 146
I/O unit commands 309
minimum/maximum value 256
offset and gain commands 256
offset and gain commands (instructions) 256
point commands 256, 342
point, definition 47
TPO 256

applications
launching from PAC Control 65

archiving strategies
restoring archives 112
to computer 179
to control engine 110

argument
described in the Command Reference 81
in Add Instruction dialog box 250
in OptoScript 344

ASCII, decimal and hex values of characters 329

automation 47
autorun 188

B
background downloading 183
switching strategies 182

baud rate and mode for serial I/O units (Pro) 122
baud rate for serial I/O units 122

bill of materials 202

bit commands 313

bitwise operator, in OptoScript 350

block
block 0 214
changing color or size 223
changing color or size in a chart window 215
connecting blocks 218
definition 214
deleting 222
drawing 217
finding in a chart 61
moving 221
naming 218
naming conventions 83
OptoScript 334
selecting 221
stepping through 191

BOM 202

bookmark 357
breakpoints in a chart 193
CA root certificate 292
calling a subroutine 370
case statement 339, 352
programming example 87
certificate 292
changing
active control engine 105
analog I/O while strategy is running 157
baud rate and mode for serial I/O units (Pro) 122
baud rate for serial I/O units 122
block color or size 223
block color or size in a chart window 215
chart background 215
chart name or description 224
column width in a dialog box 62
command (instruction) 252
connection line color or size 223
control engine definition 104
debug level 189
debugger speed 189
digital (discrete) I/O while strategy is running 155
I/O points 148
I/O unit configuration 124
I/O while strategy is running 153
numeric table 247
numeric variable 244
PID loop 152
pointer table 248
pointer variable 246
scale of a chart 59
strategy download compression 187
string table 247
string variable 244
text color or size 223
text color or size in a chart window 215
text in chart 221
variable 244
chart
adding text to 220
auto stepping 193
breakpoints 193
calling a subroutine 370
changing background 215
changing name or description 224
changing scale 59
closing 224
commands 257
contents 214
copying 224
creating 213
definition 49
deleting 225
designing 79
exporting 225
finding a block 61
flow-through logic 82
guidelines for design 82
importing 227
loop logic 82
looping 337
monitoring in watch window 170
opening 223
pausing 190
printing commands (instructions) 200
printing graphics 198
renaming 224
replacing elements 206
saving 223
saving and closing 177
searching 204
statuses defined 49
stepping through 191
stepping through a chart or subroutine 191
View Chart Status dialog box 197
viewing 57
viewing an individual chart 197
zooming in or out 59
chart element
changing color or size 223
cutting, copying, and pasting 222
moving 221
selecting 221
client
defined 260
role in communications 261
client/server architecture 259
closing
chart 224
saving and closing a strategy 177
strategy 178
command
adding 249
adding in OptoScript 355
arguments 81
changing 252
commenting out 253
cutting or copying 253
definition 50
deleting 252
deleting temporarily 253
for continue block 254
groups
   analog point commands 256
chart commands 257
communication commands 257
control engine commands 302
error handling commands 307
I/O unit—event message commands 310
I/O unit—memory map commands 311
I/O unit—scratch pad commands 311
logical commands 313
mathematical commands 314
miscellaneous commands 317
PID—Ethernet commands 318
pointer commands 321
simulation commands 322
string commands 323
time/date commands 330
timing commands 330
in OptoScript 342
  function 344
  procedure 344
pasting 253
printing 200
comment 253, 317
in OptoScript 356, 405
communication
  Ethernet link redundancy 100, 309
  I/O memory map commands (instructions) 311
  I/O unit—event message commands (instructions) 310
  I/O unit—scratch pad commands 311
  incoming 263
  outgoing 261
  PC and control engine 95
  peer-to-peer 261, 311
  TCP/IP 258
  with serial communication module 261, 264, 266
communication commands 257
communication handle
  adding 233
  definition 52, 231, 258
examples
  File 279
  FTP 283
  TCP 264, 265
File 275
FTP 282
port numbers 262
serial 286
serial communication modules 264
TCP 258
types 258
viewing 244
comparison operators 349
compiling
  copy errors and warnings 181
  strategy 25, 180
  strategy without downloading 183
  subroutine 368
condition block
  definition 214
condition command, definition 50
condition in OptoScript 340
configuration mode toolbar 54
Configure mode, definition 54
configuring
  continue block 254
  control engine 95
  I/O points 126
  I/O unit 117
  PID loop 148
  PID loop on I/O units 319
  serial module 140
  subroutine parameters 364
  variables 233
connection line
  changing color or size 215, 223
  definition 214
  deleting 222
  drawing 218
  moving 221
  selecting 221
constant, See literal
continue block
  command (instruction) 254
  configuring 254
  definition 214
control characters, adding to string 325
control engine
  active control engine 105
  archiving strategies 110
  changing definition 104
  changing the active control engine 105
  commands (instructions) 302
  configuring 95
  definition 47
  deleting from strategy 105
  download file, creating 186
  hostname 97
  inspecting 106
  IP address 97
  moving to another PC 113
  removing association with strategy 105
  restoring archived strategies 112
  testing communication 377
  viewing message queue 108
control network
control structures, in OptoScript 351
controller, See control engine
converting a strategy 385
converting IEEE float 315
copying
  block 222
  chart 224
  command (instruction) 253
configured I/O point 146
connection line 222
I/O configuration 118
text block 222
count variable programming example 86
counter commands (instructions) 304
CRC commands 302
creating
  flowchart 213
  PID loop 148
  strategy 175
subroutine 362, 363
watch window 170
See also changing
cross reference window 202
cutting
  block 222
  command (instruction) 253
  connection line 222
text block 222
data
IEEE float format 315
data format
IEEE float 315
data types in subroutines 362
data, sorting, in a dialog box 63
date commands 330
Debug mode
  definition 54
  inspecting control engine 106
  inspecting I/O 153
displayed toolbar 55
designing
  basic rules for strategies 82
  steps for 75
dialog box
  sizing columns 62
  sorting columns 63
digital
  adding digital point 126
  changing I/O while strategy is running 155
copying I/O point 146
counter 304
I/O unit commands 309
latches 304
point commands 342
point, definition 47
pulse commands (instructions) 305
quadrature counter 305
totalizer 305
directory listing 285
disabling I/O 306
discrete
  changing I/O while strategy is running 155
docking
  Strategy Tree 58
  watch window 172
down timers 331
downloading
  files using FTP 282
  files using PAC Terminal 114
initialization file for table variable 243
strategy 180, 183
client compression 187
  without using PAC Control 185
drawing toolbar 215
duplicate object names 385
editing, See changing
eased time 196
email 290
error
cannot delete item 376
copy compile errors 181
queue 108, 384
status codes 385
TCP/IP cannot connect 378
types 383
See also troubleshooting
error handling
commands (instructions) 307
programming example 85
error lookup 383
Ethernet
connections 267
link redundancy 100
commands for 309
ports 267
Ethernet I/O units and commands 209
example
case statements 87, 339
complex operations 341
control system 46
creating messages to display on screen 84
error handling chart 85
File communication handle 279
flag lock 88
FTP communication handle 283
if statements 340
loops 337
mathematical expressions 334
pointers (indexing) 90
repetitive actions 86
string building 326, 335
string data extraction 326
string formats 325
string table 325
subroutine parameters 367
TCP communication handle 264
timer 87
exiting, See closing
exporting
chart 225
I/O configuration 118

flag lock example 88
flash memory
saving files to 303
saving strategy to 178
float
IEEE 315
floating point
converting to integer 317
converting to string 328
definition 52
in logic 314
variable, definition 230
flowchart, See chart
flow-through logic 82
follow debugger stepping 190
for loop 337, 353
format
File communication handle 276
FTP communication handle 283
IEEE float 315
serial communication handle 288
FTP
directory listing 285
FTP communication handle 282
full debug, definition 189
functions in OptoScript 342

G
gain
and offset 256
in PID loops 165
grammar in OptoScript 405

H
handshake 260
hardware requirements for PAC Control 5
help
See also troubleshooting
help, online 74
hex display mode 63
high-density digital
enabling commands 209
high-density points 310
host task
definition 51
hostname, control engine 97
HTTP Get and HTTP Post
timeouts 298, 302
Hungarian notation 83
I

I/O
changing configured point 148
configuring 126
copying configured point 146
deleting configured point 148
disabling 306
exporting configuration 118
importing configuration 119
in strategy design (building) 78
in strategy design (problem definition) 76
monitoring in watch window 170
moving configured point 145
naming points 84
point numbers 119
point, definition 47
saving configuration 155
segmenting I/O from host network 99
using in OptoScript 342
viewing all in a strategy 201
viewing and printing cross references 202
I/O unit
changing 124
commands 309
commands, event message 310
commands, memory map 311
commands, scratch pad 311
configuring 117
definition 117
deleting 124
exporting configuration 118
importing configuration 119
monitoring in watch window 170
point numbers 119
IEEE float 315
if statements
   in OptoScript 351
if/then statements 340
importing
   chart 227
   I/O configuration 119
info, viewing 108
initialization file
   creating 241
downloading 243
downloading files using PAC Terminal 114
input point
   definition 47
disabling 306
input/output, See I/O
inspecting
   control engine 106
control engine using PAC Terminal 110
I/O 154
I/O (Debug mode) 153
I/O using watch window 170
PID loop 160
See also viewing
installing PAC Control 4
instruction, See command
integer
   converting to float 317
definition 52, 315
   in logic 314
   variable, definition 230
interacting algorithm for PID 319
IO Enabler 307
IP address
   control engine 97
   loopback 119, 261, 265
   primary and secondary 119
ISA algorithm for PID 319
IVAL 306

K
keyboard shortcuts 73

L
lag time, for PID 160
latch
   commands (instructions) 304
launching, See opening
legacy options, enabling 208
link redundancy 101, 309
   SoftPAC controller 101
literal
   constant 232
load last mode at startup 176
load last strategy at startup 176
local subroutine parameter 362
local variable 362
log file 394
logic, in charts 82
logical commands (instructions) 313
logical operator in OptoScript 350
logical true and false 314
look up an error 383
loop logic 82
loopback address 119, 261, 265
looping
   complex loops 337
   for loop 353
   repeat loop 353
while loop 352

M
mathematical commands (instructions) 314
mathematical expressions 334
in OptoScript 349
memory 376
memory map commands 311
message on screen, programming example 84
message queue 108
microSD card 279
accessing files via FTP 283
minimal debug, definition 189
minimum/maximum value
reading 256
mistic I/O units and commands 209
mode
 Configure, definition of 54
 Debug, definition of 54
 Online, definition of 54
modifying, See changing monitoring, See inspecting and viewing
moving
 block 221
 connection line 221
 control engine definitions 113
 files via FTP 282
 I/O point 145
 text block 221
to another window or chart 57
moving control engines 113
multitasking 51
 and strings 324

O
offset and gain commands 256
offset and gain commands (instructions) 256
online help 74
Online mode
 avoiding memory problems 54
definition 54
online mode toolbar 54
opening
 applications from PAC Control 65
 chart 223
 strategy 176
 watch window 172
operator
 bitwise, in OptoScript 350
 comparison, in OptoScript 349
 in standard commands (AND/OR) 251
 logical, in OptoScript 350
 order of precedence 404
OptoScript
 bitwise operators 350
 block example 334
 block, definition 214
 bookmark 357
 case statements 339, 352
 command types 344
 commands 342
 comments 405
 communication handle 281
 comparison operators 349
 comparison with other languages 399
 complex loops 337
 conditions 340
 control structures 351
 debugging strategies 359
definition 333
 editor 354
 for loop 353
 functions 342
 if statements 351
 language reference 399
 logical operator 350
 math expressions 334, 349
 notes for programmers 403
 pointers 346
 numeric literals 345
 numeric variables 345
 numeric table
 as alternative to strings 324
 numeric variable
string handling 335
strings 345
switch statements 352
syntax 343, 403, 405
tables 348
toolbar 355
troubleshooting 357
types of commands 344
when to use 334
while loop 352
OptoVersion utility 381
order of precedence for operators 404
output point
definition 47
disabling 306

P

PAC Control
definition 45
designing a strategy 75
directory, list of files in 394
ersors 383
files, list of 393
installing 4
main window 53
mode 54
opening other applications 65
programming 75, 333
system requirements 5
PAC Display 51
PAC Message Viewer utility 380
PAC Terminal utility
downloading files 114
inspecting control engines 110
testing communication with control engine 377
PAC Utilities 110, 377, 380, 381
page setup for printing graphics 198
panning 60
parallel algorithm for PID 319
parameters
configuring subroutine 364
parameters, subroutine 361
passed-in subroutine parameters 361
pasting
block 222
command (instruction) 253
connection line 222
text block 222
pausing
chart 190
peer-to-peer communication
Ethernet 267
incoming and outgoing 261
scratch pad commands 311
string variables for 230
permanent storage, see flash memory
permissions in Windows 382
persistent data 232
persistent RAM 376
PID loop
algorithms 319
changing 152
configuring 148
configuring I/O units 319
definition 319
deleting 153
determining system lag 160
inspecting 160
tuning 165
PID—Ethernet commands 318
pointer
adding 233
commands 321
commands (working with) 346
definition 52, 231
in OptoScript 346
programming example (indexing) 90
using 321
pointer table 322
port
Ethernet 267
peer-to-peer communication
port numbers 262
Powerup chart 50
uses 82
precedence for operators 404
primary and secondary addresses
for I/O unit 119
printing
bill of materials 202
chart commands (instructions) 200
chart graphics 198
chart instructions 254
page setup 198
subroutine commands 200
problems, see troubleshooting
Product Support 4
programming
comparing OptoScript with other languages 399
examples 84
in PAC Control 75
Public Tag Access
analog and digital points 140
variables 239
pulse commands (instructions) 305

Q
quadrature counter commands (instructions) 305
queue
view message dialog box 384
viewing messages 108
quotation marks in strings 345

R
RAM 376
redundant communication links
 commands for 309
 using, in PAC Control 100
redundant controllers 104
renaming
 block 218
 chart 224
repeat loop 337, 353
repetitive actions programming example 86
replacing elements 206
resolution, timer 331
retrieving a directory listing 285
root certificate 292
RTS/CTS 288
running a strategy 27
 automatically 188
 manually 188

S
saving
 and closing a chart 177
 chart 223
 files to flash memory 303
 strategy and charts 177
 strategy to flash 178
 subroutine 368
saving I/O unit configuration 155
scratch pad commands 311
searching 204
secondary address 119
security certificate 292
Security type 291
segmenting control network 99
selecting
 block or text block 221
 connection line 221
Send Email
timeouts 298
send email 290
serial communication handle 286
serial communication module
 communicating with 261, 264, 266
 configuring 140
serial devices, communicating with 286
serial I/O unit
 changing baud rate 122
 changing baud rate and mode (Pro) 122
server 260, 261
setpoint, for PID 148
setting hex display mode 63
shortcuts, keyboard 73
Simple I/O units and commands 209
simulation commands 322
sizing columns in a dialog box 62
SNAP PAC redundancy option 104
SNAP-PAC-S2
 RTS/CTS 288
SoftPAC
 adding a control engine 24
 archiving strategies 110
 file storage 275
 link redundancy 101
 saving files to flash 303
software, launching from PAC Control 65
 sorting columns in a dialog box 63
SSL (Secure Sockets Layer) 291
starting a strategy 188
status codes 385
step into 191
step out 191
step over 191
stepping
 inside blocks 192
 one block at a time 191
 through a chart 191
 within a block 189
stepping through a chart
 auto stepping 193
 single stepping and auto stepping 191
stopping
 strategy 189
strategy
 archiving
 to computer 179
 to control engine 110
closing 177, 178
compiling 25, 180
compiling without downloading 183
creating 175
debugging 189
debugging when using OptoScript 359
definition 52, 175
deleting control engine 105
designing 75, 82
disassociating control engine 105
downloading 180, 183
downloading, changing compression 187
downloading, without using PAC Control 185
files 393
including subroutine 368
opening 176
replacing elements 206
restoring archive from control engine 112
running 27
  automatically 188
  manually 188
saving 177
saving to flash EEPROM 178
searching 204
starting automatically 243
stopping 189
transfer to another PC 113
viewing all operands 202
viewing variables and I/O 201
Strategy Tree
definition 56
docking 58
icons 56
string
  adding control characters 325
  commands 323, 345
    equivalents in Visual Basic and C 327
  convert-to-string commands 328
data extraction, example of 326
definition 52
  examples 325, 345
  in OptoScript 345
  length and width 324
  quotation marks 345
  variable, adding 233
  variable, definition of 230
string handling 335
string table
  example 325
subroutine
  adding commands (instructions) 367
  adding local variables 367
  auto stepping 193
  breakpoints 193
  calling from a chart 370
  compiling 368
  configuring parameters 364
  configuring parameters, example 367
  creating 362, 363
  data types 362
debugging 372
definition 361
  including in strategy 368
  list of files in 394
  parameters 361
  pausing 190
  printing commands 200
  printing graphics 198
  saving 368
  searching 204
  stepping through 191
tips 362
  viewing 372
  viewing all operands 202
  viewing variables 201
Switch & Run 182
switch statement 339, 352
switching strategies 182, 183
sync block
definition 214
syntax
  common errors, in OptoScript 359
  in OptoScript 343, 403, 405
system requirements for PAC Control 5

T
  table
    commands 310, 317
    in OptoScript 348
    numeric table as alternative to strings 324
table variable 231
  changing 247, 248
  initializing during strategy download 240
  monitoring in a watch window 247, 248
tabs, using to view windows 57
target address 309
task queue 257
TCP communication handle 258
TCP/IP cannot connect error, resolving 378
text
  changing color or size 223
text block
    deleting 222
    moving 221
    selecting 221
text, changing color or size 215
time/date commands (instructions) 330
timeouts
  for HTTP Get and HTTP Post 298, 302
  for Send Email commands 298
HTTP Get and HTTP Post commands 302

pointer, definition 321
table 231
types of data 230
types, in PAC Control 231
viewing all in a strategy 201, 202
velocity algorithm for PID 319
version, checking with OptoVersion 381
subroutine

troubleshooting
how to begin 375
in OptoScript 357
memory problems 376
memory problems from Online mode changes 54
PAC Message Viewer utility 380
Product Support 4
Windows permissions 382
tuning
PID loop 165
types of OptoScript commands 344

variable
adding 233
changing 244, 246
configuring 233
definition 52, 229
deleting 244
in strategy design 79
literal (constant) 232
monitoring in a watch window 170, 244, 246
monitoring variable 244
opening 172
while loop 337, 352
Windows permissions 382

UDP communication handle 267
Ultimate I/O units and commands 209

up timers 331

X
XVAL 306

Z
zooming in or out 59
z-order, changing 222